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Legal Notices

Novell, Inc. makes no representations or warranties with respect to the contents or use of this documentation, and 
specifically disclaims any express or implied warranties of merchantability or fitness for any particular purpose. 
Further, Novell, Inc. reserves the right to revise this publication and to make changes to its content, at any time, 
without obligation to notify any person or entity of such revisions or changes.

Further, Novell, Inc. makes no representations or warranties with respect to any software, and specifically disclaims 
any express or implied warranties of merchantability or fitness for any particular purpose. Further, Novell, Inc. 
reserves the right to make changes to any and all parts of Novell software, at any time, without any obligation to 
notify any person or entity of such changes.

Any products or technical information provided under this Agreement may be subject to U.S. export controls and the 
trade laws of other countries. You agree to comply with all export control regulations and to obtain any required 
licenses or classification to export, re-export, or import deliverables. You agree not to export or re-export to entities 
on the current U.S. export exclusion lists or to any embargoed or terrorist countries as specified in the U.S. export 
laws. You agree to not use deliverables for prohibited nuclear, missile, or chemical biological weaponry end uses. 
Please refer to www.novell.com/info/exports/ for more information on exporting Novell software. Novell assumes no 
responsibility for your failure to obtain any necessary export approvals.

Copyright © 2004-2005 Novell, Inc. All rights reserved. Permission is granted to copy, distribute, and/or modify this 
document under the terms of the GNU Free Documentation License (GFDL), Version 1.2 or any later version, 
published by the Free Software Foundation with no Invariant Sections, no Front-Cover Texts, and no Back-Cover 
Texts. A copy of the GFDL can be found at http://www.fsf.org/licenses/fdl.html or at “GNU Free Documentation 
License” on page 346.

THIS DOCUMENT AND MODIFIED VERSIONS OF THIS DOCUMENT ARE PROVIDED UNDER THE 
TERMS OF THE GNU FREE DOCUMENTATION LICENSE WITH THE FURTHER UNDERSTANDING 
THAT:

1. THE DOCUMENT IS PROVIDED ON AN “AS IS” BASIS, WITHOUT WARRANTY OF ANY KIND, 
EITHER EXPRESSED OR IMPLIED, INCLUDING, WITHOUT LIMITATION, WARRANTIES THAT THE 
DOCUMENT OR MODIFIED VERSION OF THE DOCUMENT IS FREE OF DEFECTS, MERCHANTABLE, 
FIT FOR A PARTICULAR PURPOSE, OR NON-INFRINGING. THE ENTIRE RISK AS TO THE QUALITY, 
ACCURACY, AND PERFORMANCE OF THE DOCUMENT OR MODIFIED VERSION OF THE DOCUMENT 
IS WITH YOU. SHOULD ANY DOCUMENT OR MODIFIED VERSION PROVE DEFECTIVE IN ANY 
RESPECT, YOU (NOT THE INITIAL WRITER, AUTHOR OR ANY CONTRIBUTOR) ASSUME THE COST OF 
ANY NECESSARY SERVICING, REPAIR OR CORRECTION. THIS DISCLAIMER OF WARRANTY 
CONSTITUTES AN ESSENTIAL PART OF THIS LICENSE. NO USE OF ANY DOCUMENT OR MODIFIED 
VERSION OF THE DOCUMENT IS AUTHORIZED HEREUNDER EXCEPT UNDER THIS DISCLAIMER; 
AND

2. UNDER NO CIRCUMSTANCES AND UNDER NO LEGAL THEORY, WHETHER IN TORT (INCLUDING 
NEGLIGENCE), CONTRACT, OR OTHERWISE, SHALL THE AUTHOR, INITIAL WRITER, ANY 
CONTRIBUTOR, OR ANY DISTRIBUTOR OF THE DOCUMENT OR MODIFIED VERSION OF THE 
DOCUMENT, OR ANY SUPPLIER OF ANY OF SUCH PARTIES, BE LIABLE TO ANY PERSON FOR ANY 
DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES OF ANY CHARACTER 
INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF GOODWILL, WORK STOPPAGE, 
COMPUTER FAILURE OR MALFUNCTION, OR ANY AND ALL OTHER DAMAGES OR LOSSES ARISING 
OUT OF OR RELATING TO USE OF THE DOCUMENT AND MODIFIED VERSIONS OF THE DOCUMENT, 
EVEN IF SUCH PARTY SHALL HAVE BEEN INFORMED OF THE POSSIBILITY OF SUCH DAMAGES.

Novell, Inc. has intellectual property rights relating to technology embodied in the product that is described in this 
document. In particular, and without limitation, these intellectual property rights may include one or more of the U.S. 
patents listed at http://www.novell.com/company/legal/patents/ and one or more additional patents or pending patent 
applications in the U.S. and in other countries.



novdocx (E
N

U
)  10 A

ugust 2006
Novell, Inc.
404 Wyman Street, Suite 500
Waltham, MA 02451
U.S.A.
www.novell.com

Online Documentation: To access the online documentation for this and other Novell products, and to get 
updates, see www.novell.com/documentation.
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Novell Trademarks

ConsoleOne is a registered trademark of Novell, Inc., in the United States and other countries.
DirXML is a registered trademark of Novell, Inc., in the United States and other countries.
eDirectory is a trademark of Novell, Inc.
Evolution is a trademark of Novell, Inc.
NetWare is a registered trademark of Novell, Inc., in the United States and other countries.
Novell is a registered trademark of Novell, Inc., in the United States and other countries.
NetWare Core Protocol and NCP are trademarks of Novell, Inc.
Red Carpet is a registered trademark of Novell, Inc., in the United States and other countries.
SUSE is a registered trademark of Novell, Inc., in the United States and other countries.
ZENworks is a registered trademark of Novell, Inc., in the United States and other countries.

Third-Party Materials

All third-party trademarks are the property of their respective owners.
Parts of this manual are copyright © 2003-2004 Sun Microsystems.
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About This Guide

This guide is intended for use by professional network and systems administrators during the actual 
planning, deployment, configuration, and operation of Novell® Linux* Desktop (NLD) in an 
enterprise environment. As such, it is solely concerned with ensuring that NLD is properly 
configured and that requisite services on the network are available to allow it to properly function as 
initially installed. This guide does not cover the process of ensuring that NLD offers proper 
compatibility with your enterprise’s application software, or that its core functionality meets those 
requirements. It assumes that a full requirements audit has been done and the installation has been 
requested or that a test installation, for the purpose of such an audit, has been requested. 

This guide contains the following:

Chapter 1, “Planning for Novell Linux Desktop,” on page 13
Chapter 2, “Deploying Novell Linux Desktop,” on page 21
Chapter 3, “Upgrading Novell Linux Desktop,” on page 99
Chapter 4, “Novell Linux Desktop Utilities,” on page 105
Chapter 5, “Troubleshooting,” on page 109
Appendix A, “Using YaST to Configure the Novell Linux Desktop,” on page 125
Appendix B, “Linux Authentication Using LDAP and eDirectory,” on page 179
Appendix C, “Automatic Linux Installation and Configuration Using AutoYaST,” on page 195
Appendix D, “Partitioning,” on page 255
Appendix E, “GNOME Configuration for Administrators,” on page 261
Appendix F, “KDE Configuration for Administrators,” on page 305
Appendix G, “Working with the Shell,” on page 321
Appendix H, “GNU Licenses,” on page 341

Audience

This guide is intended for NLD administrators.

Feedback

We want to hear your comments and suggestions about this manual and the other documentation 
included with this product. Please use the User Comments feature at the bottom of each page of the 
online documentation, or go to www.novell.com/documentation/feedback.html and enter your 
comments there.

Documentation Updates

For the latest version of this documentation, see the Novell Linux Desktop documentation (http://
www.novell.com/documentation/lg/nld/index.html) Web site.
About This Guide 11
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Additional Documentation

For user documentation, see the Novell Linux Desktop Quick Start (http://www.novell.com/
documentation/nld/qsnld/data/brmch9i.html), the Novell Linux Desktop GNOME User Guide (http:/
/www.novell.com/documentation/nld/userguide_gnome/data/front.html) and the Novell Linux 
Desktop KDE User Guide (http://www.novell.com/documentation/nld/userguide_kde/data/
front.html).

For information on the SUSE® Linux Enterprise Server 9 operating system, see the SUSE LINUX 
Enterprise Server 9 Administration Guide (http://www.novell.com/documentation/sles9/pdfdoc/
sles_9_admin_guide/sles_9_admin_guide.pdf).

Documentation Conventions

In Novell documentation, a greater-than symbol (>) is used to separate actions within a step and 
items in a cross-reference path.

A trademark symbol (®, TM, etc.) denotes a Novell trademark. An asterisk (*) denotes a third-party 
trademark.
 Desktop 9 Deployment Guide
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1Planning for Novell Linux Desktop

This chapter is meant to be read by a systems or network administrator who is responsible for the 
rollout of Novell® Linux Desktop (NLD) in an enterprise, or for the safe operation of a network 
where NLD systems will be brought up and operated. It is intended to answer some of the most 
important questions experienced administrators might ask when told that NLD systems will be 
added to their areas of responsibility.

To those who aren’t familiar with NLD or Linux at all and who come from a Windows*, 
Macintosh*, NetWare®™, or UNIX background, we suggest evaluating NLD on a single machine 
before rolling it out to the network. Chapter 2, “Deploying Novell Linux Desktop,” on page 21 
provides an overview of the deployment techniques available with NLD and contains a detailed 
description of the installation procedure (“Manual Installation” on page 25). By doing a manual 
install and testing it in lab conditions, administrators can familiarize themselves with NLD and 
determine how it meets the needs of their network and which deployment method best fits their 
requirements.

The first question that comes to mind if a new software is to be deployed is “What do I need to run 
NLD in the enterprise?” Next, experienced network administrators think of such questions as “What 
will NLD do to my network? What will it want from my network? How will it behave?” Because the 
answer to the first question determines whether the other questions apply, it is answered first (see 
“Hardware Requirements” on page 13).

Some of the more typical discussions that might be expected in an administrator’s guide 
(partitioning, performance optimization, network traffic optimization) have been given short shrift. 
This is due to NLD’s focus as a desktop product as opposed to a server product. As such, rather than 
discussing fairly common server topics such as RAID levels and RAID system configuration, for 
example, this documentation instead directs the reader to the appropriate companion documentation 
for SUSE® LINUX Enterprise Server (SLES) if the NLD component in question is shared with 
SLES, or to documentation resources available from the Open Source Community (see “Additional 
Documentation” on page 19).

1.1  Hardware Requirements
To install Novell Linux Desktop, some minimum system requirements must be met. Make sure your 
target systems match the following criteria:

Personal computer with a Pentium* II or higher processor, or any other AMD64 for Intel* 
EM64T processor, and a bootable CD-ROM drive
1 or 2 physical CPUs
4 GB hard disk space when installing the default GNOME or KDE desktop but not more than 8 
TB. 
8 GB is recommended if installing both GNOME and KDE desktops, or additional software 
selections.
128 MB RAM (256 MB recommended, but not more than 64 GB)
Super VGA display adapter
Network card (if you are connecting to a network)
Planning for Novell Linux Desktop 13
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BIOS and network hardware supporting network boot (if you plan on doing a remote mass 
deployment)
USB, PS/2*, or serial mouse
Screen resolution of at least 1024 x 768

NLD can run on a wide range of x86-compatible hardware. As with most desktop operating systems, 
the requirements vary depending on the anticipated uses of the particular system. However, some 
general guidelines can be helpful for planning purposes. Seasoned administrators might want to test 
their own final configurations with particular care to include any third-party applications or 
network-based services, on a range of available hardware, to ensure that adequate resources are 
available for each configuration’s expected tasks.

Following are some suggested hardware minimums for various typical workstations and their 
intended uses under NLD. Note that while the product can be installed on hardware of lower 
performance, sharply reduced responsiveness might result.

Table 1-1   Suggested Hardware Minimums

The original release of NLD was not certified to run on Intel EM64T or AMD64 processors in native 
64-bit mode. However, this capability has been implemented for the SP1 release (and later) of NLD. 
It now runs on these platforms in 32-bit mode as well as in native 64-bit mode.

1.2  Network Services Used by Novell Linux 
Desktop
NLD is most effectively used as a networked operating system. Although NLD does not require 
network services in order to function, such as on a standalone workstation or on a disconnected 
laptop, most users and organizations can realize maximal gains from installing NLD and using it in 
a networked environment. Therefore, there are several standard infrastructural network services 
which can increase the performance and usability of your NLD systems. They should be familiar to 
any experienced TCP/IP network administrator. They are listed below by type, with specific 
examples of each type given. Usually, only one of each type is required.

1.2.1  Name Resolution Services
Network name resolution is done by Domain Name System (DNS). Most TCP/IP networks have 
access to DNS services. NLD quite easily uses DNS for name resolution; no special (nonstandard) 
DNS records or services need to be present for NLD to function. There are some specific 
configuration tricks on the client side for ensuring that NLD properly retrieves its hostname in a 

Desktop Hardware Minimum

Minimum Graphic Desktop (basic GUI, 
OpenOffice.org, Web browsing with minimal 
Java*/Flash/multimedia)

Pentium 3 500 MHz, 256 MB RAM, 8 GB hard 
drive

Standard Graphic Desktop (basic GUI, 
OpenOffice.org, Web browsing with Java/Flash/
streaming media, real-time audio in background, 
shared folders, occasional graphics manipulation, 
programming, and compilation)

Pentium 3/4 1 GHz, 512 MB RAM, 20 GB hard 
drive, 100 MB/sec Ethernet
 Desktop 9 Deployment Guide
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dynamic address environment, or on a system which frequently changes networks (such as a laptop 
with wireless networking).

Although no special additions to DNS are required, there are some techniques involving DNS which 
can be used to make the networked installation of NLD easier, or to make the management of 
dynamically addressed machines go more smoothly. For more information, see “Section 21.7: 
DNS—Domain Name System” in the SUSE LINUX Enterprise Server 9 Administration Guide 
(http://www.novell.com/documentation/sles9/pdfdoc/sles_9_admin_guide/
sles_9_admin_guide.pdf).

1.2.2  Network Address Services
Dynamic Host Configuration Protocol (DHCP) is a server-based system for allocating network 
configuration information and more to a host upon startup. NLD can be configured to receive its 
network address from a DHCP server (either during initial installation or at any point thereafter 
using the configuration utilities). Allocating network addresses for NLD machines should not differ 
in any way from allocating TCP/IP network addresses for machines running other operating 
systems, because it is OS-independent. For information on how to allocate addresses using DHCP, 
refer to your DHCP server product’s documentation. If you do not have a DHCP server and want to 
set one up, either for a test installation or for production use, SUSE LINUX Enterprise Server 
(SLES) contains a fully functional ISC DHCP server and all the documentation required for its 
configuration. You can also download this server and view or download its documentation from the 
Internet System Consortium (http://www.isc.org/index.pl?/sw/dhcp) Web site. 

NOTE: The DHCP server is instrumental in setting up a networked install environment using 
PXEBOOT and AutoYaST. For more information, see Chapter 2, “Deploying Novell Linux 
Desktop,” on page 21 and Appendix C, “Automatic Linux Installation and Configuration Using 
AutoYaST,” on page 195.

1.2.3  Directory Services
Directory services allow the task of managing user and group information (including account data, 
group membership information and, optionally, additional information on users such as contact 
information and corporate administrative information) to be done from a central location. This 
prevents the need to have such information replicated to each user’s desktop, avoiding the potential 
for conflicts, out-of-date information, inappropriate access and changes, etc. Some popular directory 
services include OpenLDAP, NIS, and Novell eDirectory™™. 

Planning for directory services can be complex. While they can make the task of user information 
management much more streamlined, they can complicate matters immensely if machines travel on 
and off your corporate network and cannot access your directory servers from outside. You must 
take care to either make sure that these services are available from all locations or that every 
machine has a local user information record for those times when it is unable to contact the 
appropriate services.

NLD is able to interact with many directory services. It is able to do so out-of-the-box using two 
protocols: LDAP (Lightweight Directory Access Protocol) and NIS (Network Information Service). 
It should be noted at the outset that its ability to utilize many directory services is dependent on the 
ability of each server’s ability to respond using one of these two protocols. OpenLDAP (which is 
also present in SUSE LINUX Enterprise Server) is an open source LDAP-protocol directory server 
Planning for Novell Linux Desktop 15
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popular in the Linux community. The eDirectory product is capable of serving directory information 
in the LDAP format, which is one way NLD is used in-house at Novell.

LDAP

If your organization currently provides directory services, your primary concern will be discovering 
how to ensure that your current directory can be made available to NLD systems. If you currently 
use an OpenLDAP or other LDAP v2/3 compatible directory, your primary concern will be making 
sure that your directory contains enough information, in the correct schema, for NLD to perform 
lookups and (if necessary) authentication. 

For a general jumpstart and reference material, see the documentation available at the OpenLDAP 
(http://www.openldap.org) Web site or turn to the introductory chapter on LDAP in the SUSE 
LINUX Enterprise Server 9 Administration Guide (http://www.novell.com/documentation/sles9/
pdfdoc/sles_9_admin_guide/sles_9_admin_guide.pdf). Although experienced LDAP administrators 
will no doubt want to build or add on to their own custom schemas, a shorthand version of the 
minimum required information can be expressed as follows: an OpenLDAP server serving the 
core.schema, cosine.schema, inetorgperson.schema, and 
posixAccount.schema should provide enough information for most organizations’ network 
identification needs. The OpenLDAP documentation referenced above contains fully annotated 
versions of those schemas. They are also included with OpenLDAP as it is shipped in SUSE LINUX 
Enterprise Server 9.

Here is a sample LDIF template that provides a one-stop view of all the fields required for basic user 
information lookup from within NLD:
dn: uid=joebloggs,ou=People,dc=mycompany,dc=com
uid: joebloggs
objectClass: organizationalPerson
objectClass: inetOrgPerson
objectClass: posixAccount
objectClass: top
uidNumber: 500
gidNumber: 100
loginShell: /bin/bash
homeDirectory: /home/joebloggs
gecos: Joe Bloggs
sn: Bloggs
cn: Joe
givenName: Joseph
mail: joebloggs@mycompany.com

dn: cn=staff,ou=Group,dc=mycompany,dc=com
changetype: modify
memberUid: joebloggs

dn: cn=sales,ou=Group,dc=mycompany,dc=com
changetype: modify
memberUid: joebloggs

The first section should be familiar to any LDAP admin. It defines Joe Bloggs as a DN 
(Distinguished Name) within the OU (Organizational Unit) People of the domain mycompany.com. 
His userid (UNIX username) is joebloggs. Note that his uidNumber is 500, traditionally the first 
“regular” user on many Linux distributions; his gidNumber (default Group ID) is 100, traditionally 
 Desktop 9 Deployment Guide
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the first “regular” user group. After this, the path to his preferred login shell (here, /bin/bash) 
and his home directory location are given. His gecos information corresponds to the GECOS field in 
Linux’s /etc/passwd file; surname, common name, given name, and delivery e-mail address 
round out the section.

The second and third sections add Joe Bloggs to the usergroups named staff and sales, respectively. 
It is assumed that LDAP objects for these groups already exist in the database; these stanzas merely 
modify them to add Joe Bloggs to their list of members. When the above LDIF is added to the 
LDAP database (perhaps with the OpenLDAP tool ldapadd, for example), then any NLD machine 
pointed at that LDAP directory should recognize the user with UID 500 as Joe Bloggs.

Note carefully that the above LDIF does not contain a password. This section is concerned with 
directory services, not authentication. Therefore, any attempt to authenticate against this record 
would fail. Password fields could certainly be added, however. The list of schemas mentioned 
earlier do, in fact, include encrypted password fields for just this purpose.

eDirectory

If your organization is currently using eDirectory, see Appendix B, “Linux Authentication Using 
LDAP and eDirectory,” on page 179 for instructions on integrating NLD into your eDirectory 
infrastructure.

NIS

NIS (Network Information Service) is a database-like service that provides user and group 
information to all clients on a network. People often refer to NIS as YP, which simply stands for the 
idea of the network's “yellow pages.”

For information on NIS, see “Section 21.9: NIS—Network Information Service” in the SUSE 
LINUX Enterprise Server 9 Administration Guide (http://www.novell.com/documentation/sles9/
pdfdoc/sles_9_admin_guide/sles_9_admin_guide.pdf).

1.2.4  Authentication Services
Authentication services are those network-based systems which allow user credentials to be 
centrally managed. Some of the most popular examples in the Linux world include LDAP, 
Kerberos*, and SMB. Although NLD does not require a networked authentication service, it can use 
them, but planning for them can be complex. If your systems are desktop machines and are always 
online, there is really no downside to having them be centrally authenticated. However, if you have 
laptop users, you must consider the situation where they have the machine off your corporate 
network. There must then be a fallback authentication method by which they can be authenticated 
via local resources. Usually, this can be accomplished via Linux-PAM (Pluggable Authentication 
Modules). However, such fallback authentication methods have their own security risks, which 
should not be ignored.

It is more difficult to offer specific suggestions concerning authentication systems, because they are 
more prone than directory services to be proprietary or modified for site-specific needs. If your site 
is currently running a network authentication system, the admin responsible for it will need to 
determine how to best make it function with NLD. NLD as shipped can authenticate against the 
three networked services mentioned above; the configuration tools provided allow the administrator 
or user to configure NLD to authenticate against an LDAP directory containing an encrypted 
password, a Heimdal Kerberos v5 authentication system (or an MIT Kerberos v5 system), or a 
Planning for Novell Linux Desktop 17
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Windows domain controller/Samba server. In addition, it contains tools for users to manage their 
password information from their local machine for each of these services.

For information, see Kerberos: The Network Authentication Protocol (http://web.mit.edu/kerberos/
www), the Kerberos chapters in SUSE LINUX Enterprise Server 9 Administration Guide (http://
www.novell.com/documentation/sles9/pdfdoc/sles_9_admin_guide/sles_9_admin_guide.pdf), 
LDAP Authentication for Linux (http://www.metaconsultancy.com/whitepapers/ldap-linux.htm), 
and SMB Proxy Authentication Module (http://www.hacom.nl/~richard/software/smb_auth.html).

1.3  Network Behavior of Novell Linux Desktop
The first question that most admins might ask when told to support a new installation on their 
networks is “What will it do to my network?” This section attempts to answer that with reference to 
a basic installation of NLD. The short answer is this: NLD, like most Linux distributions, integrates 
smoothly into existing networks. However, it behaves somewhat differently from the average 
Windows or Macintosh computer and, as such, a quick overview of what can be expected is given 
here.

Security is a subject on most admins’ minds these days. NLD is no more unbreakable than any other 
software product out there; however, with a modicum of care and foresight, it can easily be one of 
the most trouble-free user desktops on your network. Most of the tools necessary for this ship with 
NLD itself. 

From a planning point of view, there are several questions whose answers make deploying the 
desktop go more smoothly. These questions are not all specific to NLD and are familiar to any 
experienced admin:

Are there any easily defined subgroups which can be isolated by their network use patterns 
(common file servers, common gateways, common printers)?
Are there any network segments behind slow or unreliable network links? (Because of NLD’s 
heavy use of DNS when networked, these segments might benefit from a dedicated DNS 
server.)
Will NLD users be restricted from using any ports to send packets from their machines? Should 
they be?
Will NLD machines be able to open persistent connections to locations where those 
connections can be abused?

The first two should certainly be addressed before deployment. The second two will affect how 
NLD functions on the network and, therefore, should be addressed even before user and machine 
security policy is discussed or devised.

NLD’s most visible network behavior, absent heavy user network load, is its relatively frequent use 
of directory services and network name resolution services if it is configured to use them. Several 
components of the desktop rely heavily on DNS to function properly, and such simple operations as 
performing a directory listing can cause multiple directory connections if the machine is configured 
to retrieve user information from a remote server, because it will perform such a lookup in order to 
properly display the ownership of each file and subdirectory within the listing. It is not uncommon 
to see NLD machines maintain several open TCP/IP connections to their local directory and DNS 
servers at all times when in use, performing queries at a fairly rapid rate even if the user is not 
working in applications that typically would seem to need directory information, such as e-mail 
clients. Therefore, relatively short and noncomplex paths to these services are essential. If, for 
example, these services are separated from the NLD machines by a NAT (Network Address 
 Desktop 9 Deployment Guide
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Translation) gateway, ensuring that the number of available NAT sessions is adequate to support 
multiple sessions per machine is extremely important, or performance can be severely degraded. 
Similarly, if these services are behind a network bottleneck such as a slow WAN (Wide Area 
Network) link, performance problems might result.

Perhaps the most important decision the admin can make regarding users and NLD’s network 
behavior is the degree of access users have to root services. Although it is possible and, in some 
cases, recommended, that users do not have root access to the NLD machine, this setup requires 
careful planning in the deployment phase in order to ensure that essential tasks such as software 
upgrades and local machine configuration are still possible without hands-on admin intervention. 
While local user access to root can make delegating management functions much simpler and, in 
some cases (expert users, lab machines, developers) necessary, it also allows local users to access 
the network in more fundamental ways, using privileged TCP ports (below 1024) at will, for 
example, and should be taken into account when planning network security.

The most effective means at the admin’s disposal to ensure that local root access is not used to 
compromise network security is the same in the case of NLD as it is with any other machine on the 
network: central security measures. These include but are not limited to firewalls, router ACLs 
(Access Control Lists), Intrusion Detection Systems, enforced proxy access policies, identity 
management and access control policies, and zoned defenses. Because this documentation is not 
intended to serve as a network security primer, here are some additional references we strongly 
recommend if you want a better starting point:

The Linux Security HOWTO (http://www.linuxsecurity.com/docs/LDP/Security-HOWTO)
The Network Security HOWTO (http://www.linuxsecurity.com/docs/LDP/Security-HOWTO/
network-security.html)
TrinityOS: A Guide to Configuring Your Linux Server for Performance, Security, and 
Manageability (http://www.ecst.csuchico.edu/~dranch/LINUX/TrinityOS/cHTML/TrinityOS-
c.html)

1.4  Additional Documentation
Apart from the specific NLD documentation that is available from the NLD documentation home 
page (http://www.novell.com/documentation/nld/), check the following resources for additional 
open source documentation on Linux:

SLES Installation and Administration Guide 
This guide offers you indepth information on typical server-related configuration issues. Find it 
on the SLES documentation home page (http://www.novell.com/documentation/sles9/pdfdoc/
sles_9_admin_guide/sles_9_admin_guide.pdf).

Package Documentation 
Almost every package shipped with NLD comes with its own documentation. To check out a 
package’s documentation, always turn to /usr/share/doc/packages/
package_name. The bare minimum you could expect to find there is a readme file, but most 
packages ship with quite comprehensive documentation, often even including example 
scenarios or ready-to-use configuration examples.

Project Home Pages 
Planning for Novell Linux Desktop 19
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Check out a project’s home page for additional documenation, screenshots, examples, and 
often even a mailing list for users and developers of the project. Even just browsing the 
archives of these lists often proves valuable.

The Linux Documenation Project (TLDP) 
Volunteers from all over the world and from all kinds of projects through the open source 
world have contributed to a large database containing various kinds of documentations ranging 
from mere mini-HOWTOs and quick references to full-blown guides. See the TLPD web site 
(http://www.tlpd.org) for more information.

1.5  Support for Your Deployment of NLD
Another big issue in industry deployments of any software is where to turn to in case of problems 
and where to get immediate help. Novell offers several different options to support their NLD 
customers in every possible way.

If you are looking for more information on the product, or want to discuss the product with peers, 
turn to the Novell Linux Desktop Support Community (http://support.novell.com/products/desktop/
). This site offers you the following:

A comprehensive search on NLD-related items in any Novell publication, such as 
documentation, knowledgebase, and articles and tips.
Novell support forums, either NLD specific or for all Novell products.
The documentation associated with NLD.
The latest articles that have been published for NLD.
Product-related downloads.

These self-support options are all offered free of charge.

For help with a technical problem related to NLD, turn to the paid support options of Novell Linux 
Desktop Installation Support (http://support.novell.com/products/desktop/installation/) or Novell 
Linux Desktop Component Support (http://support.novell.com/products/desktop/
component_support.html).

If you want specially trained professionals to help with your deployment of NLD, contact the Novell 
Consulting Services through the Novell Consulting Home Page (http://www.novell.com/consulting/
).
 Desktop 9 Deployment Guide

http://www.tlpd.org
http://support.novell.com/products/desktop/
http://support.novell.com/products/desktop/installation/
http://support.novell.com/products/desktop/installation/
http://support.novell.com/products/desktop/component_support.html
http://support.novell.com/products/desktop/component_support.html
http://www.novell.com/consulting/


2
novdocx (E

N
U

)  10 A
ugust 2006
2Deploying Novell Linux Desktop

There are several different ways to deploy Novell® Linux Desktop (NLD) on workstations. Choose 
from various approaches to a local install using either physical media or a network installation 
server or do a mass deployment using a remote controlled, highly customized and automatic 
installation technique. 

This chapter introduces several scenarios either for single installations or potential mass 
deployments of NLD:

“Manual Installation” on page 25
“Remote Installation” on page 53
“Automated Installation” on page 76

2.1  Deployment Strategies
The following section should help you determine which installation method featured in this chapter 
best matches your requirements.

2.1.1  Deploying up to 10 Workstations
If your deployment of NLD involves only one to 10 workstations, the easiest and least complex way 
of deploying NLD would be a plain manual install as featured in “Manual Installation” on page 25.

Manual installation can be done in several different ways depending on your requirements:

Installation 
Method

Installation 
Source

Tasks Requiring Manual 
Interaction Remotely Controlled Tasks

“Using the NLD 
CDs or DVD as 
the Installation 
Source” on 
page 25

NLD media kit Insert installation media 

Boot installation target

Change media

Determine YaST installation 
scope

Configure YaST system.

None.

“Network 
Installation with 
OpenSLP” on 
page 53

Network 
installation 
server holding 
the NLD 
installation 
media

Insert boot disk

Provide boot options

Boot installation target

Determine YaST installation 
scope

Configure YaST system

None, but method can be 
combined with VNC (see 
below).
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2.1.2  Deploying up to 100 Workstations
With a growing numbers of workstations to install, you certainly don’t want to install and configure 
each one of them manually. There are many automated or semiautomated approaches as well as 
several options to perform an installation with minimal or no physical user interaction.

Before considering a fully automated approach, take into account that the more complex the 
scenario, the longer it takes to set up. If a time limit is associated with your deployment, you might 
choose a less complex approach that can be carried out much faster. Automization makes sense for 
huge deployments and those that are to be carried out remotely.

“Network 
Installation 
through VNC” 
on page 53

Network 
installation 
server holding 
the NLD 
installation 
media

Insert boot disk

Provide boot options

Boot installation target

Determine YaST 
installation scope.

Configure YaST system.

Installation 
Method

Installation 
Source Preparations Control/

Monitoring Best Suited For Drawbacks 

“Simple 
Remote 
Installation via 
VNC—Static 
Network 
Configuration” 
on page 54

Network Set up 
install 
source

Boot from 
install 
media

Remote: 
VNC

Small to medium 
scenarios with 
heterogeneous 
hardware 
configuration

Each machine 
has to be set 
up individually

Physical 
access 
needed for 
booting

“Simple 
Remote 
Installation via 
VNC—
Dynamic 
Network 
Configuration 
via DHCP” on 
page 54

Network Set up 
install 
source

Boot from 
install 
media

Remote: 
VNC

Small to medium 
scenarios with 
heterogeneous 
hardware 
configuration

Each machine 
has to be set 
up individually

Physical 
access 
needed for 
booting

“Remote 
Installation via 
VNC—PXE 
Boot and 
Wake-on-LAN” 
on page 55

Network Set up 
install 
source

Configure 
DHCP, 
TFTP, 
PXE boot, 
and WOL

Network 
boot

Remote: 
VNC

Small to medium 
scenarios with 
heterogeneous 
hardware 
configuration

Completely 
remote installs, 
cross-site 
deployment

Each machine 
has to be set 
up manually

Installation 
Method

Installation 
Source

Tasks Requiring Manual 
Interaction Remotely Controlled Tasks
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“Simple 
Remote 
Installation via 
SSH—Static 
Network 
Configuration” 
on page 56

Network Set up 
install 
source

Boot from 
install 
media

Remote: 
SSH

Small to medium 
scenarios with 
heterogeneous 
hardware 
configuration

Low bandwidth 
connections to 
target

Each machine 
has to be set 
up individually

Physical 
access 
needed for 
booting

“Simple 
Remote 
Installation via 
SSH—
Dynamic 
Network 
Configuration 
via DHCP” on 
page 57

Network Set up 
install 
source

Boot from 
install 
media

Remote: 
SSH

Small to medium 
scenarios with 
heterogeneous 
hardware 
configuration

Low bandwidth 
connections to 
target

Each machine 
has to be set 
up individually

Physical 
access 
needed for 
booting

“Remote 
Installation via 
SSH—PXE 
Boot and 
Wake-on-LAN” 
on page 57

Network Set up 
install 
source

Configure 
DHCP, 
TFTP, 
PXE boot, 
and WOL

Boot 
network 

Boot 
network

Remote: 
SSH

Small to medium 
scenarios with 
heterogeneous 
hardware 
configuration

Completely 
remote installs, 
cross-site 
deployment

Low bandwidth 
connections to 
target

Each machine 
has to be set 
up individually

“Imaging” on 
page 76

Network Set up 
NFS 
server

Boot 
master 
and target 
from 
install 
media

Set up 
master 
machine

Prepare 
target 
machine

Local Medium to large 
scenarios with 
identical 
hardware

Exact clones of 
one machine (if 
needed)

Applies only to 
homogenous 
hardware 
setups

Considerable 
configuration 
efforts needed

Each machine 
has to be 
configured 
individually

Physical 
access 
needed

Installation 
Method

Installation 
Source Preparations Control/

Monitoring Best Suited For Drawbacks 
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“Firstboot 
Configuration” 
on page 80

Network YaST 
firstboot 
configurati
on

Set up 
NFS 
server

Boot 
master 
and target 
from 
install 
media

Set up 
master 
machine

Prepare 
target 
machine

Local Medium to large 
scenarios with 
identical 
hardware

Exact clones of 
one machine a 
(if needed)

Applies only to 
homogenous 
hardware 
setups

Considerable 
configuration 
efforts needed

Each machine 
has to be 
configured 
individually

Physical 
access 
needed

“Create 
Custom 
Installations 
Using the 
control.xml 
File” on 
page 84

Network Create 
custom 
control file

Set up 
server for 
install 
media and 
control file

Set up 
network 
boot 
(DHCP, 
TFTP, 
PXE, 
WOL or

Boot 
target 
from 
install 
media 

Local or 
remote: 
VNC or 
SSH

Medium to large 
scenarios with 
identical or 
similar hardware

Customized 
installations are 
called for

Cross-site 
scenarios (if 
remotely 
controlled)

Applies only to 
fairly 
homogenous 
hardware 
setups

Considerable 
configuration 
efforts needed

Each machine 
has to be set 
up individually

Installation 
Method

Installation 
Source Preparations Control/

Monitoring Best Suited For Drawbacks 
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2.1.3  Deploying More Than 100 Workstations
Most of the considerations mentioned for medium installation scenarios in “Deploying up to 10 
Workstations” on page 21 still hold true for large scale deployments. But with a growing number of 
installation targets, the benefits of a fully automated installation method outweigh its disadvantages.

It is worthwhile to invest a considerable amount of time to create a sophisticated rule and class 
framework in AutoYaST to match the requirements of a huge deployment site. Not having to touch 
each target separately can save you a huge amount of time depending of the scope of your 
installation project.

2.2  Manual Installation
Manual installation can be done in several different ways. You can either install from a local 
installation source (such as the NLD CDs or DVD) or get the installation sources from an FTP, 
HTTP, or NFS server. In any case, this approach requires physical access to the system that is to be 
installed and user interaction during the installation and configuration procedure.

The installation procedure is basically the same, no matter which installation source or method you 
use. Understanding the manual procedure can help you to understand the automated installation 
procedures as well.

2.2.1  Using the NLD CDs or DVD as the Installation Source
Installation can be done from the distribution CDs by inserting Novell Linux Desktop CD 1 or DVD 
and then booting the workstation. This type of installation requires user interaction. 

“Automatic 
Linux 
Installation and 
Configuration 
Using 
AutoYaST” on 
page 195

Preferably 
network

Create 
AutoYaST 
profile

Set up 
installation 
server

Distribute 
profile

Set up 
network 
boot 
(DHCP, 
TFTP, 
PXE, 
WOL) or

Boot 
target 
from 
install 
media 

Local or 
remote: 
VNC or 
SSH

Large scenarios

Heterogeneous 
hardware 
configurations

Completely 
hands-off (if 
network boot is 
used)

Cross-site 
scenarios

Considerable 
configuration 
efforts needed

Installation 
Method

Installation 
Source Preparations Control/

Monitoring Best Suited For Drawbacks 
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IMPORTANT: Make sure that the workstation's BIOS has been configured to boot from CD before 
you start the installation process. Otherwise, you cannot perform an installation because the installer 
is not able to access the installation media in your drive.

Booting for Installation

Insert the Novell Linux Desktop CD 1 or DVD into the drive, then reboot the computer to start the 
installation program.

This brings up the installation screen offering the following options for you to choose from.

Boot from Hard Disk 
Boots the system already installed on the hard drive (the system normally booted when the 
machine is started).

Installation 
Boots the normal installation. 

Installation—ACPI Disabled 
If the normal installation fails, it could be because the system hardware doesn't support the 
Advanced Configuration and Power Interface (ACPI). If this seems to be the case, use this 
option to install without ACPI support.

Installation—Safe Settings 
Boots the system with the DMA mode (for CD-ROM drives) and any interfering power 
management functions disabled.

Manual Installation 
 By default, drivers are loaded automatically during the installation. If this appears to cause 
problems, use this option to load drivers manually. This option does not work if you use a USB 
keyboard on your system.

Rescue System 
If you are unable to boot into your installed Linux system for some reason, you can boot the 
computer from the CD using this option. This starts a minimal Linux system without a 
graphical user interface, which lets you access disk partitions for troubleshooting and repairing 
the installed system. For more information on the rescue system, refer to “How do I recover a 
corrupted system?” on page 123.

Memory Test 
Tests your system RAM by means of repeated read and write cycles. This is done in an endless 
loop because memory corruption often shows up sporadically and many read and write cycles 
might be necessary to detect it. If you suspect that your RAM is defective, start this test and let 
it run for several hours. If no errors are found after a long period of time, you can assume that 
the memory is intact. End the test by rebooting the system.

IMPORTANT: Some hardware models, mostly fairly aged or very recent ones, require special boot 
options to be passed on to the kernel at installation time. Use the boot options prompt to pass these 
on to the kernel. After you determined the right set of options to use, YaST automatically adds them 
to the boot loader configuration making sure the system boots up correctly. See Chapter 5, 
“Troubleshooting,” on page 109 for details on this and read “Chapter 8: Booting and Boot 
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Managers” in the SUSE LINUX Enterprise Server 9 Administration Guide (http://www.novell.com/
documentation/sles9/pdfdoc/sles_9_admin_guide/sles_9_admin_guide.pdf) for instructions on the 
syntax of the boot loader configuration in NLD.

Use the boot options prompt to enter any additional boot option for the Linux kernel. Options 
entered here are valid during only one boot process.

The menu bar at the bottom of the screen offers some additional functionality needed in some 
setups:

Table 2-1   Installation Menu Bar Options

Leave these menus either by selecting one of these options or by pressing Esc.

Then select Installation and press Enter. This loads the Novell Linux Desktop installation program 
and starts the installation in normal mode.

Read the License agreement, then click I Agree to accept it and continue the installation.

Language Selection

After you have accepted the licence agreement, set the keyboard language. This setting applies not 
only to the keyboard layout during installation, but also to the installed system. The settings made 
here are used by NLD to assume the time zone settings for your workstation.

TIP: If you want to change these settings later on during the installation process, launch the YaST 
modules for time zone and keyboard from the Installation Settings screen (described in “Installation 
Settings” on page 29). If you want to change these settings in the installed NLD system, start the 
YaST Control Center and launch the Date and Time and Select Keyboard modules of the System 
submenu.

Option Description

F1 Launches a help section on the boot screen.

F2 If the graphical installation mode at a given screen resolution causes any problem, use 
this menu to either select a lower resolution or switch over to the text mode of the 
installation program. 

F3 Selects the installation source. The default setting is CD-ROM. If network installation 
sources are available, consider selecting one of the different network installation 
procedures.

F4 Selects the language used for the installation screen and all of the following dialogs.

F5 By default, the system does not display the log messages of the ongoing installation. 
By selecting Native, these messages are shown. To get a complete log of the 
procedure, select Verbose.

F6 If you have a driver update disk that needs to be applied before the actual installation, 
select this option. You are asked for this disk later in the installation process.
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Figure 2-1   Language Selection

After you have completed the language settings, click Accept and proceed with selecting your 
preferred desktop environment.

Selecting the Desktop Environment

Novell Linux Desktop ships with two fully fledged desktop environments, GNOME and KDE. 
Selecting one of them at this point limits the scope of your installation to a set of default system 
packages plus all the packages provided by the desktop of your choice. If you do not know which 
environment your company prefers, ask your system administrator. For more information on the 
desktop environments, see the Novell Linux Desktop GNOME User Guide (http://www.novell.com/
documentation/nld/userguide_gnome/data/front.html) and the Novell Linux Desktop KDE User 
Guide (http://www.novell.com/documentation/nld/userguide_kde/data/front.html).

TIP: If you want to install packages belonging to the other desktop environment because you need a 
special tool, you can do so later on in the installation process. See “Software Selection” on page 34 
for information.
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Figure 2-2   Selecting the Default Desktop Environment

Installation Settings

The Installation Settings screen comprises any information relevant to the installation procedure. 
You can select any of the following options and configure them in the corresponding dialogs. After 
your changes have been made, you are always returned to the Installation Settings screen, which is 
updated accordingly.

System 
Detects system hardware and lets you save the results to a floppy or file.

Mode 
This version of Novell Linux Desktop only offers the New Installation mode.

Keyboard Layout 
Changes the previously selected keyboard layout. By default, the layout corresponds to the 
selected language.

Mouse 
Selects a mouse type other than the one NLD detected automatically. After selecting a mouse 
type, press Alt+T to test whether the device works correctly without making the selection 
permanent.

Partitioning 
Customizes the partitioning. In most cases, NLD suggests a reasonable partitioning scheme that 
can be accepted without any change. For more information, see “Partitioning” on page 31.

Software 
NLD offers several types of software packages with various installation scopes. Depending on 
the available disk space and the desktop environment you selected, NLD selects one of the 
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these predefined systems for you. Use this option to change the selected desktop environment 
and to add or remove packages and filters. For more information on how the management of 
software packages is done using YaST, see “Software” on page 127.

Booting 
During the installation, NLD proposes a boot configuration for your system. You should 
normally leave these settings unchanged, but you can use this option if you need a custom 
setup.

Time Zone 
Selects a time zone. You can also set the hardware clock to Local Time or UTC. If you set the 
hardware clock to UTC, your system can rely on NLD to switch between standard time and 
daylight saving time automatically. Set the clock to Local Time if you are dual booting.

Language 
Changes the language you selected. You can also change the language when you log in.

Default Runlevel 
Defines how the system is started after booting. Use the default runlevel 5: Full Multiuser with 
Network and xdm (which prompts you to log in directly under a graphical interface). Do not 
change the runlevel unless instructed to do so by your system administrator. For more 
information on the SUSE® LINUX boot concept that is used with NLD, see “Chapter 11: The 
SUSE LINUX Boot Concept” in the SUSE LINUX Enterprise Server 9 Administration Guide 
(http://www.novell.com/documentation/sles9/pdfdoc/sles_9_admin_guide/
sles_9_admin_guide.pdf).

Figure 2-3   Installation Settings Overview
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Partitioning

During installation, YaST usually suggests a reasonable partitioning. However, if you want to 
change the suggested partitioning (for example, add extra partitions for later use or for alternate 
operating systems), you can customize the partition setup by clicking the Partitioning heading in the 
Installation Settings screen mentioned above.

YaST displays the current partitioning suggestions. 

Figure 2-4   Suggested Partitioning

Select from the following options to continue with the partitioning setup:

Accept proposal as-is 
Leave the suggested partitioning unchanged and return to the Installation Settings screen.

Base partition setup on this proposal 
Refine the proposed partitioning using the Expert Partitioning dialog. Only those partitions and 
hard disks will be listed that YaST which were included in its initial suggestion.

Create custom partition setup 
If you want to make changes to the partition setup that go beyond mere fine-tuning of the YaST 
suggestions, select this option. Any hard disk and partition included in your system then 
applies.

Select Create custom partition setup and click Next to create a new partition setup. 
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The following dialog lets you select the disks your settings should be applied on. 

Figure 2-5   Customizing Your Partition Setup

To create a whole new partitioning setup, select Custom partitioning — for experts. The Expert 
Partitioner appears.

Figure 2-6   Expert Partitioner: Adding, Deleting and Editing Partitions

The Expert Partitioner displays any partition and hard disk inc6luded in your system. You can add 
partitions, edit existing ones, delete partitions, or resize them. Whole disks appear without any 
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device number. SCSI disks are called /dev/sdxy, whereas (E)IDE disks are called /dev/hdxy. 
The.x represents the disk number; the first disk in a Linux system always appears as “a.” The y 
represents the partition number on a disk. The first partition on the first SCSI disk would, therefore, 
be addressed as /dev/sda1.

To create a new partition, select Create. In the next step, determine the type of partition you want to 
create. For detailed information on the partition types in Linux, turn to “Partition Types” on 
page 255.

Figure 2-7   Determining the Partition Type

To create another primary partition on your first hard disk, select Primary Partition and then click 
OK.

Figure 2-8   Creating a New Partition

Set the partitioning parameters, such as file system ID, type, size, and mount point. If you are just 
creating a new Linux partition to hold additional data, select Reiser as the file system (the NLD 
default file system). For the size of the new partition just specify the end point of it; the start cylinder 
is assigned automatically. Finally, assign a mount point, if the partition is to be mounted into your 
installed system. If you don't want to include it right now, just omit the mount point. The partition 
appears in the partition table of the installed system, but it is not mounted by default.

TIP: For detailed information on partitioning, turn to Appendix D, “Partitioning,” on page 255. For 
an overview of Linux file systems, see “Chapter 18: File Systems in Linux” of the SUSE LINUX 
Enterprise Server 9 Administration Guide (http://www.novell.com/documentation/sles9/pdfdoc/
sles_9_admin_guide/sles_9_admin_guide.pdf).
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Software Selection

Although you have already selected the desktop environment for your NLD workstation, you might 
want to refine your selection. To modify the software selection, click Software. The Software 
Selection dialog appears.

Figure 2-9   Editing the Software Selection
 Desktop 9 Deployment Guide



novdocx (E
N

U
)  10 A

ugust 2006
To open the YaST package management tool, click Detailed selection. The YaST package manager 
allows you to select and deselect single packages as well as entire package groups or package 
selections and offers an extensive search function.

Figure 2-10   Selecting New Packages

The right part of the package window displays the list of packages included in the recent selection 
and an information window on the currently selected package featuring a brief package description, 
technical data, packages dependencies associated with this particular package, and the package's 
version. To the bottom left, statistics for the current disk usage are displayed. To select an entire 
package selection, such as an additional desktop environment or Accessibility software, select 
(check) the package name in the Selection window on the left.
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To search for a particular package, switch the Filter setting from Selection to Search. Determine the 
scope and mode of your search and type the name of the package you are looking for or a binary or 
pathname included in this package. 

Figure 2-11   Searching for Packages

By default, the list of package names and package summaries are searched for the string you 
entered. The following options can be selected as well:

Description 
Searches through the verbose packages descriptions. These are displayed in the Description tab 
of the information window.

Provides 
Searches through the binaries or capabilities provided by any package. This information is 
displayed in the Technical Data tab of the information window.

Requires 
Similar to the Provides option in that it allows a search for paths and binaries, but it triggers a 
search over the requirements of a package. This information is displayed in the Technical Data 
tab of the information window.

The search mode is usually set to Contains, which allows a much broader search than if you limited 
the search method to Begins with. Begins with comes in handy if you know exactly what you are 
searching for and need to limit the scope of the search.

For more information about the YaST package manager, see “Installing and Removing Software” on 
page 127.

After you finish the package selection, click Accept. YaST automatically checks for missing 
packages dependencies or for conflicting packages. In case of a conflict, YaST displays a summary 
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screen showing all package conflicts arising with the current selection and offering possible 
solutions.

Booting

The default boot loader configuration created during installation works for any default installation of 
NLD. However, if you want to modify it on your own (for example, add a boot entry for another 
operating system), you need to modify the boot loader's configuration files. 

Click Booting on the Installation Settings screen to launch the YaST Boot Loader Configuration 
module.

Figure 2-12   Configuring the Boot Loader

For a detailed description of this module and some background information on GRUB, the NLD 
boot loader, see “Chapter 8: Booting and Boot Managers” in the SUSE LINUX Enterprise Server 9 
Administration Guide (http://www.novell.com/documentation/sles9/pdfdoc/sles_9_admin_guide/
sles_9_admin_guide.pdf)
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Initiating the Installation

Having finished the package selection (and any optional boot loader configuration), you are returned 
to the Installation Settings screen. As soon as you have verified all other settings, click Accept to 
launch the installation process. A prompt appears asking you to confirm this action. 

Figure 2-13   Start Installation

Click Yes, install and the installation procedure begins. First, the hard disk is partitioned and 
formatted according to the settings made in the Partitioning dialog. After that, the actual installation 
of software begins.

Figure 2-14   Formatting the Hard Disk Prior to Installation

Installing Software

After the hard disk has been partitioned and formatted according to your preferences, YaST installs 
the software packages. If installing from an NLD DVD, all packages get installed without any 
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further actions required from your side. If you are installing from a set of NLD CDs, you need to 
change CDs when prompted.

Figure 2-15   Installing Software Packages—Opening Window

During package installation, you are shown a slide show highlighting the most important features of 
your Novell Linux Desktop system. The right side of the window displays some statistics on the 
media needed and the amount of data that needs to be transferred onto your hard disk. Click Details 
to view a detailed log of the packages currently being installed.

Figure 2-16   Initial System Boot after Installation of CD1 Has Been Completed
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After all packages (or all packages of the first CD) are installed, the system boots and updates the 
system configuration and continues with the package installation. When the boot loader comes up, 
leave the default boot option (Boot from Hard Disk) unchanged and wait for the system to boot on 
its own.

YaST continues with the installation requesting additional CDs or, if you installed from DVD, 
moves on to the system configuration.

Figure 2-17   Installing Software Packages Continuation

Configuring the System Administrator's Account (root)

After the initial boot of the installed system and after the final packages have been installed, you are 
prompted to configure the system administrator's account (root). Unlike regular users, which might 
or might not have permission to do certain things on the system, root has unlimited power to do 
anything: change the system configuration, install programs, and set up new hardware. If users 
forget their passwords or have other problems with the system, root can help. The root account 
should be used only for system administration, maintenance, and repair. Logging in as root for daily 
work is rather risky: a single mistake could lead to irretrievable loss of many system files.

IMPORTANT: The user root has all the permissions needed to make changes to the system. To 
carry out such tasks, the root password is required. You cannot carry out any administrative tasks 
without this password.
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Figure 2-18   Creating the Root Account

For verification purposes, the password for root must be entered twice. Don't forget the root 
password. When entered, this password cannot be retrieved. 

TIP: Make sure your passwords cannot easily be guessed. Use a mixture of digits, capitalized 
letters, and special keys.

Using the default encryption method of NLD, DES, you can use passwords of five to eight 
characters in length. However, NLD supports a maximum password length of 72 characters. To use 
a password longer than eight characters, click Expert Options > Password Encryption and then 
select the Blowfish encryption option.

Figure 2-19   Determining the Password Encryption Method

Network Configuration

You can configure any network devices for a connection to the outside world, such as network 
cards, modems, and ISDN or DSL hardware. If you have such devices, it is a good idea to configure 
them now, because an Internet connection allows YaST to retrieve any available NLD updates and 
include them in the installation.
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TIP: If your network is set up to support DHCP-based configuration of the network clients, you can 
just accept the network settings as preconfigured by YaST during installation. DHCP network 
configuration works out of the box with any NLD installation. If your network doesn't include 
DHCP services, configure the detected network devices from scratch.

Figure 2-20   List of Available Network Interfaces

The Network Configuration dialog lists all possible network hardware. If an item has been detected 
and preconfigured during installation, this configuration appears in the overview screen. To edit any 
configuration item, click it and a dialog specific to this type of interface opens.

To configure an Ethernet device with a static IP address, click Network interfaces on the Network 
Configuration screen. Then decide whether you want to modify an existing configuration or start 
from scratch. To modify the preconfigured DHCP-based configuration, click Edit.
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The Network address setup dialog opens. Don't change the configuration name; it is normally 
derived automatically during system setup. Select Static address setup and specify an appropriate IP 
address and netmask. If necessary, get these parameters from your network administrator.

Figure 2-21   Configuring the Network Address

Detailed settings lets you set up a hostname and name server for this particular machine and 
configure a default route and some advanced settings, such as the following:

Hardware Details 
If your network hardware requires specialized kernel modules, configure them here. This 
should not be necessary in most cases.

DHCP Client Options 
Depending on whether your network device is set up via DHCP, you can do some fine-tuning 
on the DHCP client side.

Detailed Settings 
Sets the maximum transfer rate of your network interface and the device activation mode. 
Because the default setting for the MTU size is reasonable and the device activation is set to At 
Boot Time, you hardly ever need to make changes here. Changing the device activation mode to 
Manually or When Hotplugged would make sense if your machine contained more than one 
type of interface and you didn't want all interfaces to be active at the same time.

Virtual Aliases 
If you intend to use one and the same network hardware for a set of differently configured 
virtual interfaces, define these configurations using this option. This option is rarely needed 
outside very complex network setups.
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Unless your setup requires any of this fine-tuning to be performed, proceed with the configuration of 
the hostname and name server.

Figure 2-22   Configuring Host Name and Name Server

Specify a hostname and a domain name for your machine. If necessary, get this information from 
your network administrator. Specify an IP address and search domain for at least one name server in 
your network. If possible, specify more than one to have a fallback server in place just in case the 
main name server of your network crashes or is offline.
 Desktop 9 Deployment Guide



novdocx (E
N

U
)  10 A

ugust 2006
Click OK to go back to the Network address setup dialog and click Routing to configure any routing 
information needed for your machine.

Figure 2-23   Configuring the Routing

If you are in a local network that uses one particular host as a gateway to other networks and the 
Internet, type its IP address in Default Gateway (ask your network administrator for details). Select 
Enable IP Forwarding only if you intend to use your NLD machine as a router; otherwise, click OK 
to return to the Network address setup dialog. Click Finish to complete your network configuration.
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After your network has been set up correctly, YaST offers to let you test your Internet access by 
querying the Novell update server for software updates for NLD. Select Yes, Test Connection to the 
Internet and click Next to launch the activation dialog for ZENworks®™.

Figure 2-24   Testing the Internet Connection

Other Network Connection Types

The previous sections cover network integration only by means of an Ethernet device. However, 
ISDN, modem, and DSL connections are supported as well. Detailed instructions on the 
configuration of these devices can be found in “Section 21.4: Network Integration” in the SUSE 
LINUX Enterprise Server 9 Administration Guide (http://www.novell.com/documentation/sles9/
pdfdoc/sles_9_admin_guide/sles_9_admin_guide.pdf).

ZENworks Linux Management Activation and Update

Novell Linux Desktop makes use of the ZENworks Online Update service. Before you can actually 
receive the patches and updates available for your NLD installation, you must provide the activation 
data you received upon purchase of NLD and the subsequent registration of your product.

In case you haven't yet registered your NLD with Novell, proceed as follows:

1 After purchasing NLD, you received an e-mail containing a URL that took you to the Novell 
eLogin page. If you already have an eLogin account, enter your username and password to log 
in. If not, create one using the Create a Profile option on the eLogin page.

2 Log in providing your authentication data.
This takes you to the registration page containing a serial number and status for your NLD 
product.

3 Make note of the serial number, because it will later serve as the activation code.
4 Register the activation code by clicking Click to Register.
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When the activation code is registered, you can use it for ZENworks authentication.

Figure 2-25    Activating the ZENworks Online Update Service

After you have entered the correct authentication data, the Online Update automatically starts 
installing the most recent patches and updates on top of your NLD installation.

If you prefer to not run the online update right now, select Do not activate ZENworks Online Update 
Service now and click Next to close the dialog.

TIP: In an installed system, activate the update service by starting Red Carpet® and clicking File > 
Activate. For more information on ZENworks and Red Carpet, see the ZENworks Linux 
Management (http://www.novell.com/documentation/zlm/index.html) and Novell Red Carpet (http:/
/www.novell.com/documentation/ximian/redcarpet.pdf) documentation.

Managing User Accounts

NLD offers several different methods for user authentication and management. You can choose 
between network based methods and local authentication:

Local 
Local authentication is mostly used on standalone workstations. All user authentication data is 
stored locally in a file called /etc/passwd. Adding or editing user information has to be 
done locally.

LDAP 
If your machine runs in a corporate environment, use a centralized user database instead of a 
local file. Apart from serving as a user authentication database, LDAP can be used for many 
other purposes as well. To learn more about LDAP, see “Section 21.8: LDAP—A Directory 
Service” in the SUSE LINUX Enterprise Server Administration Guide (http://www.novell.com/
documentation/sles9/pdfdoc/sles_9_admin_guide/sles_9_admin_guide.pdf).
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NIS 
Very similar to LDAP, NIS provides a means to distribute user authentication data throughout a 
network. To learn more about NIS, see “Section 21.9: NIS—Network Information Service” in 
the SUSE LINUX Enterpriser Server 9 Administration Guide (http://www.novell.com/
documentation/sles9/pdfdoc/sles_9_admin_guide/sles_9_admin_guide.pdf).

Figure 2-26   Selecting the User Authentication Method

Select the appropriate user authentication method, then click Next. If you select NIS or LDAP, you 
are prompted for the server name.
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If you select Local, YaST prompts you for the user data of the first local user.

Figure 2-27   Adding a New Local User

Specify the full username, a login name, and a password for the first local user. You can let YaST 
propose a user login name by clicking Suggestion. Password handling is similar to the root user 
account. 

If you want to redirect mail messages generated by your system to this particular user, select Receive 
System Mail. If the local user account you just configured is the only one on this system, you might 
consider skipping the login procedure for this user and letting them enter the system without any 
username and password. Select Auto-Login if you want automatic login for a single-user system.

WARNING: Enabling auto-login might present a severe security issue. Anybody who can 
physically access this system will be able to enter it without the need to authenticate himself. When 
logged in, this person has access to all user data. 

Password Settings provides a means to configure parameters like password expiration time and 
number of retries. Details lets you modify the default attributes assigned to a new user account, such 
as group membership, user ID, and location of home directory.

Clicking User Management opens the YaST module for user management and creation where you 
can add several new users, configure user authentication sources, and delete users.

After you click Next, the new user is added to the system configuration. 
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Finishing the Installation

After you have completed the user configuration, the system rewrites the system configuration to 
make sure all your settings are applied. Wait until the SuSEconfig script is done. Depending on your 
hardware, this system initialization process might take a long time. 

Figure 2-28   Writing the System Configuration

After the system configuration has been successfully written to disk, YaST displays the release notes 
associated with this release of NLD. These notes contain important information that was not 
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included in any other documentation and that needs to be acknowledged in order to get NLD 
working properly. 

Figure 2-29   Release Notes of Novell Linux Desktop

After you have read and acknowledged the release notes, click Next and finish the installation by 
optionally configuring additional hardware items such as printers, sound devices, or joysticks. These 
items can always be configured later in the installed system by launching the YaST Control Center 
and selecting the appropriate modules. See “The YaST Control Center” on page 126 for further 
information on the configuration modules offered by YaST.
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Click Finish to end the installation process and switch to your freshly installed system. A graphical 
login screen appears prompting you for your username and password. When you have successfully 
authenticated yourself, the system automatically starts the desktop environment of your choice.

Figure 2-30   Installation Completed

2.2.2  Using a Network Installation Source
If you want to install manually but prefer a centralized installation source, consider using a network 
installation server. The procedure is very much the same as described later for remote installations.

Standard Manual Network Installation

To perform a standard manual network installation:

1 Set up an installation server as described in “Setting Up the Server Holding the Installation 
Sources” on page 58.

2 Insert the first CD or DVD of the media kit into the CD-ROM drive and reboot the machine.
3 At the boot screen, select Installation and use the boot options prompt to give additional 

information, such as
Location of the installation server.
Network configuration parameters (if your setup doesn't support the network to be 
configured via DHCP).

Detailed information on the use of boot options at installation time can be found in “Using 
Custom Boot Options” on page 72.

4 Click Enter to boot for installation.
If no network parameters have been specified at the boot options prompt, the installation 
routines try to set up the network using DHCP. If this fails, you are prompted for these 
parameters. After you have provided them, the installation proceeds as normal.
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5 Finish the installation as you would if you had chosen to install from physical media (see 
“Manual Installation” on page 25).

Network Installation with OpenSLP

If your network setup supports OpenSLP and your network installation source has been configured 
to announce itself via OpenSLP (see “Setting Up the Server Holding the Installation Sources” on 
page 58), you can simply do the following:

1 Set up an installation server as described in “Setting Up the Server Holding the Installation 
Sources” on page 58.

2 Insert the first CD or DVD of the media kit into the CD-ROM drive and reboot the machine.
3 At the boot screen, select Installation, press F3, and then select SLP.

For more information on the use of the F keys during the initial boot, see “Using the F Keys” 
on page 72
The installation program retrieves the location of the network installation source via OpenSLP 
and configures the network connection via DHCP. If the DHCP network configuration fails, 
you are prompted to enter the appropriate parameters manually. The installation then proceeds 
as normal.

4 Finish the installation as if you had chosen to install from physical media (see “Manual 
Installation” on page 25).

Network Installation through VNC

If you want to remotely control the network installation, proceed as described in “Simple Remote 
Installation via VNC—Static Network Configuration” on page 54 or “Simple Remote Installation 
via VNC—Dynamic Network Configuration via DHCP” on page 54.

2.3  Remote Installation
There are several different ways to remotely install an NLD workstation. Each method is introduced 
by means of two short checklists, one listing the prerequisites for this method and the other 
illustrating the basic procedure. More detail is then provided on all the techniques used in these 
installation scenarios.

NOTE: In the following sections, the system to hold your new NLD installation is referred to as the 
target system or installation target. Installation source is used for any kind of source of installation 
data. This included physical media such as CDs and DVD, as well as network servers distributing 
the installation data across your network.

2.3.1  Installation Scenarios for Remote Installation
This section introduces the most common installation scenarios for remote installations. For each 
scenario, carefully check the list of prerequisites and follow the procedure outlined for this scenario. 
If you need detailed instructions for any particular step, follow the links provided for it.

IMPORTANT: The configuration of the X Window system isn't part of any remote installation 
process. After the installation is finished, log in as root to the target system, enter init 3 and then 
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start SaX2 to configure the graphics hardware as described in “Configuring the Graphics Card and 
Monitor” on page 130.

Simple Remote Installation via VNC—Static Network Configuration

This type of installation still requires some degree of physical access to the target system to boot for 
installation. The installation itself is entirely controlled via a remote workstation using VNC to 
connect to the installation program. User interaction is required as with the manual installation 
described earlier (see “Manual Installation” on page 25).

For this type of installation, make sure the following requirements are met:

Remote installation source (NFS, HTTP, FTP, or SMB) with working network connection
Target system with working network connection
Controlling system with a working network connection and VNC viewer software or Java-
enabled browser (for example, Firefox*, Konqueror*, Internet Explorer)
Target system capable of being booted from a physical boot medium (CD, DVD, or custom 
boot disk)
Valid static IP addresses already assigned to the installation source and the controlling system
Valid static IP address to be assigned to the target system 

To perform this kind of installation, proceed as follows:

1 Set up the installation source as described in “Setting Up the Server Holding the Installation 
Sources” on page 58. 

2 Boot the target system using the first CD or DVD of the NLD media kit.
3 As the boot screen of the target system comes up, use the boot options prompt to give the 

appropriate VNC options and the address of the installation source. 
This is described in detail in “Booting the Target System for Installation” on page 71.
The target system boots up in a text-based environment, giving you the network address and 
display number under which the graphical installation environment can be addressed by any 
VNC viewer application or browser. VNC installations announce themselves over SLP and can 
be found using Konqueror in service:// or slp:// mode.

4 At the controlling workstation, open a VNC viewing application or Web browser and connect 
to the target system as described in “VNC Installation” on page 74.

5 Perform the installation as described in “Manual Installation” on page 25.
6 Reconnect to the target system after the initial boot (done in the same way as in Step 4 on 

page 55).
7 Finish the installation.

Simple Remote Installation via VNC—Dynamic Network Configuration via DHCP

This type of installation still requires some degree of physical access to the target system to boot for 
installation. The installation itself is entirely controlled via a remote workstation using VNC to 
connect to the installer, but still requires user interaction for the actual configuration efforts.

For this type of installation, make sure the following requirements are met:

Remote installation source (NFS, HTTP, FTP, or SMB) with working network connection
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Target system with working network connection
Controlling system with a working network connection and VNC viewer software or Java-
enabled browser (for example, Firefox, Konqueror, or Internet Explorer)
Target system capable of being booted from a physical boot medium (CD, DVD, or custom 
boot disk)
Running DHCP server providing IP addresses

To perform this kind of installation, proceed as follows:

1 Set up the installation source as described in “Setting Up the Server Holding the Installation 
Sources” on page 58. 

Choose an NFS, HTTP, FTP, or SMB type of network server.
2 Boot the target system using the first CD or DVD of the NLD media kit.
3 As the boot screen of the target system comes up, use the boot options prompt to give the 

appropriate VNC options and the address of the installation source. 
This is described in detail in “Booting the Target System for Installation” on page 71.
The target system boots up to a text-based environment, giving you the network address and 
display number under which the graphical installation environment can be addressed by any 
VNC viewer application or browser. VNC installations announce themselves over SLP and can 
be found with Konqueror in service:// or slp:// mode.

4 At the controlling workstation, open a VNC viewing application or Web browser and connect 
to the target system as described in “VNC Installation” on page 74.

5 Perform the installation as described in “Manual Installation” on page 25.
6 Reconnect to the target system after the initial boot (done in the same way as in Step 4 on 

page 55).
7 Finish the installation.

Remote Installation via VNC—PXE Boot and Wake-on-LAN

This type of installation is completely hands-off. The target machine is started and booted remotely. 
User interaction is needed only for the actual installation. This approach is suitable for cross-site 
deployments.

To perform this type of installation, make sure the following requirements are met:

Remote installation source (NFS, HTTP, FTP, or SMB) with working network connection
TFTP server
Running DHCP server for your network
Target system capable of PXE boot, networking, and Wake-on-LAN
Controlling system with a working network connection and VNC viewer software or Java-
enabled browser (for example, Firefox, Konqueror, or Internet Explorer)

To perform this type of installation, proceed as follows:

1 Set up the installation source as described in “Setting Up the Server Holding the Installation 
Sources” on page 58.

Choose an NFS, HTTP, or FTP type of network server.
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2 Set up a TFTP server to hold a boot image that can be pulled by the target system (see “Setting 
Up a TFTP Server” on page 66).

3 Set up a DHCP server to provide IP addresses to all machines, revealing the location of the 
TFTP server to the target system (see “Setting Up a DHCP Server” on page 64).

4 Prepare the target system for PXE boot (see “Preparing the Target System for PXE Boot” on 
page 70).

5 Initiate the boot process of the target system using Wake-on-LAN (see “Wake-on-LAN” on 
page 71).

6 At the controlling workstation, open a VNC viewing application or Web browser and connect 
to the target system as described in “VNC Installation” on page 74.

7 Perform the installation as described in “Manual Installation” on page 25.
8 Reconnect to the target system after the initial boot (done in the same way as in Step 4 on 

page 55).
9 Finish the installation.

Simple Remote Installation via SSH—Static Network Configuration

This type of installation still requires some degree of physical access to the target system to boot for 
installation and to determine the IP address of the installation target. The installation itself is entirely 
controlled via a remote workstation using SSH to connect to the installer. User interaction is 
required as with the manual installation described earlier (see “Manual Installation” on page 25).

For this type of installation, make sure the following requirements are met:

Remote installation source (NFS, HTTP, FTP, or SMB) with a working network connection
Target system with a working network connection
Controlling system with a working network connection and VNC viewer software or Java-
enabled browser (for example, Firefox, Konqueror, or Internet Explorer)
Target system capable of being booted from a physical boot medium (CD, DVD, or custom 
boot disk)
Valid static IP addresses already assigned to the installation source and the controlling system
Valid static IP address to be assigned to the target system 

To perform this kind of installation, proceed as follows:

1 Set up the installation source as described in “Setting Up the Server Holding the Installation 
Sources” on page 58. 

2 Boot the target system using the first CD or DVD of the NLD media kit.
3 As the boot screen of the target system comes up, use the boot options prompt to give the 

appropriate parameters for network connection, location of the installation source, and the SSH 
enablement. 
See “Using Custom Boot Options” on page 72 for detailed instructions on the use of these 
parameters.
The target system boots up in a text-based environment, giving you the network address under 
which the graphical installation environment can be addressed by any SSH client.

4 At the controlling workstation, open a terminal window and connect to the target system as 
described in “Connecting to the Installation Program” on page 76.
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5 Perform the installation as described in “Manual Installation” on page 25.
6 Reconnect to the target system after the initial boot (done in the same way as in Step 4 on 

page 55).
7 Finish the installation.

Simple Remote Installation via SSH—Dynamic Network Configuration via DHCP

This type of installation still requires some degree of physical access to the target system to boot for 
installation and to determine the IP address of the installation target. The installation itself is entirely 
controlled via a remote workstation using VNC to connect to the installer, but still requires user 
interaction for the actual configuration efforts.

For this type of installation, make sure the following requirements are met:

Remote installation source (NFS, HTTP, FTP, or SMB) with a working network connection
Target system with a working network connection
Controlling system with a working network connection and VNC viewer software or Java-
enabled browser (for example, Firefox, Konqueror, or Internet Explorer)
Target system capable of being booted from a physical boot medium (CD, DVD, or custom 
boot disk)
Running DHCP server providing IP addresses

To perform this kind of installation, proceed as follows:

1 Set up the installation source as described in “Setting Up the Server Holding the Installation 
Sources” on page 58. 

Choose an NFS, HTTP, FTP, or SMB type of network server.
2 Boot the target system using the first CD or DVD of the NLD media kit.
3 As the boot screen of the target system comes up, use the boot options prompt to give the 

appropriate parameters for network connection, location of the installation source and the SSH 
enablement. 
See “Using Custom Boot Options” on page 72 for detailed instructions on the use of these 
parameters.
The target system boots up in a text-based environment, giving you the network address under 
which the graphical installation environment can be addressed by any SSH client.

4 At the controlling workstation, open a terminal window and connect to the target system as 
described in “Connecting to the Installation Program” on page 76.

5 Perform the installation as described in “Manual Installation” on page 25.
6 Reconnect to the target system after the initial boot (done in the same way as in Step 4 on 

page 55).
7 Finish the installation.

Remote Installation via SSH—PXE Boot and Wake-on-LAN

This type of installation is completely hands-off. The target machine is started and booted remotely.
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To perform this type of installation, make sure the following requirements are met:

Remote installation source (NFS, HTTP, FTP, or SMB) with a working network connection
TFTP server
Running DHCP server for your network, providing a static IP to the host that needs be installed
Target system capable of PXE boot, networking, and Wake-on-LAN
Controlling system with a working network connection and SSH client software

To perform this type of installation, proceed as follows:

1 Set up the installation source as described in “Setting Up the Server Holding the Installation 
Sources” on page 58. 

Choose an NFS, HTTP, or FTP type of network server.
2 Set up a TFTP server to hold a boot image that can be pulled by the target system.

See “Setting Up a TFTP Server” on page 66.
3 Set up a DHCP server to provide IP addresses to all machines, revealing the location of the 

TFTP server to the target system. 
See “Setting Up a DHCP Server” on page 64.

4 Prepare the target system for PXE boot. 
See “Preparing the Target System for PXE Boot” on page 70.

5 Initiate the boot process of the target system using Wake-on-LAN. 
See “Wake-on-LAN” on page 71.

6 At the controlling workstation, start a VNC client and connect to the target system as described 
in “SSH Installation” on page 76.

7 Perform the installation as described in “Manual Installation” on page 25.
8 Reconnect to the target system after the initial boot (done in the same way as in Step 4 on 

page 55).
9 Finish the installation.

2.3.2  Setting Up the Server Holding the Installation Sources
Depending on the operating system running on the machine you want to use as network installation 
source for NLD, there are several options for the server configurations. The easiest way to set up an 
installation server is to use YaST on a SUSE LINUX Enterprise Server 9 machine. On other 
versions of SUSE LINUX Enterprise Server or SUSE LINUX, set up the installation source 
manually.

TIP: You can even use a Microsoft* Windows machine as the installation server for your Linux 
deployment. See “Managing an SMB Installation Source” on page 63 for details.

Setting Up an Installation Server Using YaST on SLES 9

YaST offers a graphical tool to create network installation sources. It supports HTTP, FTP, and NFS 
types of network installation servers.

1 Log in as root to the machine that is to be the installation server.
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2 Run YaST > Miscellaneous > Installation Server.
3 Select the server type (HTTP, FTP, or NFS).

The selected server service is started automatically every time the system starts. If a service of 
the selected type is already running on your system and you want to configure it manually for 
the server, deactivate the automatic configuration of the server service by selecting Do not 
configure any network services. In both cases, define the directory in which the installation data 
should be made available on the server.

4 Configure the required server type.
This step relates to the automatic configuration of server services. It is skipped when automatic 
configuration is deactivated. Define an alias for the root directory of the FTP or HTTP server 
where the installation data will be located. The installation source is later located under ftp:/
/Server-IP/Alias/Name (FTP) or under http://Server-IP/Alias/Name 
(HTTP). Name stands for the name of the installation source, which is defined in Step 5. If you 
selected NFS in Step 3, define wildcards and exports options. The NFS server will be 
accessible under nfs://Server-IP/Name. 
Details of NFS and exports can be found in “Section 21.10: NFS—Shared File Systems” in the 
SUSE LINUX Enterprise Server 9 Administration Guide (http://www.novell.com/
documentation/sles9/pdfdoc/sles_9_admin_guide/sles_9_admin_guide.pdf).

5 Configure the installation source.
Before the installation media are copied to their destination, define the name of the installation 
source (ideally, an easily remembered abbreviation of the product and version). YaST allows 
providing ISO images of the media instead of copies of the installation CDs. If you want to take 
this route, select this option and specify the directory path under which the ISO files will be 
found locally. Depending on the product you are going to distribute using this installation 
server, more add-on CDs or service pack CDs might be required to install the product 
completely. If you activate Prompt for Additional CDs, YaST automatically reminds you to 
supply these media. To announce your installation server in the network via OpenSLP, select 
that option.

TIP: Consider announcing your installation source via OpenSLP if your network setup 
supports this option. This saves you from having to enter the network installation path on every 
single target machine. The target systems are booted using the SLP boot option and can find the 
network installation source without any further configuration. For details on this option, see 
“Booting the Target System for Installation” on page 71.

6 Upload the installation data.
The most lengthy step in configuring an installation server is the copying of the actual 
installation CDs. Insert the media in the sequence requested by YaST and wait for the copying 
procedure to end. When the sources have been fully copied, return to the overview of existing 
information sources and close the configuration by clicking Finish.
Your configuration server is now fully configured and ready for service. It is automatically 
started every time the system is started. No further intervention is required. You need to 
configure and start this service correctly by hand only if you have deactivated the automatic 
configuration of the selected network service with YaST as an initial step.

To deactivate an installation source, click Change in the overview to reach a list of all available 
installation sources. Then select the entry to remove and click Delete. This delete procedure relates 
to the deactivation of only the server service. The installation data itself remains in the chosen 
directory. However, you can remove it manually.
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If your installation server should provide the installation data for more than one product or product 
version, start the YaST installation server module and select Configure in the overview of existing 
installation sources to configure the new installation source.

Manual Setup of an NFS Installation Source

IMPORTANT: We assume you are using some kind of SUSE LINUX (SUSE LINUX Enterprise 
Server 9 or SUSE LINUX Professional 9.x) based operating system on the machine that will serve 
as the installation server. If this is not the case, refer to the other vendor's documentation on NFS 
instead of completing the following directions.

Setting up an NFS source for installation is basically done in two steps. First, create the directory 
structure holding the installation data and copy the installation media to this structure. Then export 
the directory holding the installation data to the network. 

To create a directory holding the installation data, proceed as follows:

1 Log in as root.
2 Create a directory to later hold the entire installation data and change to this directory.

For example:
mkdir install/nld/NLD9

3 For each CD contained in the media kit, do the following:
3a Copy the entire content of the installation CD to the installation server directory by 

entering:
cp -a /media/path_to_your_CD-ROM_drive.

Replace path_to_your_CD-ROM_drive with the actual path to your CD/DVD drive. 
Depending on the type of drive used in your system, this can be either cdrom, cdrecorder, 
dvd, or dvdrecorder.

3b Rename the directory to the CD number by entering
mv path_to_your_CD-ROM_drive CDx

Replace x with the actual number of your CD.

To export the installation sources via NFS using YaST, proceed as follows:

1 Log in as root.
2 Run YaST > Network Services > NFS Server.
3 Select Start NFS Server and Open Port in Firewall, then click Next.
4 Select Add Directory, then specify the path to the directory holding the installation data. 

In this case, it is /NLD9.
5 Select Add Host, then specify the hostnames of the machines you want the installation data to 

be exported to. 
Instead of specifying hostnames here, you could also use wildcards, ranges of network 
addresses, or just the domain name of your network. Also specify the appropriate export 
options or keep the default, which works fine in most setups. For more information on the 
syntax used in exporting NFS shares, read the manual page (man exports).

6 Click Finish.
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The NFS server holding the NLD installation sources automatically starts and is integrated into 
the boot process.

If you prefer to manually export the installation sources via NFS instead of using the YaST NFS 
Server module, proceed as follows:

1 Log in as root.
2 Open the /etc/exports file, add the following line, then save and exit the file.
/NLD9 *(ro,root_squash,sync)

This exports the /NLD9 directory to any host that is part of this network that can connect to this 
server. To limit the access to this server, use netmasks or domain names instead of the general 
wildcard (*). See man exports for details.

3 To add the NFS service to the list of servers started at system bootup, execute the following 
commands:
insserv /etc/init.d/nfsserver

insserv /etc/init.d/portmap

4 Start the NFS server by entering
rcnfsserver start

If you need to change the configuration of your NFS server later on, modify the configuration 
file and restart the NFS daemon with rcnfsserver restart.

To announce the NFS server via OpenSLP and make its address known to all clients in your 
network, proceed as follows: 

1 Log in as root.
2 Change to the /etc/slp.reg.d/ directory.
3 Create a configuration file called install.suse.nfs.reg containing the following lines:
# Register the NFS Installation Server                      
service:install.suse:nfs://$HOSTNAME/path_instsource/CD1,en,65535 
description=NFS Installation Source for NLD9

Replace path_instsource with the actual path to the installation source on your server.
4 Save this configuration file and start the OpenSLP daemon using the following command:

rcslpd start

For more information on OpenSLP, see the package's documentation located under /usr/share/
doc/packages/openslp/ or “Section 21.6: SLP Services in the Network” in the SUSE LINUX 
Enterprise Server 9 Administration Guide (http://www.novell.com/documentation/sles9/pdfdoc/
sles_9_admin_guide/sles_9_admin_guide.pdf).

Manual Setup of an FTP Installation Source

Creating an FTP installation source is very similar to creating an NFS installation source. FTP 
installation sources can be announced over the network using OpenSLP as well.

1 Create a directory holding the installation sources as described in “Manual Setup of an NFS 
Installation Source” on page 60.

2 Configure the FTP server to distribute the contents of your installation directory.
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2a Log in as root and install the package pure-ftpd (a lean FTP server) using the YaST 
package manager.

2b Change to the FTP server root directory by entering
cd /srv/ftp

2c Create a subdirectory holding the installation sources in the FTP root directory by entering
mkdir instsource

Replace instsource with the product name.
2d Copy the contents of all installation CDs to the FTP server's root directory (similar to the 

procedure described under Step 3 on page 60).
Alternatively, mount the contents of the already existing installation repository into the 
change root environment of the FTP server by entering
mount --bind path_to_instsource /srv/ftp/instsource
Replace path_to_instsource and instsource with values matching your setup. If you need 
to make this permanent, add it to /etc/fstab.

2e Start pure-ftpd by entering:
pure-ftpd &

3 Announce the installation source via OpenSLP (if this is supported by your network setup).
3a Create a configuration file called install.suse.ftp.reg under /etc/slp/

reg.d/ which contains the following lines:
# Register the FTP Installation Server         
service:install.suse:ftp://$HOSTNAME/srv/ftp/instsource/
CD1,en,65535 
description=FTP Installation Source for NLD9

Replace instsource with the actual name of the installation source directory on your 
server. Also note that the service: line should be entered as one continuous line.

3b Save this configuration file and start the OpenSLP daemon by entering
rcslpd start

Manual Setup of an HTTP Installation Source

Creating an HTTP installation source is very similar to creating an NFS installations source. HTTP 
installation sources can be announced over the network using OpenSLP as well.

1 Create a directory holding the installation sources as described in “Manual Setup of an NFS 
Installation Source” on page 60.

2 Configure the HTTP server to distribute the contents of your installation directory.
2a Log in as root and install the apache2 package using the YaST package manager.
2b Change to the root directory of the HTTP server (/srv/www/htdocs) and create a 

subdirectory to hold the installation sources:
mkdir instsource

Replace instsource with the product's name.
2c Create a symbolic link from the location of the installation sources to the root directory of 

the Web server (/srv/www/htdocs):
ln -s /path_instsource /srv/www/htdocs/instsource
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2d Modify the configuration file of the HTTP server (/etc/apache2/default-
server.conf) to make it follow symbolic links by replacing
Options None

with
Options Indexes FollowSymLinks

2e Restart the HTTP server by entering
rcapache2 restart

3 Announce the installation source via OpenSLP (if this is supported by your network setup).
3a Create a configuration file called install.suse.ftp.reg under /etc/slp/

reg.d/ which contains the following lines:
# Register the HTTP Installation Server            
service:install.suse:http://$HOSTNAME/srv/www/htdocs/
instsource/CD1/,en,65535                                                       
description=HTTP Installation Source for NLD9

Replace path_to_instsource with the actual path to the installation source on your server. 
Also not that the service: line should be entered as one continuous line.

3b Save this configuration file and start the OpenSLP daemon using the following command:
rcslpd restart

Managing an SMB Installation Source

Using an SMB (Samba) source, you can pull in the installation sources from a Microsoft Windows 
server and start your Linux deployment even with no Linux machine around.

To set up an exported Windows Share holding your NLD installation sources, proceed as follows:

1 Log in to your Windows machine.
2 Start Explorer and create a new folder to hold the entire installation tree. 

Name it INSTALL, for example.
3 Export this share according to the procedure outlined in your Windows documentation.
4 Enter this share and create a subfolder called NLD.
5 Copy each NLD CD to a separate folder and name these folders CD1, CD2, CD3, etc.
6 Change to the top directory of the exported share (INSTALL, in this example) and copy the 

following files and folders from NLD/CD1 to this folder: content, media.1, 
control.xml, and boot.

7 Create a new folder under INSTALL and name it yast.
8 Change to the yast folder and create the files order and instorder.
9 Open the order file and enter the following line:
/NLD/CD1 smb://user:password@hostname/NLDCD1

Replace user with the username you use on the Windows machine or use Guest to enable guest 
login to this share. Replace password with either your login password or any other string in 
case you use guest login. Replace hostname with the network name of your Windows machine.

10 Open the instorder file and add the following line:
/NLD/CD1

To use an SMB mounted share as installation source, proceed as follows:
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1 Boot the installation target.
2 Select Installation.
3 Press F3 for a selection of installation sources.
4 Select SMB and then specify the Windows machine’s name or IP address, the share’s name 

(INSTALL, in this example), username, and password.
5 Press Enter.

YaST starts and you can now perform the installation.

IMPORTANT: If you are considering using your SMB server as a source for Service Packs (SPs) 
later on, follow the procedure as described above, create subfolders holding the SP CDs (see 
“Manual Setup of a Network Installation Source” on page 99), and adjust the order and 
instorder files accordingly.

2.3.3  Preparing the Boot of the Target System
This section details the configuration tasks needed in complex boot scenarios. It contains ready-to-
apply configuration examples for DHCP, PXE boot, TFTP, and Wake-on-LAN.

Setting Up a DHCP Server

There are two ways to set up a DHCP server. For SUSE LINUX Enterprise Server 9 (SLES 9), 
YaST provides a graphical interface to the process. Users of SUSE LINUX professional and non-
SUSE LINUX users should manually edit the configuration files or use the front end provided by 
their operating system vendors.

IMPORTANT: The following sections cover only the configuration changes needed to make your 
DHCP server ready for PXE boot. For more information on the configuration of DHCP, see your 
operating system vendor’s documentation.

Setting Up a DHCP Server with YaST on SLES 9

To announce the TFTP server's location to the network clients and to specify the boot image file to 
be pulled by the installation target, add two declarations to your DHCP server configuration.

1 Log in as root to the machine hosting the DHCP server.
2 Run YaST > Network Services > DHCP server.
3 Click Expert Settings, then click Yes when warned about leaving the start-up dialog.
4 In the Configured Declarations window, select the subnet where the new system is to be located 

and click Edit.
5 In the Subnet Configuration Window, click Add to add a new option the subnet's configuration.
6 Select filename and specify pxelinux.0 as the option's value.
7 Add another option (next-server) and set its value to the address of the TFTP server.
8 Click OK > Finish to complete the DHCP server configuration.

To configure DHCP to provide a static IP address to a specific host, specify the Expert Settings of 
the DHCP server configuration module (Step 3 on page 64) and add a new declaration of the host 
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type. Add the hardware and fixed-address options to this host declaration and provide the 
appropriate values.

Manual Setup of a DHCP Server

All the DHCP server needs to do apart from providing automatic address allocation to your network 
clients is to announce the IP address of the TFTP server and the file to be pulled in by the installation 
routines on the target machine.

1 Log in as root to the machine hosting the DHCP server.
2 Add the following lines to your DHCP server's configuration file located under /etc/
dhcpd.conf:
group { 
  # PXE related stuff ... 
  # 
  # “next-server” defines the tftp server which will serve the 
  pxelinux image to the PXE clients. 
  next-server 192.168.100.1; 
  # 
  # “filename” specifies the pxelinux image on the tftp server  
  which will be served to the PXE clients. 
  # The configured tftp server on 192.168.100.1 runs in a “change- 
root jail” to /srv/tftpboot filename “pxelinux.0”; 
 
  host Zert120 { hardware ethernet 00:10:dc:95:d7:b7; } 
}

Replace ip_of_the_tftp_server with the actual IP address of the TFTP server.
For more information on the options available in dhcpd.conf, see the manual page (man 
dhcpd.conf).

3 Restart the DHCP server by entering
rcdhcpd restart

If you plan on using SSH for the remote control of a PXE/Wake-on-LAN installation, you need to 
explicitly specify the IP address DHCP is supposed to provide to the installation target. In order to 
achieve this, modify the above-mentioned DHCP configuration according to the following example:
group {
  # PXE related stuff
  # 
  # “next server” defines the tftp server that will be used
  next server ip_tftp_server:
  
  #
  # “filename” specifies the pxelinux image on the tftp server
  # the server runs in chroot under /srv/tftpboot
  filename “pxelinux.0”;

  host test { 
  hardware ethernet mac_address;
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  fixed-address some_ip_address;
  }
}

The host statement introduces the hostname of the installation target. To bind the hostname and IP 
address to a specific host, you have to know and specify the system's hardware (MAC) address. 
Replace all the variables used in this example by the actual values that match your environment.

When you restart the DHCP server, it provides a static IP to the host you specified and thus enables 
you to connect to the system via SSH.

Setting Up a TFTP Server

Setting up a TFTP server can be done either with YaST on the recent versions of SUSE LINUX 
Enterprise Server or SUSE LINUX Professional operating systems or manually on any other Linux 
operating system that supports xinetd and TFTP. The TFTP server delivers the boot image to the 
target system when it boots up and sends a request for it.

Setting Up a TFTP Server Using YaST

1 Log in as root.
2 Run YaST > Network Services > TFTP Server, then install the requested package.
3 Click Enable to make sure the server is started and included in the boot up routines. 

No further action from your side is required to secure this; xinetd starts tftpd at boot time.
4 Click Open Port in Firewall to open the appropriate port in the firewall running on your 

machine. 
If there is no firewall running on your server, this option won't be available.

5 Click Browse to browse for the boot image directory.
The default /tftpboot directory is created and selected automatically.

6 Click Finish to apply your settings and start the server.

Manual Setup of a TFTP Server

1 Log in as root and install the tftp and xinetd packages.
2 If unavailable, create the /srv/tftpboot and /srv/tftpboot/pxelinux.cfg 

directories.
3 Add the appropriate files needed for the boot image as described in “PXE Boot” on page 67.
4 Modify the configuration of xinetd located under /etc/xinetd.d/ to make sure the TFTP 

server is started on boot.
4a If it doesn't exist, create a file called tftp under this directory:

touch tftp

chmod 755 tftp

4b Open the tftp file and add the following lines:
service tftp
{
             socket_type     = dgram
             protocol        = udp
             wait            = yes
 Desktop 9 Deployment Guide



novdocx (E
N

U
)  10 A

ugust 2006
             user            = root
             server          = /usr/sbin/in.tftpd
             server_args     = -s /tftpboot
             disable         = no
}

4c Save the file, then restart xinetd by entering:
rcxinetd restart

PXE Boot

For reference, some technical background information as well as PXE’s complete specifications are 
available in the Preboot Execution Environment (PXE) Specification (ftp://download.intel.com/labs/
manage/wfm/download/pxespec.pdf).

1 Change to the directory of your installation repository and copy the linux, initrd, 
message, and memtest files to the /srv/tftpboot directory by entering the following:

cp -a boot/loader/linux boot/loader/initrd boot/loader/message 
boot/loader/memtest /srv/tftpboot

2 Install the syslinux package directly from your installation CDs or DVDs with YaST.
3 Copy the /usr/share/syslinux/pxelinux.0 file to the /srv/tftpboot directory 

by entering the following:
cp -a /usr/share/syslinux/pxelinux.0 /srv/tftpboot

4 Change to the directory of your installation repository and copy the isolinux.cfg file to 
/srv/tftpboot/pxelinux.cfg/default by entering the following:
cp -a boot/loader/isolinux.cfg /srv/tftpboot/pxelinux.cfg/
default

5 Edit the /srv/tftpboot/pxelinux.cfg/default file and remove the lines beginning 
with: 

gfxboot 
readinfo 
framebuffer 

6 Insert the following entries in the append lines of the default failsafe and apic labels:

Entry Description

insmod=e100 Loads the kernel module for an Intel 100MBit/s network card 
is on the PXE clients. This entry depends on the client’s 
hardware and must be adapted accordingly. In the case of a 
Broadcom* GigaBit network card, this entry would read 
insmod=bcm5700.

netdevice=eth0 Defines the client’s network interface that must be used for 
the network installation. It is necessary only if the client is 
equipped with several network cards and must be adapted 
accordingly. In case of a single network card, this entry can 
be omitted.
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An example /srv/tftpboot/pxelinux.cfg/default file follows. Adjust the 
protocol prefix for the installation source to match you network setup and specify your 
preferred method of connecting to the installer by adding the vnc and vncpassword or the ssh 
and sshpassword options to the install entry.
default linux
# default
label linux
  kernel linux
  append initrd=initrd ramdisk_size=65536 insmod=e100
      install=nfs://ip_instserver/path_instsource/NLD9
# failsafe
label failsafe
  kernel linux
  append initrd=initrd ramdisk_size=65536 ide=nodma apm=off
   acpi=off insmod=e100 install=nfs://ip_instserver/
path_instsource/NLD9
# apic
label apic
  kernel linux
  append initrd=initrd ramdisk_size=65536 apic insmod=e100
  install=nfs://ip_instserver/path_instsource/NLD9
# manual
label manual
  kernel linux
  append initrd=initrd ramdisk_size=65536 manual=1
# rescue
label rescue
  kernel linux
  append initrd=initrd ramdisk_size=65536 rescue=1
# memory test
label memtest
  kernel memtest
# hard disk
label harddisk
  kernel linux
  append SLX=0x202
implicit        0
display         message

install=nfs://ip_instserver/
path_instsource/CD1

Defines the NFS server and the installation source for the 
client installation. Replace ip_instserver with the actual IP 
address of your installation server and path_instsource with 
the actual path to the installation sources. HTTP, FTP, or 
SMB sources are addressed in a similar manner, except for 
the protocol prefix, which should read http or ftp.

IMPORTANT: If you need to give other boot options for the 
installation routines, such as SSH or VNC boot parameters, 
add them to the install entry. See “Booting the Target 
System for Installation” on page 71 for an overview of 
parameters and some examples.

Entry Description
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prompt          1
timeout         100

Replace ip_instserver and path_instsource with the values used in your setup.

The following section serves as a short reference of the PXELINUX options used in this setup. More 
information on the options available can be found in the documentation of the syslinux package 
located under /usr/share/doc/packages/syslinux/.

PXELINUX Configuration Options

The options listed here are a subset of all the options available for the PXELINUX configuration 
file.

Table 2-2   PXELINUX Configuration Options.

Option Description

DEFAULT kernel options... Sets the default kernel command line. If PXELINUX boots 
automatically, it acts just as if the entries after DEFAULT had been 
typed in at the boot: prompt except that the auto option is 
automatically added, indicating an automatic boot.

If no configuration file is present, or no DEFAULT entry is present in 
the config file, the default is the kernel name “linux” with no options.

APPEND options...  Adds one or more options to the kernel command line. These are 
added for both automatic and manual boots. The options are added 
at the very beginning of the kernel command line, usually permitting 
explicitly entered kernel options to override them.

LABEL label KERNEL image 
APPEND options...

Indicates that if label is entered as the kernel to boot, PXELINUX 
should instead boot image, and the specified APPEND options should 
be used instead of the ones specified in the global section of the file 
(before the first LABEL command.) The default for image is the same 
as label, and if no APPEND is given, the default is to use the global 
entry (if any). Up to 128 LABEL entries are permitted. 

Note that GRUB uses the following syntax:
title mytitle
    kernel my_kernel my_kernel_options
initrd myinitrd

whereas PXELINUX uses the following syntax:
label mylabel
    kernel mykernel
    append myoptions

Labels are mangled as if they were filenames, and they must be 
unique after mangling. For example, the two labels “v2.1.30” and 
“v2.1.31” would not be distinguishable under PXELINUX because 
both mangle to the same DOS filename.

The kernel doesn’t have to be a Linux kernel; it can be a boot sector 
or a COMBOOT file.

APPEND - Appends nothing. APPEND with a single hyphen as argument in a 
LABEL section can be used to override a global APPEND.
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Preparing the Target System for PXE Boot

Prepare the system's BIOS for PXE boot by including the PXE option in the BIOS boot order.

Do not place the PXE option ahead of the hard disk boot option in the BIOS. If you do, this system 
tries to reinstall itself every time you boot it.

Preparing the Target System for Wake-on-LAN

Wake-on-LAN requires the appropriate BIOS option to be enabled prior to the installation. Also, 
make note of the MAC address of the target system because this data is needed to initiate Wake-on-
LAN.

LOCALBOOT type On PXELINUX, specifying LOCALBOOT 0 instead of a KERNEL 
option means invoking this particular label and causes a local disk 
boot instead of a kernel boot.

0: Performs a normal boot.

4: Performs a local boot with the Universal Network Driver Interface 
(UNDI) driver still resident in memory.

5: Performs a local boot with the entire PXE stack, including the 
UNDI driver, still resident in memory.

All other values are undefined. If you don’t know what the UNDI or 
PXE stacks are, specify 0.

TIMEOUT timeout Indicates how long to wait at the boot: prompt until booting 
automatically, in units of 1/10s. The timeout is cancelled as soon as 
the user types anything on the keyboard, the assumption being that 
the user will complete the command line already begun. A timeout of 
zero (0) disables the timeout completely (this is also the default).

The maximum possible timeout value is 35996; (just less than one 
hour).

PROMPT flag_val If flag_val is 0, displays the boot: prompt only if the Shift or Alt key is 
pressed, or Caps Lock or Scroll Lock is set (this is the default). If 
flag_val is 1, always displays the boot: prompt.
F2 filename
F1 filename
..etc...
F9 filename
F10 filename

Displays the indicated file on the screen when a function key is 
pressed at the boot: prompt. This can be used to implement preboot 
online help (presumably for the kernel command line options.) For 
backward compatibility with earlier releases, F10 can be also 
specified as F0. Note that there is currently no way to bind filenames 
to F11 and F12.

Option Description
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Wake-on-LAN

Wake On LAN allows a machine to be powered on via a special network packet that is sent 
containing the machine's MAC address. Because every machine in the world has a unique MAC 
identifier, you don't need to worry about accidentally powering on the wrong machine.

IMPORTANT: If the controlling machine is not located in the same network segment as the 
installation target that should be woken, either configure the WOL requests to be sent as multicasts 
or remotely control a machine on that network segment to act as the sender of these requests.

Users of SUSE LINUX Enterprise Server 9 can use a YaST module called WOL to easily configure 
Wake-on-LAN. Users of other versions of SUSE LINUX operating systems can use a command line 
tool.

Configuring Wake-on-LAN with YaST

1 Log in as root.
2 Run YaST > Network Services > WOL.
3 Click Add, then specify the hostname and MAC address of the target system.
4 To power on this machine, select the appropriate entry and click Wake up.

Manual Configuration of Wake-on-LAN

1 Log in as root.
2 Run YaST > Install and Remove Software, then install the netdiag package.
3 Open a terminal and enter the following command as root to wake the target:

ether-wake mac_of_target

Replace mac_of_target with the actual MAC address of the target.

2.3.4  Booting the Target System for Installation
Basically, there are two different ways to customize the boot process for installation apart from 
those mentioned under “Wake-on-LAN” on page 71 and “PXE Boot” on page 67.

You can either use the default boot options and F keys or use the boot options prompt of the 
installation boot screen to pass on any boot options that the installation kernel might need on this 
particular hardware.

Using the Default Boot Options

The boot options have already been described in detail in “Manual Installation” on page 25. Refer to 
the section called “Booting for Installation” on page 26 for more information on the individual 
options.

Generally, just selecting Installation starts the installation boot process. If problems occur, the 
Installation—ACPI Disabled or Installation—Safe Settings options might come in handy.
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Using the F Keys 

The menu bar at the bottom of the screen offers some advanced functionality needed in some setups. 
Using the F keys, you can specify additional options to be given to the installation routines without 
having to know the detailed syntax of these parameters as you would need to if you entered them as 
boot options (see “Using Custom Boot Options” on page 72).

See the following table for a complete set of the available options.

Table 2-3   F Keys during Installation

Using Custom Boot Options

Using the appropriate set of boot options helps facilitate your installation procedure. Many 
parameters can also be configured later on using the linuxrc routines (described in further detail in 
“Section 3: Special Installation Procedures” in the SUSE LINUX Enterprise Server 9 Administration 
Guide (http://www.novell.com/documentation/sles9/pdfdoc/sles_9_admin_guide/
sles_9_admin_guide.pdf)), but using the boot options is easier. In some automated setups, the boot 
options can be provided via the initrd or an info file.

The following table lists all installation scenarios mentioned in this chapter with the required boot 
parameters and corresponding boot options. Just add all of them in the order they appear in the 
following table to get one boot option string that is handed down to the installation routines. For 
example (all in one line):

Key Purpose Available Options Default Value

F1 Provide help None None

F2 Change the screen resolution 
for the installation

Text Mode

VESA

Resolution #1

Resolution #2

...

Depends on your graphics 
hardware.

F3 Select the installation source CD-ROM

SLP

FTP

HTTP

NFS

SMB

Hard Disk

CD-ROM

F4 Select the installation 
language

All supported languages English

F5 Display installation log files Native

Verbose

Silent

Silent

F6 Apply driver update disk Driver None
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install=... netdevice=... hostip=... netmask=... vnc=... 
vncpassword=...

Replace all the values (...) in this string with the values appropriate for your setup.

Table 2-4   Installation (Boot) Scenarios Used in This Chapter

Installation Scenario Parameters Needed for Booting Boot Options

“Using the NLD CDs 
or DVD as the 
Installation Source” on 
page 25

None (system boots automatically) N/A

“Using a Network 
Installation Source” on 
page 52

Location of the network installation 
server

Network setup if DHCP isn't 
supported

install=(nfs,http,ftp,smb)
://path_to_instmedia

• hostip=some_ip

• netmask=some_netmask

• gateway=ip_gateway

“Simple Remote 
Installation via VNC—
Static Network 
Configuration” on 
page 54

Location of the installation server

Network device

IP address

Netmask

Gateway

VNC enablement

VNC password

install=(nfs,http,ftp,smb)
://path_to_instmedia

netdevice=some_netdevice 
(needed only if several network 
devices are available)

• hostip=some_ip

• netmask=some_netmask

• gateway=ip_gateway

vnc=1

• vncpassword=some_password

“Simple Remote 
Installation via VNC—
Dynamic Network 
Configuration via 
DHCP” on page 54

Location of the installation server

VNC enablement

VNC password

install=(nfs,http,ftp,smb)
://path_to_instmedia

vnc=1

• vncpassword=some_password

“Remote Installation 
via VNC—PXE Boot 
and Wake-on-LAN” on 
page 55

Location of the installation server

Location of the TFTP server

VNC enablement

VNC password

N/A (process managed through PXE 
and DHCP)
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TIP: You can find more information on the linuxrc boot options used for booting a Linux system in 
/usr/share/doc/packages/linuxrc/linuxrc.html.

2.3.5  Monitoring the Installation Process
There are several options to remotely monitor the installation process. If the proper boot options 
have been specified while booting for installation, either VNC or SSH can be used to completely 
control the installation and system configuration from a remote workstation.

VNC Installation

Using any VNC viewer software, you can remotely control the installation of NLD from virtually 
any operating system. This section introduces the setup using a VNC viewer application or a Web 
browser, alternatively.

Preparing for VNC Installation

All you need to do on the installation target to prepare for a VNC installation is provide the 
appropriate boot options at the initial boot for installation (see “Using Custom Boot Options” on 
page 72). The target system boots up in a text-based environment and waits for a VNC client to 
connect to the installation program.

The installation program announces the IP address and display number you need to connect to for 
installation. If you have physical access to the target system, this information is provided right after 

“Simple Remote 
Installation via SSH—
Static Network 
Configuration” on 
page 56

Location of the installation server

Network device

IP address

Netmask

Gateway

SSH enablement

SSH password

install=(nfs,http,ftp,smb)
://path_to_instmedia

netdevice=some_netdevice 
(needed only if several network 
devices are available)

• hostip=some_ip

• netmask=some_netmask

• gateway=ip_gateway

usessh=1

• sshpassword=some_password

“Simple Remote 
Installation via SSH—
Dynamic Network 
Configuration via 
DHCP” on page 57

Location of the installation server

SSH enablement

SSH password

install=(nfs,http,ftp,smb)
://path_to_instmedia

usessh=1

• sshpassword=some_password

“Remote Installation 
via SSH—PXE Boot 
and Wake-on-LAN” on 
page 57

Location of the installation server

Location of the TFTP server

SSH enablement

SSH password

N/A (process managed through PXE 
and DHCP)

Installation Scenario Parameters Needed for Booting Boot Options
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the system boots for installation. Enter these data when your VNC client software prompts for it and 
provide your VNC password.

As the installation target announces itself via OpenSLP, you can retrieve the address information of 
the installation target via an SLP browser without the need for any physical contact to the 
installation itself, provided your network setup and all machines support OpenSLP:

1 Start Konqueror (the KDE file and Web browser).
2 Enter service://yast.installation.suse at the location bar.

The target system appears as an icon in the Konqueror screen. Clicking this icon launches the 
KDE VNC viewer where you can perform the installation. Alternatively, run your VNC viewer 
software with the IP address provided and add :1 at the end of the IP address for the display 
that the installation is running on.

Connecting to the Installation Program

Basically, there are two ways to connect to a VNC server (the installation target, in this case). You 
can either launch an independent VNC viewer application on any operating system you want or 
connect using a Java-enabled Web browser. 

Using VNC you can control the installation of a Linux system from any other operating system, 
including other Linux flavors, Windows, and Mac OS.

Connecting via a VNC Viewer Application

On a Linux machine, make sure that the tightvnc package is installed. On a Windows machine, 
install the Windows version of this application, which can be obtained at the TightVNV home page 
(http://www.tightvnc.com/download.html).

1 Start the VNC viewer.
2 Enter the IP address and display number of the installation target as provided by the SLP 

browser or the installation program itself:
ip_address:display_number

A window opens on your desktop displaying the YaST screens as in a normal local installation.

Connecting via a Web Browser

Using a Web browser to connect to the installation program makes you totally independent of any 
VNC software or the underlying operating system. As long as the browser application has Java 
support enabled, you can use any browser (such as Firefox, Internet Explorer, or Konqueror) to 
perform the installation of your Linux system.

1 Launch your preferred Web browser.
2 Enter the following at the address prompt:

http://ip_address_of_target:5801

3 Enter your VNC password when prompted to do so.
The browser window displays the YaST screens as in a normal local installation.
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SSH Installation

Using SSH, you can remotely control the installation of your Linux machine using any SSH client 
software. 

Preparing for SSH Installation

Apart from installing the appropriate software package (OpenSSH for Linux and PuTTY for 
Windows), you need to give the appropriate boot options to enable SSH for installation. See “Using 
Custom Boot Options” on page 72 for details. OpenSSH is installed by default on any SUSE 
LINUX based operating system.

Connecting to the Installation Program

1 Retrieve the installation target's IP address.

If you have physical access to the target machine, just take the IP address the installation 
routines provide at the console after the initial boot. Otherwise, take the IP address that has 
been assigned to this particular host in the DHCP server configuration.

2 At a command line, enter
ssh -X root@ip_address_of_target

Replace ip_address_of_target with the actual IP address of the installation target.
3 When prompted for a username, enter root.
4 When prompted for a password, enter the password that has been set via the SSH boot option.

After you have successfully authenticated, a command line prompt appears on the installation 
target.

5 Type yast to launch the installation program.
A window opens showing the normal YaST screens as described in “Using the NLD CDs or 
DVD as the Installation Source” on page 25.

2.4  Automated Installation
This section on automated installation comprises several different types of installation that enable 
you to roll out highly customized installations to a great number of machines. Not all of the 
scenarios are completely hands-off (not requiring any physical access to the machines), but all of 
them involve customization of the machine's configuration, software selection, or even the 
installation procedure itself.

IMPORTANT: Before considering mass deployment of NLD using any of the following 
techniques (imaging, firstboot, or control.xml), make sure the roll-out is done to machines of a 
similar or even identical type and setup. Make sure the amount of disk space and RAM is identical 
and that the same type of disk is used on all target machines. Otherwise you might end up with 
unusable installations.

2.4.1  Imaging
Imaging is the process of installing a default configuration on a workstation, taking a “snapshot” of 
that workstation, and then duplicating the configuration on other workstations.
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Considerations

Before you start, consider the following issues:

Are the master machine and the targets of an identical hardware configuration? If not, this 
approach isn't suitable for installing NLD in this particular setup.
Be aware of the fact that some aspects of the targets’ configuration need to be changed 
manually, especially if you didn’t use DHCP network configuration on the master machine. 
Cloning machines using static network setup would result in conflicting IP addresses and a 
nonfunctional networking environment.
Do not consider imaging using this method on machines with multiple disks. The approach is 
not suited for complex multidisk environments.
To what degree would you like to customize the installation? 
Simple imaging just clones the system's basic configuration. If you are aiming for customized 
cloning of the desktop environment, consider the “Customizing Novell Linux Desktop” on 
page 79.

Prerequisites

You need the following items to be able to do imaging:

An installed, pristine NLD machine to act as master machine.
The original NLD installation CD1 or DVD.
An NFS server in the same network as the master and target machines with enough disk space 
to hold the master machine's disk image.
A fully functional network configuration on any machine involved in this setup.
A copy of your partition table to determine which disk and which partition need to be imaged. 
In a system with several disks, always image the one holding the root partition with all the 
system configuration data.
Determine the type of disk used on the master machine. The first SCSI disk would be referred 
to as /dev/sda whereas the first (E)IDE disk would be referred to as /dev/hda.
Make sure the target’s hard disk is at least of the same size as the master machine’s disk. 
Otherwise, the image would be incomplete, vital functionality could be missing, and the system 
would be unusable.

Simple Imaging

Simple imaging is used to just clone the basic system configuration of the master to any target 
machine you want.

1 Boot the master machine from the original installation media (NLD CD1 or DVD).
2 Select the Rescue System option to boot into the rescue mode of NLD.
3 Type root to log in. 

A password isn't required at this point.
4 Select the language settings to be used in the rescue system.
5 Configure the network in the rescue system to be able to connect to the NFS server.

5a Configure the IP address and netmask, then activate the interface by entering
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ifconfig eth0 ip_address netmask some_netmask up

Replace ip_address and some_netmask with values that fit your network setup.
5b Configure routing (if necessary) by entering

route add default gw ip_address_gateway

Replace ip_address_gateway with a gateway address that matches your requirements.
6 Mount an NFS exported directory from the NFS server to the /mnt directory on the master 

machine to hold the disk image by entering
mount ip_nfs_server:exported_dir /mnt

Replace ip_nfs_server and exported_dir with the actual values in your setup.
7 Create an image of your hard disk and store it on the NFS mounted directory by entering
dd if=/dev/hda of=/mnt/image.bin bs=16k

In the above command, the first (E)IDE disk is imaged. Adjust the command to the 
requirements of your machine's setup. If you need to image a SCSI disk, use /dev/sda 
instead.

8 Boot the target machine from the original installation media (NLD CD1 or DVD). 
9 Select the Rescue System option to boot into the rescue mode of NLD.

10 Type root to log in. 
A password isn't required at this point.

11 Select the language settings to be used in the rescue system.
12 Configure the network in the rescue system to be able to connect to the NFS server.

12a Configure the IP address and netmask, then activate the interface by entering
ifconfig eth0 ip_address netmask some_netmask up

Replace ip_address and some_netmask with values that fit your network setup.
12b Configure routing (if necessary) by entering

route add default gw ip_address_gateway

Replace ip_address_gateway with a gateway address that matches your requirements.
13 Mount an NFS exported directory from the NFS server to the /mnt directory on the target 

machine by entering
mount ip_nfs_server:exported_dir /mnt

Replace ip_nfs_server and exported_dir with the actual values in your setup.
14 To avoid swapping while transferring the image onto the target’s hard disk, identify the swap 

device currently in use and disable swapping for this device by entering
swapon -s
swappoff /dev/output_of_swapon

15 Enter the following to transfer the disk image from the NFS mounted partition in the rescue 
system to the disk of the target system:

dd if=/mnt/image.bin of=/dev/hda bs=16k

Make sure you adjust the disk type used to the disk setup in the target machine (see Step 7 on 
page 78).

16 Remove the boot (installation) media from the CD-ROM drive, then reboot the target machine.
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Advanced Imaging

For more advanced imaging features, use a third-party, commercial package such as Symantec* 
Ghost* (http://sea.symantec.com/content/product.cfm?productid=9).

Customizing Novell Linux Desktop

NLD offers several methods for customizing the NLD installation you roll out to the target 
machines. You can customize NLD with regard to the following aspects:

Hardware configuration (if rolled out to a set of identical machines)
Disk use and partitioning (if rolled out to a set of identical machines)
Default settings for new users
Desktop look-and-feel
Standard applications

Customizing NLD Using YaST

Most of the default system settings (like hardware configuration, partitioning and device setup) can 
be done using YaST. For more information, see Appendix A, “Using YaST to Configure the Novell 
Linux Desktop,” on page 125.

WARNING: Make sure both the master and target machine share the same hardware setup. 
Exporting partitioning schemes, graphics settings, or other hardware configurations to machines that 
don't match the setup or the master machine might break the installation and render the systems 
unusable.

Initial Environment

When the home directory for a new user is created, it is initialized with files from the /etc/skel 
directory. As system administrator, you can create files in /etc/skel that provide a default 
environment for users. For example, you might create a /etc/skel/.profile file that sets the 
EDITOR environment variable to a text editor that is easy for new users to use.

However, it is usually best to keep /etc/skel as small as possible, because it is difficult to update 
existing users’ files. For example, if the name of the friendly editor changes, all existing users would 
have to edit their .profile file. You could try to do it automatically, with a script, but that is 
almost certainly going to break someone’s file. 

Whenever possible, it is best to put global configuration into global files, such as /etc/profile. 
This way, it is possible to update without breaking users’ personal settings.

Customizing GNOME

The GNOME desktop configuration is done via a centralized repository that can be edited using the 
gconf editor tool that comes with the GNOME desktop. gconf allows you to customize the following 
aspects of your desktop:

Desktop theming (window themes, background images, number of virtual desktops)
Panel configuration (allow or disallow certain configuration options)
Menu options available in any GNOME/Gtk-based application and on the desktop
Deploying Novell Linux Desktop 79

http://sea.symantec.com/content/product.cfm?productid=9
http://sea.symantec.com/content/product.cfm?productid=9


80 Novell Linux

novdocx (E
N

U
)  10 A

ugust 2006
User actions (log out, lock screen, launch command)

For more information, see Appendix E, “GNOME Configuration for Administrators,” on page 261.

Customizing KDE

The kiosk framework of KDE allows you to customize almost any aspect of your desktop. The KDE 
desktop comes with the kiosk configuration tool offering a graphical interface to all the different 
configuration tasks. It allows you to customize the following aspects of your desktop:

Desktop theming
Panel configuration
Menu options in any Qt application and on the desktop
User actions
Internet use (disallow certain URLs in Konqueror) 

For more information, see Appendix F, “KDE Configuration for Administrators,” on page 305.

2.4.2  Firstboot Configuration
The YaST firstboot utility (YaST Initial System Configuration), which runs after the installation is 
completed, lets you configure NLD before creation of the install image so that on the first boot after 
configuration, users are guided through a series of steps that allow for easier configuration of their 
desktops. 

IMPORTANT: Because this scenario involves imaging, the concerns and constraints of this 
technique mentioned in “Imaging” on page 76 also apply to this approach.

Considerations

Consider using firstboot if you want to

Customize the installation experience for the users or administrators that will be using NLD.
Make sure all installations proceed in the same way, which makes maintaining these systems 
much easier compared to maintaining a lot of different types of machines and installation 
patterns.
Use imaging and have a similar software pattern and configuration rolled out to a large number 
of similar machines. 

Prerequisites

Before using firstboot, make sure the following items are provided and taken care of:

A master machine where NLD can be installed
Target machines of the same (or at least a very similar) hardware configuration as the master 
machine (hard drives, peripherals, graphics, and sound devices) 
A machine acting as the NFS server to hold and distribute the image
The NLD installation media (CDs or DVD)
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A working network environment for the master, target, and NFS server machines (including a 
name service)

Procedures

A typical firstboot process can be split into three subtasks:

1. Preparing the master machine
2. Imaging the master machine's hard disk
3. Configuring the target machine

Preparing the Master Machine

The master machine needs to be installed and configured before you can enable firstboot and start 
the imaging process.

1 Install NLD on a master machine, making sure that you install the firstboot package.

Firstboot is disabled by default. The YaST firstboot package is not part of any software 
selection and has to be installed individually. During the NLD installation, on the Installation 
Settings screen, click Software > Detailed Selection, and then search for and install the yast2-
firstboot package.

2 As root, create a file called /etc/reconfig_system by entering

touch /etc/reconfig_system

3 Enable the firstboot service either by using the YaST runlevel editor or by entering the 
following at the command line as root: 

insserv firstboot

Imaging the Master Machine's Hard Disk

To export the master machine's configuration, you need to image its hard disk and export this image 
to the targets.

1 Boot the master machine from the original installation media (NLD CD1 or DVD).
2 Select the Rescue System option to boot into the rescue mode of NLD.
3 Enter root to log in. 

A password isn't required at this point.
4 Select the language settings to be used in the rescue system.
5 Configure the network in the rescue system to be able to connect to the NFS server.

5a Configure the IP address and netmask, then and activate the interface by entering
ifconfig eth0 ip_address netmask some_netmask up

Replace ip_address and some_netmask with values that fit your network setup.
5b Configure routing (if necessary) by entering

route add default gw ip_address_gateway

Replace ip_address_gateway with a gateway address that matches your requirements.
6 Mount an NFS exported directory from the NFS server to the /mnt directory on the master 

machine to hold the disk image by entering
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mount ip_nfs_server:exported_dir /mnt

Replace ip_nfs_server and exported_dir with the actual values in your setup.
7 Create an image of your hard disk and store it on the NFS mounted directory by entering
dd if=/dev/hda of=/mnt/image.bin bs=16k

In the above command, the first (E)IDE disk is imaged. Adjust this command to the 
requirements of your machine's setup. If you need to image a SCSI disk, use /dev/sda 
instead.

8 Boot the target machine from the original installation media (NLD CD1 or DVD).
9 Select the Rescue System option to boot into the rescue mode of NLD.

10 Enter root to log in. 
A password isn't required at this point.

11 Select the language settings to be used in the rescue system.
12 Configure the network in the rescue system to be able to connect to the NFS server.

12a Configure the IP address and netmask, then activate the interface by entering
ifconfig eth0 ip_address netmask some_netmask up

Replace ip_address and some_netmask with values that fit your network setup.
12b Configure routing (if necessary) by entering

route add default gw ip_address_gateway

Replace ip_address_gateway with a gateway address that matches your requirements.
13 Mount an NFS exported directory from the NFS server to the /mnt directory on the target 

machine by entering
mount ip_nfs_server:exported_dir /mnt

Replace ip_nfs_server and exported_dir with values matching your actual setup.
14 To avoid swapping while transferring the image onto the target’s hard disk, identify the swap 

device currently in use and disable swapping for this device by entering
swapon -s
swappoff /dev/output_of_swapon

15 Enter the following to transfer the disk image from the NFS-mounted partition in the rescue 
system to the disk of the target system:

dd if=/mnt/image.bin of=/dev/hda bs=16k

Make sure you adjust the disk type used to the disk setup in the target machine (see Step 7 on 
page 78).

16 Remove the boot (installation) media from the CD-ROM drive, then reboot the target machine.

Configuring the Target Machine

After the master machine's configuration has been cloned to the target's hard disk and the target is 
booted for the first time, firstboot starts and then the user or system administrator needs to complete 
some final configuration steps.
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NOTE: The Post Configuration Utility (firstboot) expects the X Window System to be configured. 
If it isn’t, firstboot automatically starts in text mode.

1 Acknowledge the License Agreement.
2 Set the date and time to match with your setup.
3 Set the machine's root password.
4 Create user logins.
5 Finish the configuration and exit firstboot.

During firstboot, two additional dialogs are displayed (for writing the data and running SuSEconfig) 
which require no user interaction. For more information on SuSEconfig, see “Section 11.6, 
SuSEconfig and /etc/sysconfig” in the SUSE LINUX Enterprise Server 9 Administration and 
Installation Guide (http://www.novell.com/documentation/sles9/pdfdoc/sles_9_admin_guide/
sles_9_admin_guide.pdf).

Customizing YaST Firstboot

The user's experience of YaST and YaST firstboot can be customized to a certain extent. You can 
set certain actions to be taken in certain situations, add scripts to be executed to further adjust the 
target machine's configuration, and customize the messages passed on to the user.

The configuration file for firstboot is located in /etc/sysconfig/firstboot. The following 
variables can be used to further customize the firstboot process.

Table 2-5   Firstboot Configuration File Variables

Variable Description

SCRIPT_DIR="/usr/share/firstboot/scripts" Specifies the path where all scripts used by firstboot are 
located. If you want to add your own scripts to further 
customize the system, store them at the given location 
or specify another.

FIRSTBOOT_WELCOME_FILE="" Specifies the location of your own customized version of 
the YaST welcome message. If left empty, the NLD 
default welcome message is displayed.

FIRSTBOOT_LICENSE_FILE="/var/lib/
YaST2/info.txt"

Provides the license text, or EULA (End User License 
Agreement), of the product being installed. The default 
text is taken from the /var/lib/YaST2/info.txt 
file. If you need to use a custom license agreement, 
create a text file containing the custom license and 
specify its location here.

FIRSTBOOT_FINISH_FILE="" Specifies the location of your own customized version of 
the YaST finish message. If left empty, the NLD default 
finish message is displayed.

NOTE: If the referenced files in welcome, license, and 
finish messages are in plain text, they are shown as 
such automatically. If they contain any markup 
language, they are formatted as rich text.
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2.4.3  Create Custom Installations Using the control.xml File
The product configuration file (control.xml) lets you customize the installation by making it 
possible to enable and disable features of the final installed product during installation. It controls 
the workflow a user sees during installation. 

Besides workflow configuration, other system variables are configurable and can be predefined by 
the system administrator, including software selection and environment settings such as language, 
time zone, and keyboard. Any configuration here overrides default variables provided with Novell 
Linux Desktop. 

The idea of having a predefined installation workflow and predefined system settings is the middle 
ground between manual installation and automated installation. 

Considerations

Before you start using the control.xml file as a tool to install your clients, consider the 
following:

Determine which types of hardware are involved. Different types of hardware need to be 
addressed differently by any kind of automized installation routine.
Be aware of the fact that using the control.xml file for installation only represents a 
semiautomated approach to installation. User or administrator interaction is still required to 
some degree.
If a completely hands-off installation method with no user interaction whatsoever is called for, 
consider using AutoYaST as described in Appendix C, “Automatic Linux Installation and 
Configuration Using AutoYaST,” on page 195 or imaging as described in “Imaging” on 
page 76. 
Using AutoYaST, multiple systems sharing the same environment and similar (but not 
necessarily identical) hardware performing similar tasks can easily be installed in parallel and 
in a short time.

SHOW_Y2CC_CHECKBOX="no" Determines whether the Start Control Center option 
should be displayed as part of the finish screen in 
firstboot. The default value of 
SHOW_Y2CC_CHECKBOX is set to NO because 
further user interaction with the system configuration is 
not desired. 

LICENSE_REFUSAL_ACTION="halt" Specifies which action should be taken if the user does 
not acknowledge the license agreement. Possible 
values are halt (the system is halted), continue 
(continue with firstboot system configuration), and 
abort (abort the firstboot process and boot into the 
cloned installation). Because you need all NLD users to 
formally agree to the license agreement, your default 
setting should be halt.

Variable Description
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Scope of the Control.xml File

The product configuration file is provided in text on the installation media and defines the following 
settings needed during installation:

Table 2-6   Supported Configuration Options

Option Description

Workflow Replaces the static workflow list with a configurable list using the 
product configuration file. Entire sections of the workflow can be 
skipped. 

For example, if the IT department wants to force French installations 
in Quebec, Canada, you can set the language variable in the 
configuration file so that the Language dialog is skipped during the 
installation. If the IT department wants to recommend settings but 
still give the users the ability to change the default settings, the 
Language dialog could still be shown but with French preselected. 

If none of the above options is used, the default settings are shown. 

For more information, see “Workflows” on page 87.

Proposals Are also configurable. For example, certain products would skip 
some proposals. On the proposal screen, the preconfigured settings 
can be shown with the possibility of changing them or with inactive 
links if the configuration is to be forced. 

For more information, see “Proposals” on page 88.

System Variables Lets the users define system variables such as language, keyboard, 
time zone, window manager, and display manager. The defined 
variables are used as defaults in the respective dialogs.

For more information, see “Installation and Product Variables” on 
page 89.

Package Selections and 
Additional Individual Packages

Defines what base package selection and add-on selections should 
be used for the installation. Also provides the possibility of defining a 
list of additional packages. All packages and selections can be 
selected, depending on the architecture, using a special architecture 
attribute in the configuration file. 

For more information, see “Software” on page 89.

Partitioning Integrates flexible partitioning into the configuration file instead of the 
separate file currently used. 

For more information, see “Partitioning” on page 91.

Scripting and Hooks Defines hooks and special slots where the user can execute scripts. 
For example, scripts can be executed at the very beginning of the 
installation (after processing the configuration file), in the installation 
system before the initial boot, in the chroot-ed environment after 
initial boot, and before/after every step in the workflow. The scripting 
languages supported during installation are Shell and Perl. 

For more information, see “Hooks” on page 95.
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Implementation

The control file is implemented in simple, structured XML syntax, which so far has been used for 
automated installation. The XML structure used can be mapped easily to YaST data structures, and 
all data types available in YaST are supported for easy data access and manipulation.

The primary use of the control file is to configure the workflow of the installation. It lets you 
predefine a certain setup, but it also defines product installation features and other product-related 
variables. 

NOTE: The control file is not an optional tool to help customize installation. It is required during 
installation, and installation can fail or lead to unexpected results without the file. YaST provides a 
general default control file which is always available in the system. The general and product-
independent control files are installed by the YaST-installation package in /usr/share/YaST/
control/control.xml. 

During installation, linuxrc searches for the a file named control.xml on the installation 
medium (for example, CD, NFS, or FTP), copies the file to the installation system, and makes the 
file available to YaST. YaST then starts and looks for the control file in the following three locations 
before starting with the installation workflow:

Table 2-7   Control File Locations

One of the main reasons for using the control file is to let non-YaST developers change the 
installation behavior and customize various settings without the need to change YaST packages.

Configuration

This section contains information on the following:

“Workflows” on page 87
“Proposals” on page 88
“Installation and Product Variables” on page 89
“Software” on page 89
“Partitioning” on page 91
“Algorithm for Space Allocation” on page 91
“Configuration Options” on page 92

Location Description

/control.xml Usually found in the top directory after it has been copied 
by linuxrc during the initial installation phase.

/var/lib/YaST/control.xml After reading the file, and before the second installation 
phase, the control file is copied from the top directory to 
this location.

/var/lib/YaST/control.xml.

/usr/share/YaST/control/
control.xml

The location where YaST-installation installs the file in all 
products. The file is the same on all products.
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“Hooks” on page 95

Workflows

Using the control file, you can define multiple workflows for different modes and installation stages. 
The element workflows in the control file evaluates to a list of workflows. 

Beside defining which YaST clients should be executed during installation, the workflow 
configuration also lets you specify the wizard steps and how they should appear during a graphical 
installation. 

A workflow list element is a map with the following elements: 

Table 2-8   Workflow List Elements

The following is a typical installation workflow:
<workflows config:type=”list”>
        <workflow>
            <!-- ’label’ is what the user will see -->
            <label>Base Installation</label>
            <!-- default settings for all modules -->
            <defaults>
                <!-- arguments for the clients -->
                <arguments>false,false</arguments>

Element Description

label Label of the workflow as it appears on the left side of the wizard. For example, 
Base Installation.

defaults Default arguments to the clients. This is a map element.

stage Defines the stage or phase of installation. Possible values are initial (for the 
initial), stage, and continue (for the workflow of the installation after reboot). 

mode Defines installation mode. Several modes are available; the most important are 
the following:

installation

update

autoinst

modules The actual workflow. A list of elements describing the order in which the 
installation should proceed.

A module element is a map with the following configuration options

name: Name of the module. All installation clients and modules have a 
unified prefix (inst_), which can be omitted here. For example, if the YaST 
file for the module is called inst_test, then the name in the control file is 
test.

label: Label of the module in the step dialog. This is an optional element. If it 
is not set, the label of the previous module is used.

arguments: Arguments for the module is a comma-separated list which can 
accept Boolean operators and symbols. 
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                <!-- allowed architectures “all”, “i386”, 
“i386,ia64,x86_64”  -->
                <archs>all</archs>
            </defaults>
            <stage>initial</stage>
            <mode>installation,update</mode>
            <modules  config:type=”list”>
                <module>
                    <name>info</name>
                    <arguments>false,true</arguments>
                </module>
                <module>
                    <name>proposal</name>
                    <arguments>true,true,`ini</arguments>
                    <label>Installation Settings</label>
                </module>
                <module>
                    <name>do_resize</name>
                    <update config:type=”boolean”>false</update>
                    <archs>i386,x86_64,ia64</archs>
                    <label>Perform Installation</label>
                </module>
                <module>
                    <name>prepdisk</name>
                    <!-- Multiple modules with the same ’label’ will be
                         collapsed to one single user-visible step.
                         The step is considered finished when the last 
module
                         with the same ’label’ is finished.  -->
                    <label>Perform Installation</label>
                </module>
                <module>
                    <name>kickoff</name>
                    <label>Perform Installation</label>
                </module>
                <module>
                    <name>rpmcopy</name>
                    <label>Perform Installation</label>
                </module>
                <module>
                    <name>finish</name>
                    <label>Perform Installation</label>
                </module>
            </modules>
        </workflow>

Proposals

Part of the installation workflows are proposal screens, which consist of groups of related 
configuration settings (for example, Network, Hardware, and the initial Installation proposal).

You can add or modify a proposal, which we do not recommended because of configuration 
dependencies, by using the control file:
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<proposal>
      <type>network</type>
      <stage>continue,normal</stage>
      <proposal_modules config:type=”list”>
           <proposal_module>lan</proposal_module>
           <proposal_module>dsl</proposal_module>
           <proposal_module>isdn</proposal_module>
           <proposal_module>modem</proposal_module>
           <proposal_module>proxy</proposal_module>

 <proposal_module>remote</proposal_module>
       </proposal_modules>
</proposal>

The proposal in the above example is displayed in the so-called continue mode, which is the second 
phase of the installation. The proposal consists of different configuration options which are 
controlled using a special API.

NOTE: Proposal names and captions are fixed and cannot be changed. It is not possible to create a 
special proposal screen. Instead, you should use the available screens: network and hardware.

In the workflow, the proposals are called as any workflow step with an additional argument 
identifying the proposal screen to be started (`net for network, and `hw for hardware proposals). 
The following example shows how the network proposal is called as a workflow step:
<module>
    <label>Network</label>
    <name>proposal</name>
    <arguments>true,true,`net</arguments>
</module>

Installation and Product Variables

It is possible to define some installation variables and force them in the proposal. The user can still 
change them, however.

The following variables can be set:

Timezone (timezone)
Language (language)
Keyboard (keyboard)
Auto Login (enable_autologin)
Auto Login is not recommended for multiuser environments and server installations.

The following example shows all options listed above:
<globals>

        <enable_autologin config:type=”boolean”>true<enable_autologin>
        <language>de_DE</language>
        <timezone>Canada/Eastern</timezone>

</globals>

Software

Use this section in the control file to change the software proposal during installation. 
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An example software section could look like the following:
<software> 
<delete_old_packages config:type=”boolean”>false</delete_old_packages>
    <selection_type config:type=”auto”>auto</selection_type>
</software>  

By default, the software proposal is generated depending on the available space in the system. If 
enough space is available, a fairly large number of packages and add-on package groups are 
automatically selected. This behavior is controlled by the selection_type element in the 
control file. 

The default value for selection_type is auto. To force a selection (which a user cannot 
change), use the fixed value. 

If you want a fixed software selection, the fixed selection name must be specified in the control file. 
This selection must be a base selection. To specify the name of the base selection to be forced, use 
the base_selection element.

The list of base selections can be found on the first CD of the product in the suse/setup/descr 
directory or by using the following command over the NLD-9 repository of your network 
installation source: 
for i in `grep -l baseconf CD1/suse/setup/descr/* `; do 
      basename $i .sel; 
done

The above command generates the following output: 
Gnome
Kde

which matches the base selections in NLD.

Additionally, you can configure package updates using the following options:

delete_old_packages 
Does not delete old RPMs when updating.

only_update_selected 
Updates only packages already installed or upgraded (also installs new packages with new 
functionality).

You can also use the software_proposal element to switch from desktop-based proposals to the 
normal behavior of software proposals in YaST. Setting the value to desktop makes YaST show a 
dialog with desktops to select from (KDE or GNOME). If this element is not defined, default 
behavior is assumed. 

Adding Custom Software

You can also add additional software by creating custom software selections according to the 
procedure described in “Software” on page 218 and pulling them in via the software proposal 
described in “Software” on page 89.

To add a custom selection to your installation scope, proceed as follows:
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1 Prepare an add-on selection containing the additional software you want to include in the 
installation of NLD according to the procedure outlined in “Custom Package Selections” on 
page 218.

2 Add the selection to the control file. 
The software section of your control file should now read as follows.:
<software>
<selection_type config:type=”symbol”>fixed</selection_type>
<addons config:type=”list”>
<addon>mysel</addon>
</addons>
<base>Minimal</base>
...
</software>

The addons property encloses any additional selections you want to add. Just list any 
selection here, again enclosed by addon, and replace mysel with the actual name of your 
custom selection. The standard NLD selections you want to make are enclosed by the base 
element. A list of packages is added by the following code:
<software>
<selection_type config:type=”symbol”>fixed</selection_type>
...
<packages config:type=”list”>
<package>package1</package>
<package>package2</package>
...
</packages>
</software>

Replace package1 and package2 with package names matching your needs.

Partitioning

If present, the partition proposal is based on the data provided in the control file. 

Algorithm for Space Allocation

Space allocation on a disk happens in the following order:

1. All partitions get the size allocated that is determined by the size parameter of the partition 
description.

2. If a disk cannot hold the sum of these sizes, this disk is not considered for installation.
3. If all demands by the size parameter are fulfilled and there is still space available on the disk, 

the partitions which have a percent parameter specified are increased until the size demanded 
by percent is fulfilled.

4. If there is still available space on the disk (this normally happens only if the sum of all percent 
values is below 100), all partitions specified with a size of 0 are enlarged as far as possible.

5. If a maxsize is specified for a partition, all enlargement are done only up to the specified 
maxsize.
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If more than one of the available disks are eligible to hold a certain partition set, the disk is selected 
as follows:

1. If there is a partition allocated on that disk that has its size specified by percent or size=0 
keywords and does not have a maxsize value set, the desired size for this partition is considered 
to be unlimited.

2. If a partition group contains a partition with an unlimited desired size, the disk that maximizes 
the partition size for the unlimited partitions is selected.

3. If all partitions in a partition group are limited in size, the smallest disk that can hold the 
desired sizes of all partitions is selected for that partition group. 

If there are multiple partition groups:

1. The partition group with the lowest number (which means the highest priority) gets assigned its 
disk first.

2. The partition group with the next priority gets assigned the optimal disk from the as-yet-
unassigned disks. 

Configuration Options

The following elements are global to all disks and partitions:

Table 2-9   Configuration Elements

Element Description

disk Specifies which partitions should be placed on which disks if multiple 
disks are present in the system. All partitions with the same disk value 
are placed on the same disk. The value after the keyword determines 
the priority of the partition group. Lower numbers mean higher priority. If 
there are not enough disks in the system, a partition group with lower 
priority is assigned to a separate disk before a partition group with higher 
priority. A partition without the disk keyword is implicitly assigned the 
highest priority of 0.

Example: <disk>2<disk> 

formatopt Describes the options given to the format command. Multiple options 
must be separated by spaces. There must not be a space between an 
option letter and an option value. This entry is optional. 

Example: <formatopt>reiser<formatopt> 

fstopt Describes the options written to /etc/fstab. Multiple options must be 
separated by commas (,). This entry is optional. 

Example: <fstopt>acl,user_xattr<fstopt> 

fsys Describes the file system type created on this partition. Possible types 
are reiser, ext2, ext3, xfs, vfat, jfs, and swap. If no type is given for a 
partition, reiserfs is used. 

Example: <fsys>reiser</fsys> 
 Desktop 9 Deployment Guide



novdocx (E
N

U
)  10 A

ugust 2006
id Enables creation of partitions with partition IDs other than 0x83 (for 
normal file system partitions) or 0x82 (for swap partitions). This make it 
possible to create LVM or MD partitions on a disk. 

Example: <id>0x8E<id> 

increasable After determining the optimal disk usage, the partition can be increased 
if there is unallocated space in the same gap available. If this keyword is 
set, the partition can grow larger than specified by the maxsize and 
percent parameters. This keyword is intended to avoid having 
unallocated space on a disk after partitioning (if possible). 

Values: true|false 

Default: false 

Example: <increasable 
config:type=”boolean”>true<increasable> 

keep_partition_fsys Partitions that contain file systems in the list are not deleted even if 
prefer_remove is set to true. 

Values: Comma-separated list of reiser, xfs, fat, vfat, ext2, 
ext3, jfs, ntfs, swap 

Default: Empty list 

keep_partition_id Partitions that have a partition ID that is contained in the list are not 
deleted even if prefer_remove is set to true. 

Values: Comma-separated list of possible partition IDs

Default: Empty list 

keep_partition_num Partitions that have a partition number that is contained in the list are not 
deleted even if prefer_remove is set to true. 

To configure individual partitions and disks, a list element is used with its 
items describing how the partitions should be created and configured. 

IMPORTANT: If there is a space or an equal sign (=) contained in an 
option value, the value has to be surrounded by double quotes ("). 
Values that describe sizes can be followed by the letter K (kilobytes), M 
(megabytes), or G (gigabytes). 

Values: Comma-separated list of possible partition numbers 

Default: Empty list 

label If the file system can have a label, the value of the label is set to this 
value. 

Example: <label>emil<label> 

maxsize Limits the maximum amount of space that is allocated to a certain 
partition. This keyword is useful only in conjunction with a size 
specification by the percent keyword or by an entry of size=0. 

Example: <maxsize>4G<maxsize> 

Element Description
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Examples of Flexible Partitioning 

In the example below, if the machine has three disks, each of the partition groups is put on a separate 
disk. So one disk holds /var; another disk holds /home; and another disk holds /, /usr, and 
/opt. 
          <partitions config:type=”list”>
            <partition>
                <disk config:type=”integer”>3</disk>
                <mount>/var</mount>
                <percent config:type=”integer”>100</percent>               
            </partition>
            <partition>
                <disk config:type=”integer”>2</disk>                                
                <mount>/</mount>
                <size>1G</size>
            </partition>
            <partition>
                <disk config:type=”integer”>2</disk>                                

mount Describes the mount point of the partition. For a swap partition, the 
special value swap has to be used. 

Example: <mount>swap</mount> 

percent Determines that a partition should be allocated a certain percentage of 
the available space for installation on a disk. 

Example: <percent>30<percent> 

prefer_remove Values: true|false 

Default: true 

If set to false, the partition suggestion tries to use gaps on the disks or 
reuse existing partitions. If set to true, the partition suggestion prefers 
to remove existing partitions. 

remove_special_partitions If set to false, YaST does not remove some special partitions (for 
example, 0x12 Compaq diagnostics, 0xde Dell Utility) if they exist on 
the disk, even if prefer_remove is set to true. If set to true, YaST 
removes even those special partitions. 

WARNING: Some machines are not bootable when these partitions are 
removed, so be careful when setting this to true.

Values: true|false 

Default: false 

size Determines the minimum size for a partition. A size value of 0 means 
that YaST should try to make the partition as large as possible after all 
other demands regarding partition size are fulfilled. The special value of 
auto can be given for the /boot and swap partitions. If auto is set, 
YaST computes a suitable partition size by itself. 

Example: <size>2G<size> 

Element Description
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                <mount>/usr</mount>
                <size>2G</size>
            </partition>
            <partition>
                <disk config:type=”integer”>2</disk>                                
                <mount>/opt</mount>
                <size>2G</size>
            </partition>
           <partition>
                <disk config:type=”integer”>1</disk>
                <mount>/home</mount>
                <percent config:type=”integer”>100</percent>               
            </partition>       
       </partitions>

If the machine has only two disks, then /home is on a separate disk (because it has lower priority 
than the other partition groups) and /, /usr, /opt, and /var share the other disk. If there is only 
one disk in the system, all partitions are on that disk.

A more complete example with other options is shown below:
      <partitioning>        
        <partitions config:type=”list”>
            <partition>
                <disk config:type=”integer”>2</disk>
                <mount>swap</mount>
                <size>auto</size>
            </partition>
            <partition>
                <disk config:type=”integer”>1</disk>
                <fstopt>defaults</fstopt>
                <fsys>reiser</fsys>
                <increasable config:type=”boolean”>true</increasable>
                <mount>/</mount>
                <size>2gb</size>
            </partition>
            <partition>
                <disk config:type=”integer”>2</disk>
                <fstopt>defaults,data=writeback,noatime</fstopt>
                <fsys>reiser</fsys>
                <increasable config:type=”boolean”>true</increasable>
                <mount>/var</mount>
                <pct config:type=”integer”>100</pct>
                <size>2gb</size>
            </partition>
        </partitions>
        <prefer_remove config:type=”boolean”>true</prefer_remove>
        <remove_special_partitions config:type=”boolean”>false
      </remove_special_partitions>
    </partitioning>

Hooks

It is possible to add hooks before and after any workflow step for further customization of the 
installed system and to perform nonstandard tasks during installation.
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Two additional elements define custom script hooks:

prescript 
Executes before the module is called.

postscript 
Executes after the module is called.

Both script types accept two elements: the interpreter used (Shell or Perl) and the source of the 
scripts (which is embedded in the XML file using CDATA sections to avoid confusion with the 
XML syntax). The following example shows how scripts can be embedded in the control file: 
                <module>
                    <name>info</name>
                    <arguments>false,true</arguments>
                    <prescript>
                        <interpreter>shell</interpreter>
                        <source>
<![CDATA[#!/bin/sh
touch /tmp/tux
echo anas > /tmp/anas
]]>
                        </source>
                    </prescript>
                </module>

An Example Installation Scenario Using a Control.xml File

The following example should outline the basic procedure to install one or multiple targets with a 
predefined installation scope using a control.xml file.

The example assumes the following items are present in your environment and correctly set up:

A control.xml file that has been modified to match your requirements (see Section 2.4.3, 
“Create Custom Installations Using the control.xml File,” on page 84 for instructions).
A properly working network setup that includes DHCP and name service.
A network installation source (FTP or NFS) which provides the installation data as well as the 
control.xml file itself. For details on how to set up a network installation server, see 
“Setting Up the Server Holding the Installation Sources” on page 58.
The original product installation media to boot the targets from or a network and target 
configuration that allows booting via network (see “Preparing the Boot of the Target System” 
on page 64).
One or more target machines. Ideally, multiple machines should share the same kind of 
hardware configuration.

To proceed with the installation, do the following:

1 Boot the target machines either using a physical boot medium or via the network.

If using boot media, make sure the location of the network installation source is passed on to 
the installation routines. See “Using Custom Boot Options” on page 72.

YaST starts up and pulls in the control.xml file from the installation server, then the 
installation proceeds as outlined in the control.xml file.
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2 Make the settings the custom workflow requires you to, then complete the installation.

TIP: Because this procedure closely resembles a standard network installation, any of the 
techniques mentioned in “Remote Installation” on page 53 can be used to remotely control the 
installation procedure.
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3Upgrading Novell Linux Desktop

This chapter introduces the use of Service Packs for upgrading your Novell® Linux Desktop (NLD) 
installation. There are several different ways in which you can apply a Service Pack for NLD. You 
can either upgrade the existing installation of NLD or start a whole new installation using the 
Service Pack media.

This chapter discusses possible scenarios for upgrading your system and setting up a central network 
installation source:

“Setting Up a Network Installation Source for Service Pack Media” on page 99
“Installing an NLD Service Pack” on page 100
“Upgrading to an NLD Service Pack” on page 103

3.1  Setting Up a Network Installation Source for 
Service Pack Media
As with the initial installation of NLD, it is much more efficient having a central installation source 
on your network to serve all clients rather than installing all of them separately using a set of 
physical media. The setup of this installation server is very similar to the one described in “Setting 
Up the Server Holding the Installation Sources” on page 58.

3.1.1  Configuring a Network Installation Source on SLES 9 
Using YaST
Basically, follow the procedure outlined in “Setting Up an Installation Server Using YaST on SLES 
9” on page 58. Just add another installation source called NLD-9-SPx (where x is the number of the 
Service Pack) and make it available via NFS, HTTP, or FTP.

3.1.2  Manual Setup of a Network Installation Source
The procedure for manual setup of a network installation source is very similar to the one described 
in “Setting Up the Server Holding the Installation Sources” on page 58. A few minor changes have 
to be applied to the procedures for setting up NFS, FTP, HTTP, and SMB installation sources.

When copying the installation media, proceed as follows:

1 Log in as root.
2 Change to the directory that is already holding the original installation media of NLD (in this 

example, /install/nld) by entering
cd /install/nld

3 Create a new subdirectory called NLD-9-SPx (replacing x with the number of the SP) by 
entering
mkdir NLD-9-SPx

4 Copy the contents of each CD to their own subdirectory.
5 Create the following symbolic links:
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ln -s NLD-9-SPx/CD1/boot boot
ln -s NLD-9-SPx/CD1/content content
ln -s NLD-9-SPx/CD1/control.xml control.xml
ln -s NLD-9-SPx/CD1/media.1 media.1

6 Create a subdirectory called yast and then change to this directory by entering
mkdir yast
cd yast

7 Create a file called order which determines which media (original source vs. Service Pack) 
should be searched for and installed first. 
A valid order file for NLD would look like the following example:
NLD-9-SPx/CD1
NLD-9/CD1

Replace x with the actual number of the Service Pack. This order file tells the installation 
routines to first install the original NLD sources and then apply the SP sources on top of that.

8 Make the sources available via NFS, FTP, or HTTP as described in “Manual Setup of an NFS 
Installation Source” on page 60, “Manual Setup of an FTP Installation Source” on page 61, 
“Managing an SMB Installation Source” on page 63, or “Manual Setup of an HTTP Installation 
Source” on page 62, respectively.

3.2  Installing an NLD Service Pack
NOTE: To update an existing NLD 9 system to an NLD 9 SP, see “Upgrading to an NLD Service 
Pack” on page 103. 

Installing an NLD Service Pack is very similar to installing the original NLD media. As with the 
original installation, you can choose between a manual or a network installation.

3.2.1  Manual Installation
“Prerequisites” on page 100
“Procedure” on page 100

Prerequisites

Before starting a new installation of an NLD SP, ensure that the following items are available:

The original NLD installation media (CDs or DVD)
All of the Service Pack installation CDs

Procedure

1 Insert NLD SP CD 1 and boot your machine. 

A boot screen similar to the original installation of NLD 9 is displayed.
2 Select Installation to boot the SP kernel from CD.

The kernel loads and the following message appears:
Make sure that CD number 1 is in your drive.
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3 Insert the original NLD 9 CD 1, then click OK to run the regular installation.
4 Accept the license agreement, then select a language, default desktop, and other installation 

settings.
5 Click Yes, Install to start the installation.
6 Insert NLD 9 SP CD 1 when prompted, followed by NLD 9 SP CD 2. 
7 When prompted, insert the original NLD 9 CD 1 again, followed by the original NLD 9 CD 2 

and CD 3.
8 Continue as usual with the installation (entering a password for root, completing the network 

configuration, testing your Internet connection, activating the ZENworks®™ Online Update 
Service, selecting the user authentication method, and entering a user name and password).
For instructions on installing NLD, see the Novell Linux Desktop Quick Start (http://
www.novell.com/documentation/nld/qsnld/data/brmci5h.html) or quickstart-en.pdf at the root 
of the Novell Linux Desktop CD 1 or DVD.

TIP: If you get an error message during the media installation indicating that a certain file couldn’t 
be installed, skip that file and continue to the end. Then run the update again. During the reinstall, 
only the skipped packages are installed. 

3.2.2  Network Installation
“Prerequisites” on page 101
“Procedures” on page 101

Prerequisites

Before starting a network installation of an NLD SP, make sure that the following requirements are 
met:

A network installation source set up according to “Setting Up a Network Installation Source for 
Service Pack Media” on page 99.
A working network connection both on the installation server and the target machine that 
includes a name service, DHCP (optional/needed for PXE boot), and OpenSLP (optional). 
The NLD SP CD1 to boot the target system or a target system set up for PXE boot according to 
“Remote Installation via VNC—PXE Boot and Wake-on-LAN” on page 55.

Procedures

“Network Installation—Boot from CD” on page 101
“Network Installation—PXE Boot” on page 102

Network Installation—Boot from CD

To perform a network installation using the SP CD1 as the boot medium, proceed as follows:

1 Insert NLD SP CD 1 and boot your machine. 

A boot screen similar to the original installation of NLD 9 is displayed.
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2 Select Installation to boot the SP kernel from CD, then use the F3 key to select a type of 
network installation source (FTP, HTTP, NFS, or SMB).

3 Provide the appropriate path information or select SLP as the installation source. 
4 Select the appropriate installation server from what the installation program offers or use the 

boot options prompt to provide the type of installation source and its actual location (as in 
“Using Custom Boot Options” on page 72).
YaST starts up.

5 Accepting the license agreement, then select a language, default desktop, and other installation 
settings.

6 Click Yes, Install to start the installation.
7 Continue as usual with the installation (entering a password for root, completing the network 

configuration, testing your Internet connection, activating the ZENworks™ Online Update 
Service, selecting the user authentication method, and entering a user name and password).
For detailed instructions on installing NLD, see Chapter 2, “Deploying Novell Linux Desktop,” 
on page 21.

TIP: If you get an error message during the media installation indicating that a certain file couldn’t 
be installed, skip that file and continue to the end. Then run the update again. During the reinstall, 
only the skipped packages are installed. 

Network Installation—PXE Boot

To perform an network installation of an NLD Service Pack via network, proceed as follows:

1 Adjust the setup of your DHCP server to provide the address information needed for PXE boot. 

See “Setting Up a DHCP Server” on page 64 for more information.
2 Set up a TFTP server to hold the boot image needed for PXE boot. 

Use the first CD of your NLD Service Pack for this and otherwise follow the instructions in 
“Setting Up a TFTP Server” on page 66.

3 Prepare PXE boot and Wake-on-LAN on the target machine as described in “PXE Boot” on 
page 67.

4 Initiate the boot of the target system and use VNC to remotely connect to the installation 
routine running on this machine. 
See “VNC Installation” on page 74 for more information.

5 Accept the license agreement, then select a language, default desktop, and other installation 
settings.

6 Click Yes, Install to start the installation.
7 Continue as usual with the installation (entering a password for root, completing the network 

configuration, testing your Internet connection, activating the ZENworks™ Online Update 
Service, selecting the user authentication method, and entering a user name and password).
For detailed instructions on installing NLD, see Chapter 2, “Deploying Novell Linux Desktop,” 
on page 21.
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TIP: If you get an error message during the media installation indicating that a certain file couldn’t 
be installed, skip that file and continue to the end. Then run the update again. During the reinstall, 
only the skipped packages are installed. 

3.3  Upgrading to an NLD Service Pack
You need access to the original NLD 9 CDs or DVD in order to complete the upgrade.

1 In a running NLD system, insert NLD SP CD 1 into your CD drive, then click Yes when the 
hardware detection notice appears.

If the CD isn't autodetected, try reinserting it. If autodetect continues to fail, select System > 
Administrator Settings > Software > Patch CD Update.

2 If you are not logged in as root, enter the root password when prompted.
The YaST Online Update dialog appears.

3 Click Next to begin the update process.
The Download and Installation log tracks the update progress.

TIP: If you see a patch installation error message at any time during the update, click Skip 
Patch, complete the update, and then repeat the update process to install the skipped packages. 
Only the skipped packages are installed when the process is repeated.

4 When prompted for the YOU Patch CD CD2, insert NLD SP CD2 and then click OK.
This prompt does not appear if you are updating from a DVD.

5 Click Finish when you see Installation Finished reported near the end of the progress log.
6 If you skipped patches, repeat this update procedure
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4Novell Linux Desktop Utilities

This chapter contains information on the following utilities:

“Using Red Carpet to Update Novell Linux Desktop” on page 105
“Using the NCP Utilities to Mount NetWare Volumes” on page 106
“Using CIFS to Mount an SMB Filesystem” on page 107
“Installing VMware” on page 108

4.1  Using Red Carpet to Update Novell Linux 
Desktop
ZENworks® Linux Management lets you manage any number of client machines from a central 
server located within your firewall. Using the Web interface or the command line tool, you can 
create groups of individual machines and channels of software, and then distribute the software to 
the machines. You can delegate authority to multiple administrators, follow progress with the built-
in reporting system, and maintain your network.

Individual users can use the Red Carpet® client to manage the software they have on their 
computers. It can help them install, update, and remove programs without making them keep track 
of dependencies and conflicts themselves.

To install, update, or remove software, you must enter your system’s root password. If you do not 
have root privileges, you can only view the software installed on your system.

For more information on ZENworks Linux Management, see the Novell ZENworks Linux 
Management Administrator's Guide (http://www.novell.com/documentation/zlm/index.html).

For more information on Red Carpet, see the Novell Red Carpet Administration Guide (http://
www.novell.com/documentation/ximian/redcarpet.pdf).

4.1.1  Subscribing to a Red Carpet Channel
To receive updates through Red Carpet, you must subscribe to a Red Carpet channel. To access a 
Red Carpet channel, you need an activation code.

There are two kinds of activation codes: registered and non-registered. Evaluation codes (good for 
30 days worth of updates, but with no Support services) are preregistered and can be used right 
away. Purchased activation codes are not preregistered and must go through a registration process. 
To receive an evaluation access code, see Novell Linux Desktop 9 Evaluation Download (http://
www.novell.com/products/desktop/eval.html). To purchase a regular activation code, see How to 
Buy Novell Linux Desktop 9 (http://www.novell.com/products/desktop/howtobuy.html).

After your activation code is registered, you can activate your desktop by adding a service and 
entering your e-mail address and activation code.

1 Start the Red Carpet client:

GNOME: Click System > Software Update.
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KDE: Click  > System > Configuration > Red Carpet.
2 If you are not logged in as root, enter the root password, then click OK. 
3 Click Edit > Services > Add Service.
4 Specify the URL of the service you want to add (for example, https://update.novell.com/data), 

then click OK. 
5 Click File > Activate.
6 Specify your e-mail address and the activation key, then click Activate.
7 On the Red Carpet toolbar, click Channels. 
8 Select the Subscribed check boxes you want, then click Close.

The workstation is now configured to receive updates for NLD.

4.1.2  Getting Software Updates
An update notice is shown only for software you already have installed that is in a channel to which 
you are subscribed, and for which there is a newer version than what you already have.

1 Start the Red Carpet client:

GNOME: Click System > Software Update.

KDE: Click  > System > Configuration > Red Carpet.
2 If you are not logged in as root, enter the root password, then click OK. 
3 On the Updates tab, select one or more packages in the list of available updates.
4 Mark the selected packages for installation by clicking Mark for Installation.
5 Click Run Now to perform the update.

When the update is finished, the Update tab will show that your system is up-to-date.

4.2  Using the NCP Utilities to Mount NetWare 
Volumes
ncpfs is a Linux file system that understands the NCP protocol (the protocol NetWare clients use to 
talk to NetWare® servers).

The following NCP utilities let you mount and unmount volumes from a specified NetWare file 
server: 

“ncpmount” on page 107
“ncpumount” on page 107

ncpmount, when invoked with all appropriate arguments, attaches and logs in to the specified server 
and mounts all volumes (or one volume or subtree) from the server under the specified mount point. 
When invoked without any arguments specifying the fileserver, user ID, and password, ncpmount 
checks the file $HOME/.nwclient to find a file server, a username, and possibly a password to 
use for the specified mount point.

To enable mounting without root privileges, use the following commands:
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chmod 4755 /usr/bin/ncpmount
chmod 4755 /usr/bin/ncpumount

All NCP connection are available to all users.

4.2.1  ncpmount 
ncpmount -S server_name -A server’s_DNS_name -U userid.context -V vol1 
/your_favorite_mount_point

Example (with root privileges):

ncpmount -S server1 -A server1.mycompany.com -U 
user123.local.mycompany -V vol1 -c 1000 -u 1000 /home/user123/server1

Example (without root privileges):

ncpmount -S server1 -A server1.mycompany.com -U 
user123.local.mycompany -V vol1 ~/server1

IMPORTANT: All commands are supposed to be entered as one line.

4.2.2  ncpumount
ncpumount mount_point

Example:

ncpumount ~/server1

4.3  Using CIFS to Mount an SMB Filesystem
CIFS (Common Internet File System) lets multiple clients access and update the same file while 
preventing conflicts with file-sharing and locking semantics. These mechanisms also permit 
aggressive caching and read-ahead/write-behind without loss of cache coherency. CIFS also 
supports fault tolerance in the case of network and server failures. 

CIFS is an enhanced version of Microsoft's open, cross-platform Server Message Block (SMB) 
protocol, the native file-sharing protocol used by Windows 95, Windows NT, and OS/2 operating 
systems. It is the standard way that PC users share files across corporate intranets. CIFS is also 
widely available on UNIX, VMS, and other platforms. 

4.3.1  Enabling Mounting with Root Access
Use the following commands to mount
smbmount //server.name/volume /your_favorite_mount_point -o 
username=ID_on_remote_system,uid=uid_of_local_user
smbumount mount_point

For example:

smbmount //server1.mycompany.com/vol1 ~/server1 -o 
username=user123,uid=1000
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smbumount ~/server1

4.3.2  Enabling Mounting Without Root Access
To enable mounting without root access, use the following commands:

chmod 4755 /usr/bin/smbmnt
chmod 4755 /usr/bin/smbumount

4.4  Installing VMware
VMware Workstation lets you run different operating systems in a virtual machine on your desktop. 
Use the following steps to install VMware Workstation on Novell Linux Desktop 9. To get the latest 
version of the VMware package, see the VMware Download Center (http://www.vmware.com/
download).

1 Make sure that you have the following packages installed on your system.
kernel-source

gcc

make

If you need to install these packages, see “Installing and Removing Software” on page 127 for 
more information.

2 Make sure that the version of your kernal-source package is the same as the version of your 
running kernel. 
You will have kernel-default if you have a uni-processor machine, and kernel-smp if you have 
a multiprocessor machine or if hyperthreading is turned on. 

3 After you have verified that the two kernel pieces are the same, recompile the new kernel with 
the following commands:
cd /usr/src/linux;
make cloneconfig; make prepare-all

NOTE: You must do this every time you update a kernel. This will not cause you to loose your 
VMware configurations.

4 Install VMware and run vmware-config.pl (the VM ware configuration script).
For more information, see Installing VMware Workstation (http://www.vmware.com/support/
ws5/doc/install_ws.html).
Every time you update a kernel, repeat Step 3 on page 108, then run vmware-config.pl 
again. This will not cause you to loose your VMware configurations.
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5Troubleshooting

This chapter addresses a range of common problems which might arise with Novell® Linux Desktop 
(NLD), covering as many of the various types of potential problems as possible. If your precise 
situation isn’t listed here, there might be one similar enough to offer hints as to the solution.

5.1  Where to Look for Information
One of the benefits of Linux is that it logs things in a fair amount of detail. Thus, when things do go 
wrong, there is usually some information as to what happened; and even if the logs don’t tell you 
why (although they do, sometimes), you can at least get a head start on figuring it out. There are 
several places to look when you have problems with an NLD system—most of which are standard to 
Linux systems in general, and some of which are peculiar to SUSE®/NLD systems.

The following is a list of the most commonly checked log files on an NLD machine and what they 
typically contain.

Table 5-1   NLD Log Files

Linux comes with a great number of tools for system analysis and monitoring. See “Chapter 28: 
System Monitoring Utilities” in the SUSE LINUX Enterprise Server 9 Administration Guide (http://
www.novell.com/documentation/sles9/pdfdoc/sles_9_admin_guide/sles_9_admin_guide.pdf) for a 
selection of the most important ones used in system diagnostics.

Log File Description

/var/log/boot.msg Messages from the kernel during the boot process.

/var/log/mail.* Messages from the mail system.

/var/log/messages Ongoing messages from the kernel and system log daemon during 
runtime.

/var/log/rcd/ Directory containing Red Carpet® log information.

/var/log/samba/ Directory containing Samba server and client log messages.

/var/log/SaX.log Hardware messages from the SaX display and KVM system.

/var/log/warn All messages from the kernel and system log daemon deemed to 
be of WARNING level or higher.

/var/log/wtmp Binary file containing user login records for the current machine 
session.

/var/log/XFree86.*.log Various startup and runtime logs from the X Windows system; 
handy for debugging failed X startups.

/var/log/YaST2/ Directory containing YaST’s actions and their results.

/home/user/.xsession-
errors

Messages from the desktop applications currently running. 
Replace user with the actual username.
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The remainder of this chapter contains information about the following:

“Installation Problems” on page 110
“Boot Problems” on page 113
“Login Problems” on page 114
“Network Problems” on page 118
“Data Problems” on page 121

Each scenario begins with a heading describing the problem, followed by a paragraph or two 
offering suggested solutions, available references for more detailed solutions (some problems are 
familiar to the Linux community and have been well documented online), and cross-references to 
other scenarios that might be related.

5.2  Installation Problems
Installation problems are situations where a machine fails to install NLD. It might fail entirely or it 
just might not be able to start the graphical installer. This section highlights some of the typical 
problems you might run into and offers possible solutions or workarounds for this kind of situation.

5.2.1  The installation fails and the machine fails to boot.
Some hardware types, mainly fairly old or very new ones, fail to install NLD. In many cases this 
happens due to missing support for this type of hardware in the installation kernel or due to certain 
functions included in this kernel (like ACPI, for example), which still cause problems on some 
hardware.

If your system fails to install using the standard Installation mode from the first installation boot 
screen, try the following:

1 With CD1 still in the CD-ROM drive, reboot the machine with Ctrl+Alt+Del or using the 
hardware RESET button.

2 When the boot screen appears, use the arrow keys of your keyboard to navigate to Installation 
— ACPI Disabled and press Enter to launch the boot and installation process. 
This option disables the support for ACPI power management techniques.

3 Proceed with the installation as described in Chapter 2, “Deploying Novell Linux Desktop,” on 
page 21.

If this fails, proceed as above, but in Step 2 on page 110 select Installation — Safe Settings instead. 
This option disables ACPI and DMA support. Most hardware should boot with this option.

If both of these options fail, use the boot options prompt to pass any additional parameters needed to 
support this type of hardware on to the installation kernel. For more information on the parameters 
available as boot options, see the kernel documentation located in /usr/src/
kernel_version/Documentation/kernel-parameters.txt and “Chapter 3: Special 
Installation Procedures” in the SUSE LINUX Enterprise Server 9 Administration Guide (http://
www.novell.com/documentation/sles9/pdfdoc/sles_9_admin_guide/sles_9_admin_guide.pdf).

After you have discovered the right combination, YaST automatically writes them to the boot loader 
configuration to make sure that the system boots up properly next time.
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5.2.2  The machine fails to launch the graphical installer.
After you insert CD1 into your CD-ROM drive and reboot your machine, the installation screen 
comes up—but when you select Installation, the graphical installer does not start.

There are several ways to deal with this situation:

Try to select another screen resolution for the installation dialogs
Select Text Mode for installation
Do a remote installation via VNC using the graphical installer

To change the screen resolution for installation, proceed as follows:

1 Boot for installation.
2 Press F2 to launch a menu from which you can select a lower resolution for installation 

purposes.
3 Select Installation and proceed with the installation as described in Chapter 2, “Deploying 

Novell Linux Desktop,” on page 21.

To perform an installation in text mode, proceed as follows:

1 Boot for installation.
2 Press F2 and select Text Mode.
3 Select Installation and proceed with the installation as described in “Deploying Novell Linux 

Desktop” on page 21.

To perform a VNC installation, proceed as follows:

1 Boot for installation.
2 Enter the following text at the boot options prompt:
vnc=1 vncpassword=password

Replace password with any password you want to use for the installation.
3 Select Installation and press Enter to launch the installation, then select DHCP for network 

configuration when prompted to do so.
Instead of starting right into the graphical installation routine, the system continues to run in 
text mode and then stops, displaying a message containing the IP address and port number 
under which the installer can be reached via a browser interface or a VNC viewer application.

4 Do one of the following:
If using a browser to access the installer, launch the browser, type the address information 
provided by the installation routines on the future NLD machine, and then press Enter.
For example:
http://ip_address_of_NLD_machine:5801

IMPORTANT: Installing NLD via VNC works with any browser under any operating 
system, provided Java support is enabled.

Enter the VNC password when prompted.
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If using any kind of VNC viewer on your preferred operating system, enter the IP address 
and password when prompted to do so. A window opens, displaying the installation 
dialogs.

5 Proceed with the installation as described in Chapter 2, “Deploying Novell Linux Desktop,” on 
page 21.

5.2.3  The machine boots, but it comes up with a minimalistic 
boot screen. How do I proceed?
You inserted the first CD into the drive, the BIOS routines finished, but the system does not start up 
with graphical boot screen. Instead, it launches a very minimalistic text-based screen interface. This 
might happen on any machine not providing sufficient graphics memory for the rendering of a 
graphical boot screen.

Although the text boot screen looks minimalistic, it provides nearly the same functionality as the 
graphical one:

Table 5-2   Text Boot Screen Functionality

5.2.4  After installing from CD1, the system does not boot and 
request a second CD. Instead it seems to stop, displaying a 
minimal GRUB screen.
The system installs from CD1, but after it shuts down installation for the initial boot, it stops in a 
minimal GRUB and neither continues to boot nor continues with the installation (prompting for the 
second installation CD). 

Unlike the normal installation version of GRUB, this version needs some user interaction to proceed 
with the installation. Select harddisk and press Enter to proceed with the boot process for the 
installation.

Function Description

Boot options Unlike with the graphical interface, the different boot options can't 
be selected via the cursor keys of your keyboard. The boot menu 
of the text mode boot screen offers you some keywords to be 
entered at the boot prompt. These keywords map to the options 
offered in the graphical version. Enter your choice and press Enter 
to launch the boot process.

Custom boot options After you select a boot option, enter the appropriate keyword at 
the boot prompt or enter some custom boot options as described 
in “The installation fails and the machine fails to boot.” on 
page 110. To launch the installation process, press Enter.

F keys Use the F keys to determine the screen resolution for installation. 
If you need to boot in text mode, press F2.
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5.3  Boot Problems
Boot problems are situations where your NLD system does not boot properly (that is, does not boot 
to the expected startup runlevel and Welcome screen).

5.3.1  The machine loads the BIOS properly but fails to load the 
GRUB boot loader properly, producing an error message or 
nothing at all.
If, in fact, the hardware is functioning properly, it is possible that the boot loader has become 
corrupted and NLD cannot start up on the machine. In this case, it is necessary to reinstall the boot 
loader. This can be done using the CD-ROM install media for NLD and the AutoYaST install 
program, or via a network boot system which brings up AutoYaST.

Insert the Installation CD-ROM, make sure the machine’s BIOS is set to check the CD-ROM before 
the hard disk, then reboot using the RESET button. When the initial boot screen is shown, select 
Rescue System. The rescue system is described in more detail in “How do I recover a corrupted 
system?” on page 123.

Other reasons for the machine not booting up might be BIOS-related:

BIOS settings

Check your BIOS for references to your hard drive. GRUB might not be started up if the hard 
drive itself cannot be found with the current BIOS settings. 
BIOS boot order
Check whether your system’s boot order includes the hard disk. If the hard disk option wasn’t 
enabled, your system might install properly but fail to boot when access to the hard disk is 
required.

5.3.2  The machine loads the GRUB boot loader but, after 
selecting a Linux kernel, it produces error messages during the 
boot process which result in the machine hanging during the 
loading of Linux. No login screen or prompt is ever reached.
This behavior typically occurs after a failed kernel upgrade and it is known as a kernel panic 
because of the type of error on the system console that sometimes can be seen at the final stage of 
the process. If, in fact, the machine has just been rebooted following a software update, then the 
immediate goal is to reboot it using the previous, known-good version of the Linux kernel and 
associated files. This can be done in the GRUB boot loader screen during the boot process, as 
follows:

1 Reboot the computer using the hardware RESET button.
2 When the GRUB boot screen becomes visible, select the Linux - Failsafe option and then press 

Enter. 
The machine should boot using the previous version of the kernel and its associated files.
If Linux-Failsafe option does not boot the computer properly, boot the computer using the 
install media.
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3 After the boot process is completed, remove the newly installed kernel (preferably using the 
tool which installed it, such as YaST or Red Carpet) and, if necessary, manually modify 
/boot/grub/menu.lst to indicate the previous kernel as the default option.
For detailed information on the syntax used in this configuration file, see “Section 8.4: Booting 
with GRUB” in the SUSE LINUX Enterprise Server 9 Administration Guide (http://
www.novell.com/documentation/sles9/pdfdoc/sles_9_admin_guide/sles_9_admin_guide.pdf)
Updating this file might not be necessary, as automated update tools usually modify it for you 
during the rollback process.

4 Reboot.

5.3.3  The machine loads the GRUB boot loader properly and 
boots Linux, but presents a text-based console with a login 
prompt rather than a graphical desktop login manager.
If the machine comes up but doesn’t boot into the graphical login manager, anticipate problems 
either with the choice of the default runlevel or the configuration of the X Window system.

To check the runlevel configuration, log in as the root user and check whether the machine is 
configured to boot into runlevel 5 - graphic desktop. A quick way to check this is to examine the 
contents of /etc/inittab by entering

nld-machine:~ # grep “id:” /etc/inittab
id:5:initdefault:
nld-machine:~ #

The returned line ideally indicates that the machine’s default runlevel (initdefault) is set to 5 and that 
it should, in fact, boot to the graphics desktop. If the runlevel is set to any other number, use the 
YaST Runlevel Editor module to set it to 5.

IMPORTANT: Do not edit the runlevel configuration manually. YaST or, rather, SuSEconfig 
overwrites these changes on its next run. If you need to make manual changes here, you can disable 
the SuSEconfig overwrites by setting CHECK_INITTAB in /etc/sysconfig/suseconfig to 
No.

If the runlevel is set to 5, you might have corruption problems with your desktop or X Windows 
software. Examine the logfiles at /var/log/XFree86.*.log for detailed messages from the X 
server as it attempts to start. If the desktop fails during startup, it might log error messages to 
/var/log/messages. If these error messages hint at a configuration problem at the X server, try 
to fix these issues. If the graphical system still does not come up, it might be time to consider 
reinstalling the graphical desktop.

The startx command should force the X Windows system to start with the configured defaults if 
the user is currently logged in at the console. If that does not work, it should log errors to the 
console.

5.4  Login Problems
Login problems are those where your machine does, in fact, boot to the expected Welcome screen or 
login prompt, but refuses to accept the proper username/password, or accepts them but then does not 
behave properly (fails to start the graphical desktop, produces errors, drops to a command line, etc.).
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5.4.1  Users cannot log in; the NLD machine refuses to accept 
any valid username/password combinations.
This usually occurs because NLD is configured to use network authentication or directory services 
and, for some reason, is unable to retrieve results from its configured servers. The root user, as the 
only local user, is the only user that can still log in to these machines. The following are some 
common reasons why an NLD machine might appear functional but be unable to process logins 
correctly:

The network is not working. For help with, see “Network Problems” on page 118.
DNS is not working at the moment, which prevents GNOME or KDE from working and NLD 
from making validated requests to secure servers. One indication that this is the case is that 
NLD takes an extremely long time to respond to any action, even that of just pressing the Enter 
key on a blank field in a dialog. This is the DNS lookup timing out for every action that 
involves addressing the active window in the X Windows system. For more information on 
this, see “Network Problems” on page 118.
If the NLD system is configured to use Kerberos, the system’s local time might have drifted 
past the accepted variance with the Kerberos server time (this is typically 300 seconds). If NTP 
(Network Time Protocol) is not working properly or local NTP servers are not working, 
Kerberos authentication ceases to function because it depends on common clock 
synchronization across the network.
The system's authentication configuration is misconfigured. Check the PAM configuration files 
involved for any typos or misordering of directives. For additional information on PAM and 
the syntax of the configuration files involved, see “Chapter 20: PAM Pluggable Authentication 
Modules” in the SUSE LINUX Enterprise Server 9 Administration Guide (http://
www.novell.com/documentation/sles9/pdfdoc/sles_9_admin_guide/sles_9_admin_guide.pdf).

In all cases which do not involve external network problems, the solution is to reboot the system into 
a single-user mode and repair the configuration before booting again into operating mode and 
attempting to log in again.

To boot into single-user mode:

1 Reboot the system.

The NLD boot screen appears, offering you a prompt.
2 Enter 1 at the boot prompt to make the system boot into single-user mode.

You are prompted for a username and password.
3 Enter the username and password for root.
4 Make all the changes you need.
5 Boot into the full multiuser and network mode by entering telinit 5 at the command line.

5.4.2  A user cannot log in; the NLD machine refuses to accept 
a particular valid username/password combination.
This is by far the most common problem that NLD machines present, because there are many 
reasons this can occur. First and foremost, determine that the user’s username and password do, in 
fact, work on other (properly functioning) machines. If so, then see if another user can log in to the 
misbehaving machine. If another user can log in without difficulty, or if root can log in, then log in 
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and examine the /var/log/messages file. Locate the timestamps which correspond to the login 
attempts and determine if PAM has produced any coherent error messages.

The following are some common reasons why authentication for a particular user might fail on a 
specific machine:

The userid exists in the machine’s local authentication files and is in use by a different user.
The home directory exists but is either corrupt or unavailable. Perhaps it is write protected or is 
on a server which is inaccessible at the moment.
The user does not have permission to log in to that particular host in the authentication system.
The machine has changed hostnames, for whatever reason, and the user does not have 
permission to log in to that host.
The machine cannot reach the authentication server or directory server which contains that 
user’s information.
There might be problems with the X Window system authenticating this particular user, 
especially if the user's home has been used with another Linux distribution prior to installing 
NLD.

To locate the cause of the login problems, try the following:

1 Try to log in via a console (Ctrl+Alt+F1). 

If this is successful, the blame cannot be put on PAM or the directory server the user's home is 
hosted on, because it is possible to authenticate this user on this machine. Try to locate any 
problems with the X Window system or the desktop (GNOME or KDE).

2 If the user's home directory has been used with another Linux distribution, remove the 
Xauthority file in the user's home. Use a console login via Ctrl+Alt+F1 and issue the rm 
.Xauthority command as this user, then try a graphical login again.

3 If graphical login still fails, try a console login via Ctrl+Alt+F1 and try to start an X session on 
another display (the first one (:0) is already in use) by entering
startx -- :1

This should bring up a graphical screen and your desktop as well. If it doesn't, check the log 
files of the X Window system (/var/log/XFree86.displaynumber.log) or the log 
file for your desktop applications (.xsession-errors in the user's home directory) for any 
irregularities.

4 If the desktop still cannot start up, it is probably due to corrupt configuration files; therefore, 
refer to “A user cannot log in to GNOME Desktop; the NLD machine accepts the username and 
password but does not bring up the GNOME Desktop properly.” on page 116 or “A user cannot 
log in to KDE Desktop; the NLD machine accepts the username and password but does not 
bring up the KDE Desktop properly.” on page 117.

5.4.3  A user cannot log in to GNOME Desktop; the NLD 
machine accepts the username and password but does not 
bring up the GNOME Desktop properly.
If this is true for a particular user, it is likely that the user’s GNOME configuration files have 
become corrupted. Some symptoms might include the keyboard failing to work, the screen geometry 
becoming distorted, or even the screen coming up as a bare gray field. The important distinction is 
that if another user logs in, the machine works normally. If this is the case, then it is likely that the 
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problem can be fixed relatively quickly by simply moving the user’s GNOME configuration 
directory to a new location, which causes the GNOME Desktop to initialize a new one. Although the 
user is forced to reconfigure his GNOME Desktop settings, none of his data is lost.

1 Log in as root.
2 Change to the user’s home directory.
3 Move the user's GNOME config directories to a temporary location by entering
nld-machine:~user/ # mv ./gconf ./gconf-ORIG-RECOVER
nld-machine:~user/ # mv ./gnome2 ./gnome2-ORIG-RECOVER

4 Log out.
5 Let the user log in, but do not let them run any applications.
6 Recover the user's individual application configuration data (including, most importantly, the 

EvolutionTM e-mail client data) by copying the ~/gconf-ORIG-RECOVER/apps/ directory 
back into their new ~/gconf directory as follows:
nld-machine:~user/ # cp -a ./gconf-ORIG-RECOVER/apps ./gconf/

If this causes the login problems to reoccur, it might be time to attempt to recover only the 
critical application data and force the user to reconfigure the remainder of the applications.

5.4.4  A user cannot log in to KDE Desktop; the NLD machine 
accepts the username and password but does not bring up the 
KDE Desktop properly.
There are several reasons why a KDE Desktop might not allow users to log in. Corrupted cache data 
can cause login problems as well as corrupt KDE Desktop configuration files. 

Cache data is used at desktop startup to increase startup performance. If these data are corrupted, 
startup is slowed down or fails entirely. Removing them forces the desktop startup routines to start 
from scratch. This takes more time than a normal startup, but the data is intact after this and the user 
can log in.

To remove the cache files of the KDE Desktop, issue the following command as root:
nld-machine:~ # rm -rf /tmp/kde-user /tmp/socket-user

Replace user with the actual username. Removing these two directories removes just the corrupted 
cache files, so no real data is harmed.

Corrupted desktop configuration files can always be replaced by the initial configuration files. If you 
want to recover the user's adjustments, replace them after restoring the configuration.

To replace a corrupted desktop configuration by the initial configuration values, proceed as follows:

1 Log in as root.
2 Change to the user's home directory by entering

nld-machine:~ # cd /home/user
3 Move the KDE configuration directory and the .skel files to a temporary location by entering

nld-machine:~user/ # mv .kde .kde-ORIG-RECOVER
nld-machine:~user/ # mv .skel .skel-ORIG-RECOVER

4 Log out.
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5 Let the user log in to this machine.
6 After the desktop has started successfully, copy the user's own configurations adjustments back 

into place by entering
user@nld-machine:~ > cp -a .kde-ORIG-RECOVER/share .kde/share

TIP: If the user's own adjustments caused the login to fail and continue to do so, repeat the 
procedure as described above but don't copy the .kde/share directory.

5.5  Network Problems
Many of your NLD system problems might be network related, even though they don't seem to be at 
first. For example, the reason for a system not allowing users to log in as mentioned in “The 
machine loads the GRUB boot loader properly and boots Linux, but presents a text-based console 
with a login prompt rather than a graphical desktop login manager.” on page 114 might be a network 
problem of some kind. 

This section presents a simple step list you can apply to identify the cause of any network problem 
you encounter.

When checking the network connection of your NLD machine, proceed as follows:

1 If using an Ethernet connection, check the hardware first. Make sure your network cable is 
properly plugged in to your computer. The control lights right next to your Ethernet connector 
should both be active.

If the connection fails, check whether your network cable works with another machine. If it 
does, your network card causes the failure. If hubs or switches are included in your network 
setup, suspect them to be the culprits as well.

2 If using a wireless connection, check whether the wireless link can be established by other 
machines. If not, contact the wireless network's administrator.

3 After you have checked your basic network connectivity, try to find out which service is not 
responding.
Gather the address information of every network server needed in your NLD setup. Either look 
them up in the appropriate YaST module or ask your system administrator. The following list 
gives you some of the typical network servers involved in an NLD setup together with the 
symptoms an outage of these servers would have on your NLD machine.

Server/Outage Symptoms

DNS (name service) A broken or malfunctioning name service affects the network's 
functioning in many ways. If the local NLD machine relies on any 
network servers for authentication and these servers cannot be 
found due to a broken DNS, users cannot even lo in. Machines in the 
network managed by a broken name server are not able to “see” 
each other and communicate.

NTP (time service) A malfunctioning or completely broken NTP service could affect 
Kerberos authentication and X server functionality.
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4 Check whether the network servers are running and whether your network setup allows you to 
establish a connection.
4a Use ping hostname (hostname being the hostname of the server you want to connect 

to) to check whether each server is up and responding to the network. 
If this command is successful, it tells you that the host you are looking for is up and 
running and that the name service for your network is configured correctly.
If ping fails with destination host unreachable, either your system or the 
server you are trying to connect to is not properly configured or is down. Check whether 
your system is reachable by issuing ping your_hostname at another machine. If you 
succeed in reaching your machine at another machine, it is the server which is either not 
running at all or not configured correctly.
If ping fails with unknown host, the name service is not configured correctly or the 
hostname you used is incorrect. Use ping -n ipaddress to try to connect to this host 
without name service. If this is successful, check the spelling of the hostname and look for 
a misconfigured name service in your network. For further checks on this matter, refer to 
Step 4b on page 119. If ping still fails, either your network card is not configured correctly 
or your network hardware is faulty. Refer to Step 4c on page 120 for information on this.

4b Use host hostname to check whether the hostname of the server you are trying to 
connect to is properly translated into an IP address and vice versa. 
If this command returns the IP address of this host, the name service is up and running. If 
the host command fails, check all network configuration files relevant to name/address 
resolution on your host:

NFS (file service) If any application needs data stored in an NFS mounted directory, it 
cannot start up or function properly if this service is down or 
misconfigured. In a worst case scenario, a user's personal desktop 
configuration does not come up if his home directory containing his 
.gconf or .kde subdirectories cannot be found due to an outage of the 
NFS server.

Samba (file service) If any application needs data stored in a directory stored on a Samba 
server, it cannot start up or function properly if this service is down.

NIS (user management) If your NLD system relies on a NIS server to provide user data, users 
cannot log in to this machine if the NIS service is down.

LDAP (user management) If your NLD system relies on an LDAP server to provide user data, 
users cannot log in to this machine if the LDAP service is down.

Kerberos (authentication) Authentication does not work and login to any machine fails.

CUPS (network printing) Users cannot print.

Server/Outage Symptoms
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4c If your system cannot establish a connection to a network server and you have excluded 
name service problems from the list of possible culprits, check the configuration of your 
network card.
Use ifconfig network_device (executed as root) to check whether this device 
was properly configured. Make sure both inet address and Mask are configured 
correctly. A typo in the IP address or a missing bit in your network mask would render 
your network configuration unusable. If necessary, perform this check on the server 
machine as well.

File Description

/etc/resolv.conf Keeps track of the name server and domain you are currently 
using. It can either be modified manually or be automatically 
adjusted by YaST. The latter option is preferable. However, make 
sure this file has the following structure and all network addresses 
and domain names are correct:

search 
fully_qualified_domain_name
nameserver 
ipaddress_of_nameserver

This file can contain more than one name server address, but at 
least one of them must be correct to provide name resolution to 
your host. If needed, adjust this file via the YaST Hostname and 
Nameserver Module.

If your network connection is handled via DHCP, let YaST change 
these parameters for you by selecting Change host name via 
DHCP and Change name servers and search list via DHCP in the 
Host name and name server configuration dialog of the YaST 
network module. 

/etc/nsswitch.conf Directs Linux where to look for name service information. The file 
should look like this:
...
hosts:files dns
networks: files dns
...

The dns entry is vital, because it tells Linux to make use of an 
external name server. Normally, these entries are automatically 
made by YaST, but it never hurts to check.

If all the relevant entries on the host are correct, check the DNS 
server configuration for the correct zone information. For detailed 
information on DNS, see “Section 27.1, DNS—Domain Name 
System” in the SUSE LINUX Enterprise Server 9 Administration 
Guide (http://www.novell.com/documentation/sles9/pdfdoc/
sles_9_admin_guide/sles_9_admin_guide.pdf).

If you have made sure that the DNS configuration of your host and 
the DNS server are correct, proceed with checking the 
configuration of your network and network card in Step 4c on 
page 120. 
 Desktop 9 Deployment Guide

http://www.novell.com/documentation/sles9/pdfdoc/sles_9_admin_guide/sles_9_admin_guide.pdf
http://www.novell.com/documentation/sles9/pdfdoc/sles_9_admin_guide/sles_9_admin_guide.pdf
http://www.novell.com/documentation/sles9/pdfdoc/sles_9_admin_guide/sles_9_admin_guide.pdf
http://www.novell.com/documentation/sles9/pdfdoc/sles_9_admin_guide/sles_9_admin_guide.pdf


novdocx (E
N

U
)  10 A

ugust 2006
4d If name service and network hardware are properly configured and running, but some 
(external) network connections still get long timeouts or fail entirely, use traceroute 
fully_qualified_domain_name (executed as root) to track the network route 
these requests are taking. 
This command lists any gateway (hop) a request from your machine passes on its way to 
its destination. It also lists the response time of any hop and whether this hop is reachable 
at all. Use a combination of traceroute and ping to track down the culprit and, if this 
machine is in your company's network, let the administrators know.

After you have identified the cause of your network trouble, you can resolve the problem either 
yourself (if the problem is located on your machine) or let the system administrator of your network 
know about your findings so he can reconfigure the services or repair the machine they are running 
on.

5.6  Data Problems
Data problems are those times when the machine might or might not boot properly but, in either 
case, it is clear that there is data corruption on the system and that the system needs to be recovered. 
These situations call for a backup of your critical data, enabling you to recover the status quo if your 
system fails. NLD comes with dedicated YaST modules for system backup and recovery as well as 
with a rescue system that can be used to recover a corrupted system from the outside.

5.6.1  How do I backup critical data?
System backups can be easily managed using the YaST System Backup module:

1 As root, start YaST and click System > System Backup.

For more information, see Section A.1, “Starting YaST,” on page 125.
2 Create a backup profile holding all details needed for the backup (filename of the archived file, 

scope, and type of the backup).
2a Click Profile Management > Add.
2b Specify a name for the archive.
2c Specify the path to the location of the backup, if you want to keep a local backup. 

If you want your backup to be archived on a network server (via NFS), specify the IP 
address or name of the server and the directory which should hold your archive.

2d Select the archive type, then click Next.
2e Select the backup options to use (whether files not belonging to any package should be 

backed up, whether a list of files should be displayed prior to creating the archive, and 
whether changed files should be identified using the (time-consuming) MD5 mechanism).
Use the Expert button to open a dialog for the backup of entire hard disk areas. Currently, 
this option applies only to the Ext2 file system.

2f Finally, set the search constraints excluding certain system areas from the backup area 
which do not need to be backed up (like lock files or cache files); add, edit, or delete items 
until your needs are met; then click OK.

3 After you have finished the profile settings, do any of the following:
Start the backup right away (click Start)
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Configure automatic backup
Create other profiles tailored for various other purposes

To configure automatic backup for a given profile, proceed as follows:

1 As root, start YaST and click System > System Backup.

For more information, see Section A.1, “Starting YaST,” on page 125.
2 Select the profile you want, then click Profile Management > Automatic Backup.
3 Click Start Backup Automatically.
4 Select the backup frequency (daily, weekly, or monthly).
5 Set the backup start time.

These settings depend on the backup frequency you selected.
6 Select whether you want to keep old backups and how many of them should be kept. 

If you want to receive an automatically generated status message of the backup process, select 
Send Summary Mail to user root.

7 Click OK to apply the settings.

5.6.2  How do I replay a system backup?
Use the YaST Restore System module to restore the system configuration from a backup. You can 
either replay the entire backup or select specific components that are corrupted and need to be reset 
to their old state.

1 As root, start YaST and click System > Restore System.

For more information, see Section A.1, “Starting YaST,” on page 125.
2 Specify the location of the backup file, then click Next. 

This can be a local file, a network mounted file, or a file on a removable device such as a floppy 
or a CD.
A dialog displays a summary of the archive properties, such as the filename, date of creation, 
type of backup, and optional comments.

3 Review the archived content by clicking Archive content, then clicking OK to go back to the 
Archive properties dialog.

4 Click Expert to open a dialog where you can do some additional finetuning to the restore 
process, accept the default options, then return to the Archive properties dialog by clicking OK.

5 Click Next to launch the view of packages to restore.
6 Click Accept to restore all files in the archive or use the various Select buttons for a finetuning 

of your selection. 
Select Restore RPM database only if you corrupted or deleted the package database by 
accident and if this file is included in the backup. Otherwise, leave this option unchecked.
After you click Accept, the backup is applied.

7 Click Finish to leave the module after the restore process is finished.
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5.6.3  How do I recover a corrupted system? 
There are several reasons why an NLD system could fail to come up and run properly. A corrupted 
file system after a system crash, corrupted configuration files, and corrupted boot loader 
configurations are the most common reasons. If the system can't be booted from hard disk, use the 
installation media (CD1) as boot media and launch the rescue system.

After you log in to the rescue system, you can recover and complete a number of other tasks:

Manipulate any type of configuration file.
Check, modify, and reinstall the boot loader configuration.
Check the file system for defects and start automatic repair processes.
Resize partitions using the parted command. More information on this tool can be found at 
the GNU Parted (http://www.gnu.org/software/parted/parted.html) Web site.

To manipulate a configuration file, proceed as follows:

IMPORTANT: Before entering the rescue system, make sure you have a copy of the partition table 
of your NLD system. Otherwise, you cannot mount the root file system of your NLD installation to 
the rescue system in Step 4 on page 123.

1 Launch the rescue system of NLD by inserting CD1 into the CD-ROM drive of your machine. 

Make sure that the BIOS uses the CD-ROM as the preferred source of boot information and 
that you reboot the system using the RESET button.

2 When the initial boot screen appears, select Rescue System and press Enter. 
3 Select the language and keyboard layout used in the rescue system, then click OK.

The system boots into a minimal Linux system that resides entirely in a RAM disk and is thus 
totally independent of your installed system.

4 To access your original NLD system, mount its root file system to a directory in the rescue 
system. 
For example, to mount a root file system located under /dev/hda3 to the rescue system, use 
the following command:
mount /dev/hda3 /mnt
All directories of the NLD system are now located in /mnt.

5 Change to the directory in the mounted NLD root file system by entering
cd /mnt

6 Open the broken configuration file in the minimal text editor vi using the following command:

vi myfile

7 Enter and save your changes.
8 Unmount the NLD root file system from the rescue system by entering
umount /mnt

9 Reboot the machine.

To check the boot loader configuration and reinstall the boot loader, proceed as follows:
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1 Mount the root file system of your NLD system under the rescue system as described in the 
previous procedure.

2 Check whether the following files are correctly configured according to the GRUB 
configuration principles outlined in “Chapter 8: Booting and Boot Managers” in the SUSE 
LINUX Enterprise Server 9 Administration Guide (http://www.novell.com/documentation/
sles9/pdfdoc/sles_9_admin_guide/sles_9_admin_guide.pdf):

etc/grub.conf

boot/grub/device.map

boot/grub/menu.lst

Apply fixes to the device mapping (device.map) or the location of the root partition and 
configuration files, if necessary.

3 Reinstall the boot loader using the following command sequence:
Rescue:~ # chroot /mnt
Rescue:/ # grub --batch < /etc/grub.conf

4 Reboot the system.

Checking a file system while it is mounted is virtually impossible. If the root file system is 
corrupted, you can analyze and fix it only through the rescue system. The rescue system contains all 
file system (check) utilities needed for any of the major Linux file systems.
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AUsing YaST to Configure the 
Novell Linux Desktop

YaST is the configuration tool for Novell® Linux Desktop. This appendix covers the configuration 
of your system with YaST, which enables comfortable configuration of the main system 
components. This includes most of the hardware, the graphical user interface, Internet access, 
security settings, user administration, software installation, and system updates and information. 
This chapter also provides instructions for using YaST in text mode. 

“Starting YaST” on page 125
“The YaST Control Center” on page 126
“YaST in Text Mode (ncurses)” on page 176

A.1  Starting YaST
To start YaST:

1 Do one of the following, depending on the desktop you are using:

GNOME: Click System > Administrator Settings.

KDE: Click  > System > YaST. 
2 Enter the password for the root user.

The configuration must be performed with root privileges, because only the system 
administrator is entitled to change Linux system files.
The YaST Control Center window appears. 

To change the language of YaST and your entire system:

1 In the YaST Control Center, click System > Choose Language.
2 Select the language you want, then click Accept.
3 Click Close to exit the YaST Control Center.
4 Log out of your computer, then log in again and restart YaST to activate the new language 

setting.
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A.2  The YaST Control Center
When you start YaST in the graphical mode, the YaST Control Center opens first.

Figure A-1   YaST Control Center

In the left frame, the following categories are displayed:

Software
Hardware
System
Network Devices
Network Services
Security and Users
Misc

If you click one of the icons, the respective contents are listed on the right-hand side. For example, if 
you click Hardware, then click Sound to the right, a configuration dialog opens for the sound card.

The configuration of the individual items usually involves several steps. Always click Next to 
proceed to the following step. 

The left frame displays help text for the respective topic, explaining the entries required. After the 
necessary specifications have been made, complete the procedure by clicking Finish in the last 
configuration dialog. The configuration is then saved. 
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A.2.1  Software
You can use the Software option to perform the following tasks:

“Changing the Installation Source” on page 127
“Installing Patches from CD to Update Your Current Installation” on page 127
“Installing and Removing Software” on page 127
“Installing the System into a Directory” on page 128
“Updating the System” on page 128

Changing the Installation Source 

In the YaST Control Center, click Software > Change Source of Installation.

The installation source is the medium containing the software to install. Install from CD or DVD 
(the usual approach), from a network server, or from the hard disk. Refer to the detailed YaST help 
text for more information.

When you exit with Save and Exit, the settings are saved and applied to the Install and Remove 
Software, Boot and Kernel Configuration, and System Update configuration module. However, this 
module also offers the possibility to continue with Install to install or remove packages.

Installing Patches from CD to Update Your Current Installation 

In the YaST Control Center, click Software > Patch CD Update.

Patches are installed from a CD. Updating with the CD is pretty faster. When you insert the patch 
CD, all patches available on the CD are displayed in the dialog of this YaST module. Select 
packages for installation from the patch list. If an alert is displayed about a missing CD, insert the 
CD and restart the patch CD update. 

Installing and Removing Software 

In the YaST Control Center, click Software > Install and Remove Software.

Use this module to install, update, or remove software. To install from CD, insert the first CD in the 
drive. 

The Selection Filter 

Using the Filter drop-down box at the top left of the main dialog, determine how packages are to be 
displayed. The default setting is to display according to Selections. 

With the selection filter, predefined selections of specific application areas can be installed or 
selected for installation by selecting the respective check boxes. You can also uninstall an 
entire group. For each selection, the packages of the selection and their current statuses are 
displayed to the right. Select or deselect individual packages as desired. 
Another option is to list according to package groups. These package groups are displayed in a 
tree structure on the left-hand side. If you click one of the main groups (for example, 
Development or Documentation), all program packages belonging to this main group are listed 
at the top of the right frame. If you click one of the subgroups, the right frame displays the 
packages of only the subgroup. 
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NOTE: If desired, mark an installed package for deletion. Observe the alerts and do not delete 
any packages of the Linux base system (mostly located in the package group System). 

The easiest way to find a specific package is to use the search function, which can also be 
accessed here. Enter a search string and use the check boxes to set the search method (only in 
the name, in the description, in the package dependencies). For example, you can use this 
feature to determine which packages use a specific library. 

The Package Window 

The package window to the right features the following information (from left to right): status (see 
below), the package name, a short description, the size, and the version. The package status is 
displayed by means of various icons that are shown in the context menu reachable via the right 
mouse button. 

Change the status of a package by clicking the icons to the left of the package name. Only relevant 
status settings are available. For example, a package that is not installed cannot have the status 
Uninstall. If you are not sure about what a specific status indicates, do not select it or do not change 
it if set automatically. 

You can mark installed packages for deletion. Observe the alerts and do not delete any packages of 
the Linux base system, mostly located in the System package group.

The Information Window 

At the bottom right, a window with several tabs provides access to various kinds of information 
about the selected package, such as a detailed description, the technical data, a list of files installed 
with this package, packages additionally required by this package, and any conflicts with other 
installed packages or packages marked for installation. 

Checking Dependencies 

Under the information window, locate Check Dependencies and Auto Check. If Auto Check is 
activated and you select a package for installation, other required programs are displayed 
automatically. If preferred, simply disable the automatic check and use Check Dependencies after 
selecting packages. If automatic checking is disabled and you do not check the dependencies 
manually, the package dependencies are checked when you click Accept. 

Consumption of Hard Disk Space 

Monitor the space consumed on the hard disk partitions in the overview at the bottom left. If you 
select too many packages, an alert is displayed. 

Installing the System into a Directory

In the YaST Control Center, click Software > Installation into Directory.

Use this option to install the Novell Linux Desktop system into a directory of your choice.

Updating the System 

In the YaST Control Center, click Software > System Update.

This module let you update your system. The process consists of several steps. YaST checks which 
packages to update. If desired, decide individually for each package whether to perform an update. 
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This approach cannot be used for the base system, which requires a boot from the installation 
medium, such as from CD. 

IMPORTANT: The system update is a very complex procedure. For each program package, YaST 
must check which version is installed on the computer and what needs to be done to replace the old 
version with the new version correctly. YaST also tries to adopt any personal settings of the installed 
packages. However, some configurations might cause problems after the update if the old 
configuration is unable to handle the new program version as expected or if unexpected 
inconsistencies arise between various configurations. 

The older the existing version is, and the more the configuration of the packages to update diverges 
from the standard, the more problematic the update is. Sometimes, the old configuration cannot be 
adopted correctly. In this case, an entirely new configuration must be made. Before starting the 
update, you should save the existing configuration. 

A.2.2  Hardware
New hardware must first be installed or connected as specified by the vendor. Switch on external 
devices, such as the printer or the modem, and start the respective YaST module. Most devices are 
automatically detected by YaST and the technical data is displayed. If the automatic detection fails, 
YaST offers a list of devices (model, vendor, etc.) to select from. Consult the documentation 
enclosed with your hardware for more information. 

IMPORTANT: Use caution with model designations. If your model is not included in the device 
list, try a model with a similar designation. However, in some cases, the model must match exactly, 
as similar designations do not always indicate compatibility. 

You can use the Hardware option to perform the following tasks:

“Configuring the CD/DVD Drives in Your System” on page 129
“Configuring the Graphics Card and Monitor” on page 130
“Activating or Deactivating the DMA Mode for IDE Hard Disks and CD/DVE Drives” on 
page 137
“Configuring Your Printer” on page 137
“Changing the Mouse Model” on page 140
“Configuring Disk Controllers” on page 140
“Displaying Hardware Information” on page 140
“Configuring a Joystick” on page 141
“Configuring a Scanner” on page 141
“Configuring Sound Cards” on page 142

Configuring the CD/DVD Drives in Your System

In the YaST Control Center, click Hardware > CD-ROM Drives.

Within the scope of the installation, all detected CD-ROM drives are integrated in the installed 
system by means of entries in the /etc/fstab file. The respective subdirectories are created in 
/media. Use the Add and Remove buttons to change the state of integration for an entry in the list.
Using YaST to Configure the Novell Linux Desktop 129



130 Novell Linux

novdocx (E
N

U
)  10 A

ugust 2006
When the module is started, a list of all detected drives is displayed. Mark any new drives using the 
check boxes at the beginning of the lines and complete the integration by clicking Finish. The new 
drives are then integrated in the system.

Configuring the Graphics Card and Monitor

In the YaST Control Center, click Hardware > Graphics Card and Monitor.

The graphical user interface or X server handles the communication between hardware and 
software. Desktops, like KDE and GNOME, use the X server for interaction with the user. 

The graphical user interface is initially configured during installation. To change the settings later, 
run this YaST module. In the Desktop Settings dialog, choose between Text Mode Only (no 
graphical desktop) and Graphical Desktop Environment. The current settings are saved and you can 
restore them anytime. The current values are displayed and offered for modification, such as the 
screen resolution, the color depth, the refresh rate, and the vendor and type of your monitor (if it was 
autodetected). If you have just installed a new graphics card and you want to initialize it, a small 
dialog appears asking if you want to activate 3D acceleration for your graphics card. 

Click Change to open SaX2, the configuration tool for input and display devices. 

Figure A-2   SaX2 Main Window 

In the left frame, there are four components displayed:

Desktop 
Configures your monitor, graphics card, color depth, resolution, and the position and size of the 
screen.
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Multihead 
Configures multiple screens. 

Input Devices 
Configures a keyboard, mouse, touchscreen monitor, and graphics tablet.

AccessX 
Controls the mouse pointer with the number pad.

Select your monitor and graphics card. Usually, the monitor and graphics card are autodetected by 
the system. In this case, no manual settings are required. If your monitor is not autodetected, 
automatically proceed to the monitor selection dialog. Select your monitor from the extensive list of 
vendors and devices, or manually enter the monitor values specified in the monitor manual. 
Alternatively, select one of the preconfigured VESA modes.

Click Finish in the main window following the completion of the settings for your monitor and your 
graphics card, then test your settings. This ensures that your configuration is suitable for your 
devices. If the image is not steady, terminate the test immediately by pressing Esc and reduce the 
refresh rate or the resolution and color depth. Regardless of whether you run a test, all modifications 
are activated only after you restart the X server.

Desktop

Use the Desktop dialogs to configure your monitor, graphics card, color depth, resolution, and the 
position and size of the screen.

Monitor

Click Properties to configure your monitor. A dialog with Monitor-Model, Frequencies, and Expert 
tabs opens.

Figure A-3   Monitor Selection
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In the left part of the Monitor-Model tabbed page, select the vendor. In the right part, select your 
model. If you have floppy disks with Linux drivers for your monitor, click Manufacturer Disk to 
install these.

On the Frequencies tabbed page, specify the horizontal and vertical frequencies for your screen. The 
vertical frequency is another designation for the image refresh rate. Normally, the acceptable value 
ranges are read from the model and noted here. Usually, they do not need to be changed.

WARNING: There are safety mechanisms, but you should still be very careful when manually 
changing the allowed frequencies. False values might destroy your monitor. If in doubt, refer to the 
manual for the monitor.

On the Expert tabbed page, specify options for your screen. In the upper selection field, define the 
method to use for the calculation of the screen resolution and screen geometry. Do not change 
anything unless the monitor is addressed incorrectly and the display is not stable. You can also 
change the size of the displayed image and activate the DPMS power saving mode.

Graphics Card

Click Add New Card to add a new graphics card, or click Properties to configure an existing 
graphics card. In both cases, a dialog with a General and an Expert tab opens.

Figure A-4   Graphics Card Selection Dialog

In the left part of the General tabbed page, select the vendor of your graphics card. In the right part, 
select your model.

On the Expert tabbed page, specify advanced configuration options for your screen. On the right 
side, you can turn your screen to the left or to a vertical position, which is useful for some turnable 
TFT screens. The entries for the BusID are relevant only if you operate several screens. Normally, 
nothing needs to be changed here. You should not modify the card options unless you have 
experience in this field and know what the options mean. If necessary, check the documentation for 
your graphics card.
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Colors and Resolutions

Click Properties to change the color depth and resolution displayed on your screen.

Figure A-5   Color and Resolution Dialog

Depending on the hardware used, select a color depth of 16, 256, 32768, 65536, or 16.7 million 
colors (4, 8, 15, 16, or 24 bit). For a reasonable display quality, set at least 256 colors.

When the hardware is detected, the resolution is queried. Therefore, the module usually offers only 
resolution and color depth combinations that your hardware can display correctly. This keeps the 
danger of damaging your hardware with incorrect settings very low. If you change the resolution 
manually, consult the documentation for your hardware to make sure the value you set can be 
displayed.

The Expert tabbed page lets you add your own resolutions, which are subsequently included for 
selection on the Resolution tabbed page.

Virtual Resolution

Every desktop has a certain resolution that is displayed over the full screen of the monitor. However, 
it is possible to set the resolution larger than the visible area of the screen. If you move the mouse 
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beyond the margins of the desktop, the virtual part of the desktop is displayed on screen. This 
increases the available work space.

Figure A-6   Virtual Resolution Dialog

The virtual resolution can be set in two ways:

Move the mouse pointer over the monitor image so the pointer turns into crosshairs. While 
pressing the left mouse button, move the mouse to enlarge the raster image, which corresponds 
with the virtual resolution.This method is best if you are not quite sure how much virtual space 
you want on your desktop.
The pop-up menu in the middle of the raster image displays the currently used virtual 
resolution. To use one of the default virtual resolutions, select one from the menu.
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Geometry

You can use the Geometry option to precisely adjust the size and the position of the image with the 
arrows.

Figure A-7   Image Geometry Dialog

If you have a multihead environment (more than one screen), click Next Screen to switch to the 
other monitors to adjust their size and position. Click Save to save your settings.

Multihead

If you have installed more than one graphics card in your computer or a graphics card with multiple 
outputs, you can connect more than one screen to your system. If you operate two screens, this is 
referred to as dualhead. More than two is referred to as multihead. SaX2 automatically detects 
multiple graphics cards in the system and prepares the configuration accordingly. Set the multihead 
mode and the arrangement of the screens in the Multihead dialog. The following three modes are 
offered:

Traditional Multihead (default) 
Each monitor represents an individual unit. The mouse pointer can switch between the screens.

Cloned Multihead 
All monitors display the same contents. The mouse is visible only on the main screen.

Xinerama Multihead (one screen) 
All screens combine to form a single large screen. Program windows can be positioned freely 
on all screens or scaled to a size that fills more than one monitor.

The layout of a multihead environment describes the arrangement of and the relationship between 
the individual screens. By default, SaX2 configures a standard layout that follows the sequence of 
the detected graphics cards, arranging all screens in a row from left to right. In the Layout dialog of 
the Multihead tool, determine the way the monitors are arranged by using the mouse to move the 
screen symbols in the grid. When finished, click Test to verify the new configuration.

NOTE: Linux currently does not offer 3D support for Xinerama multihead environments. In this 
case, SaX2 deactivates the 3D support
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Input Devices

Mouse  
If the mouse already works, you do not need to do anything. However, if the mouse does not 
work, control it with the number pad of the keyboard as described in “AccessX” on page 136.
If the automatic detection fails, use this dialog to configure your mouse manually. Refer to the 
documentation for your mouse for a description of the model. Select your model from the list 
of supported mouse types and confirm by pressing 5 on the number pad.

Keyboard 
Use the selection field at the top of this dialog to specify the kind of keyboard you want to use. 
Then select the language for the keyboard layout (the country-specific position of the keys). 
Use the Test Field to see if special characters are displayed correctly.
The status of the check box used for activating and deactivating the entry of accented letters 
depends on the respective language and does not need to be changed. Click Finish to apply the 
new settings to your system.

Tablet 
Currently, XFree86 supports only a limited number of graphics tablets. SaX2 enables the 
configuration of graphics tablets connected to the USB port or the serial port. From the 
configuration perspective, a graphics tablet is another input device like a mouse.
Double-click a vendor in the Model list box to add a graphics tablet from the selection list. 
Select the check boxes to the right if you have connected a pen or eraser. If your tablet is 
connected to the serial port, verify the port. /dev/ttyS0 refers to the first serial port, and /
dev/ttyS1 refers to the second; additional ports use similar notation. Click Finish to save 
the configuration.

Touchscreen 
Currently, XFree86 supports only Mutouch, Microtouch, and Elo Touch-Systems 
touchscreens. SaX2 can only autodetect the monitor, not the toucher. The toucher is treated as 
an input device.
To configure the toucher, click Add New Touchscreen and then double-click the model. Save 
the configuration by clicking Finish. You do not need to test the configuration.
Touchscreens feature a variety of options and usually must be calibrated first. Unfortunately, 
there is no general tool for this purpose in Linux. The standard configuration contains suitable 
default values for the dimensions of the touchscreen. Normally, no additional configuration is 
required.

AccessX

If you do not use a mouse on your computer, start SaX2 and activate AccessX to be able to control 
the mouse pointer with the following keys on the numeric keypad:

Table A-1   Keys Used to Control the Mouse Pointer

Key Description

/ Selects the left mouse button.

* Selects the middle mouse button.
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With the slider, set the speed of the mouse pointer movement when a key is pressed.

Activating or Deactivating the DMA Mode for IDE Hard Disks and CD/DVE Drives 

In the YaST Control Center, click Hardware > IDE DMA Mode.

This module enables you to activate and deactivate the DMA mode for the IDE hard disks and IDE 
CD/DVD drives in the installed system. DMA (Direct Memory Access) enables drives to transmit 
data directly to the RAM without the detour through the processor control.

This module does not have any function for SCSI devices. DMA modes can substantially increase 
the performance and data transfer speed in your system. During the installation, the current SUSE® 
LINUX kernel automatically activates DMA for hard disks but not for CD drives, because default 
DMA activation for all drives often causes problems with CD drives. Use the DMA module to 
decide whether to activate DMA for your drives. If the drive supports the DMA mode smoothly, the 
data transfer rate of your CD drive can be increased by activating DMA. 

Configuring Your Printer 

This section covers printer configuration with YaST. For more information on printing in Linux, see 
“Chapter 13: Printer Operation” in the SUSE LINUX Enterprise Server 9 Administration Guide 
(http://www.novell.com/documentation/sles9/pdfdoc/sles_9_admin_guide/
sles_9_admin_guide.pdf).

Configuration with YaST

To set up a printer:

1 In the YaST Control Center, click Hardware > Printer.

- Selects the right mouse button.

5 Invokes a click event of the previously selected mouse button.The left mouse 
button is preset if no other button was selected. The selection is reset to its 
default after the event.

+ Acts like 5 except is a double-click event.

0 Acts like 5 except is a click-and-hold event.

Del Releases the click-and-hold event previously invoked with 0.

7 Moves the cursor toward the upper left. 

8 Moves the cursor straight upwards.

9 Moves the cursor toward the upper right.

4 Moves the cursor toward the left.

6 Moves the cursor toward the right.

1 Moves the cursor toward the lower left.

2 Moves the cursor straight downwards.

3 Moves the cursor toward the lower right.

Key Description
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The main printer configuration window appears. In the upper pane, you can view the detected 
printers. The lower pane lists any configured queues.

2 (Conditional) If your printer was not autodetected, click Restart Detection to restart the 
detection process. 

3 (Conditional) If it fails again, click Configure to configure the printer manually.

Not every printer can be configured for both printing systems (CUPS and LPRng/lpdfilter). Certain 
configurations are supported only by either CUPS or LPRng/lpdfilter. YaST informs you about this 
when configuring the printer. 

In Novell Linux Desktop, the default printing system is CUPS, but you can switch from CUPS to 
LPRng and back at any time:

1 In the YaST Control Center, click Hardware > Printer.
2 Click Change > Advanced.
3 Select the printing system you want, then configure it.

Automatic Configuration 

YaST configures the printer automatically if the following requirements are met: 

The parallel or USB port can be set up automatically in the correct way and the connected 
printer can be autodetected. 
The ID string of the printer, as supplied to YaST during hardware autodetection, is included in 
the printer database. Because this ID might be different from the actual name of the model, you 
might need to select the model manually. 
The printer database contains at least one configuration for the respective model that is known 
to work without problems. Depending on the printer, up to five queues are configured 
automatically. 

To make sure everything works properly, each configuration should be checked with the print test 
function of YaST. The YaST test page also provides important information about the selected 
configuration. 

Manual Configuration 

If one of the requirements for automatic configuration is not met or if you want a custom setup, you 
can configure the printer manually. 

Depending on how successful the autodetection is and how much information about the printer 
model is found in the database, YaST might be able to determine the right settings automatically, or 
at least make a reasonable preselection. The following parameters must be configured. 

Hardware Connection (Port)  
The configuration of the hardware connection depends on whether YaST has been able to find 
the printer during hardware autodetection. 

If YaST is able to detect the printer model automatically, you can assume that the printer 
connection works on the hardware level and no settings need to be changed in this respect. 
If YaST is unable to autodetect the printer model, this might indicate that the printer 
connection on the hardware level must be configured manually. See “Chapter 13: Printer 
Operation” in the SUSE LINUX Enterprise Server 9 Administration Guide (http://
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www.novell.com/documentation/sles9/pdfdoc/sles_9_admin_guide/
sles_9_admin_guide.pdf) for more information.

Name of the Queue: 
The queue name is used when issuing print commands. The name should be relatively short 
and consist of lowercase letters and numbers only.

Ghostscript Driver or Printer Language (Printer Model): 
The Ghostscript driver and the printer language depend on your printer model. YaST lets you 
select a predefined configuration suitable for the model. Selecting a manufacturer and a model 
basically means selecting a printer language and a Ghostscript driver suitable for this language 
with some default settings for the driver. These settings can be changed in an additional dialog 
as needed. 

Figure A-8   Selecting the Printer 

For non-PostScript* models, all printer-specific data is produced by the Ghostscript driver. The 
driver configuration (both the right driver and the correct options for it) is the single most important 
factor determining the output quality. The settings made at this point affect the printout on a queue-
by-queue basis. 

If your printer was autodetected (using the printer database) or if you selected the model manually, 
YaST presents a choice of suitable Ghostscript drivers, usually with a number of predefined 
configurations for each of them. For example:

monochrome 
color 300 dpi 
Using YaST to Configure the Novell Linux Desktop 139



140 Novell Linux

novdocx (E
N

U
)  10 A

ugust 2006
photo 600 dpi 

A predefined configuration includes a suitable Ghostscript driver and, if available, a set of options 
for the driver related to output quality. Not all selectable combinations of driver settings work with 
every printer model. This is especially true for higher resolutions.

Always check to make sure your settings work as expected by printing the test page. If the output is 
garbled, for example, with several almost empty pages, stop the printer by first removing all paper 
and then stopping the print test from YaST. However, in some cases the printer will refuse to resume 
work if you do so. It might then be better to stop the print test first and wait for the printer to eject all 
pages by itself. 

If the printer model is not listed in the printer database, YaST offers a selection of standard drivers 
for the standard printer languages. 

Advanced Settings 
Includes the hardware-dependent (driver-specific) and hardware-independent settings. You can 
specify special settings for the queues and restrict the access to the printer. However, there is 
normally no need to modify these settings. 

Using the CUPS Printing System 
For information on printing with CUPS, see “Chapter 13: Printer Operation” in the SUSE 
LINUX Enterprise Server 9 Administration Guide (http://www.novell.com/documentation/
sles9/pdfdoc/sles_9_admin_guide/sles_9_admin_guide.pdf). 

Changing the Mouse Model

1 In the YaST Control Center, click Hardware > Select Mouse Model.
2 Click the mouse type for the mouse attached to your computer.

You can also use the arrow keys to select a mouse. If the selection bar does not move, press the 
Tab key until it does. 

3 Click Test to test the selected settings.
4 Click Apply.

Configuring Disk Controllers

In the YaST Control Center, click Hardware > Disk Controller.

Normally, YaST configures the hard disk controller of your system during the installation. If you 
add controllers, use this module to integrate these into the system. You can also modify the existing 
configuration, but this is generally not necessary.

The Disk Controller Configuration dialog presents a list of detected hard disk controllers and 
enables assignment of the suitable kernel module with specific parameters. Click Test Loading of 
Module to determine if the current settings work before they are saved permanently in the system.

WARNING: We recommend testing the setting before making it permanent in the system. Incorrect 
settings can prevent the system from booting.

Displaying Hardware Information 

In the YaST Control Center, click Hardware > Hardware Information.
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YaST performs a hardware detection for the configuration of hardware components. The detected 
technical data is displayed in this screen. This is especially useful if, for example, you want to 
submit a support request for which you need information about your hardware. 

Figure A-9   Hardware Information 

Configuring a Joystick

In the YaST Control Center, click Hardware > Joystick.

Use this module to configure your joystick by selecting the manufacturer and the model from the 
displayed list. Because joysticks are usually connected to the sound card, you can also access this 
module from the sound card configuration (see “Configuring Sound Cards” on page 142).

Configuring a Scanner

In the YaST Control Center, click Hardware > Scanner.

If your scanner is connected and switched on, it should be detected automatically when this YaST 
module is started. In this case, the dialog for the installation of the scanner appears. If no scanner is 
detected, the Manual Scanner Configuration dialog appears. If you have already installed one or 
more scanners, a table listing existing scanners that can be modified or deleted appears. Click Add to 
configure a new device. 

Next, an installation is performed with default settings. If the installation is successful, a 
corresponding message appears. Test your scanner by inserting a document and clicking Test. 
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Scanner Was Not Detected 

Only supported scanners can be autodetected. Scanners connected to another network host are not 
detected. The manual configuration distinguishes the three following types of scanners: 

USB scanner 
Specify the vendor and model. YaST attempts to load USB modules. If your scanner is very 
new, the modules might not be loaded automatically. In this case, continue to a dialog in which 
you can load the USB module manually. See the YaST help text for more information.

SCSI scanner 
Specify the device (such as /dev/sg0). SCSI scanners should not be connected or 
disconnected when the system is running; shut down the system first. 

Network scanner 
Specify the IP address or the hostname.

You can use a scanner that is connected to a host in your network and configured as a network 
scanner. To configure a network scanner, refer to the Support Database article “Scanning in Linux” 
in The SUSE Support Database (http://portal.suse.com/sdb/en/index.html), keyword “scanner”). 
When selecting a network scanner, specify the hostname or the IP address of the host that the 
scanner is connected to.

If your scanner is not detected, the device probably is not supported. However, sometimes even 
supported scanners are not detected. If that is the case, proceed with the manual scanner selection. If 
you can find your scanner in the list of vendors and models, select it. For information about scanners 
that work with Linux, see the SANE (http://www.sane-project.org) Web site. 

WARNING: Assign the scanner manually only if you are absolutely sure of the model. An 
incorrect selection could damage your hardware. 

Troubleshooting 

Your scanner might not have been detected for one of the following reasons: 

The scanner is not supported 
Your SCSI controller was not installed correctly 
There are termination problems with your SCSI port 
Your SCSI cable is too long 
Your scanner has a SCSI Light Controller that is not supported by Linux 
Your scanner is defective 

IMPORTANT: SCSI scanners should not be connected or disconnected when the system is 
running. Shut down the system first. 

Configuring Sound Cards

In the YaST Control Center, click Hardware > Sound.

When the sound configuration tool is started, YaST tries to autodetect your sound cards. You can 
configure one or more sound cards. Click Finish to save the current settings and complete the sound 
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configuration. If YaST is unable to autodetect your sound card, click Add Sound Card to open a 
dialog where you can select a sound card and module. 

Setup

With Quick Automatic Setup, you are not required to go through any subsequent configuration steps 
and no sound test is performed. The sound card is configured automatically. With Normal Setup, 
you have the possibility of adjusting the output volume and playing a test sound. Advanced Setup 
lets you manually customize the sound card options.

Set up your joystick by selecting the respective check box. Select the joystick type in the following 
dialog, then click Next. The same dialog appears when you click Joystick in the YaST Control 
Center.

Sound Card Volume 

Click Volume to set the volume for each channel of the selected sound card. Click Next to save the 
volume settings, or click Back to restore the original settings. Click Test to test your sound 
configuration. If you cannot hear anything, increase the volume.

Sound Configuration 

Click Delete to remove a sound card. Existing entries of configured sound cards are deactivated in 
the /etc/modules.conf file. Click Options to open a dialog you can use to customize the 
sound module options manually. Click Add Sound Card to configure additional sound cards.

If YaST autodetects another sound card, continue to “Configuring a Sound Card” on page 143. If 
YaST does not detect a sound card, you are directed to “Manually Selecting a Sound Card” on 
page 143 automatically. 

With Start ALSA, you can enable or disable the startup of ALSA (Advanced Linux Sound 
Architecture) when booting. For playback of MIDI files, activate Start Sequencer. This way, the 
sound modules required for sequencer support will be loaded along with the ALSA modules.

The volume and configuration of all installed sound cards installed is saved when you click Finish. 
The ALSA configuration data is appended at the end of the /etc/modules.conf file. 

Configuring a Sound Card 

If multiple sound cards were detected, select your preferred card under List of Automatically 
Recognized. Continue to Setup by clicking Next. If the sound card was not autodetected, click Select 
from List and proceed to the next section, “Manually Selecting a Sound Card” on page 143. 

Manually Selecting a Sound Card 

If your sound card was not autodetected, a list of sound card drivers and models to choose from is 
displayed. Click All to see the entire list of supported cards. Refer to your sound card documentation 
for the information required. A reference list of sound cards supported by the Advanced Linux 
Sound Architecture (ALSA) with their corresponding sound modules is available at the Advanced 
Linux Sound Architecture (http://www.alsa-project.org) Web site. After making your selection, 
click Next to return to Setup.
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A.2.3  System
Use the System option to perform the following tasks:

“Changing the Settings in the /etc/sysconfig File” on page 144
“Changing the System's Language” on page 144
“Changing the Date and Time” on page 144
“Partitioning a Hard Disk” on page 145
“Configuring Powertweak Settings” on page 145
“Restoring Files from Backup Archives” on page 145
“Selecting a Keyboard Layout” on page 146
“Changing Boot Loader Settings” on page 147
“Creating a Boot, Rescue, or Module Disk” on page 149
“Creating and Configuring Volume Groups” on page 151
“Configuring Power Management” on page 151
“Configuring Profiles” on page 152
“Configuring Runlevels” on page 152
“Backing Up Files and System Areas” on page 153

Changing the Settings in the /etc/sysconfig File

In the YaST Control Center, click System > /etc/sysconfig Editor.

The /etc/sysconfig directory contains the files with the most important settings for Novell 
Linux Desktop. The sysconfig editor displays all settings in a well arranged form. The values can be 
modified and saved to the individual configuration files. Generally, manual editing is not necessary, 
because the files are automatically adapted when a package is installed or a service is configured.

IMPORTANT: Do not edit the files in /etc/sysconfig if you do not know exactly what you 
are doing, because this could seriously inhibit the operability of your system.

For more information on /etc/sysconfig/, see “Section 11.6: SuSEconfig and /etc/sysconfig” 
in the SUSE LINUX Enterprise Server 9 Administration Guide (http://www.novell.com/
documentation/sles9/pdfdoc/sles_9_admin_guide/sles_9_admin_guide.pdf).

Changing the System's Language

In the YaST Control Center, click System > Choose Language.

Use this module to select the language for your Novell Linux Desktop system. The language can be 
changed at any time. The language selected in YaST applies to the entire system, including YaST 
and the desktop environment (GNOME or KDE).

Changing the Date and Time

In the YaST Control Center, click System > Date and Time.
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The time zone was already set during the installation, but you can make changes here. Select your 
country or region from the list on the left, then select Local Time or UTC (Universal Time 
Coordinated) from the Hardware Clock Set To drop-down list. Machines with additional operating 
systems, such as Microsoft Windows, mostly use local time. Machines that have only Linux 
installed should be set to UTC.

Partitioning a Hard Disk

In the YaST Control Center, click System > Partitioner.

Although it is possible to modify the partitions in the installed system, this should be handled by 
experts who know exactly what they are doing, because the risk of losing data is very high. If you 
decide to use this tool, see “Partitioning” on page 255. The partitioning tool used during the 
installation is the same as in the installed system.

Configuring Powertweak Settings

In the YaST Control Center, click System > Powertweak Configuration.

Use this module to tune the kernel, hardware, networking, VFS subsystem, and virtual memory 
options. Select the item you want to tune from the expandable list of the left, then make the changes 
you want in the panel on the right.

Figure A-10   Powertweak Configuration

Restoring Files from Backup Archives

In the YaST Control Center, click System > Restore System.
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The restore module enables restoration of your system from a backup archive. Follow the 
instructions in YaST. Click Next to proceed to the individual dialogs. First, specify where the 
archives are located (removable media, local hard disks, or network file systems). A description and 
the contents of the individual archives are displayed, letting you decide what to restore from the 
archives.

Figure A-11   Start Window of the Restore Module

Additionally, there are two dialogs for uninstalling packages that were added since the last backup 
and for the reinstallation of packages that were deleted since the last backup. These two steps let you 
restore the exact system state at the time of the last backup.

IMPORTANT: Because this module normally installs, replaces, or uninstalls many packages and 
files, use it only if you have experience with backups, or else you might lose data.

Selecting a Keyboard Layout

In the YaST Control Center, click System > Select Keyboard Layout.

Use this module only if you work on a system without the X Window System and a graphical user 
interface. If you use a graphical system (such as GNOME or KDE), set up the keyboard with the 
Display and Input Devices module.The desired keyboard layout usually matches the selected 
language. Use the test field to see if special characters, such as the pipe symbol ( | ), are displayed 
correctly.
 Desktop 9 Deployment Guide



novdocx (E
N

U
)  10 A

ugust 2006
Changing Boot Loader Settings

In the YaST Control Center, click System > Boot Loader Configuration.

This YaST module simplifies the configuration of the boot loader, which is the first software 
program that runs when a computer starts. It is responsible for loading and transferring control to the 
operating system kernel software. The kernel, in turn, initializes the rest of the operating system. 
You should not experiment with this module unless you understand the concepts behind it. The 
following discussion mainly covers the default boot loader GRUB.

The Main Window

The current boot loader configuration of your system is displayed in the main window, where you 
can make any needed changes.

Figure A-12   Boot Loader Setup Main Window

The table listing the configuration data consists of three columns. Under Ch. (Changed) on the left, 
flags mark the changed options listed in the Options column (in the center). To add an option, click 
Add. To change the value of an existing option, click Edit. If you do not want to use an existing 
option at all, select it and then click Delete.Click Reset for the following options:
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Table A-2   Boot Loader Reset Options

To edit the relevant configuration files in an editor, click Edit Configuration Files. To edit a file, 
load it by means of the selection field and then click OK to save your changes. To exit the boot 
loader configuration, click Cancel. To return to the main window, click Back.

IMPORTANT: The sequence of the options or commands is very important in GRUB. If the 
specified sequence is not followed, the machine might not boot.

Boot Loader Configuration Options

For less experienced users, configuration with YaST is easier than editing the files directly. Select 
an option, then click Edit to open a dialog where you can change the settings according to your 
needs. To confirm the changes and return to the main menu where you can edit other options, click 
OK. The available options depend on the boot loader used.

The following table introduces some options of the GRUB boot loader:

Option Description

Propose New Configuration Generates a new configuration suggestion. Older Linux 
versions or other operating systems found on other 
partitions are included in the boot menu, letting you boot 
Linux or its old boot loader. The latter takes you to a second 
boot menu.

Start from Scratch Lets you create the entire configuration from scratch. No 
suggestions are generated.

Reread Configuration from Disk If you already made some changes and are not satisfied 
with the result, use this option to reload your current 
configuration.

Propose and Merge with Existing 
GRUB Menus

If another operating system and an older Linux version are 
installed in other partitions, the menu is generated from an 
entry for the new Novell Linux Desktop, an entry for the 
other system, and all entries of the old boot loader menu. 
This procedure might take some time. This is not possible if 
LILO is used.

Restore MBR of Hard Disk Restores the backup master boot record (MBR) saved on 
the hard disk.
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Table A-3   GRUB Boot Loader Options

Use Time-out to define how many seconds the boot loader should wait for keyboard input before the 
default system is booted. A number of other options can be specified with Add. However, the use of 
these options requires a deeper understanding and is not covered here. See the man pages for GRUB 
and LILO (man grub, man lilo, and man lilo.conf) for more information. A detailed 
online manual for GRUB is available at the GNU GRUB (http://www.gnu.org/software/grub) Web 
site.

Creating a Boot, Rescue, or Module Disk

In the YaST Control Center, click System > Create a Boot, Rescue, or Module Floppy.

Option Description

Boot Loader Type Switches between GRUB and LILO. Continue to another dialog to 
specify the way this change should be performed. (For instance, 
convert the current GRUB configuration into a similar LILO 
configuration.) However, some settings might be lost if no 
equivalent options are available. You can also create a new 
configuration from scratch or generate and edit a suggestion for a 
configuration.

If you start the boot loader configuration in the running system, you 
can load the configuration from the hard disk. If you decide to return 
to the original boot loader, you can load its configuration via the last 
option. However, this possibility exists only as long as you do not 
close the boot loader module.

Boot Loader Location Specifies where to install the boot loader: in the master boot record 
(MBR), in the boot sector of the boot partition (if available), in the 
boot sector of the root partition, or on a floppy disk. Use Others to 
specify a different location.

Disk Order If your computer has more than one hard disk, specifies the boot 
sequence of the disks as defined in the BIOS setup of the machine.

Default Section Specifies the kernel or operating system that should be booted by 
default. The selected system is booted after the timeout. Click Edit 
to view a list of all boot menu entries. Select an entry from the list, 
then click Set as Default. At this point, you can also modify any 
entry by clicking the Edit button.

Available Sections Lists the existing entries of the boot menu. If you select this option 
and then click Edit, a dialog opens that is identical to the Default 
Entry dialog.

Make Boot Loader Partition 
Active

Activates the partition whose boot sector holds the boot loader 
independently from the partition where the directory with the helper 
files of the boot loader are stored (/boot or the root directory /).

Replace Code in MBR Specifies whether to overwrite the MBR, which might be necessary 
if you have changed the location of the boot loader.

Back Up Files and Parts of Hard 
Disks

Backs up the changed hard disk areas.

Add Saved MBR to Boot Loader 
Menu

Adds the saved MBR to the boot loader menu.
Using YaST to Configure the Novell Linux Desktop 149

http://www.gnu.org/software/grub


150 Novell Linux

novdocx (E
N

U
)  10 A

ugust 2006
Use this module to create boot disks, rescue disks, and module disks. These floppy disks are helpful 
if the boot configuration of your system is damaged. The rescue disk is especially necessary if the 
file system of the root partition is damaged. In this case, you might also need the module disk with 
various drivers to be able to access the system (for example, to access a RAID system).

Figure A-13   Creating a Boot, Rescue, or Module Disk

You can create the following types of disks:

Standard Boot Floppy 1, 2, or 3 
Use these options to create standard boot disks to boot an installed system with. These disks are 
also needed to start the rescue system.

Rescue Floppy 
This disk contains a special environment that allows you to perform maintenance tasks in your 
installed system, such as checking and repairing the file system and updating the boot loader.
To start the rescue system, boot with the standard boot disk and then select Manual Installation 
> Start Installation or System > Rescue System. You are then prompted to insert the rescue 
disk. If your system was configured to use special drivers (such as RAID or USB), you might 
need to load the respective modules from a module disk.

Module Floppies 
Module disks contain additional system drivers. The standard kernel supports only IDE drives. 
If the drives in your system are connected to special controllers (such as SCSI), load the needed 
drivers from a module disk. If you select this option and click Next, you are taken to a dialog 
for creating various module disks.
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The following module disks are available:
USB Modules 

This floppy disk contains the USB modules you might need if USB drives are connected.
IDE, RAID, and SCSI Modules 

Because the standard kernel supports only normal IDE drives, you need this module disk 
if you use special IDE controllers. All RAID and SCSI modules are provided on this disk.

Network Modules 
If you need access to a network, load the suitable driver module for your network card 
from this floppy disk.

PCMCIA, CD-ROM (non-ATAPI), FireWire, and File Systems 
This floppy disk contains all PCMCIA modules used especially for laptop computers. The 
modules for FireWire and some less common file systems are also available here. Older 
CD-ROM drives that do not comply with the ATAPI standard can also be operated with 
drivers from this floppy disk.

To load drivers from a module disk to the rescue system, click Kernel Modules (hardware 
drivers) and the desired module category (SCSI, ethernet, etc.). You are prompted to insert the 
respective module disk and the contained modules are then listed. Select the desired module. 
Watch the system messages carefully. Loading module modulename failed 
indicates that the hardware could not be recognized by the module. Some older drivers require 
specific parameters to be able to address the hardware correctly. In this case, refer to your 
hardware documentation.

Custom Floppy 
Use this option to write any existing floppy disk image from the hard disk to a floppy disk.

Download Floppy Image 
Using this option, specify a URL and authentication data to download a floppy disk image from 
the Internet.

To create one of these floppy disks, select the corresponding option and then click Next. Insert a 
blank floppy disk when prompted. If you click Next again, the floppy disk is created.

Creating and Configuring Volume Groups

In the YaST Control Center, click System > LVM.

The Logical Volume Manager (LVM) is a tool for custom partitioning of hard disks into logical 
drives. For information about LVM, see “Section 3.10: LVM Configuration” in the SUSE LINUX 
Enterprise Server 9 Administration Guide (http://www.novell.com/documentation/sles9/pdfdoc/
sles_9_admin_guide/sles_9_admin_guide.pdf).

Configuring Power Management

In the YaST Control Center, click System > Power Management.

Use this module to configure power management functions such as standby, suspend, hibernation, 
battery monitor, automatic power off, shutdown of system components, and processor speed control. 
When starting the module from the YaST Control Center, the first dialog of the module is displayed. 
Here you can select the schemes to use for battery operation and AC operation. To add or modify the 
schemes, click Edit Schemes, which opens an overview of the existing schemes.
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In the scheme overview, select the scheme to modify and then click Edit. To create a new scheme, 
click Add. The dialog that opens is the same in both cases.

First, enter a suitable name and description for the new or edited scheme. For the hard disk, define a 
Standby Policy for maximum performance or for energy saving. The Acoustic Policy controls the 
noise level of the hard disk. Click Next to open the CPU and Cooling Policy dialog. CPU contains 
the CPU Frequency Scaling and Throttling options. Use these options to define if and to what extent 
the CPU frequency can be throttled. The Cooling Policy determines the cooling method. Complete 
all settings for the scheme, then click OK to return to the start dialog. In the start dialog, assign the 
custom scheme to one of the two operating modes. To activate your settings, click OK.

Global power management settings can also be made from the initial dialog using Battery Warnings 
or ACPI Settings. Click Battery Warnings to view the battery charge level.

The BIOS of your system notifies the operating system whenever the charge level drops below 
certain configurable limits. In this dialog, there are three limits: Warning Capacity, Low Capacity, 
and Critical Capacity. Specific actions are triggered when the charge level drops below these limits. 
Usually, the first two levels merely trigger a notification to the user. The third critical level triggers 
a suspend, because the remaining energy is not sufficient for continued system operation. Select 
suitable charge levels and the respective actions, then click OK to return to the start dialog.

Click ACPI Settings to access the dialog for configuring the ACPI buttons. These settings determine 
how the system should respond to the activation of certain switches. Configure the system response 
to pressing the Power button, pressing the Sleep button, and then closing the laptop lid. Click OK to 
complete the configuration and return to the start dialog. Click OK again to exit the module and 
confirm your power management settings.

For more information, see “Chapter 17: Power Management” in the SUSE LINUX Enterprise Server 
9 Administration Guide (http://www.novell.com/documentation/sles9/pdfdoc/sles_9_admin_guide/
sles_9_admin_guide.pdf).

Configuring Profiles

In the YaST Control Center, click System > Profile Manager.

The SCPM (System Configuration Profile Management) module enables creating, managing, and 
switching between system configurations. This is especially useful for mobile computers that are 
used in different locations (in different networks) and by different users. However, this feature is 
useful even for stationary machines, because it enables the use of various hardware components or 
test configurations. For more information about SCPM basics and handling, see “Chapter 16: Linux 
on Mobile Devices” in the SUSE LINUX Enterprise Server 9 Administration Guide (http://
www.novell.com/documentation/sles9/pdfdoc/sles_9_admin_guide/sles_9_admin_guide.pdf).

Configuring Runlevels

In the YaST Control Center, click System > Runlevel Editor.

Novell Linux Desktop can be operated in several runlevels. By default, the system boots to runlevel 
5, which offers multiuser mode, network access, and the graphical user interface (X Window 
System). The other runlevels offer multiuser mode with network but without X (runlevel 3) and 
multiuser mode without network (runlevel 2).

The various runlevels are useful if problems are encountered in connection with a particular service 
(X or network) in a higher runlevel. In this case, the system can be booted to a lower runlevel to 
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repair the service. Many servers operate without a graphical user interface and must be booted in a 
runlevel without X, such as runlevel 3. 

Usually you need only the standard runlevel (5). However, if the graphical user interface freezes at 
any time, you can restart the X Window system by switching to a text console by pressing 
Ctrl+Alt+F1, logging in as root, and switching to runlevel 3 with the init 3 command. This shuts 
down your X Window System, leaving you with a text console. To restart the graphical system, 
enter the init 5 command.

In a default installation, runlevel 5 is selected. To start a different runlevel when the system is 
booted, change the default runlevel here. Click Expert Mode to see which services are started in 
which runlevel. 

WARNING: Incorrect settings for system services and runlevels can render your system useless. 
To retain the operability of your system, consider the possible consequences before modifying any 
of these settings.

For more information on runlevels, see “Section 11.2: Runlevels” in the SUSE LINUX Enterprise 
Server 9 Administration Guide (http://www.novell.com/documentation/sles9/pdfdoc/
sles_9_admin_guide/sles_9_admin_guide.pdf).

Backing Up Files and System Areas

In the YaST Control Center, click System > System Backup.

The YaST backup module lets you create a backup of your system. The backup created by the 
module does not comprise the entire system, but only saves information about changed packages 
and copies of critical storage areas and configuration files.

Define the kind of data to save in the backup. By default, the backup includes information about any 
packages changed since the last installation. In addition, it can include data that does not belong to 
packages themselves, such as many of the configuration files in /etc or the directories under 
/home. Apart from that, the backup can include important storage areas on your hard disk that 
might be crucial when trying to restore a system, such as the partition table or the master boot record 
(MBR).

A.2.4  Network Devices
Use the Network Devices option to perform the following tasks:

“Configuring a DSL Connection” on page 153
“Configuring an ISDN Card” on page 155
“Configuring Network Cards” on page 158
“Setting Up an ISDN Fax Device” on page 159
“Configuring a Modem” on page 160
“Setting Up a Phone Answering Machine” on page 161

Configuring a DSL Connection

In the YaST Control Center, click Network Devices > DSL.
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This module consists of several dialogs where you can set the parameters of DSL links based on one 
of the following protocols:

PPP over Ethernet (PPPoE)
PPP over ATM (PPPoATM)
CAPI for ADSL (Fritz Cards)
Point-to-Point Tunneling Protocol (PPTP) - Austria

The configuration of a DSL connection based on PPPoE or PPTP requires the corresponding 
network card to have already been set up in the correct way. If you have not done this, first configure 
the card by clicking Network Devices > Network Card in the YaST Control Center (see 
“Configuring Network Cards” on page 158 for more information). In the case of a DSL link, 
addresses can be assigned automatically but not via DHCP, which is why you should not enable the 
Automatic Address Setup (via DHCP) option. Instead, type a static dummy address for the interface, 
such as 192.168.22.1. In Subnet Mask, specify 255.255.255.0. If you are configuring a 
standalone workstation, leave the Default Gateway field empty.

NOTE: Values in the IP Address and Subnet Mask fields are only placeholders. They are needed 
only to initialize the network card and do not represent the DSL link as such.

Figure A-14   DSL Configuration

To begin the DSL configuration, select the PPP mode and the Ethernet card that the DSL modem is 
connected to (in most cases, this is eth0). Then use Device Activation to specify whether the DSL 
link should be established during the boot process. The dialog also lets you select your country and 
choose from a number of ISPs operating in it. The details of any subsequent dialogs of the DSL 
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configuration depend on the options set so far. For details on the available options, read the detailed 
help available in the dialogs boxes.

To use Dial on Demand on a standalone workstation, specify the name server (DNS server). Most 
ISPs support dynamic DNS. The IP address of a name server is sent by the ISP each time you 
connect. For a single workstation, however, provide a placeholder address such as 192.168.22.99. If 
your ISP does not support dynamic DNS, specify the name server IP address provided by your ISP.

The Idle Time-out (seconds) option defines a period of network inactivity after which the 
connection is automatically terminated. A reasonable timeout value is between 60 and 300 seconds.

If you enable Dial on Demand in addition to the option mentioned above, the connection will not be 
completely terminated after the timeout. Instead, the connection remains in a standby mode and is 
re-established automatically as soon as a program requests some kind of data traffic. If Dial on 
Demand is disabled, the connection is completely terminated and must by re-established manually 
when needed. It might then be useful to set the timeout to zero to prevent automatic hang-up.

The configuration of T-DSL is very similar to the DSL setup. Simply select TOnline as your 
provider and YaST will open the T-DSL configuration dialog. Here you can provide some additional 
information required for T-DSL, such as the line ID, the T-Online number, the user code, and your 
password. All of these should be included in the information you received after subscribing to T-
DSL.

Configuring an ISDN Card

In the YaST Control Center, click Network Devices > ISDN.

Use this module to configure one or more ISDN cards for your system. If YaST did not autodetect 
your ISDN card, manually select it. Multiple interfaces are possible, but several ISPs can be 
configured for one interface. In the subsequent dialogs, set the ISDN options necessary for the 
proper functioning of the card.
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In the next dialog, shown below, select the protocol to use. 

Figure A-15   ISDN Configuration

The default is Euro-ISDN (EDSS1), but for older or larger exchanges, select 1TR6. If you are in the 
US, select NI1. Select your country in the relevant field. The corresponding country code then 
appears in the field next to it. Finally, provide your area code and the dial prefix (if necessary).

Start Mode defines how the ISDN interface should be started. OnBoot causes the ISDN driver to be 
initialized each time during the boot process. Manual requires you to load the ISDN driver as root 
with the rcisdn start command. Hot Plug, used for PCMCIA or USB devices, loads the driver after 
the device is plugged in. When you are finished with all these settings, click OK.

In the next dialog, specify the interface type for your ISDN card and add ISPs to an existing 
interface. Interfaces can be either the SyncPPP or the RawIP type, but most ISP operate in the 
SyncPPP mode, which is described below.

The number to specify for My Phone Number varies depending on your particular setup, as 
described in the following sections.

ISDN Card Directly Connected to Phone Outlet

A standard ISDN line provides three phone numbers (called multiple subscriber numbers, or 
MSNs). If the subscriber asked for more, there can be up to 10. One of these MSNs must be 
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specified here, but without your area code. If you specify the wrong number, your phone operator 
automatically falls back to the first MSN assigned to your ISDN line.

Figure A-16   ISDN Interface Configuration

ISDN Card Connected to a Phone Exchange

The configuration can vary depending on the equipment installed:

Smaller phone exchanges built for home purposes mostly use the Euro-ISDN (EDSS1) 
protocol for internal calls. These exchanges have an internal S0 bus and use internal numbers 
for the equipment connected to them.

Use one of the internal numbers as your MSN. You should be able to use at least one of the 
exchange’s MSNs that have been enabled for direct outward dialing. If this does not work, try a 
single 0. For further information, see the documentation that came with your phone exchange.
Larger phone exchanges designed for businesses normally use the 1TR6 protocol for internal 
calls. Their MSN is called EAZ and usually corresponds to the direct-dial number. For the 
configuration under Linux, use the last digit of the EAZ. As a last resort, try each of the digits 
from 1 through 9.

For the connection to be terminated just before the next charge unit is due, enable ChargeHUP. 
However, this might not work with every ISP. You can also enable channel bundling (multilink 
PPP) by selecting the corresponding check box. Finally, you can enable SuSEfirewall2 for your link 
by clicking Activate Firewall.

Details opens a dialog where you can implement more complex connection schemes and then click 
Next.
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In the next dialog, specify IP address settings. If you have not been given a static IP by your 
provider, click Dynamic IP Address. Otherwise, use the fields provided to specify your host’s local 
IP address and the remote IP address according to the specifications of your ISP. If the interface 
should be the default route to the Internet, click Default Route. Each host can have only one 
interface configured as the default route.

The next dialog let you set your country and select an ISP. The IPSs included in the list are call-by-
call providers only. If your ISP is not in the list, click New. This opens the Provider Parameters 
dialog where you can specify all the details for your ISP. When typing the phone number, make sure 
you do not include any blanks or commas among the digits. Finally, type your login name and the 
password as provided by the ISP.

To use Dial on Demand on a standalone workstation, also specify the name server (DNS server). 
Most ISPs support dynamic DNS, which means the IP address of a name server is sent by the ISP 
each time you connect. For a single workstation, however, you still need to provide a placeholder 
address such as 192.168.22.99. If your ISP does not support dynamic DNS, specify the name 
server IP addresses of the ISP. If you want, specify a timeout for the connection, or the period of 
network inactivity (in seconds) after which the connection should be automatically terminated.

Configuring Network Cards

In the YaST Control Center, click Network Devices > Network Card.

After starting the module, YaST displays a general network configuration dialog. The upper part 
shows a list with all the network cards yet to be configured. Any card properly autodetected during 
the boot procedure is listed with its name. Devices that could not be detected are listed as Other (not 
detected). The lower part displays a list of the devices configured so far, with their network types 
and addresses. You can now configure a new network card or change an existing configuration.

Manually Configuring a Network Card

The configuration of a network card that was not autodetected includes the following items:

Device Type 
Specify the type of network device and the device number.

Wireless Settings 
If you are within reach of a wireless network and your network card is designed for this 
connection type, use Wireless Settings to set the operating mode, the network name (ESSID), 
the network identifier (NWID), the encryption key, and a nickname.

Kernel Module and Selection of Network Card 
If your network card is a PCMCIA or USB device, select the corresponding check boxes and 
click Next. Otherwise, click Select from List and then specify your network card. YaST 
automatically loads the appropriate driver for the selected card.

Setting the Network Address

This lets you specify how the address should be assigned to your network card:

Automatic Address Setup (via DHCP) 
If your network includes a DHCP server, you can rely on it to set up your network address 
automatically. The option should also be used if you are using a DSL line but with no static IP 
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assigned by the ISP. If you decide to use DHCP, configure the details after clicking DHCP 
Client Options. Specify whether the DHCP server should always honor broadcast requests and 
any identifier to use. By default, DHCP servers use the card’s hardware address to identify an 
interface. If you have a virtual host setup where different hosts communicate through the same 
interface, an identifier is necessary to distinguish them.

Static Address Setup 
If your have a static address, select the corresponding check box and then specify the address 
and subnet mask for your network. The preset subnet mask should match the requirements of a 
typical home network.

Cable Modem

In some countries (such as Austria and the US), it is quite common to access the Internet through the 
TV cable network. The TV cable subscriber usually gets a modem that is connected to the TV cable 
outlet on one side and to a computer network card on the other (using a 10Base-TG twisted pair 
cable). The cable modem then provides a dedicated Internet connection with a fixed IP address.

Depending on the instructions provided by your ISP, when configuring the network card, either 
click Automatic Address Setup (via DHCP) or Static Address Setup. Most providers today use 
DHCP. A static IP address often comes as part of a special business account.

Setting Up an ISDN Fax Device

This option sets up the fax system for one or more users. Each user must have at least one unique fax 
number configured.

1 In the YaST Control Center, click Network Devices > Fax.
2 (For users behind a PBX) In the Prefix field, type the prefix number for getting a public line.

This number will be dialed before any destination number.
3 Click Add or Edit to add or edit a user.

When adding or editing a user, a dialog appears with the following options:

4 Click OK > Finish.

Option Description

User The system user that this fax account belongs to.

Fax Numbers The numbers (separated by commas) where faxes should be received 
for this user. If you type an asterisk (*), the user gets any call. Leave this 
empty for a send-only account.

Outgoing MSN The number to use for outgoing calls. If empty, the first number in Fax 
Numbers is used.

StationID The fax station ID. Set it to the external number in international format, 
such as +49 89 12345.

Headline The headline used for sending faxes (normally a string containing a 
name).

Action By using the default MailAndSave, received faxes are sent to the user as 
mail and saved to disk. To disable the mails, set this option to SaveOnly.
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Configuring a Modem

In the YaST Control Center, click Network Devices > Modem.

If your modem was not automatically detected, click Configure to open the dialog for manual 
configuration. Under Modem Device, specify the interface that the modem is connected to.

Figure A-17   Modem Configuration

If you are behind a private branch exchange (PBX), you might need to specify a dial prefix. This is 
often a 0. Consult the instructions that came with the PBX to find out. Also select whether to use 
tone or pulse dialing, whether the speaker should be on, and whether the modem should wait until it 
detects a dial tone. The latter option should not be enabled if the modem is connected to an 
exchange.

Under Details, set the baud rate and the modem initialization strings. Change these settings only if 
your modem was not autodetected or if it requires special settings for data transmission to work. 
This is mainly the case with ISDN terminal adapters.

In the next dialog, select the ISP (Internet service provider). To select from a predefined list of ISPs 
operating in your country, click Countries; or click New to open a dialog where you can provide the 
data for your own ISP. This includes a name for the dial-up connection and for the ISP and also the 
login and the password as provided by your ISP. Enable Always Ask for Password if you want to be 
prompted for the password each time you connect.

The final dialog allows specification of the following additional connection options:
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Table A-4   Modem Connection Options

Click Next to return to the original dialog, which displays a summary of the modem configuration. 
Then click Finish.

Setting Up a Phone Answering Machine

This option sets up an answering machine for one or more users. Each user must have at least one 
unique phone number configured. 

1 In the YaST Control Center, click Network Devices > Phone Answering Machine.
2 Click Add or Edit to add or edit a user.

When adding or editing a user, a dialog appears with the following options:

Option Description

Dial on Demand If you enable this, specify at least one name server.

Modify DNS When Connected Enabled by default, which means that the name server address is 
updated each time you connect to the Internet. However, if you 
enable Dial on Demand, disable this option and provide a fixed 
name server address.

Stupid Mode Ignores input prompts sent by the ISP’s server to prevent it from 
interfering with the connection process. This option is enabled by 
default. 

Activate Firewall Enables the firewall, which protects you from outside attacks 
during the time of your Internet connection.

Idle Time-out (seconds) Specifies a period of network inactivity after which the modem 
disconnects automatically.

IP Details Opens the Address Configuration dialog. If your ISP does not 
assign a dynamic IP address to your host, disable Dynamic IP 
Address and then specify your host’s local IP address and the 
remote IP address (ask your ISP for this information). Leave 
Default Route enabled, then click OK.

Option Description

User The system user who wants to receive calls with the answering 
machine.

Phone Numbers One or more phone numbers (separated by commas) that belong 
(only) to this user. You can also type an asterisk (*), which means 
that the user will get any call.

Delay Delay (in seconds) before the answering machine responds to the 
call.

Duration Maximum record length for one call.

Action By using the default MailAndSave, recorded calls are sent to the 
user as mail and saved to disk. To disable the mails, set this option 
to SaveOnly. None forbids recording (the answering machine only 
plays the announcement).
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3 Click OK > Finish.

A.2.5  Network Services
Use the Network Services option to perform the following tasks:

“Configuring Your Computers's Hostname and Domain Name” on page 162
“Configuring a Kerberos Client” on page 162
“Configuring Mail Settings” on page 163
“Configuring a NIS Client” on page 164
“Configuring Network Services (inetd)” on page 165
“Setting Up Remote Administration” on page 166
“SLP Browser” on page 167
“Host Names” on page 168
“Configuring a Machine As an LDAP Client” on page 168
“Configuring an NFS Client” on page 168
“Configuring the NTP Client” on page 169
“Configuring Your Internet Proxy (Caching) Settings” on page 170
“Configuring Routing” on page 170
“Configuring a TFTP Server” on page 171

Configuring Your Computers's Hostname and Domain Name

In the YaST Control Center, click Network Services > DNS and Host Name.

Use this module to configure your computer's hostname and domain name if these settings were not 
already been made while configuring the network devices.

Insert the hostname and domain name for your computer. Name Server List and Domain Search List 
are optional. A name server is a computer that translates hostnames into IP addresses. This value 
must be specified as an IP address (for example,10.10.0.1), not as a hostname.

Search domain is the domain name where hostname searching starts. The primary search domain is 
usually the same as the domain name of your computer (for example, novell.com). There might 
be additional search domains (for example, novell.de).

If you are using DHCP to get an IP address, specify whether to get a hostname via DHCP or to set 
name servers and searched domains via DHCP.

If you plan to use a dial-up Internet connection and have set up your connection to use dynamic 
DNS assignment, these values are temporarily disabled during the connection.

Configuring a Kerberos Client

In the YaST Control Center, click Network Services > Kerberos Client.

Pin Identification code for the remote inquiry function.

Option Description
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Kerberos provides an authentication method that a user must register with once and is then trusted in 
the complete network for the rest of the session.

To configure a Kerberos client, you need the pam_krb5 and heimdal-lib packages, available from 
the Novell Linux Desktop CD 1.

When the Kerberos Client Configuration dialog opens, click Use Kerberos. To set up a DNS-based 
client, it is sufficient to confirm the Basic Kerberos Settings as displayed. If your domain does not 
support this kind of configuration, provide the correct values for the Default Domain, the Default 
Realm, and the KDC Server Address. Clicking Advanced Settings opens another YaST dialog where 
you can modify options related to tickets, OpenSSH support, and time synchronization.

The dialog opened with Advanced Settings includes all the settings related to ticket attributes. To 
forward your complete identity to use your tickets on other hosts, click Tickets Are Forwardable. To 
enable the transfer of certain tickets only, click Tickets Are Proxiable. Tickets can be kept available 
by a PAM module even after a session has ended by enabling Retain Tickets. The Default Ticket 
Lifetime can be specified in days, hours, or minutes (using the units of measurement d, h, and m, 
with no space between the value and the unit). To enable Kerberos authentication support for your 
OpenSSH client, select the corresponding check box. The client then uses Kerberos tickets to 
authenticate with the SSH server. You exclude a range of user accounts from using Kerberos 
authentication by providing a value for the Minimum UID that a user of this feature must have. For 
instance, you might want to exclude the system administrator (root). Lastly, use Clock Skew to set a 
value for the allowable difference between the time stamps and your host’s system time. 

To keep the system time in sync with an NTP server, you can also set up the host as an NTP client 
by selecting NTP Configuration. After finishing the configuration, YaST performs all the necessary 
changes and the Kerberos client is ready for use.

For more information, see “Chapter 25: Network Authentication - Kerberos” and “Chapter 26: 
Installing and Administering Kerberos” in the SUSE LINUX Enterprise Server 9 Administration 
Guide (http://www.novell.com/documentation/sles9/pdfdoc/sles_9_admin_guide/
sles_9_admin_guide.pdf).

Configuring Mail Settings

In the YaST Control Center, click Network Services > Mail Transfer Agent.

This module lets you configure your mail settings if you send your e-mail with sendmail, postfix, or 
the SMTP server of your provider. You can retrieve mail via the fetchmail program, for which you 
can also specify the details of the POP3 server or IMAP server of your provider.

You can also use a mail program of your choice, such as KMail or Evolution, to set your POP and 
SMTP access data as usual (to receive mail with POP3 and send mail with SMTP). In this case, you 
do not need this module.

Connection Type

To configure your mail with YaST, specify the desired type of connection to the Internet from the 
following options in the first dialog of the e-mail configuration module:

Permanent 
Select this option if you have a dedicated line to the Internet. Your machine is online 
permanently, so no dial-up is required. If your system is part of a local network with a central e-
mail server, select this option to ensure permanent access to your e-mail messages.
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Dial-up 
This item is relevant for users who have a computer at home, are not located in a network, and 
occasionally connect to the Internet.

No connection 
If you do not have access to the Internet and are not located in a network, you cannot send or 
receive e-mail.

You can activate virus scanning for your incoming and outgoing e-mail with AMaViS by selecting 
the respective check box. The package is installed automatically as soon as you activate the mail 
filtering feature. In the following dialogs, specify the outgoing mail server (usually the SMTP server 
of your provider) and the parameters for incoming mail. If you use a dial-up connection, specify 
diverse POP or IMAP servers for mail reception by various users. You can also assign aliases, use 
masquerading, or set up virtual domains.

Configuring a NIS Client

In the YaST Control Center, click Network Services > NIS Client.

This module lets you configure the Network Information Service (NIS) client. When multiple Linux 
systems in a network want to access common resources, it becomes important that all user and group 
identities are the same for all machines in that network. The network should be transparent to users 
so that whatever machine users use, they always finds themselves in exactly the same environment. 
This is made possible by means of NIS and NFS services.

NIS can be described as a database-like service that provides access to the contents of /etc/
passwd, /etc/shadow, and /etc/group across networks. NIS can also be used for other 
purposes, such as to make available the contents of files like /etc/hosts or /etc/services.
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After choosing to use NIS and, depending on the circumstances, the following dialog opens:

Figure A-18   Configuration of NIS Client

Select whether the host has a fixed IP address or receives one issued by DHCP. DHCP also provides 
the NIS domain and the NIS server. If a static IP address is used, specify the NIS domain (for 
example, foo.com) and the NIS server's address (for example, nis.foo.com or 10.20.1.1). 
Specify multiple servers by separating their addresses with spaces. The Broadcast option enables 
searching in the local network to find a server after the specified servers fail to respond. It is a 
security risk. Find makes YaST search for an active NIS server in your network.

If you are using DHCP and the server provides the NIS domain name or servers, you can enable 
their use here. DHCP itself can be set up in the network module. Automounter is a daemon that 
mounts directories (such as users’ home directories) automatically. It is assumed that its 
configuration files (auto.*) already exist, either locally or over NIS.

In addition, you can specify multiple domains with one default domain. Use Add to specify multiple 
servers including the broadcast function for the individual domains.

In the expert settings, click Answer to the Local Host Only if you do not want other hosts to be able 
to query which server your client is using. By clicking Broken Server, the client is enabled to receive 
replies from a server communicating through an unprivileged port. For more information, see man 
ypbind.

Configuring Network Services (inetd)

In the YaST Control Center, click Network Services > Network Services (inetd).
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This module lets you determine which network services (such as telnet, finger, talk, or ftp) should 
start when Novell Linux Desktop boots. These services enable external hosts to connect to your 
computer. You can also configure various parameters for each service. By default, the master 
service that manages the individual services (inetd or xinetd) is not started. When this module starts, 
choose which of the two services to configure. The selected daemon can be started with a standard 
selection of network services.You can add, delete, or edit services to compose your own selection of 
services.

Figure A-19   Network Services Configuration

Network Services Configuration

Click Enable to enable network services managed by a super-server (inetd or xinetd—it depends on 
what you have installed) configuration. To stop the super-server, click Disable.

Service Status

All services marked with X in the Ch column were edited and will be changed in the system 
configuration. All services marked with a dash (—) are inactive (locked). All services marked with 
On are active (unlocked). All services marked with NI are not installed and cannot be configured.

To change the service status, select the service you want to enable or disable and then click Toggle 
Status (On or Off).

Setting Up Remote Administration

In the YaST Control Center, click Network Services > Remote Administration.
 Desktop 9 Deployment Guide



novdocx (E
N

U
)  10 A

ugust 2006
If this is enabled (Allow Remote Administration has been selected), you will be able to administer 
this machine remotely from another machine. You can use a VNC client, such as krdc (connect to 
hostname:5901), or a Java-capable Web browser (connect to http://hostname:5801/). 
This form of remote administration is less secure than using SSH (Secure Shell Server), which is 
enabled by default.

SLP Browser

The Service Location Protocol (SLP) is used to make the availability of a certain service known to 
all clients in the local network. Applications that support SLP can use the distributed information 
and can be configured automatically. Services that offer SLP support include cupsd, rsyncd, ypserv, 
openldap2, openwbem (CIM), ksysguardd, saned, kdm vnc login, smpppd, rpasswd, postfix, and 
sshd (via fish.). You can use SLP to provide networked clients with central functions, such as 
installation server, file server, or print server NLD Server.

The SLP Browser lists all services in the local network announced via SLP in a tree diagram.

Figure A-20   SLP Browser

To open the SLP Browser, click Network Services > SLP Browser in the YaST Control Center.

For more information, see “Section 21.6: SLP Services in the Network” in the SUSE LINUX 
Enterprise Server 9 Administration Guide (http://www.novell.com/documentation/sles9/pdfdoc/
sles_9_admin_guide/sles_9_admin_guide.pdf).
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Host Names

Use this option to set up hosts.

1 In the YaST Control Center, click Network Services > Host Names.
2 Click Add or Edit to add or edit a hostname.
3 Type a host IP address, a hostname, and optional host aliases, separated by spaces.
4 Click OK > Finish

Configuring a Machine As an LDAP Client

Use this option to set up a machine as an LDAP client. To configure and access LDAP services, the 
pam_ldap and nss_ldap packages must be installed. These packages are available on the Novell 
Linux Desktop CD 1.

1 In the YaST Control Center, click Network Services > LDAP Client.
2 To authenticate your users with an OpenLDAP server, select Use LDAP.

NSS and PAM are then configured accordingly.
3 To deactivate LDAP services, select Do Not Use LDAP.

If you deactivate LDAP, the current LDAP entry for passwd in /etc/nsswitch.conf is removed. 
The PAM configuration is modified and the LDAP entry is removed.

4 Type the Distinguished Name of the search base (“base DN”, such as 
dc=example,dc=com) and the LDAP server’s address (for example, 
ldap.example.com or 10.20.0.2).
Specify multiple servers by separating their addresses with spaces. It must be possible to 
resolve the addresses without using LDAP. You can also specify the port where the server is 
running using the syntax server:port (for example, ldap.example.com:379).

5 (Conditional) If your LDAP server supports StartTLS (http://www.faqs.org/rfcs/rfc2830.html) 
and it is configured, click LDAP TLS/SSL to encrypt your communication with the LDAP 
server.

6 (Conditional) If you have an LDAP server using protocol 2 (for example, OpenLDAP v1), 
click LDAP Version 2.

7 (Optional) To configure advanced LDAP settings, click Advanced Configuration.

Automounter is a daemon that automatically mounts directories, such as users’ home directories. It 
is assumed that its configuration files (auto.*) already exist, either locally or over LDAP. If 
Automounter is not installed and you want to use it, it will be installed automatically.

For more information, see “Section 21.8: LDAP — A Directory Service” in the SUSE LINUX 
Enterprise Server 9 Administration Guide (http://www.novell.com/documentation/sles9/pdfdoc/
sles_9_admin_guide/sles_9_admin_guide.pdf).

Configuring an NFS Client

The Network File System (NFS) let you operate a file server that can be accessed by members of 
your network. On this file server, you can make programs, files, or storage space available for users. 
It does not matter which terminal users are logged in at, because they will always find themselves in 
the same environment.
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NFS is an asymmetric service, meaning that there are NFS servers and NFS clients. A machine can 
be both; it can supply file systems over the network (export) and mount file systems from other hosts 
(import). Generally, these are servers with a very large hard disk capacity, whose file systems are 
mounted by other clients.

Any user authorized to do so can mount NFS directories from an NFS server into their own file tree. 
This is accomplished using the NFS Client module to enter the hostname of the NFS server, the 
directory to import, and the mount point to mount this directory at locally.

1 In the YaST Control Center, click Network Services > NFS Client.

A table appears containing all NFS entries which will be written to /etc/fstab.
2 Click Add or Edit to enter or edit the hostname of the NFS server, the directory to import, and 

the mount point to mount this directory to locally.

Figure A-21   Importing a File System

3 Click OK > Finish.

For more information on fstab, type man fstab in a terminal window. For more information on 
NFS, see “Section 21.10: NFS — Shared File Systems” in the SUSE LINUX Enterprise Server 9 
Administration Guide (http://www.novell.com/documentation/sles9/pdfdoc/sles_9_admin_guide/
sles_9_admin_guide.pdf).

Configuring the NTP Client

NTP (Network Time Protocol) is a protocol for synchronizing the clocks of network hosts.

1 In the YaST Control Center, click Network Services > NTP Client.
2 To start the NTP daemon when the system is booted, click When Booting System.

The NTP daemon resolves hostnames when initializing. Your network connection must be 
started before the NTP daemon starts.

3 To select the address of the NTP server, click the NTP Server drop-down list.
To find an NTP server, ask your Internet provider or see Public NTP Time Servers (http://
www.eecis.udel.edu/~mills/ntp/servers.html).

4 To find NTP servers in the local network using the Service Location Protocol (SLP), click 
Lookup.

5 To configure this host to synchronize against multiple remote hosts or against a locally 
connected clock, click Complex Configuration.

6 Click Finish.
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For more information, see “Section 21.12: Time Synchronization with xntp” in the SUSE LINUX 
Enterprise Server 9 Administration Guide (http://www.novell.com/documentation/sles9/pdfdoc/
sles_9_admin_guide/sles_9_admin_guide.pdf).

Configuring Your Internet Proxy (Caching) Settings

Use this option to configure your Internet proxy (caching) settings.

1 In the YaST Control Center, click Network Services > Proxy.
2 Click Enable Proxy, then complete the following:

3 (Conditional) If you are using a proxy server with authorization, fill in the Proxy User Name 
and Proxy Password fields.

4 Click Finish.

Configuring Routing

In the YaST Control Center, click Network Services > Routing.

Use this option to set up routing. The Default Gateway matches every possible destination, but 
poorly. If any other entry exists that matches the required address, it is used instead of the default 
route. The idea of the default route is simply to let you say “and everything else should go here.”

Enable IP Forwarding if the system is a router.

The routing table is set up in Novell Linux Desktop via the /etc/sysconfig/network/
routes and /etc/sysconfig/network/ifroute-* configuration files. All the static 
routes required by the various system tasks (routes to a host, routes to a host via a gateway, and 
routes to a network) can be entered in the /etc/sysconfig/network/routes file. For each 
interface that needs individual routing, define an additional configuration file: /etc/
sysconfig/network/ifroute-*. Replace * with the name of the interface. The entries in 
the routing configuration files look like this:
DESTINATION GATEWAY NETMASK    INTERFACE [ TYPE ] [ OPTIONS ]
DESTINATION GATEWAY PREFIXLEN  INTERFACE [ TYPE ] [ OPTIONS ]
DESTINATION/PREFIXLEN GATEWAY -          INTERFACE [ TYPE ] [ OPTIONS ]

To omit GATEWAY, NETMASK, PREFIXLEN, or INTERFACE, write - instead. The entries TYPE 
and OPTIONS can be omitted.

The route’s destination is in the first column. This column might contain the IP address of a network 
or host or, in the case of reachable name servers, the fully qualified network or hostname.

Option Description

HTTP Proxy URL The name of the proxy server for your access to the World Wide 
Web (WWW). For example, http://proxy.provider.com:3128/.

FTP Proxy URL The name of the proxy server for your access to the file transfer 
services (FTP).

No Proxy Domains A list of domains that the requests should be done for directly 
without caching.
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The second column contains the default gateway or a gateway that a host or a network can be 
accessed through.

The third column contains the netmask for networks or hosts behind a gateway. The mask is 
255.255.255.255, for example, for a host behind a gateway.

The last column is relevant only for networks connected to the local host, such as loopback, 
Ethernet, ISDN, PPP, and dummy device. The device name must be specified here.

The following scripts in the /etc/sysconfig/network/scripts/ directory assist with the 
handling of routes:

Table A-5   Route Handing Scripts

Configuring a TFTP Server

Use this option to configure a server for TFTP (Trivial File Transfer Protocol). It is started using 
xinetd. To configure the TFTP server, the xinetd and tfpt packages must be installed. These 
packages are available on the Novell Linux Desktop CD 2.

1 In the YaST Control Center, click Network Services > TFTP Server.
2 Click Enable, then specify the directory where served files are located.

The usual value is /tftpboot. It is created if it does not already exist. The server uses it as its 
root directory (using the -s option).

3 Click Finish.

A.2.6  Security and Users
A basic aspect of Linux is its multiuser capability. Consequently, several users can work 
independently on the same Linux system. Each user has a user account identified by a login name 
and a personal password for logging in to the system. All users have their own home directories 
where personal files and configurations are stored.

Use the Security and Users option to perform the following tasks:

“Creating and Editing Users” on page 172
“Creating and Editing Groups” on page 173
“Configuring Local Security Settings” on page 173
“Setting Up a Firewall” on page 175

Script Description

ifup-route Sets up a route.

ifdown-route Disables a route.

ifstatus-route Checks the status of the routes.
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Creating and Editing Users

In the YaST Control Center, click Security and Users > Edit and Create Users.

Figure A-22   User Administration Dialog

YaST provides an overview of all local users in the system. If you are part of an extensive network, 
click Set Filter to list all system users (for example, root) or NIS users. You can also create user-
defined filter settings. Instead of switching between individual user groups, combine them according 
to your needs. To add new users, fill in the required blanks in the screen that follows. Subsequently, 
the new user can log in to the host with the login name and password. The user profile can be fine-
tuned with Details. You can manually set the user ID, the home directory, and the default login shell. 
And you can assign the new user to specific groups.

Configure the validity of the password in Password Settings. Click Edit to change these settings 
whenever necessary. To delete a user, select the user from the list and click Delete. For advanced 
network administration, use Expert Options to define the default settings for the creation of new 
users. Select the authentication method (NIS, LDAP, Kerberos, or Samba) and the algorithm for the 
password encryption. These settings are relevant for large (corporate) networks.
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Creating and Editing Groups

In the YaST Control Center, click Security and Users > Edit and Create Groups.

Figure A-23   Group Administration Dialog

You can start the Group Administration dialog from the YaST Control Center or by clicking Groups 
in the User Administration dialog. Both dialogs have the same functionality, allowing you to create, 
edit, or delete groups.

YaST provides a list of all groups. To delete a group, select it from the list (the line is highlighted 
dark blue) and click Delete. Under Add and Edit, specify the name, group ID (gid), and members of 
the group in the respective YaST screen. If you want, you can set a password for the change to this 
group. The filter settings are the same as in the User Administration dialog.

Configuring Local Security Settings

1 In the YaST Control Center, click Security and Users > Security Settings.
2 In the Local Security Configuration dialog, select one of the following options:

Level 1 (Home Workstation) is for standalone computers (preconfigured).
Level 2 (Networked Workstations) is for workstations with a network (preconfigured).
Level 3 (Network Server) is for a server with a network (preconfigured).
Custom Settings is for your own configuration.
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3 If you selected Level 1-3, incorporate one of the levels of preconfigured system security 
options by clicking Finish, or click Details to access the individual settings that can be 
modified.
or
If you selected Custom Settings, click Next to proceed to the following dialogs, in the order 
listed:

Password Settings 
For new passwords to be checked by the system before they are accepted, click Checking 
New Passwords and Plausibility Test for Password. Set the minimum and maximum 
length of passwords for newly created users. Define the period for which the password 
should be valid and how many days in advance an expiration alert should be issued when 
the user logs in to the text console.

Boot Settings 
Specify how the Ctrl+Alt+Del key combination should be interpreted by selecting the 
action from the drop-down list. Usually this key combination causes the system to reboot. 
Do not modify this setting unless your machine or server is publicly accessible and you 
are afraid someone could carry out this action without authorization. If you select Stop, 
this key combination causes the system to shut down. Ignore causes this key combination 
to be ignored. Specify the Shutdown Behavior of KDM by granting permission to shut 
down the system from the KDE Display Manager, the graphical login of KDE. Give 
permission to Only Root (the system administrator), All Users, Nobody, or Local Users. If 
Nobody is selected, the system can be shut down only via the text console.

Login Settings 
Typically, following a failed login attempt, there is a waiting period lasting a few seconds 
before another login is possible. This makes it more difficult for password sniffers to log 
in. You can also activate Record Failed Login Attempts and Record Successful Login 
Attempts. If you suspect someone is trying to discover your password, check the entries in 
the system log files in /var/log. With Allow Remote Graphical Login, other users are 
granted access to your graphical login screen via the network. However, this access 
possibility represents a potential security risk, so it is inactive by default.

Adding Users 
Every user has a numerical and an alphabetical user ID. The correlation between these is 
established via the /etc/passwd file and should be as unique as possible.Using the data 
in this screen, define the range of numbers assigned to the numerical part of the user ID 
when a new user is added. A minimum of 500 is suitable for users. Proceed in the same 
way with the group ID settings.

Miscellaneous Settings 
For Setting of File Permissions, there are three options: Easy, Secure, and Paranoid. The 
first one should be sufficient for most users. The YaST help text provides information 
about the three security levels.The Paranoid setting is extremely restrictive and can serve 
as the basic level of operation for system administrator settings. If you select Paranoid, 
remember that some programs might not work correctly or at all because users no longer 
have the permissions to access certain files. In this dialog, you can also define which user 
should start the updatedb program. This program, which automatically runs on a daily 
basis or after booting, generates a database (locatedb) where the location of each file on 
your computer is stored. If you select Nobody, any user can find only the paths in the 
database that can be seen by any other (unprivileged) user. If root is selected, all local files 
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are indexed, because the user root, as superuser, can access all directories. Finally, make 
sure the Current Directory in Root’s Path option is deactivated (default).

4 Click Finish to complete your security configuration. 

Setting Up a Firewall

In the YaST Control Center, click Security and Users > Firewall.

Use this module to configure SuSEfirewall2 to protect your machine against attacks from the 
Internet. Detailed information about SuSEfirewall2 can be found in “Section 26.3: Masquerading 
and Firewalls” in the SUSE LINUX Enterprise Server 9 Administration Guide (http://
www.novell.com/documentation/sles9/pdfdoc/sles_9_admin_guide/sles_9_admin_guide.pdf).

A.2.7  Misc
Use the Misc option to perform the following tasks:

“Configuring the System for Autoinstallation” on page 175
“Viewing the System Log” on page 175
“Installing a Driver from a Vender-Specific CD” on page 175
“Viewing the Startup Log” on page 175

Configuring the System for Autoinstallation

In the YaST Control Center, click Misc > Autoinstallation.

See Appendix C, “Automatic Linux Installation and Configuration Using AutoYaST,” on page 195 
for more information.

Viewing the System Log

In the YaST Control Center, click Misc > View System Log.

The system log logs the operations of your computer to /var/log/messages. Kernel messages are 
recorded here, sorted according to date and time.

Installing a Driver from a Vender-Specific CD

In the YaST Control Center, click Misc > Load Vender Driver CD.

Use this module to automatically install device drivers from a Linux driver CD that contains drivers 
for Novell Linux Desktop. When installing Novell Linux Desktop from scratch, use this YaST 
module to load the required drivers from the vendor CD after the installation.

Viewing the Startup Log

In the YaST Control Center, click Misc > View Start-up Log.

The boot log contains the screen messages displayed when the computer is started. It is logged to /
var/log/boot.msg. Use this YaST module to view the log to, for example, check if all services and 
functions were started as expected.
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A.3  YaST in Text Mode (ncurses)
YaST can also be controlled by means of a text-based terminal. This is useful in the case of a system 
that cannot run the X Window System, or where X is not needed, such as a dedicated server or 
firewall machine. It is also useful for administrators remotely accessing a system.

The main window consists of three areas. The left frame, which is surrounded by a thick white 
border, features the categories that the various modules belong to. The active category is indicated 
by a colored background. The right frame, which is surrounded by a thin white border, provides an 
overview of the modules available in the active category. The bottom frame contains the Help and 
Exit buttons.

When the YaST Control Center is started, the Software category is selected automatically. Use the 
Up- and Down-arrows to change the category. To start a module from the selected category, press 
the Right-arrow. The module selection now appears with a thick border. Use the Up- and Down-
arrows to select the module you want. Keep the arrow keys pressed to scroll through the list of 
available modules. When a module is selected, the module title appears with a colored background 
and a brief description is displayed in the bottom frame.

Press Enter to start a module. Various buttons or selection fields in the module contain a letter with 
a different color (yellow by default). Use Alt+yellow_letter to select a button directly instead of 
navigating there with the Tab key. Exit the YaST Control Center by pressing the Exit button or by 
selecting Exit in the category overview and then pressing Enter.

A.3.1  Navigation in Modules
The following description of the control elements in the YaST modules assumes that all function 
keys and Alt key combinations work and are not assigned different global functions. See 
“Restriction of Key Combinations” on page 177 for information about possible exceptions.

Navigation among Buttons and Selection Lists

Use Tab and Alt+Tab or Shift+Tab to navigate among the buttons and the frames containing 
selection lists.

Navigation in Selection Lists

Use the Up- and Down-arrow keys to navigate among the individual elements in an active frame 
containing a selection list (for example, among the individual modules of a module group in the 
Control Center).

If individual entries within a frame exceed its width, use Shift+Right-arrow or Shift+Left-arrow to 
scroll horizontally to the right or to the left. You can also use Ctrl+E or Ctrl+A. This combination 
can also be used if using the Right- and Left-arrow keys would result in changing the active frame or 
the current selection list, as in the Control Center.

Buttons, Radio Buttons, and Check Boxes

To select buttons with empty square brackets (check boxes) or empty parentheses (radio buttons), 
press the Space bar or Enter key. Radio buttons and check boxes can be selected directly with 
Alt+yellow_letter. In this case, you do not need to confirm with Enter.
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If you navigate to an item with the Tab key, press Enter to execute the selected action or activate the 
respective menu item.

Function Keys

The function keys (F1 to F12) enable quick access to the various buttons. Which function keys are 
actually mapped to which buttons depends on the active YaST module, because the different 
modules offer different buttons (Details, Info, Add, Delete, etc.). Use F10 for OK, Next, and Finish. 
Press F1 to access the YaST help which shows the functions mapped to the individual F keys.

A.3.2  Restriction of Key Combinations
If your window manager uses global Alt combinations, the Alt combinations in YaST might not 
work. Keys like Alt or Shift can also be occupied by the settings of the terminal.

Replacing Alt with Esc

Alt shortcuts can be executed with Esc instead of Alt. For example, Esc+H can replace Alt+H.

Backward and Forward Navigation with Ctrl+F and Ctrl+B

If the Alt and Shift combinations are occupied by the window manager or the terminal, use the 
combinations Ctrl+F (forward) and Ctrl+B (backward) instead.

Restriction of Function Keys

The F keys are also used for functions. Certain function keys might be occupied by the terminal and 
might not be available for YaST. However, the Alt key combinations and F keys should always be 
fully available on a pure text console.

A.3.3  Starting the Individual Modules
To save time, the individual YaST modules can be started directly. To start a module, enter the 
following:

yast module_name

The network module, for example, is started by entering yast lan. 

A list of all module names available on your system can be viewed with the following commands:

yast -l or yast --list
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BLinux Authentication Using LDAP 
and eDirectory

This appendix provides information on implementing Linux authentication against Novell® 
eDirectoryTM (no local users) based on PAM and LDAP.

B.1  Authentication Scheme
Figure B-1   Authentication Scheme

We recommend the following:

Use LDAP APIs for cross-platform services that require accessing eDirectory objects and 
attribute information.
Use PAM-ldap for native Linux applications for Linux authentication and authorization.
Use DirXML® (del text, JDBC, JMS drivers) when applications are not directory enabled or 
PAM enabled, or cannot be customized.

B.2  Server Configuration
1 Add multicast routing, using the following command:.

route add -net 224.0.0.0 netmask 240.0.0.0 dev eth0

2 Add a fixed IP address and verify the DNS information.
3 Install eDirectory on the server.

See the Novell eDirectory 8.7.3 Installation Guide (http://www.novell.com/documentation/
edir873/index.html) for more information.

eDirectory
LDAP/S Enabled

Linux Client
pam_ldap enabled

User credentials

Credentials validated
User's Unix profile forwarded

Useris accepted for login
User's $HOME is created

Multiuser
login enabled

User credentials

/etc/passwd
only system users
are stored locally

Schema extended
for Unix profile
uid
gid
login shell
...
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4 Update the PATH and MANPATH variables in /etc/profile.

Figure B-2   /etc/profile File

5 Configure eDirectory.

Figure B-3   eDirectory Configuration
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6 Verify the eDirectory and the server status.

Figure B-4   eDirectory and Server Status

7 Install iManager 2.0.x.
For more information, see the Novell iManager 2.0.x Administration Guide (http://
www.novell.com/documentation/imanager20/index.html).

8 Install ConsoleOne® 1.3.6 and snap-ins.
For more information, see the ConsoleOne 1.3.x User Guide (http://www.novell.com/
documentation/consol13/index.html).
You do not have to install a JRE if a previous one exists.

9 Add C1_JRE_HOME=/path/to/jre to the /etc/exports file.
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10 Verify the server status and services.

Figure B-5   Server Status and Services

NOTE: This machine is not running XDM.

B.3  eDirectory Configuration for Linux Client 
Authentication

1 Extend the eDirectory schema using the following command:.

ndssch -h localhost -t treename cn=admin.o=novell \
rfc2307-usergroup.sch

2 Create an eDirectory group and add the posixGroup extension to it.
These groups are used as primary groups for Linux users.

3 Create an eDirectory user and extend it with the posixAccount extension.
4 Populate the user’s primary Group/GID with the posixGroup you created in Step 2 on 

page 182.
5 After the user has been created, add the loginshell attribute.
6 Set loginshell to /bin/bash (or whatever shell you want).
7 Verify LDAP services with an LDAP tool such as directory_administrator, which lets you 

manage LDAP objects with UNIX profiles.
For example, in the following figure, there are three users but only two of them have been 
extended as posixAccount (Amalaguti and Jdoe). When an LDAP search is performed, only 
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these two users will be displayed. You will also see the primary group you created as 
posixGroup.

Figure B-6   directory_administrator LDAP Tool

B.3.1  LDAP Service Configuration
For testing purposes, do not allow clear text connections for a proxy user. Or, for testing purposes, 
configure a proxy user with Read and Compare rights over all attributes.

1 Create a proxy user for LDAP, set a null password for this user, and disable password 
changing.

2 Configure the LDAP Group to use the proxy user.
3 Enable TLS/SSL and validate the certificates, server IP address, and hostname.
4 Verify that ports 389 and 636 are not being blocked by a firewall.
5 Set proxy user tree browsing restrictions and limit proxy user visibility of eDirectory by 

granting specific rights to your tree.
Make the proxy user a trustee of [root] and give the proxy user the Browse entry right and the 
Read and Compare property rights on the following attributes:

CN
Description
O
OU
Object Class
dc
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gecos
gidNumber
homeDirectory
loginShell
memberUid
uidNumber
uniqueID

6 Refresh the LDAP service and do an LDAP trace to verify that it is working fine.
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B.3.2  LDAP Trace
Figure B-7   LDAP Trace Results

B.3.3  Testing the Connection
To test your connection, use the ldapsearch command and verify the results.
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The following figure shows the results of an anonymous LDAP search from a remote client 
searching for cn=amalaguti object, with no TLS/SSL. The following command was used:
linux:/home/amalaguti # ldapsearch -h 192.168.74.128 -x -b o=novell -s 
sub “(cn=amalaguti)”

Figure B-8   ldapsearch Results

B.4  Linux Client Configuration
This sections contains the following information:

“LDAP-based eDirectory Authentication” on page 186
“X Window Authentication” on page 188
“PAM Configuration Examples” on page 189

B.4.1  LDAP-based eDirectory Authentication
LDAP-based eDirectory authentication requires the following files:

/etc/ldap.conf
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Configuration file for the pam_ldap and nss_ldap modules.
/etc/openldap/ldap.conf

Holds configuration and default settings for OpenLDAP utilities. This file is not used for PAM 
configuration.

1 In the YaST Control Center, run the tool for authentication configuration by clicking Network 
Services.> LDAP Client.

2 Modify /etc/ldap.conf to suite your environment requirements.

Figure B-9   /etc/ldap.conf File

3 Modify /etc/nsswitch.conf to suite your authentication order needs.

Figure B-10   /etc/nsswitch.conf File

4 Modify /etc/pam.d/login to suite your needs.

Figure B-11   Sample /etc/pan.d/login File

5 Try LDAP auth first; if it fails, try local auth.
auth sufficient pam_ldap.soauth required pam_unix_auth.so 
try_first_pass

6 Create the home directory $HOME automatically during login if it doesn’t already exist.
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session required pam_mkhomedir.so skel=/etc/skel umask=0022

Figure B-12   Creating &HOME Automatically

B.4.2  X Window Authentication
Modify /etc/pam.d/xdm (KDE) or /etc/pam.d/gdm (GNOME), following the same rules 
as /etc/pam.d/login.

KDE Login Testing

NDS/LDAP username: cn=user1.ou=users.o=novell
NDS/LDAP password: 123
Local user > /etc/passwd: Not Available (authentication forwarded to eDirectory LDAP).
User’s $HOME: Not Available (will be created after login).
Login KDE Prompt
Username: user1
Password: 123

KDE Login Background

1. LDAP query filtering “user1”.
2. User and password validation against eDirectory.
3. KDE Login’s startups scripts begin running.
4. Service pam.d/xdm creates user’s $HOME in local file system based on the user’s UNIX 

profile.
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B.4.3  PAM Configuration Examples
Figure B-13   PAM Configuration Example 1

Figure B-14   PAM Configuration Example 2
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Figure B-15   PAM Configuration Example 3

B.5  Security
This sections contains the following information:

“LDAP Proxy User” on page 190
“Secure LDAP Connections with TLS/SSL” on page 190

B.5.1  LDAP Proxy User
Create an LDAP proxy user and assign corresponding attributes. View the LDAP service 
configuration.

B.5.2  Secure LDAP Connections with TLS/SSL
1 Use the ldapsearch command to perform a TLS-enabled search.
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For example: ldapsearch -h 10.0.0.100 -D cn=admin,o=novell -W -x -b 
-s one -ZZ

Figure B-16   Packet Capture and Trace of a Nonsecure (No TLS/SSL) Connection, Binding User Is 
cn=admin,o=novell with Password novell (No Proxy User)

2 Enable secure LDAP connections (TLS/SSL) on the server side.
For the LDAP Group object, enable the Require TLS for Simple Binds with Password 
option.
For the LDAP Server object, enable the Require TLS for All Operations option.

3 Enable secure LDAP connection on the client side (TLS).
In /etc/ldap.conf, set ssl start_tls.

IMPORTANT: LDAP bind with username and password is not required or recommended. 
Use anonymous bind (don't configure #binddn and #bindpwd).
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Figure B-17   Encrypted Session

Figure B-18   LDAP Trace: TLS Enabled, Logged In As Username “amalaguti,” LDAP Bind As admin.novell (No 
Anonymous Bind)
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Figure B-19    LDAP Trace: TLS Enabled, Logged In As Username “amalaguti,” Anonymous Bind

4 Enable secure LDAP connection on the client side (SSL). 
For PAM LDAP, edit /etc/ldap.conf and set SSL to On and Port to 636.
For OpenLDAP-based tools (such as ldapsearch), edit /etc/openldap/ldap.conf. 
OpenLDAP must be configured to allow self-signed certificates. To prevent certificate errors 
during TLS/SSL handshaking, set TLS_REQCERT to Allow.
Some applications could require importing the Trusted Root Certificate. You can get it from 
ConsoleOne in DER format and execute this command:
#openssl x509 -in trustedroot.der -inform DER -out /etc/ssl/
certs/trustedroot.pem -outform PEM

5 Test the LDAP connection over TLS/SSL, using a command similar to the following:
#ldapsearch -H ldaps://192.168.74.128 -x -b o=novell -s sub -Z

B.6  PAM Module
The pam_mount module allows users to have NCP™ (NetWare®), SMB (Windows/Samba), NFS, 
or loopback-encrypted volumes mounted on login, using the same passwords they typed to log in. A 
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remote volume can even be used as a user’s $HOME directory. Volumes mounted this way are 
automatically unmounted on logout.

Figure B-20   pam_mount Utility

pam_mount has the following two configuration files:

/etc/security/pam_mount.conf

Global configuration file.
$HOME/.pam_mount.conf

Per user configuration file.

B.7  ConsoleOne Snap-ins for UNIX Profile
These snap-ins are not recommended. In some instances, you might be unable to save changes to a 
user’s UNIX Profile.

To install UNIX snap-ins for ConsoleOne:

1 Download the Account Management 2.1 Snap-in for ConsoleOne 1.3.5 from the Novell 
Download (http://download.novell.com) site.

2 Unzip AccountManagementUnix.zip.
3 Copy unixSnapinRes.jar to ../ConsoleOne/resources.
4 Copy unixsnapin.jar to ../ConsoleOne/snapins/unix.
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CAutomatic Linux Installation and 
Configuration Using AutoYaST

AutoYaST is a system for installing one or more Novell® Linux Desktop (NLD) systems 
automatically and without user intervention. AutoYaST installations are performed using a control 
file with installation and configuration data. The control file can be created using the configuration 
interface of AutoYaST and can be provided to YaST2 during installation in different ways.

Regular installation of NLD is semi-automated by default. The user is requested to select the 
necessary information at the beginning of the installation (in most cases, language only), then 
YaST2 generates a proposal for the underlying system depending on different factors and system 
parameters. In most cases, and especially for new systems, such a proposal can be used to install the 
system and provides a usable installation.

The steps following the proposal are fully automated and the user is prompted only at the end of the 
installation to configure hardware and network services.

AutoYaST can be used where no user intervention is required or where customization is required. 
Using a control file, YaST2 prepares the system for a custom installation and avoids any interaction 
with the user unless specified in the file controlling the installation.

AutoYaST is not an automated GUI system. In most cases, many screens are skipped (that is, you 
never see the language selection interface). AutoYaST simply passes the language parameter to the 
subsystem without displaying any language-related interface.

Using AutoYaST, multiple systems sharing the same environment and similar, but not necessarily 
identical, hardware performing similar tasks can easily be installed in parallel and in a short time. A 
configuration file (referred to as a control file) is created using existing configuration resources. The 
control file can be easily tailored for any specific environment.

AutoYaST is fully integrated and provides various options for installing and configuring a system. 
The main advantage over other auto-installation systems is the ability to configure a computer by 
using existing modules and avoiding using custom scripts which are normally executed at the end of 
the installation.This chapter guides you through the three steps of auto-installation:

1. Preparation 

All relevant information about the target system is collected and turned into the appropriate 
directives of the control file. The control file is transferred onto the target system where its 
directives are parsed and transformed to YaST2 conforming data.

2. Installation
Follows the instructions given in the control file and installs the base system.

3. Configuration
YaST, in addition to user-defined post-install scripts, completes the system configuration.
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C.1  The Control File
The control file is a configuration description for a single system. It consists of sets of resources 
with properties including support for complex structures representations such as lists, records, trees, 
and large embedded or referenced objects.

C.1.1  Format
The XML configuration format provides a consistent file structure, which is easier to learn and 
remember when attempting to configure a new system.

Using XML, you can eliminate nearly all of the configuration file parsing and error handling. An 
external XML parser can do that instead, especially if it is a validating parser. To make sure the 
control file is well formatted and that the syntax is valid, you can run the control file through a 
validating parser before it is actually used for automatic installation. This is required if you prefer to 
edit the profile manually.

The following example shows a control file in XML format:
<?xml version=”1.0”?>
<!DOCTYPE profile SYSTEM
 “/usr/share/autoinstall/dtd/profile.dtd”>
 <profile
 xmlns=”http://www.suse.com/1.0/YaSTns”
 xmlns:cfg=”http://www.suse.com/1.0/configns”>
 <install>
  <partitioning config:type=”list”>
    <drive>
      <device>/dev/hda</device>
      <partitions config:type=”list”>
       <partition>
         <filesystem config:type=”symbol”>ext2</filesystem>
         <size>520Mb</size>
         <mount>/</mount>
       </partition>
       <partition>
         <filesystem config:type=”symbol”>reiser</filesystem>
         <size>1200Mb</size>
         <mount>/data</mount>
       </partition>
     </partitions>
    </drive>
  </partitioning>
 </install>
 <configure>
   <scripts>
    <pre-scripts>
     <script>
       <interpreter>shell</interpreter>
       <filename>start.sh</filename>
     <source>
           <![CDATA[
#!/bin/sh
echo “Starting installation”
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exit 0
]]>
      </source>
    </script>
   </pre-scripts>
  </scripts>
 </configure>
</profile>

C.1.2  Structure
The following is an example of a basic control file container, the actual content of which is 
explained later on in this chapter.
<?xml version=”1.0”?>
<!DOCTYPE profile SYSTEM
 “/usr/share/autoinstall/dtd/profile.dtd”>
  <profile
  xmlns=”http://www.suse.com/1.0/YaSTns”
  xmlns:cfg=”http://www.suse.com/1.0/configns”>
<!-- RESOURCES -->
</profile>

The profile element (root node) contains one or more distinct resource elements. The permissible 
resource elements are specified in the DTD. 

The root element in the control file can, for example, contain the following subkeywords:

installation (Tag <install>)
Bootloader configuration: Bootloader device, bootloader location (Tag 
<bootloader>).
Partitioning: Drives and partition plans (Tag <partitioning>).
General: Installation instructions, including all variables related to the client, such as 
display, languages, and keyboard. (Tag <general>).
Software: Software and package selections (Tag <software>).

configuration (Tag <configure>)
Network: Network configuration for the client and servers providing services to the target 
client (Tag <networking>).
Users: User administration, including first user and root (Tag <users>).
User scripts: (Tag <scripts>).

Resources and Properties

A resource element contains multiple and distinct property and resource elements, or it contains 
multiple instances of the same resource element, or it is empty. The permissible content of a 
resource element is specified in the DTD.

A property element is either empty or it contains a literal value. The permissible property elements 
and values in each resource element are specified in the DTD.

An element can be either a container of other elements (a resource) or have a literal value (a 
property); it can never be both. This restriction is specified in the DTD. A configuration component 
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with more than one value must be represented either as some kind of embedded list in a property 
value or as a nested resource.

Nested Resources

Nested resource elements allow a tree-like structure of configuration components to be built to any 
level.
...
<drive>
  <device>/dev/hda</device>
  <partitions config:type=”list”>
    <partition>
      <size>1000mb</size>
      <mount>/</mount>
    </partition>
    <partition>
      <size>250mb</size>
      <mount>/tmp</mount>
    </partition>
  </partitions>
</drive>
....

In the example above, the disk resource consists of a device property and a partitions resource. The 
partitions resource contains multiple instances of the partition resource. Each partition resource 
contains a size and mount property.

Although it is specified in the DTD that the partitions resource contains multiple instances, you must 
still specify this to avoid wrong data typing in YaST2. Using the example above, imagine having a 
drive with only one partition. This would result in interpreting the partition resource as a property. 
To avoid this, the following syntax must be used when defining multiple instances.
...
<drive>
  <device>/dev/hda</device>
  <partitions config:type=”list”>
    <partition>
      <size>1000</size>
      <mount>/</mount>
    </partition>
    <partition>
      <size>250</size>
      <mount>/tmp</mount>
    </partition>
  </partitions>
</drive>
....

For more information about type attributes, see “Attributes” on page 198. 

Attributes

Global profile attributes are used to define metadata on resources and properties. Attributes are used 
to define context switching. They are also used for naming and typing properties. Profile attributes 
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are in a separate namespace so they don’t have to be treated as reserved words in the default 
namespace. New ones can be added without having to potentially alter existing profiles.

Profile attributes are defined in the configuration namespace and must always be prefixed with 
config:. All profile attributes are optional. Most can be used with both resource and property 
elements, but some can be used only with one type of element, which is specified in the DTD.

The type of an element is defined using the config:type attribute. The type of a resource element is 
always RESOURCE, although this can also be made explicit with this attribute (to ensure correct 
identification of an empty element, for example, when there is no DTD to refer to). A resource 
element cannot be any other type, and this restriction is specified in the DTD. The type of a property 
element determines the interpretation of its literal value. The type of a property element defaults to 
STRING, as specified in the DTD. The full set of permissible types is also specified in the DTD.

C.1.3  The XML Document Type Definition (DTD)
The purpose of a DTD is to define the legal building blocks of an XML document. It defines the 
document structure with a list of legal elements. A DTD can be declared inline in the XML 
document, or as an external reference.

XML provides an application-independent way of sharing data. With a DTD, the application can use 
a standard DTD to verify that the data the user supplies is valid. A “Valid” XML document is a 
“Well Formed” XML document which conforms to the rules of a Document Type Definition (DTD).

In AutoYaST, a DTD should be available to allow users to validate the control files before the 
installation process is initiated. The DTD can be also used with XML editors while editing the 
control file to avoid later errors.

Example DTD

A drive resource containing a device property and a partitions property represented as a nested 
resource.
A partitions resource containing multiple instances of the partition property represented as a 
nested resource.
A partition resource containing a size property and a mount property.

Below is the XML for an sample node view profile which includes a DTD that validates it.
<?xml version=”1.0”?>
<!DOCTYPE profile [
<!ELEMENT profile (install)>
<!ELEMENT install (partitioning)>
<!ELEMENT partitioning (drive+)>
<!ELEMENT drive (device,partitions)>
<!ELEMENT device (#PCDATA)>
<!ELEMENT partitions (partition*)>
<!ELEMENT partition (size,mount)>
<!ELEMENT size (#PCDATA)>
<!ELEMENT mount (#PCDATA)>
]>
<profile>
.....
  <install>
   <partitioning config:type=”list”>
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    <drive>
     <device>
       /dev/hda
     </device>
     <partitions>
      <partition>
        <size>1000mb</size>
        <mount>/</mount>
      </partition>
      <partition>
        <size>250mb</size>
        <mount>/tmp</mount>
      </partition>
     </partitions>
    </drive>
   </partitioning>
  </install>
.....
</profile>

C.2  Creating a Control File
In order to create a control file, first you need to collect information about the systems you are going 
to install. Make sure you know the following about the machines you want to install:

Hard disk types and sizes
Graphic interface and attached monitor (if any)
Network interface and MAC address, if known (that is, when using DHCP)

With these parameters, you are ready to create a profile of your systems to control the auto-
installation process.

C.2.1  Using the Configuration Management System
In order to create the control file for one or more computers, a configuration interface based on 
YaST2 is provided. This system depends on existing modules which are normally used to configure 
a computer in regular operation mode (that is, after Novell Linux Desktop is installed).
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The configuration management system lets you create control files easily, and it also lets you 
manage a repository of configurations for use in a networked environment and with multiple clients.

Figure C-1   Configuration Management System

Creating a New Profile

With some exceptions, almost all resources of the control file can be configured using the 
configuration management system. The system offers flexibility, and configuration of some 
resources is identical to that available in the YaST2 Control Center. In addition to the existing and 
familiar modules, new interfaces have been created for special and complex configurations (for 
example, for partitioning, general options, and software).

Furthermore, using the configuration management system guarantees that the resulting control file is 
valid and ensures that it can be used directly to start automated installation.

Make sure the configuration system is installed (package autoyast) and call it either using the YaST2 
Control Center or directly as root with the following command (make sure the DISPLAY variable is 
set correctly to start the graphical user interface instead of the text-based one):

yast2 autoyast

Importing Legacy and Foreign Configuration Files

AutoYaST lets you import ALICE configuration files from previous SUSE® releases and foreign 
auto-installation systems such as Kickstart. See “Legacy and Foreign Configuration Formats” on 
page 248 for more information.
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C.2.2  Manually Creating or Editing a Control File
If you edit the control file manually, make sure it has a valid syntax. To check the syntax, use some 
tools available on the distribution. For example, to verify that the file is well formed, use the xmllint 
utility available with the libxml2 package:
xmllint control_file

If the control file is not well formed (that is, if a tag is not closed), xmllint reports the errors.

Before going on with the auto-installation, please fix any errors resulting from such checks. The 
autoinstallation process can’t start with an invalid and non-well formed control file.

You can use any XML editor available on your system or use your favorite text editor with XML 
support (for example, Emacs or Vim). However, it is not optimal to create the control file manually 
for a large number of machines, and it should be seen only as an interface between the auto-
installation engine and the Configuration Management System (CMS).

C.3  Configuration and Installation Options
This section introduces important parts of a control file for standard purposes. To get an idea of the 
other options available, use the configuration management system.

For some of the configuration options to work, additional packages must be installed, depending on 
the software selection you have configured. If you choose to install Minimal, some packages might 
be missing and they have to be added to the individual package selection.

YaST installs packages required by YaST modules in the second phase of the installation and before 
the post-installation phase of AutoYaST has started. However, if the YaST modules are not 
available in the system, this does not happen. For example, no security settings are configured if 
yast2-security is not installed.

C.3.1  General Options
This is a required section of the profile. General options include all the settings related to the 
installation process and the environment of the installed system. The following four properties 
which are required for almost any installation are also included: language, keyboard, clock, 
and mouse. If these are left out, their default values are used.
<install>
  <general>
    <clock>
      <hwclock>UTC</hwclock>
      <timezone>US/Eastern</timezone>
    </clock>
    <keyboard>
      <keymap>german</keymap>
    </keyboard>
    <language>de_DE</language>
    <mode>
      <confirm config:type=”boolean”>true</confirm>
      <forceboot config:type=”boolean”>false</forceboot>
    </mode>
    <mouse>
      <device>/dev/psaux</device>
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      <id>ps0</id>
    </mouse>
  </general>
</install>

By default, the auto-installation process must be confirmed by the user (see the confirm property). 
The confirmation should be disabled if a fully unattended installation is desired. This option is used 
to view and change the settings on a target system before anything is committed and can be used for 
debugging. It is set to True by default to avoid recursive installs when the system schedules a 
reboot after initial system setup.

After initial installation, all systems must boot.

It is possible to halt the system after the initial installation phase by using the boolean halt 
property.

C.3.2  Reporting
The report resource manages three types of pop-ups that can appear during installation.

messages (usually noncritical, informative messages)
warning (if something might go wrong)
error (in case of an error)

<install>
  <report>
    <messages>
      <show config:type=”boolean”>true</show>
      <timeout config:type=”integer”>10</timeout>
      <log config:type=”boolean”>true</log>
    </messages>
    <errors>
      <show config:type=”boolean”>true</show>
      <timeout config:type=”integer”>10</timeout>
      <log config:type=”boolean”>true</log>
    </errors>
    <warnings>
      <show config:type=”boolean”>true</show>
      <timeout config:type=”integer”>10</timeout>
      <log config:type=”boolean”>true</log>
    </warnings>
  </report>
</install>

You can skip, log, and show (with timeout) these messages. We recommend showing all 
messages with timeout. Warnings can be skipped in some places but should not be ignored.

By default, the settings in auto-installation mode show all messages without logging and with a 
timeout of 10 seconds.

All messages during installation are controlled by the report resource. Some critical messages 
concerning package installation and partitioning still show up, ignoring your settings in the report 
section. Those messages mostly have to be answered with Yes or No.
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C.3.3  The Boot Loader
If the bootloader resource is not configured, the system proposes a configuration depending on the 
partitioning scheme. In some cases, you must decide where to install the bootloader (the Master 
Boot Record or the first sector of the /boot partition) and you must specify additional options for 
the bootloader to be installed correctly.

You can also configure special kernel and boot parameters. Kernel parameters can be configured 
using the kernel_parameters property.
  <?xml version="1.0"?>
<!DOCTYPE profile SYSTEM "/usr/share/autoinstall/dtd/profile.dtd">
<profile xmlns="http://www.mycompany.com/1.0/yast2ns" 
xmlns:config="http:// 
  www.mycompany.com/1.0/configns">
  <install>
    <bootloader>
      <global config:type="list">
        <global_entry>
          <key>prompt</key>
          <value config:type="boolean">false</value>
        </global_entry>
      </global>
      <loader_device></loader_device>
      <loader_type>lilo</loader_type>
      <location>mbr</location>
      <sections config:type="list"/>
    </bootloader>
  </install>
</profile>

The global resource is used to configure additional boot loader options. Bootloaders can have 
different configurable options. Consult the documentation for the specific bootloader you want to 
use before adding any options.

For example, to configure the serial console with GRUB, add the following options:
<bootloader>
  <global config:type=”list”>
    <global_entry>
      <key>serial</key>
      <value>--unit=1 --speed=115200</value>
    </global_entry>
    <global_entry>
      <key>terminal</key>
      <value>serial console</value>
    </global_entry>
  </global>
  <loader_type>grub</loader_type>
  <location></location>
</bootloader>

TIP: The bootloader configuration interface offers more configuration options than you might need 
for a regular setup. The options described in the example above should be sufficient for most cases.
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In the current version, bootloader configuration also supports different architectures and boards. The 
configuration of the bootloader can be done offline using AutoYaST. For example, the bootloader 
configuration for PPC has the following additional options:
  <?xml version="1.0"?>
<!DOCTYPE profile SYSTEM "/usr/share/autoinstall/dtd/profile.dtd">
<profile xmlns="http://www.mycompany.com/1.0/yast2ns" 
xmlns:config="http:/
   /www.mycompany.com/1.0/configns">
  <install>
    <bootloader>
      <board_type>iseries</board_type>
      <global config:type="list"/>
      <iseries_streamfile>/boot/suse_linux_bootfile</
iseries_streamfile>
      <iseries_write_prepboot config:type="boolean">true</
        iseries_write_prepboot>
       <iseries_write_slot_a config:type="boolean">true<
        /iseries_write_slot_a>
       <iseries_write_slot_b config:type="boolean">true<
        /iseries_write_slot_b>
      <iseries_write_streamfile config:type="boolean">true</
        iseries_write_streamfile>
      <loader_device>B</loader_device>
      <loader_type>ppc</loader_type>
      <location></location>
      <prep_boot_partition>/dev/hda1</prep_boot_partition>
    </bootloader>
  </install>
</profile>

The following bootloaders can be configured offline using the AutoYaST interface:

LILO
GRUB
ELILO
zipl
yaboot

C.3.4  Partitioning
This section contains the following information:

“Automated Partitioning” on page 206
“Advanced Partitioning Features” on page 207
“Using Existing Mount Table (fstab)” on page 212
“Logical Volume Manager (LVM)” on page 213
“Software RAID” on page 215
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Automated Partitioning

For the automated partitioning to be completed, only the sizes and mount points of partitions can be 
provided. All other data needed for successful partitioning can be calculated during installation if 
they were not provided in the control file.

If no partitions are defined and the specified drive is also the drive where the root partition should be 
created, the following partitions are created automatically:

/boot 
Size of the /boot is determined by the architecture of the target system.

swap 
Size of the swap partitions is determined by the amount of memory available in the system.

/ (root partition) 
Size of the / (root partition) is the space left after creating swap and /boot.

Depending on the initial status of the drive and how it was previously partitioned, it is possible to 
create the default partitioning in the following ways:

Use free space 
If the drive is already partitioned, it is possible to create the new partitions using the available 
space on the hard drive. This requires the availability of enough space for all selected packages 
in addition to swap.

Reuse all available space 
This option deleted all existing partitions (both Linux and non-Linux).

Reuse all available Linux partitions 
This option deletes existing Linux partitions. All other partitions (such as Windows) are kept. 
This works only if the Linux partitions are at the end of the device. 

Reuse only specified partitions 
This option deletes the specified partitions. The selection of the partitions scheduled for 
deletion should be started from the last available partition.

Repartitioning using only some of the existing partitions can be accomplished only if the region 
selected to be partitioned exists at the end of the device and only with neighboring partitions. This 
means that you cannot repartition a region which contains a partition that should not be touched in 
the middle.

IMPORTANT: The value provided in the use property determines how existing data and partitions 
are treated. The all value means that all data on the disk will be erased. Make backups and use the 
confirm property if you are going to keep some partitions with important data. This is an 
automated installation and no pop-ups will notify you about partitions being deleted.

In case of the presence of multiple drives in the target system, all drives must be identified with their 
device names and how the partitioning should be performed.

Partition sizes can be given in gigabytes (GB) or megabytes (MB), or can be set to a flexible value 
using the keywords auto and max. Max is used to fill a partition to the maximal available space on 
a drive (which mean that the partition should be the last one on the drive). Auto can be used to 
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determine the size of a swap or boot partition depending on the memory available and the type of the 
system.

A fixed size can be given as shown below:

1GB creates a partition with a 1 GB size.
1500MB creates a partition which is 1.5 GB big.

The following is an example of a single-drive system, which is not prepartitioned and should be 
automatically partitioned according to the described predefined partition plan:
<partitioning config:type=”list”>
  <drive>
    <device>/dev/hda</device>
    <use>all</use>
  </drive>
</partitioning>

A more detailed example shows how existing partitions and multiple drives are handled:
<partitioning config:type=”list”>
<drive> 
<device>/dev/hda</device> 
<partitions config:type=”list”> 
<partition> 
<mount>/</mount> 
<size>5gb</size> 
</partition>
<partition>
<mount>swap</mount> 
<size>1gb</size> 
</partition> 
</partitions> 
</drive> 
<drive> 
<device>/dev/hdb</device> 
<use>all</use> 
<partitions config:type=”list”> 
<partition> 
<filesystem config:type=”symbol”>reiser</filesystem> 
<mount>/data1</mount> 
<size>15gb</size> 
</partition> 
<partition> 
<filesystem config:type=”symbol”>jfs</filesystem> 
<mount>/data2</mount> 
<size>auto</size> 
</partition> 
</partitions> 
<use>free</use> 
</drive> 
</partitioning>

Advanced Partitioning Features

This section covers advanced partitioning including LVM and RAID configuration.
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Mount Options

By default, a file system which is to be mounted is identified in /etc/fstab by the device name. 
This identification can be changed so the file system is found by searching for a UUID or a volume 
label. Not all file systems can be mounted by UUID or a volume label. To specify how a partition is 
to be mounted, use the mountby property, which has the symbol type. 

Possible options:

device (default)
label
UUID

If you choose to mount the partition using a label, the name specified in the label property is used as 
the volume label.

Add any legal mount option allowed in the fourth field of /etc/fstab. Multiple options are 
separated by commas (,). Possible fstab options include the following:

Table C-1   fstab Options

<partitions config:type=”list”>
  <partition>
    <filesystem config:type=”symbol”>reiser</filesystem>
    <format config:type=”boolean”>true</format>
    <fstopt>ro,noatime,user,data=ordered,acl,user_xattr</fstopt>
    <mount>/local</mount>
    <mountby config:type=”symbol”>uuid</mountby>
    <partition_id config:type=”integer”>131</partition_id>
    <size>10gb</size>

Option Description

Mount Read-Only (ro) No writable access to the file system is possible. 
Default=False

No Access Time (noatime) Access times are not updated when a file is read. 
Default=False

Mountable by User (user) The file system can be mounted by an ordinary 
user. Default=False

Data Journaling Mode (ordered | journal | 
writeback)

Specifies the journaling mode for file data.

journal: All data is committed into the 
journal prior to being written into the main file 
system.

ordered: All data is forced directly out to 
the main file system prior to its metadata 
being committed to the journal.

writeback: Data ordering is not preserved.

Access Control List (acl) Enable access control lists on the file system.

Extended User Attributes (user_xattr) Allow extended user attributes on the file system.
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  </partition>
</partitions>

Creating Primary and Extended Partitions

By default, AutoYaST creates an extended partition and adds all other new partitions as logical 
devices. It is possible, however, to instruct AutoYaST to create a certain partition as a primary or 
extended partition. Additionally, it is possible to specify the size of a partition using sectors instead 
of the size in MB.

The partition_id and partition_type properties control this behavior. To specify the 
size in sectors, the list resource region can be used.
<partitioning config:type=”list”>
  <drive>
    <device>/dev/hdc</device>
    <partitions config:type=”list”>
      <partition>
        <partition_id config:type=”integer”>5</partition_id>
        <region config:type=”list”>
        <region_entry config:type=”integer”>0</region_entry>
        <region_entry config:type=”integer”>16858</region_entry>
       </region>
      </partition>
      <partition>
        <filesystem config:type=”symbol”>reiser</filesystem>
        <mount>/</mount>
        <partition_id config:type=”integer”>131</partition_id>
        <region config:type=”list”>
          <region_entry config:type=”integer”>0</region_entry>
          <region_entry config:type=”integer”>2081</region_entry>
        </region>
      </partition>
      <partition>
        <mount>swap</mount>
        <partition_id config:type=”integer”>130</partition_id>
        <region config:type=”list”>
          <region_entry config:type=”integer”>2081</region_entry>
          <region_entry config:type=”integer”>781</region_entry>
        </region>
      </partition>
    </partitions>
    <use>all</use>
  </drive>
</partitioning>

The above example makes sense only if you know the exact boundaries of the partitions and if you 
are creating an exact copy of a system (for example, when cloning). The first region entry in the list 
is the beginning of the region, and the second represents the length of the region.

The following example lets you create an extended partition with a custom size:
<partitioning config:type=”list”>
  <drive>
    <device>/dev/hdc</device>
    <partitions config:type=”list”>
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      <partition>
        <filesystem config:type=”symbol”>ext2</filesystem>
        <mount>/boot</mount>
        <partition_id config:type=”integer”>131</partition_id>
        <partition_nr config:type=”integer”>2</partition_nr>
        <size>50mb</size>
      </partition>
      <partition>
        <mount>swap</mount>
        <partition_id config:type=”integer”>130</partition_id>
        <partition_nr config:type=”integer”>3</partition_nr>
        <size>100mb</size>
      </partition>
      <partition>
        <partition_id config:type=”integer”>15</partition_id>   
        <partition_nr config:type=”integer”>4</partition_nr>
        <size>3000mb</size>
      </partition>
      <partition>
        <filesystem config:type=”symbol”>ext2</filesystem>
        <mount>/</mount>
        <partition_id config:type=”integer”>131</partition_id>
        <partition_nr config:type=”integer”>5</partition_nr>
        <size>1gb</size>
      </partition>
    </partitions>
    <use>free</use>
  </drive>
</partitioning>
</install>

Keeping Specific Partitions

In some cases, you might choose to keep some partitions untouched and format only specific target 
partitions, rather than creating them from scratch. This might be the case if Linux installations have 
to coexist with another operating system, or if certain partitions contain data that you want to keep 
untouched.

Such scenarios require a certain knowledge of the target systems and hard drives. Depending on the 
scenario, you might need to know the exact partition table of the target hard drive with partition IDs, 
sizes, and numbers. With this data, you can tell AutoYaST to keep certain partitions, format others, 
and create new partitions if needed.

The following example keeps partitions 1, 2, and 5 and deletes partition 6 to create two new 
partitions. Only all kept partitions are formatted.
<install>
  <partitioning config:type=”list”>
    <drive>
      <device>/dev/hdc</device>
      <partitions config:type=”list”>
      <partition>
        <create config:type=”boolean”>false</create>
        <format config:type=”boolean”>true</format>
        <mount>/</mount>
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        <partition_nr config:type=”integer”>1</partition_nr>
      </partition>
      <partition>
        <create config:type=”boolean”>false</create>
        <format config:type=”boolean”>false</format>
        <partition_nr config:type=”integer”>2</partition_nr>
        <mount>/space</mount>
      </partition>
      <partition>
        <create config:type=”boolean”>false</create>
        <format config:type=”boolean”>true</format>
        <filesystem config:type=”symbol”>swap</filesystem>
        <partition_nr config:type=”integer”>5</partition_nr>
        <mount>swap</mount>
      </partition>
      <partition>
        <format config:type=”boolean”>true</format>
        <mount>/space2</mount>
        <size>50mb</size>
      </partition>
      <partition>
        <format config:type=”boolean”>true</format>
        <mount>/space3</mount>
        <size>max</size>
      </partition>
     </partitions>
     <use>6</use>
   </drive>
  </partitioning>
</install>

The above example requires exact knowledge of the existing partition table and about the partition 
numbers of those partitions that should be kept. In some cases, however, this data might be not 
available, especially in a mixed hardware environment with different hard drive types and 
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configurations. The following scenario is for a system with a non-Linux operating system with a 
designated area for a Linux installation.

Figure C-2   Keeping Partitions

In this scenario, as shown in Figure C-2, “Keeping Partitions,” on page 212, AutoYaST should not 
in any case create new partitions. Instead, it should search for certain partition types on the system 
and use them according to the partitioning plan in the control file. No partition numbers are given in 
this case, only the mount points and the partition types. Additional configuration data can be 
provided (for example, file system options, encryption, and filesystem type).
<install>
  <partitioning config:type=”list”>
    <drive>
      <partitions config:type=”list”>
        <partition>
          <create config:type=”boolean”>false</create>
          <format config:type=”boolean”>true</format>
          <mount>/</mount>
          <partition_id config:type=”integer”>131</partition_id>
        </partition>
        <partition>
          <create config:type=”boolean”>false</create>
          <format config:type=”boolean”>true</format>
          <filesystem config:type=”symbol”>swap</filesystem>
          <partition_id config:type=”integer”>130</partition_id>
          <mount>swap</mount>
        </partition>
      </partitions>
    </drive>
  </partitioning>
</install>

Using Existing Mount Table (fstab)

This option lets AutoYaST use an existing /etc/fstab file and the partition data from a previous 
installation. All partitions are kept and no new partitions are created. The found partitions are 
formatted and mounted as specified in the /etc/fstab file found on a Linux root partition.

Partitioned and installed area

/dev/hda1:Windows /dev/hda1:Windows

/dev/hda1:/ with reiser/dev/hda2:Linux native

/dev/hda1:/ with reiser/dev/hda2:Linux native

Partitioned and uninstalled area
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Although the default behavior is to format all partitions, it is also possible to leave some partitions 
(for example, data partitions) untouched and only mount them. If multiple installations are found on 
the system (multiple root partitions with different fstab files), the installation aborts unless the 
desired root partition is configured in the control file. The following example illustrates how this 
option can be used.
<install>
  <partitioning_advanced>
    <fstab>
      <!-- Read data from existing fstab. If multiple root partitions 
are
      found, use the one specified below. Otherwise the first root
      partition is taken -->
      <!-- <root_partition>/dev/hda5</root_partition> -->
      <use_existing_fstab config:type=”boolean”>true</
use_existing_fstab>
      <!-- all partitions found in fstab will be formatted and mounted
      by default unless a partition is listed below with different
      settings -->
      <partitions config:type=”list”>
        <partition>
          <format config:type=”boolean”>false</format>
          <mount>/bootmirror</mount>
        </partition>
      </partitions>
    </fstab>
  </partitioning_advanced>
</install>

Logical Volume Manager (LVM)

To configure LVM, first you need to create a physical volume using the normal partitioning method 
described above.

The following example shows how to prepare for LVM in the partitioning resource:
<partitioning config:type=”list”>
  <drive>
    <device>/dev/sda</device>
    <partitions config:type=”list”>
      <partition>
        <lvm_group>system</lvm_group>
        <partition_type>primary</partition_type>
        <size>max</size>
      </partition>
    </partitions>
    <use>all</use>
  </drive>
</partitioning>

This above example creates a nonformatted partition on the /dev/sda1 device of the LVM type 
and with the system volume group. The partition created uses all available space on this drive.

In previous versions of Linux, LVM configuration was done in a separate resource. This method for 
configuring LVM is still supported, but a new and easier way is now possible which allows you to 
have the LVM configuration directly in the partitioning resource. Currently, it is not possible to 
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configure LVM using the configuration system. You must add the resource manually, as shown in 
the following example.
<partitioning config:type=”list”>
  <drive>
    <device>/dev/sda</device>
    <partitions config:type=”list”>
      <partition>
        <lvm_group>system</lvm_group>
        <partition_type>primary</partition_type>
        <size>max</size>
      </partition>
    </partitions>
    <use>all</use>
  </drive>
</partitioning>
<lvm config:type=”list”>
  <lvm_group>
    <lvm_name>system</lvm_name>
    <logical_volumes config:type=”list”>
      <lv>
        <lv_fs>reiser</lv_fs>
        <lv_mount>/usr</lv_mount>
        <lv_name>usrlv</lv_name>
        <lv_size>500mb</lv_size>
      </lv>
      <lv>
        <lv_fs>reiser</lv_fs>
        <lv_mount>/opt</lv_mount>
        <lv_name>optlv</lv_name>
        <lv_size>1500mb</lv_size>
      </lv>
      <lv>
        <lv_fs>reiser</lv_fs>
        <lv_mount>/var</lv_mount>
        <lv_name>varlv</lv_name>
        <lv_size>200mb</lv_size>
      </lv>
    </logical_volumes>
    <pesize>4M</pesize>
  </lvm_group>
</lvm>

Using the new method, the above configuration has the following syntax:
<partitioning config:type=”list”>
  <drive>
    <device>/dev/sda</device>
    <partitions config:type=”list”>
      <partition>
        <lvm_group>system</lvm_group>
        <partition_type>primary</partition_type>
        <size>max</size>
        </partition>
      </partitions>
      <use>all</use>
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    </drive>
  <drive>
    <device>/dev/system</device>
    <is_lvm_vg config:type=”boolean”>true</is_lvm_vg>
    <partitions config:type=”list”>
    <partition>
      <filesystem config:type=”symbol”>reiser</filesystem>
      <lv_name>user_lv</lv_name>
      <mount>/usr</mount>
      <size>500mb</size>
    </partition>
    <partition>
      <filesystem config:type=”symbol”>reiser</filesystem>
      <lv_name>opt_lv</lv_name>
      <mount>/opt</mount>
      <size>1500mb</size>
    </partition>
    <partition>
      <filesystem config:type=”symbol”>reiser</filesystem>
      <lv_name>var_lv</lv_name>
      <mount>/var</mount>
      <size>200mb</size>
    </partition>
   </partitions>
   <pesize>4M</pesize>
   <use>all</use>
  </drive>
</partitioning>

Software RAID

Using AutoYaST, you can create and assemble software RAID devices. The supported RAID levels 
are the following:

Table C-2   Supported RAID Levels

Level Description

RAID 0 Increases your disk performance. There is no redundancy in this mode. If one of 
the drives crashes, data recovery is not possible.

RAID 1 Has the best redundancy. It can be used with two or more disks. It maintains an 
exact copy of all data on all disks. As long as at least one disk is still working, no 
data is lost. The partitions used for this level of RAID should have approximately 
the same size.

RAID 5 Combines management of a larger number of disks and still maintains some 
redundancy. It can be used on three or more disks. If one disk fails, all data is still 
intact. If two disks fail simultaneously, all data is lost.

Multipath Allows access to the same physical device over multiple controllers for 
redundancy against a fault in a controller card. It can be used with at least two 
devices.
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As with LVM, you need to create all RAID partitions first, then assign the partitions to the RAID 
device you want to create. You also need to specify whether a partition or a device should be 
configured in the RAID or if it should be configured as a Spare device.

In previous versions of Linux, RAID configuration was done in a separate resource. This method for 
configuring RAID devices is still supported, but a new and easier way is now possible which allows 
the user to have the RAID configuration directly in the partitioning resource.

The following example shows a simple RAID1 configuration:
<partitioning config:type=”list”>
  <drive>
    <device>/dev/sda</device>
    <partitions config:type=”list”>
      <partition>
        <format config:type=”boolean”>false</format>
        <partition_id config:type=”integer”>253</partition_id>
        <raid_name>/dev/md0</raid_name>
        <raid_type>raid</raid_type>
        <size>4gb</size>
      </partition>
      <!-- Here come the regular partitions, i.e. / and swap -->
    </partitions>
    <use>all</use>
   </drive>
  <drive>
    <device>/dev/sdb</device>
    <use>all</use>
    <partitions config:type=”list”>
      <partition>
        <format config:type=”boolean”>false</format>
        <partition_id config:type=”integer”>253</partition_id>
        <raid_name>/dev/md0</raid_name>
        <raid_type>raid</raid_type>
        <size>4gb</size>
      </partition>
    </partitions>
  </drive>
</partitioning>
<raid config:type=”list”>
  <raid_device>
    <chunk_size>4</chunk_size>
    <device_name>/dev/md0</device_name>
    <filesystem config:type=”symbol”>reiser</filesystem>
    <format config:type=”boolean”>true</format>
    <parity_algorithm>left-asymmetric</parity_algorithm>
    <partition_id config:type=”integer”>131</partition_id>
    <persistent_superblock config:type=”boolean”>true</
      persistent_superblock>
    <mount>/space</mount>
    <raid_type>raid1</raid_type>
  </raid_device>
</raid>

Using the new method, the above configuration has the following syntax:
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<partitioning config:type=”list”>
  <drive>
    <device>/dev/sda</device>
    <partitions config:type=”list”>
      <partition>
        <partition_id config:type=”integer”>253</partition_id>
        <format config:type=”boolean”>false</format>
        <raid_name>/dev/md0</raid_name>
        <raid_type>raid</raid_type>
        <size>4gb</size>
      </partition>
      <!-- Here come the regular partitions, i.e. / and swap -->
    </partitions>
    <use>all</use>
  </drive>
  <drive>
    <device>/dev/sdb</device>
    <partitions config:type=”list”>
      <partition>
        <format config:type=”boolean”>false</format>
        <partition_id config:type=”integer”>253</partition_id>
        <raid_name>/dev/md0</raid_name>
        <raid_type>raid</raid_type>
        <size>4gb</size>
      </partition>
    </partitions>
    <use>all</use>
  </drive>
  <drive>
    <device>/dev/md</device>
    <partitions config:type=”list”>
      <partition>
        <filesystem config:type=”symbol”>reiser</filesystem>
        <format config:type=”boolean”>true</format>
        <mount>/space</mount>
        <partition_id config:type=”integer”>131</partition_id>
        <partition_nr config:type=”integer”>0</partition_nr>
        <raid_options>
          <chunk_size>4</chunk_size>
          <parity_algorithm>left-asymmetric</parity_algorithm>
          <raid_type>raid1</raid_type>
        </raid_options>
      </partition>
    </partitions>
    <use>all</use>
  </drive>
</partitioning>

The following must be taken into consideration when configuring RAID using the new syntax:

The device for RAID is always /dev/md.
The partition_nr property is used to determine the MD device number. If partition_nr=0, 
then /dev/md0 is configured.
Automatic Linux Installation and Configuration Using AutoYaST 217



218 Novell Linux

novdocx (E
N

U
)  10 A

ugust 2006
All RAID-specific options are contained in the raid_options resource.

C.3.5  Software
This section contains the following information:

“Package Selections” on page 218
“Custom Package Selections” on page 218
“Installing Additional and Customized Packages” on page 219
“Kernel Packages” on page 220
“Removing Automatically Selected Packages” on page 220

Package Selections

You can install software on the new system using a predefined package base selection (Minimal, 
Minimal+X11, default, etc.) in addition to several add-on selections. Check the Novell Linux 
Desktop CD 1 for available selections in suse/setup/descr/.

In the control file, packages and package selections are described as follows:
<software>
  <addons config:type=”list”>
    <addon>Kde</addon>
  </addons>
  <base>Minimal</base>
  <packages config:type=”list”>
    <package>apache</package>
    <package>sendmail</package>
  </packages>
</software>

You can install one base selection and one or more add-on selections.

When installing from a CD-ROM, packages needed from other CD-ROMs are installed after the 
initial boot of the system in the second installation phase. If you are installing packages from 
multiple CD-ROMs, auto-installation has to be interrupted for switching the CD-ROMs. In the case 
of NFS installations, all packages are installed in the first stage of the installation only if the NFS 
repository is configured as a single medium.

Frequently a package must be installed in the second phase, especially custom packages which 
might contain scripts for configuring the system. This can be done using the post-packages resource.

Custom Package Selections

In addition to predefined selections, you can create custom selections by providing a selection file in 
the selection directory (suse/setup/descr). Selection files have a special format and any 
additional selection file must conform to this format, or YaST2 will not be able to read it.

For examples of a selection file, see the files available in the /suse/setup/descr/ directory on 
the Novell Linux Desktop CD1.

After creating a selection file, you can add it to the configuration as described earlier in this section. 
The selection name (for example, My.sel) has to be added to the index files selections and 
directory.yast to make it visible to the installer.
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The My.sel file should have the following format:
# SuSE-Linux-Package-Selection 3.0 -- (c) 2004 SuSE Linux AG
# generated on Thu Apr 15 19:49:04 UTC 2004
=Ver: 3.0
=Sel: LSB
=Sum: LSB Runtime Environment
=Sum.de: LSB-Laufzeitumgebung
=Cat: addon
=Vis: true
=Ord: 108
+Ins:
XFree86-Mesa
XFree86-libs
expect
fontconfig
freetype2
gettext
glibc-i18ndata
libgcj
lsb
make
makedev
patch
pax
rsync
-Ins:

To use the above selection, add the following to the control file:
<install>
...
  <software>
    <base>My</base>
  </software>
...
</install>

Installing Additional and Customized Packages

In addition to the packages available for installation on the CD-ROMs, you can add external 
packages including customized kernels. Customized kernel packages must be compatible with the 
Novell Linux Desktop packages and must be installed to the same locations.

Unlike earlier versions of Linux, there is no need for a special resource in the control file to install 
custom and external packages. You just need to re-create the package database and update it with 
any new packages or new package versions in the source repository. A script is provided for this 
task which queries packages available in the repository and creates the required package database.

Creating a new package database is needed only if new RPMs (for example, update RPMs) were 
added. To re-create the database, use the /usr/bin/create_package_descr command. For 
example, use this command line to create the package database. When creating the database, all 
languages are reset to English.
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cd /usr/local/CDs/LATEST/suse
create_package_descr -x PATH_TO_EXTRA_PROV -d /usr/local/CDs/LATEST/
suse

To provide extra dependencies which cannot be extracted from the RPM files, an extra file with 
missing dependencies is available in the suse/setup/descr directory. The EXTRA_PROV file 
can be used when re-creating the package database using the -x option.

In the example above, the /usr/local/CDs/LATEST/suse directory contains the architecture 
dependent and independent packages (noarch and i586). This might look different on other 
architectures. 

The advantage of this method is that you can keep an up-to-date repository with fixed and updated 
packages (for example, from the Novell FTP server). This method also makes the creation of custom 
CD-ROMs easier.

Kernel Packages

Kernel packages are not part of any selection. The required kernel is determined during installation. 
If the kernel package is added to any selection or to the individual package selection, installation 
will most likely fail due to conflicts.

To force the installation of a specific kernel, use the kernel property. The following is an example of 
forcing the installation of the default kernel. In this example, this kernel is installed in any case, even 
if an SMP or other kernel is required.
<software>
  <addons config:type=”list”>
    <addon>Kde</addon>
  </addons>
  <base>Minimal</base>
  <kernel>kernel-default</kernel>
  <packages config:type=”list”>
    <package>apache2</package>
  </packages>
</software>

Removing Automatically Selected Packages

Some packages are selected automatically either because of a dependency or because they are 
available in a selection.

Removing such packages might break the system consistency, and we do not recommend removing 
basic packages unless a replacement that provides the same services is provided. The best example 
of this are MTA packages. By default, postfix is selected and installed. If you want to use another 
MTA, like sendmail, then postfix can be removed from the list of selected packages using a list in 
the software resource. The following example shows how this can be done:
<software>
  <addons config:type=”list”>
    <addon>Kde</addon>
  </addons>
  <base>Minimal</base>
  <packages config:type=”list”>
    <package>sendmail</package>
  </packages>
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  <remove-packages config:type=”list”>
    <package>postfix</package>
  </remove-packages>
</software>

C.3.6  Services and Runlevels
With the runlevel resource, you can set the default runlevel and specify in detail which system 
services you want to be started in which runlevel.

The default property specifies the default runlevel of the system. Changes to the default runlevel 
take effect the next time you boot the system. After installation is completed, the system has 
runlevel 5, which is Full multiuser with network and XDM. If you have configured a system with no 
X11, then we recommend rebooting the system after the first stage using the reboot property in 
the general resource.

A service should run using a space delimited list of the runlevels, as shown in the following 
example. An alternative to specifying the exact runlevels is to change the status of the service by 
either enabling or disabling it using the service_status property.
<configure>
....
  <runlevels>
    <default>3</default>
    <services config:type=”list” >
      <service>
        <service_name>at</service_name>
        <service_start>3 5</service_start>
      </service>
      <service>
        <service_name>portmap</service_name>
        <service_status>enable</service_status>
      </service>
      <service>
        <service_name>hwscan</service_name>
        <service_status>disable</service_status>
      </service>
    </services>
  </runlevels>
....
</configure>

C.3.7  Network Configuration
Network configuration is used to connect a single Novell Linux Desktop workstation to an Ethernet-
based LAN or to configure dial-up connection. More complex configuration (multiple network 
cards, routing, etc.) is also provided. With this module, it’s possible to configure and set up Ethernet 
Controllers and Token-Ring Controllers.

Network Devices, DNS, and Routing

To configure network settings and activate networking automatically, one global resource is used to 
store the whole network configuration.
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 <configure>
.....
    <networking>
      <dns>
        <dhcp_hostname config:type=”boolean”>true</dhcp_hostname>
        <dhcp_resolv config:type=”boolean”>true</dhcp_resolv>
        <domain>local</domain>
        <hostname>linux</hostname>
      </dns>
      <interfaces config:type=”list”>
        <interface>
          <bootproto>dhcp</bootproto>
          <device>eth0</device>
          <startmode>onboot</startmode>
        </interface>
      </interfaces>
      <routing>
        <ip_forward config:type=”boolean”>false</ip_forward>
        <routes config:type=”list”>
          <route>
            <destination>default</destination>
            <device>-</device>
            <gateway>192.168.1.240</gateway>
            <netmask>-</netmask>
          </route>
        </routes>
      </routing>
      <modules config:type=”list”>
        <module_entry>
          <device>eth0</device>
          <module>e100</module>
          <options></options>
        </module_entry>
      </modules>
  </networking>
....
 </configure>

Proxy

Use this resource to configure your Internet proxy (caching) settings.

http_proxy is the name of the proxy server for your access to the World Wide Web (WWW). 
ftp_proxy is the name of the proxy server for your access to the File Transfer Services (FTP). No 
proxy domains is a list of domains for which the requests should be done directly without caching.

If you are using a proxy server with authorization, specify the Proxy username and password.
<?xml version=”1.0”?>
<!DOCTYPE profile SYSTEM “/usr/share/autoinstall/dtd/profile.dtd”>
<profile xmlns=”http://www.suse.com/1.0/yast2ns” xmlns:config=”http://
www.suse.com/1.0
  /configns”>
    <configure>
      <proxy>
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        <enabled config:type=”boolean”>true</enabled>
        <ftp_proxy>http://192.168.1.240:3128</ftp_proxy>
        <http_proxy>http://192.168.1.240:3128</http_proxy>
        <no_proxy>localhost</no_proxy>
        <proxy_password>testpw</proxy_password>
        <proxy_user>testuser</proxy_user>
      </proxy>
    </configure>
</profile>

(X)Inetd

The profile has elements to specify which superserver should be used (netd_service), whether 
it should be enabled (netd_status), and how the services should be configured (netd_conf).

A service description element has conceptually two parts: key and nonkey. When writing the 
configuration, services are matched using the key fields, and the nonkey fields are applied to the 
matching service. If no service matches, it is created. If more services match, a warning is reported. 
The key fields are script, service, protocol, and server.

service and protocol are matched literally. script is the base name of the config file, usually a 
file in /etc/xinetd.d (for example, echo-udp or inetd.conf). server is matched more 
loosely: if it is /usr/sbin/tcpd, the real server name is taken from server_args. After that, 
the basename of the first whitespace-separated word is taken and these values are compared.
<profile>
  <configure>
    ...
    <inetd>
      <netd_service config:type=”symbol”>xinetd</netd_service>
      <netd_status config:type=”integer”>0</netd_status>
      <netd_conf config:type=”list”>
        <conf>
          <script>imap</script>
          <service>pop3</service>
          <enabled config:type=”boolean”>true</enabled>
        </conf>
        <conf>
          <server>in.ftpd</server>
          <server_args>-A</server_args>
          <enabled config:type=”boolean”>true</enabled>
        </conf>
        <conf>
          <service>daytime</service>
          <protocol>tcp</protocol>
        </conf>
        ....
        <conf>...</conf>
      </netd_conf>
    </inetd>
    ...
  </configure>
</profile>
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NIS

Use the NIS resource to configure the target machine as a NIS client. The following example shows 
a detailed configuration using multiple domains.
<configure>
...
  <nis>
    <nis_broadcast config:type=”boolean”>true</nis_broadcast>
    <nis_broken_server config:type=”boolean”>true</nis_broken_server>
    <nis_by_dhcp config:type=”boolean”>false</nis_by_dhcp>
    <nis_domain>test.com</nis_domain>
    <nis_local_only config:type=”boolean”>true</nis_local_only>
    <nis_options></nis_options>
    <nis_other_domains config:type=”list”>
      <nis_other_domain>
        <nis_broadcast config:type=”boolean”>false</nis_broadcast>
        <nis_domain>domain.com</nis_domain>
        <nis_servers config:type=”list”>
          <nis_server>10.10.0.1</nis_server>
        </nis_servers>
      </nis_other_domain>
    </nis_other_domains>
    <nis_servers config:type=”list”>
      <nis_server>192.168.1.1</nis_server>
    </nis_servers>
    <start_autofs config:type=”boolean”>true</start_autofs>
    <start_nis config:type=”boolean”>true</start_nis>
  </nis>
...
</configure>

LDAP Client

The installed machine can be set up as an LDAP client to authenticate users with an OpenLDAP 
server. Required data include the name of the search base (base DN; for example, 
dc=mydomain,dc=com) and the IP address of the LDAP server (for example, 10.20.0.2).

If LDAP is activated, NSS and PAM are configured accordingly to use LDAP for user 
authentication.
<configure>
...
  <ldap>
    <ldap_domain> dc=mydomain,dc=com</ldap_domain>
    <ldap_server>10.10.0.1</ldap_server>
    <ldap_tls config:type=”boolean”>true</ldap_tls>
    <ldap_v2 config:type=”boolean”>true</ldap_v2>
    <pam_password>crypt</pam_password>
    <start_ldap config:type=”boolean”>true</start_ldap>
  </ldap>
...
</configure>
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NFS Client and Server

You can configure a system as an NFS client or an NFS server by using the configuration system. 
The following examples show how both the NFS client and server can be configured.

NFC Client Configuration
  <configure>
...
    <nfs config:type="list">
      <nfs_entry>
        <mount_point>/home</mount_point>
        <nfs_options>defaults</nfs_options>
        <server_path>192.168.1.1:/home</server_path>
      </nfs_entry>
    </nfs>
...
</configure>

NFS Server Configuration
    <configure>
....
    <nfs_server>
      <nfs_exports config:type=”list”>
        <nfs_export>
          <allowed config:type=”list”>
            <allowed_clients>*(ro,root_squash,sync)</allowed_clients>
          </allowed>
           <mountpoint>/home</mountpoint>
        </nfs_export>
        <nfs_export>
          <allowed config:type=”list”>
            <allowed_clients>*(ro,root_squash,sync)</allowed_clients>
          </allowed>
           <mountpoint>/work</mountpoint>
        </nfs_export>
      </nfs_exports>
       <start_nfsserver config:type=”boolean”>true</start_nfsserver>
    </nfs_server>
....
  </configure>

NTP Client

You can choose to start the NTP daemon when booting the system. The NTP daemon resolves 
hostnames when initializing. The first synchronization of the clock is performed before the NTP 
daemon is started. To use this host for initial synchronization, configure the initial_sync 
property.

To run the NTP daemon in chroot jail, set start_in_chroot. Starting any daemon in a chroot 
jail is more secure and strongly recommended. To adjust NTP servers, peers, local clocks, and NTP 
broadcasting, add the appropriate entry to the control file. The following is an example of various 
configuration options.
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   <?xml version=”1.0”?>
<!DOCTYPE profile SYSTEM “/usr/share/autoinstall/dtd/profile.dtd”>
<profile xmlns=”http://www.mycompany.com/1.0/yast2ns” 
xmlns:config=”http://www.mycompany.com/1.0/configns”>
  <configure>
    <ntp-client>
      <peers config:type=”list”>
        <peer>
         <address>10.10.0.1</address>
         <initial_sync config:type=”boolean”>true</initial_sync>
         <param></param>
         <type>server</type>
        </peer>
        <peer>
          <address>192.168.1.1</address>
          <initial_sync config:type=”boolean”>true</initial_sync>
          <param></param>
          <type>peer</type>
        </peer>
        <peer>
          <address>1.1.1.1</address>
          <type>broadcastclient</type>
        </peer>
        <peer>
          <address>127.127.2.3</address>
          <create_symlink config:type=”boolean”>true</create_symlink>
          <device>/dev/test</device>
          <param></param>
          <type>__clock</type>
        </peer>
        </peers>
        <start_at_boot config:type=”boolean”>true</start_at_boot>
        <start_in_chroot config:type=”boolean”>true</start_in_chroot>
     </ntp-client>
   </configure>
</profile>

C.3.8  Mail Configuration (Sendmail or Postfix)
This module lets you create a detailed mail configuration. The module contains various options and 
we recommend using it at least for the initial configuration.
  <configure>
...
    <mail>
      <aliases config:type=”list”>
        <alias>
          <alias>root</alias>
          <comment></comment>
          <destinations>foo</destinations>
        </alias>
        <alias>
          <alias>test</alias>
          <comment></comment>
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          <destinations>foo</destinations>
        </alias>
        </aliases>
        <connection_type config:type=”symbol”>permanent</
connection_type>
        <fetchmail config:type=”list”>
          <fetchmail_entry>
            local_user>foo</local_user>
            <password>bar</password>
            <protocol>POP3</protocol>
            <remote_user>foo</remote_user>
            <server>pop.foo.com</server>
          </fetchmail_entry>
          <fetchmail_entry>
            <local_user>test</local_user>
            <password>bar</password>
            <protocol>IMAP</protocol>
            <remote_user>test</remote_user>
            <server>blah.com</server>
          </fetchmail_entry>
        </fetchmail>
        <from_header>test.com</from_header>
        <listen_remote config:type=”boolean”>true</listen_remote>
        <local_domains config:type=”list”>
          <domains>test1.com</domains>
        </local_domains>
        <masquerade_other_domains config:type=”list”>
          <domain>blah.com</domain>
        </masquerade_other_domains>
        <masquerade_users config:type=”list”>
          <masquerade_user>
            <address>joe@test.com</address>
            <comment></comment>
            <user>joeuser</user>
          </masquerade_user>
          <masquerade_user>
            <address>bar@test.com</address>
            <comment></comment>
            <user>foo</user>
          </masquerade_user>
        </masquerade_users>
        <mta config:type=”symbol”>postfix</mta>
        <outgoing_mail_server>test.com</outgoing_mail_server>
        <postfix_mda config:type=”symbol”>local</postfix_mda>
        <smtp_auth config:type=”list”>
          <listentry>
            <password>bar</password>
            <server>test.com</server>
            <user>foo</user>
          </listentry>
        </smtp_auth>
        <use_amavis config:type=”boolean”>true</use_amavis>
        <virtual_users config:type=”list”>
          <virtual_user>
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            <alias>test.com</alias>
            <comment></comment>
            <destinations>foo.com</destinations>
          </virtual_user>
          <virtual_user>
            <alias>geek.com</alias>
            <comment></comment>
            <destinations>bar.com</destinations>
          </virtual_user>
        </virtual_users>
      </mail>
...
</configure>

C.3.9  Security Settings
Use the features of this module to change the local security settings on the target system. These 
settings include boot configuration, login, password, user addition, and file permissions.

Configuring the security settings automatically corresponds to the Custom Settings in the security 
module available in the running system which lets you create your own, customized configuration.

See the reference for the meaning and the possible values of the settings in the following example.
<configure>
...
  <security>
    <console_shutdown>ignore</console_shutdown>
    <cwd_in_root_path>no</cwd_in_root_path>
    <displaymanager_remote_access>no</displaymanager_remote_access>
    <fail_delay>3</fail_delay>
    <faillog_enab>yes</faillog_enab>
    <gid_max>60000</gid_max>
    <gid_min>101</gid_min>
    <kdm_shutdown>root</kdm_shutdown>
    <lastlog_enab>yes</lastlog_enab>
    <encryption>md5</encryption>
    <obscure_checks_enab>no</obscure_checks_enab>
    <pass_max_days>99999</pass_max_days>
    <pass_max_len>8</pass_max_len>
    <pass_min_days>1</pass_min_days>
    <pass_min_len>6</pass_min_len>
    <pass_warn_age>14</pass_warn_age>
    <passwd_use_cracklib>yes</passwd_use_cracklib>
    <permission_security>secure</permission_security>
    <run_updatedb_as>nobody</run_updatedb_as>
    <uid_max>60000</uid_max>
    <uid_min>500</uid_min>
  </security>
...
</configure>
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Password Settings Options

Use this resource to change various password settings stored in the /etc/login.defs file, and 
to activate one of the encryption methods currently supported. If this not set, then DES is 
configured.

DES, the Linux default method, works in all network environments, but it restricts you to passwords 
no longer than eight characters. MD5 allows longer passwords, thus providing more security; but 
some network protocols don’t support this, and you might have problems with NIS. Blowfish is also 
supported.

You can also set the system to check for password plausibility and length.

Boot Settings

Use the security resource to change the following boot settings:

How to interpret Ctrl+Alt+Del 
When someone at the console presses Ctrl+Alt+Del, the system usually reboots. Sometimes it 
might be desirable to ignore this event (for example, when the system serves as both 
workstation and server).

Shutdown behavior of KDM 
Set who is allowed to shut down the machine from KDM.

Login Settings

Use this option to change various login settings, which are stored in the /etc/login.defs file.

New User Settings (useradd Settings)

Set the minimum and maximum possible user ID as well as the minimum and maximum possible 
group ID.

C.3.10  Monitor and X11 Configuration
The following is a monitor and X11 configuration example:
<configure>
...
    <x11>
      <color_depth config:type=”integer”>16</color_depth>
      <configure_x11 config:type=”boolean”>true</configure_x11>
      <display_manager>gdm</display_manager>
      <enable_3d config:type=”boolean”>true</enable_3d>
      <monitor>
        <display>
          <max_hsync config:type=”integer”>48</max_hsync>
          <max_vsync config:type=”integer”>90</max_vsync>
          <min_hsync config:type=”integer”>30</min_hsync>
          <min_vsync config:type=”integer”>50</min_vsync>
        </display>
        <monitor_device>DT-1536A</monitor_device>
        <monitor_vendor>DAYTEK</monitor_vendor>
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      </monitor>
      <resolution>1024x768</resolution>
      <start_x11 config:type=”boolean”>true</start_x11>
      <window_manager>gnome</window_manager>
    </x11>
...
</configure>

C.3.11  Users
The root user and at least one regular user can be added during install using data supplied in the 
control file. User data and passwords (encrypted or in clear text) are part of the configure resource in 
the control file.

At minimum, the root user should be configured during autoinstallation, which ensures that you can 
to log in after installation is finished and that nobody else can log in to the system (in case the 
password is not set).

The two users in the following example are added during system configuration.
<configure>
...
    <users config:type=”list”>
      <user>
        <username>root</username>
        <user_password>password</user_password>
        <encrypted config:type=”boolean”>true</encrypted>
        <forename/>
        <surname/>
      </user>
      <user>
        <username>nashif</username>
        <user_password>password</user_password>
        <encrypted config:type=”boolean”>true</encrypted>
        <forename>Anas</forename>
        <surname>Nashif</surname>
      </user>
    </users>
...
</configure>

This example shows the minimal information required for adding users. More options are available 
for a more customized user account management. The data in /etc/default/useradd is used 
to determine the home directory of the user to be created, in addition to other parameters.

C.3.12  Customer User Scripts
By adding scripts to the auto-installation process, you can customize the installation for your needs 
and take control in different stages of the installation.

In the auto-installation process, three types of scripts can be executed:

Pre-install scripts 
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Executed before YaST2 makes any real change to the system (before partitioning and package 
installation). 
Pre-install scripts with confirmation (pre-scripts) are executed at an early stage of the 
installation. This means that if you have requested to confirm the installation, the pre-scripts 
are executed before the confirmation screen shows up (profile/install/general/mode/confirm).

Post-Install Scripts 
These scripts are executed after YaST2 has completed the installation and it has booted the 
system for the first time.

Chroot environment post-install scripts 
Chroot scripts are executed after all packages have been installed, before YaST2 boots for the 
first time, and before the boot loader is installed. Although the name of this type of scripts 
might imply that the scripts are executed in the chroot environment, the scripts are actually 
executed in the system before it is mounted. To make any changes to the system, the /mnt 
prefix has to be used with any paths.
It is also possible to run the chroot scripts in the installed system by adding the boolean 
chrooted element.

It is possible to have scripts outside of the control file. The location of the control file can be 
specified using a URL similar to the syntax used for referencing the location of the control file. The 
location of the external script should be specified using the location element.

When manually added to the control file, scripts must be included in a CDATA element to avoid 
confusion with the file syntax and other tags defined in the control file.
    <?xml version=”1.0”?>
<!DOCTYPE profile SYSTEM “/usr/share/autoinstall/dtd/profile.dtd”>
<profile xmlns=”http://www.mycompany.com/1.0/yast2ns” 
xmlns:config=”http://www.mycompany.com/1.0/configns”>
  <configure>
    <scripts>
      <chroot-scripts config:type=”list”>
        <script>
          <chrooted config:type=”boolean”>true</chrooted>
          <filename>chroot.sh</filename>
          <interpreter>shell</interpreter>
          <source><![CDATA[
#!/bin/sh
echo “Testing chroot (chrooted) scripts”
ls
]]>
          </source>
        </script>
        <script>
          <filename>chroot.sh</filename>
          <interpreter>shell</interpreter>
          <source><![CDATA[
#!/bin/sh
echo “Testing chroot scripts”
df
cd /mnt
ls
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]]>
          </source>
        </script>
      /chroot-scripts>
      <post-scripts config:type=”list”>
        <script>
          <filename>post.sh</filename>
          <interpreter>shell</interpreter>
          <source><![CDATA[
#!/bin/sh
echo “Running Post-install script”
/etc/init.d/portmap start
mount -a 192.168.1.1:/local /mnt
cp /mnt/test.sh /tmp
umount /mnt
]]>
        </source>
        </script>
        <script>
          <filename>post.pl</filename>
          <interpreter>perl</interpreter>
          <source><![CDATA[
#!/usr/bin/perl
print “Running Post-install script”;
]]>
          </source>
        </script>
      </post-scripts>
      <pre-scripts config:type=”list”>
        <script>
          <interpreter>shell</interpreter>
          <location>http://192.168.1.1/profiles/scripts/prescripts.sh</
            location>
        </script>
        <script>
          <filename>pre.sh</filename>
          <interpreter>shell</interpreter>
          <source><![CDATA[
#!/bin/sh
echo “Running pre-install script”
]]>
          </source>
        </script>
      </pre-scripts>
    </scripts>
  </configure>
</profile>

After the installation is finished, the scripts and the output logs can be found in the /var/adm/
autoinstall directory. The scripts are located in the scripts directory and the output logs of the 
scripts are located in the log directory.

The log is the output resulting from executing the shell scripts using the following command:
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/bin/sh -x script_name 2&> /var/adm/autoinstall/logs/script_name.log

C.3.13  System Variables (sysconfig)
Use the sysconfig resource to define configuration variables in the sysconfig repository (/etc/
sysconfig) directly. The sysconfig variables let you fine-tune many system components and 
environment variables exactly to your needs.

The following example shows how a variable can be set using the sysconfig resource.
<sysconfig config:type=”list” >
  <sysconfig_entry>
    <sysconfig_key>XNTPD_INITIAL_NTPDATE</sysconfig_key>
    <sysconfig_path>/etc/sysconfig/xntp</sysconfig_path>
    <sysconfig_value>ntp.host.com</sysconfig_value>
  </sysconfig_entry>
  <sysconfig_entry>
    <sysconfig_key>HTTP_PROXY</sysconfig_key>
    <sysconfig_path>/etc/sysconfig/proxy</sysconfig_path>
    <sysconfig_value>proxy.host.com:3128</sysconfig_value>
  </sysconfig_entry>
  <sysconfig_entry>
    <sysconfig_key>FTP_PROXY</sysconfig_key>
    <sysconfig_path>/etc/sysconfig/proxy</sysconfig_path>
    <sysconfig_value>proxy.host.com:3128</sysconfig_value>
  </sysconfig_entry>
</sysconfig>

Both relative and absolute paths can be provided. If no absolute path is given, it is treated as a 
sysconfig file in the /etc/sysconfig directory.

C.3.14  Adding Complete Configurations
For many applications and services, you can prepared a configuration file which should be copied in 
a complete form to some location in the installed system—for example, if you are installing a Web 
server and have a ready-to-go server configuration file (httpd.conf).

Using this resource, you can embed the file into the control file by specifying the final path on the 
installed system. YaST2 copies this file to the specified location.
  <files config:type="list">
      <config_file>
        <file_path>/etc/httpd/httpd.conf</file_path>
        <file_contents>
<![CDATA[
some content
]]>
        </file_contents>
      </config_file>
    </files>

A more advanced example is shown below. This configuration creates a file using the content 
supplied in file_contents and changes the permissions and ownership of the file. After the file has 
been copied to the system, a script is executed which can be used to manipulate the file and prepare 
it for the environment of the client.
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  <files config:type="list">
      <config_file>
        <file_path>/etc/someconf.conf</file_path>
        <file_contents>
<![CDATA[
some content
]]>
        </file_contents>
         <file_owner>nashif.users</file_owner>
         <file_permissions>444</file_permissions>
         <file_script>
           <interpreter>shell</interpreter>
           <source>
<![CDATA[
#!/bin/sh
echo "Testing file scripts" >> /etc/someconf.conf
df
cd /mnt
ls
]]>
           </source>
         </file_script>
       </config_file>
     </files>

C.3.15  Miscellaneous Hardware and System Components
In addition to the core component configuration, like network authentication and security, 
AutoYaST2 offers a wide range of hardware and system configuration available by default on any 
system installed manually and in an interactive way. For example, it is possible to configure 
printers, sound devices, TV cards, and any other hardware components that have a module within 
YaST2.

Any new configuration options added to YaST2 are automatically available as an auto-installation 
resource.

Printer

Although printer configuration, like other configurations, can be done manually, we recommend 
using the Configuration System to create a printer configuration because of the complexity and the 
range of options offered by the modules.

Using the Configuration System guarantees that the options provided are consistent. The following 
is an example of a printer configuration section created using the Configuration System.
  <configure>
....
    <printer>
      <default>lp</default>
      <printcap config:type="list">
        <printcap_entry>
          <cups-state>void</cups-state>
          <ff config:type="boolean">true</ff>
          <info></info>
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          <location></location>
          <lprng-state>changed</lprng-state>
          <name>lp</name>
          <options>
            <job-sheets>none,none</job-sheets>
          </options>
          <raw config:type="boolean">true</raw>
          <type>yast2</type>
          <uri>parallel:/dev/lp0</uri>
        </printcap_entry>
      </printcap>
    </printer>
....
  </configure>

Sound Devices

The following is an example of sound device configuration created using the Configuration System.
  <configure>
....
    <sound>
      <autoinstall config:type="boolean">true</autoinstall>
      <modules_conf config:type="list">
        <module_conf>
          <alias>snd-card-0</alias>
          <model>M5451, ALI</model>
          <module>snd-ali5451</module>
          <options>
            <snd_enable>1</snd_enable>
            <snd_index>0</snd_index>
            <snd_pcm_channels>32</snd_pcm_channels>
          </options>
        </module_conf>
      </modules_conf>
      <volume_settings config:type="list">
        <listentry>
          <Master config:type="integer">75</Master>
        </listentry>
      </volume_settings>
    </sound>
....
  </configure>

C.4  Network-Based Installation
The installation method using AutoYaST provides a way to automatically and identically install 
groups of systems. The first step when preparing AutoYaST installations is deciding how you want 
the systems at your site to be installed. For example, the following scenario would be ideal to set up 
and perform automated installations:

You need to install Novell Linux Desktop on 50 new systems.
The development department owns 30 out of the 50 new dual processor and SCSI systems, and 
its systems must be installed as clients with development software.
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The sales department owns 20 out of the 50 new uniprocessor IDE-based systems, and its 
systems must be installed as clients with end user software and office tools.

Prerequisites

A boot server on the same Ethernet segment
An install server holding the NLD installation sources
An AutoYaST configuration server that defines rules and profiles

C.4.1  Configuration Server
A configuration repository holds the control files for multiple machines. The control files can have 
any filenames, which have to be specified at the boot time of a client. To avoid supplying the profile 
name for every client, you can define only the directory of the control files. If a directory is 
specified, then the client tries to load a file with a name matching its IP address in HEX mode. This 
gives you the advantage of dealing with consistent filenames rather than IPs as filenames, which 
might lead to some confusion.

The configuration repository is the same directory you have to define if you are using the 
configuration system for creating control files.

HTTP Repository

To be able to use the HTTP protocol to retrieve control file while auto-installing, you need a 
working HTTP server on the server side. Install Apache or your favorite Web server and enable it 
using YaST2. Normally, the Web server root directory resides in /srv/www/htdocs, so you 
need to create a subdirectory below the root directory of the Web server which will be your 
configuration repository.

NFS Repository

Create a directory and make it available via NFS to the clients by exporting it. This directory could 
be in the same place where you have copied the CDs (for example, /usr/local/NLD).

TFTP Repository

By default, the TFTP directory is available under /tftpboot, which can also contain boot images 
if you are booting over the network. Don't forget to enable TFTP in the Inetd configuration file 
(/etc/inetd.conf). Inetd configuration can be done using YaST2.

C.5  Rules and Classes
For a more granular auto-installation, you need some means to control the configuration of different 
types of hardware and different kinds of use scenarios. AutoYaST makes use of classes and rules for 
this.

C.5.1  Rule-Based Auto-installation
Rules let you configure a system depending on system attributes by merging multiple control files 
during installation. The rules-based installation is controlled by a rules file.
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The rules file is an XML-based file that contains rules for each group of systems (or single systems) 
that you want to automatically install. A set of rules distinguishes a group of systems based on one 
or more system attributes. After passing all rules, it links each group of rules to a profile. Both the 
rules file and the profiles must be located in a predefined and accessible location.

The rules file is retrieved even if a specific control is supplied using the autoyast keyword. For 
example, if the following is used, the rules file is still evaluated:
autoyast=http://10.10.0.1/profile/test.xml

Figure C-3   Rules

If more than one rule applies, the final profile for each group is generated using a merge script. The 
merging process is based on the order of the rules, and later rules override configuration data in 
earlier rules.

The use of a rules file is optional. If the rules file is not found, system installation proceeds in the 
usual way by just using the supplied profile or by searching for the profile, depending on the MAC 
or the IP address of the system.

Rules File Examples

The following example illustrates how the rules file is used to retrieve the configuration for a client 
with known hardware.
<?xml version=”1.0”?>
<!DOCTYPE autoinstall SYSTEM “/usr/share/autoinstall/dtd/rules.dtd”>

AutoYaST Directory

Print Server

Engineering Computers

Sales Computers

Eng. profile

Sales profile

Print Server
profile

Rule 3
Rule 2
Rule 1

Merge
process
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<autoinstall xmlns=”http://www.suse.com/1.0/YaSTns” 
xmlns:config=”http://
      www.suse.com/1.0 configns”>
  <rules config:type=”list”>
    <rule>
      <disksize>
        <match>/dev/hdc 1000</match>
        <match_type>greater</match_type>
      </disksize>
      <result>
        <profile>machine1.xml</profile>
        <continue config:type=”boolean”>false</continue>
      </result>
    </rule>
    <rule>
      <disksize>
        <match>/dev/hda 1000</match>
        <match_type>greater</match_type>
      </disksize>
      <result>
        <profile>machine2.xml</profile>
        <continue config:type=”boolean”>false</continue>
      </result>
    </rule>
   </rules>
</autoinstall>

This example defines two rules and provides a different profile for each one. The rule used in this 
case is disksize. After parsing the rules file, YaST2 attempts to match the system being installed 
to the rules in the rules.xml file in the order of first rule through the last rule. A rule match 
occurs when the system being installed matches all of the system attributes defined in the rule. As 
soon as a system matches a rule, the result resource is added to the stack of profiles AutoYaST uses 
to create the final profile. The continue property tells AutoYaST if it should continue with other 
rules or not after a match has been found.

If the first rule does not match, each subsequent rule in the list is examined until a match is found.

Using the disksize attribute, you can provide different configurations for different hard drives 
with different sizes. The first rule checks if the /dev/hdc device is available and if it is greater 
than 1 GB in size using the match property.

A rule must have at least one attribute to be matched. If you need to check more attributes (for 
example, memory or architectures), you can add more attributes in the rule resource, as 
shown in the next example. It illustrates how the rules file is used to retrieve the configuration for a 
client with known hardware.
<?xml version=”1.0”?>
<!DOCTYPE autoinstall SYSTEM “/usr/share/autoinstall/dtd/rules.dtd”>
<autoinstall xmlns=”http://www.suse.com/1.0/YaSTns” 
xmlns:config=”http://
   www.suse.com/1.0/configns”>
  <rules config:type=”list”>
    <rule>
      <disksize>
        <match>/dev/hdc 1000</match>
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        <match_type>greater</match_type>
      </disksize>
      <memsize>
        <match>1000</match>
        <match_type>greater</match_type>
      </memsize>
      <result>
        <profile>machine1.xml</profile>
        <continue config:type=”boolean”>false</continue>
      </result>
    </rule>
    <rule>
      <disksize>
        <match>/dev/hda 1000</match>
        <match_type>greater</match_type>
      </disksize>
      <memsize>
        <match>256</match>
        <match_type>greater</match_type>
      </memsize>
      <result>
        <profile>machine2.xml</profile>
        <continue config:type=”boolean”>false</continue>
      </result>
    </rule>
  </rules>
</autoinstall>

The rules directory must be located in the same referenced directory used with the autoyast keyword 
at boot time, so that if the client is booted using autoyast=http://10.10.0.1/profiles/
, then AutoYaST searches for the rules file in http://10.10.0.1/profiles/rules/
rules.xml.

Rules File Structure

The rules.xml file must

Have at least one rule.
Be named rules.xml.
Be located in the rules directory in the profile repository.
Have at least one attribute for matching.

Predefined System Attributes

The following table lists the predefined system attributes you can match in the rules file.

Table C-3   Predefined System Attributes

Attribute Values Description

hostaddress IP address of host. Exact match required.
Automatic Linux Installation and Configuration Using AutoYaST 239



240 Novell Linux

novdocx (E
N

U
)  10 A

ugust 2006
C.5.2  Classes
You can assign a system to different classes that can be defined in the control file. Unlike rules, 
classes must be configured in the control file and represent a configuration which is typical for a 
group of systems.Using the configuration management system, you can define a set of classes. The 
class definition consists of the following variable for each class:

domain Domain name of host. Exact match required.

network Network address of host. Exact match required.

mac MAC address of host. Exact match required. MAC addresses to 
be matched should be in the form 
0080C8F6484C.

linux Number of installed Linux partitions 
on the system.

This attribute can be 0 or greater.

others Number of installed non-Linux 
partitions on the system.

This attribute can be 0 or greater.

xserver X Server needed for graphic 
adapter.

This attribute must always match exactly.

memsize Memory available on host (in MB). All match types are available.

totaldisk Total disk space available on host 
(in MB).

All match types are available.

haspcmica System has PCMCIA (for example, 
Laptops).

Exact match required: 1 for available 
PCMCIA or 0 for none.

hostid Hex representation of IP address. Exact match required.

arch Architecture of host. Exact match required.

karch Kernel Architecture of host (for 
example, SMP kernel, Athlon 
Kernel). 

Exact match required.

disksize Drive device and size. All match types are available.

product The hardware product name as 
specified in SMBIOS.

Exact match required.

product_vendor The hardware vendor as specified 
in SMBIOS.

Exact match required.

board The system board name as 
specified in SMBIOS.

Exact match required.

board_vendor The system board vendor as 
specified in SMBIOS.

Exact match required.

custom1-5 Custom rules using shell scripts. All match types are available.

Attribute Values Description
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Table C-4   Class Definition Variables

Figure C-4   Defining Classes

You can create as many classes as you need; however, we recommend keeping the set of classes as 
small as possible to keep the configuration system concise. As an example, the following set of 
classes can be used:

Table C-5   Classes

Variable Description

Name Class name.

Descriptions Class description.

Order Order (or priority) of the class in the stack of migration.

Class Description

site Physical location or site.

machine Type or make of machine.

role Function of the machine to be installed.

group Department or group within a site or location.
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A file saved in a class directory can have the same syntax and format as a regular control file but 
represent a subset of the configuration. For example, to create a new control file for a special 
computer with a specific network interface, only the resource in the control file which controls the 
configuration of the network is needed. Having multiple network types, you can merge the one 
needed for a special type of hardware with other class files and create a new control file which suits 
the system being installed.

C.5.3  Mixing Rules and Classes
It is possible to mix rules and classes during an auto-installation session. For example, you can 
identify a system using rules that contain class definitions in them. The process is described in 
“Handling Rules” on page 251.

After retrieving the rules and merging them, the generated control file is parsed and the presence of 
class definitions is checked. If classes are defined, then the class files are retrieved from the original 
repository and a new merge process is initiated.

C.6  The Auto-installation Process
After the system has booted and the control file has been retrieved, YaST2 performs configuration 
of the system according to the information provided in the control file. All the configuration is 
summarized in a window that is shown by default and should be deactivated if a full automatic 
installation is needed.

When YaST2 has reached the point where the summary of the configuration is shown, it has only 
probed hardware and prepared the system for auto-installation, so nothing has been changed in the 
system yet. In case of any error, the process still can be aborted.

A system should be automatically installable without having any graphic adaptor or monitor. Having 
a monitor attached to the client machine is recommended, however, so you follow the process and 
also get feedback in case of errors. You can choose between the Qt and the Ncurses interfaces. For 
headless clients, system messages can be monitored using the serial console.

X11 Interface

This is the default interface while auto-installing. No special variables are required to activate it.

Serial Console

You can start installing a system using the serial console by adding the console keyword (that is, 
console=ttyS0) to the kernel command line. This will start linuxrc in console mode and, later in 
the process, YaST2 also starts in serial console mode.

Text-Based YaST2 Installation

This option can also be activated at the command line. It starts YaST2 in Ncurses mode. To start 
YaST2 in text mode, add textmode=1 on the command line.

Starting YaST2 in text mode is recommended when installing a client with less than 64 MB or when 
X11 is not being configured at all, especially on headless machines.
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C.6.1  Choosing the Right Boot Medium
There are different methods for booting the client. The computer can boot from its network interface 
card (NIC) to receive the boot images via DHCP/TFTP or a suitable kernel, and from an initrd 
image loaded from a floppy or a bootable CD-ROM.

Booting from a Floppy

For testing/rescue purposes, or because the NIC does not have a PROM or PXE, you can build a 
boot floppy to use with AutoYaST. Using a floppy to initiate an auto-install process is limited due to 
the amount of data a floppy can hold. However, it is still possible to use floppies when auto-
installing a single, disconnected machine.

Floppies can be used to store the control file, especially when using the original Novell Linux 
Desktop CD-ROMs for a single, disconnected machine. Using the kernel command line, you can 
specify the location of the control file on the floppy.

Even without specifying any command line options, it is still possible to initiate the auto-install 
process by placing a control file on a floppy with a special, predefined filename (autoinst.xml). 
YaST2 checks for autoinst.xml upon startup and, if it is found, the installation switches from 
interactive to automated.

Booting from CD-ROM

You can use the original Novell Linux Desktop CD-ROMs in combination with other media (for 
example, with a floppy) to hold the control file or in combination with a network where the control 
file is located.

It is also possible to create customized CD-ROMs to hold only the package you need in addition to 
the control file, which also can be saved on the CD-ROM. This method requires creation of CD-
ROMs every time you want to change the configuration.

C.6.2  Invoking the Auto-installation Process
This sections covers all aspects needed to successfully initiate the auto-installation process.

Command Line Options

Adding the autoyast command line variable makes linuxrc start in automated mode. linuxrc searches 
for a configuration file, which should be distinguished from the main control file in the following 
places:

Root directory of the initial RAM-disk used for booting the system
Root directory of the floppy

The configuration file used by linuxrc can have the keywords in the following table. For a detailed 
description of how linuxrc works and other keywords, see “Advanced linuxrc Options” on page 251.
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Table C-6   linuxrc Configuration File Keywords

These variables and keywords will bring the system up to the point where YaST2 can take over with 
the main control file. Currently, the source medium is automatically discovered, which in some 
cases makes it possible to initiate the auto-install process without giving any instructions to linuxrc.

The traditional linuxrc configuration file (info) should be used only in the preparation phase. It 
gives the client enough information about the installation server and the location of the sources. In 
most cases, this file is not needed. It is needed, however, in special network environments where 
DHCP or BOOTP is not used or when special kernel modules must be loaded.

All linuxrc keywords can be passed to linuxrc using the kernel command line. The command line 
can also be set when creating network bootable images or it can be passed to the kernel using a 
specially configured DHCP server in combination with Etherboot or PXE.

The format of the special autoyast command line variable can be used as described in the following 
table:

Table C-7   AutoYaST Command Line Variables

Keyword Value

netdevice Network device to use for network setup (device used for BOOTP / 
DHCP requests).

server Server to contact for the source directory (NFS Server).

serverdir Directory on NFS Server.

hostip When empty, client sends BOOTP request; otherwise, client is 
configured with entered IP configuration.

netmask Netmask.

gateway Gateway.

nameserver Nameserver.

insmod Kernel modules to load.

autoyast Location of the control file to be used for the automatic installation. For 
example, autoyast=http://192.168.2.1/profiles/.

install Location of the installation directory. For example, install=nfs://
192.168.2.1/CDs/.

instmode Installation mode (nfs, http, etc.). Not needed if install is set.

Command Line Variable Description

autoyast=default Default auto-installation option.

autoyast=file://<path> Looks for the control file in specified path relative 
to source root directory (for example, file:///
autoinst.xml if in the top directory of a CD-
ROM).
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Several scenarios for auto-installation are possible using different types of infrastructure and source 
media. The simplest way is by using the source media from the Novell Linux Desktop box. In that 
case, you have either a DVD with all Novell Linux Desktop packages or a set of CD-ROMs. To 
initiate the auto-installation process, however, the auto-installation command line variable should be 
entered at system bootup and the control file should be accessible to YaST2. The following list of 
scenarios explains how the control file can be supplied, as well as the setup needed for the auto-
installation process to be successful.

Using Novell Linux Desktop original CD-ROMs from the Novell Linux Desktop box.

To use the original CD-ROMs, you need a medium with the control file. The control file can 
reside in the following places:

Floppy: Accessible via the autoyast=floppy option. YaST2 also searches upon 
startup for a file named autoinst.xml. If such a file is found, YaST2 switches into auto-
installation mode even if no special command line variables are supplied. (See “Auto-
installing a Single System” on page 246 for more information.)
Network: Accessible via the autoyast=nfs://.., autoyast=ftp://.., 
autoyast=http://.., or autoyast=tftp://.. options.

Using self-made CD-ROMs.
In this case, you can include the control file on the CD-ROM for easy access (using the 
autoyast=file:// option), or use one of the above-mentioned methods used with the 
original Novell Linux Desktop CD-ROMs.
When using CD-ROMs for auto-installation, you must instruct the installer to use the CD-ROM 
for installation and to not try to find the installation files on the network. This can be 
accomplished by adding the instmode=cd option to the kernel command line (which can be 
done by adding the option to the isolinux.cfg file on the CD).
Using NFS and floppy, network, or CD-ROM for system boot-up.
This option is the most important one due to the fact that installations of PC farms are normally 
done using NFS servers and other network services like BOOTP/DHCP. The control file can 
reside in the following places:

Floppy/CD-ROM: Accessible via the autoyast=file://.. option.
Network: Accessible via the autoyast=http://.., autoyast=ftp://.., 
autoyast=nfs://.., or autoyast=tftp://.. options.

autoyast=device://<device>/<file> Looks for the control file on a storage device. 
Need only the device name without full path (for 
example, sda1 not /dev/sda1).

autoyast=floppy://<path> Looks for the control file on the floppy (useful 
when booting from CD).

autoyast=nfs://<server>/<path> Looks for the control file on <server>.

autoyast=http://<server>/<path> Retrieves the control file from a Web server using 
the HTTP protocol.

autoyast=tftp://<server>/<path> Retrieves the control file using TFTP.

autoyast=ftp://<server>/<path> Retrieves the control file using FTP.

Command Line Variable Description
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Disabling Network and DHCP

To disable the network during installations where it is not needed or not available (for example, 
when auto-installing from CD-ROMs), use the linuxrc netsetup option to set network configuration 
behavior. To disable network setup, use netsetup=0. If autoyast=default is defined, 
YaST2 looks for a file named autoinst.xml in the following places:

Root directory of the floppy disk
Root directory of the installation medium
Root directory of the initial RAM disk used to boot the system

With all autoyast invocation options, excluding default, it is possible to specify the location of the 
control file in the following ways:

Specify the exact location of the control file:
autoyast=http://192.168.1.1/control-files/client01.xml

Specify a directory where several control files are located:
autoyast=http://192.168.1.1/control-files/

In this case, the relevant control file is retrieved using the hex digit representation of the IP as 
described below.

If only the path prefix variable is defined, YaST2 retrieves the control file from the specified 
location in the following way:

1. First, it searches for the control file using its own IP address in uppercase hexadecimal (for 
example, 192.0.2.91 -> C000025B).

2. If that file is not found, it removes one hex digit and tries again. This action is repeated until the 
file with the correct name is found. Ultimately, it tries looking for a file with the MAC address 
of the clients as the filename (MAC should have the following syntax: 0080C8F6484C) and, 
if not found, a file named default (in lower case).
For example, for 192.0.2.91, the HTTP client tries the following in the order given:
C000025B
C000025
C00002
C0000
C000
C00
C0
C
0080C8F6484C
default

To determine the hex representation of the IP address of the client, use the /usr/sbin/
gethostip utility, available with the syslinux package:
# /usr/sbin/gethostip 10.10.0.1
10.10.0.1 10.10.0.1 0A0A0001

Auto-installing a Single System

The easiest way to auto-install a system without any network connection is by using the standard 
CD-ROMs that come in the Novell Linux Desktop box. Using the CD-ROMs in combination with a 
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floppy disk makes getting started with AutoYaST very fast and without spending much time 
configuring installation servers and network environments.

Create the control file and name it autoinst.xml. Copy autoinst.xml to a floppy by either mounting 
the floppy or by using the mtools.
mcopy autoinst.xml a:

Combining the linuxrc info File with the YaST2 Control File

If you choose to pass information to linuxrc using the info file, it is possible to integrate the 
keywords in the XML control file. In this case, the file has to be accessible to linuxrc and has to be 
named info.

Linuxrc will look for a string (start_linuxrc_conf) in the control file which represents the 
beginning of the file. If it is found, it parses the content starting from that string and finishes when 
the string end_linuxrc_conf is found. The options are stored in the control file in the following 
way:
....
  <install>
....
    <init>
      <info_file>
<![CDATA[
##
Don’t remove the following line:
# start_linuxrc_conf
#
install: nfs://192.168.1.1/CDs/full-i386
textmode: 1
autoyast: file:///info
# end_linuxrc_conf
# Do not remove the above comment
#
]]>
      </info_file>
    </init>
......

</install> ....

Note that the autoyast keyword must point to the same file. If it is on a floppy, then the protocol 
floppy has to be used. In other cases where the info file is stored in the initial RAM disk, the file 
option has to be used.

C.6.3  System Configuration
The system configuration during auto-installation can be viewed as the most important part of the 
whole process. Customizing a system to your environmental needs is what makes an auto-
installation system attractive, not the installation part.

Anything can be configured automatically on the target system. In addition to the predefined 
directives, you can always use post-scripts to change other things in the system. Additionally, you 
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can change any system variables and, if required, copy complete configuration files into the target 
system.

Post-Install and System Configuration

The Post-Installation and the System Configuration are initiated directly after the last package is 
installed in the target system, and they are continued after the system has booted for the first time.

Before the system is booted for the first time, YaST2 writes all data collected during installation into 
the system, then it writes the boot loader in the specified location. In addition to these regular tasks, 
which are also done when performing a regular installation, YaST2 executes the chroot-scripts as 
specified in the control file. Note that these scripts are executed while the system is still not 
mounted.

If a different kernel than the default is installed, a hard reboot is required. A hard reboot can also be 
forced during auto-installation, independent of the installed kernel. This can be accomplished using 
the reboot property of the general resource. See “General Options” on page 202 for more 
information.

System Customization

Most of the system customization is done in the second stage of the installation. YaST2 provides 
most of the important resources needed to bring up a system to a usable, general state. However, you 
might have other requirements for the installed system. If the required customizations can’t be done 
using YaST2 resources, then the post-install scripts can be used to accomplish this task.

You can define an unlimited number of custom scripts in the control file either by editing the file or 
by using the configuration system.

C.7  Legacy and Foreign Configuration Formats
While it is possible to migrate from SUSE’s former auto-installation tool ALICE or Red Hat’s 
Kicstart to AutoYaST to some degree, there are drawbacks to these approaches. 

C.7.1  Migration from YaST2 and ALICE
ALICE, a former SUSE auto-installation system, was built around the auto-installation features that 
were available with YaST1. To use existing ALICE configuration files and resources, a special 
option provided in the configuration system lets you convert ALICE configuration files into a 
control file readable by AutoYaST.

ALICE uses YaST1 for the installation of a Linux system. This is done by creating a boot medium 
with the needed control file (info) from a set of configuration files maintained in a CVS repository. 
The info file has the traditional format used with YaST1.

The system configuration is done almost entirely after the system is installed and is initiated using 
the %post section of the ALICE RPM package.

ALICE Modules

Each ALICE module performs certain tasks and requires one or more configuration files. The 
modules are shell scripts that are invoked after the installation of the machine to set up different 
services on the client.
 Desktop 9 Deployment Guide



novdocx (E
N

U
)  10 A

ugust 2006
YaST offers an extensive and rich interface to the installed system that replaces most of the modules 
that were available with ALICE.

The prepare_alice and make_all modules provided the base and main scripts of all 
ALICE modules. The prepare_alice module is called right after the initial installation 
process, which is done after YaST1 has finished installation packages.
With YaST2, the alternative to these modules is part of the system and is not an addition or 
extension. This means that YaST2 configures the system in a single process and not in two 
different steps.

The following table shows how the results of some ALICE modules can be accomplished with 
YaST2:

Table C-8   ALICE Modules Results Using YaST2

Other Configuration Options with YaST2 and ALICE

ALICE completed most of the configuration using the /etc/rc.config system configuration 
file. This interface to the system does not exist anymore with Novell Linux Desktop. Instead, 
configuration options are now available in /etc/sysconfig.

Entries in /etc/sysconfig can easily be set and modified using YaST2 and AutoYaST. For network 
services, we recommend using the relevant YaST2 modules dealing with networking, rather than 
modifying /etc/sysconfig/network directly.

Module ALICE Result YaST Method Relevant File

User configuration Adding users is performed 
without any consistency 
checks.

Using YaST2 users 
module.

/etc/passwd

Group configuration Adding groups is 
performed without any 
consistency checks.

Using YaST2 users 
module.

/etc/group

Services X – /etc/services

Inetd X Using the inetd module. /etc/inetd.conf

Syslog X – /etc/syslog.conf 

Lilo X X /etc/lilo.conf

SNMP X – /etc/ucdsmpd.conf

Cron X – /etc/crontab

hosts X X /etc/hosts

Routing X X /etc/route.conf

Printer X X /etc/printcap

SSH X – /etc/ssh

Kernel modules X X /etc/
modules.conf
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C.7.2  Red Hat Kickstart
The Configuration Management System offers an option for importing a foreign auto-installation 
configuration file using the Kickstart system. To import a Kickstart file, you need to specify the path 
of the configuration file and decide how to handle the data either by saving the result to a file 
directly or by loading the resulting AutoYaST compatible control file into the Configuration 
Management System. The following sections describe some limitations and issues to consider when 
importing from a foreign source.

Software Selections and Packages

It is currently not possible to import package selections and single package listings into AutoYaST. 
The packages can be added to the control file, but manual selection of the desired packages is 
needed. This is because package groups and package names might differ depending on the source 
distribution.

User Scripts

Kickstart offers two types of scripts, pre- and post-scripts. More than these two types of scripts are 
not supported as they are in AutoYaST. You might need to split large scripts into smaller 
components, depending on the function, to make such scripts manageable.
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C.8  Handling Rules
The following figure illustrates how rules are handled and the process of retrieval and merge.

Figure C-5   Rules Retrieval Process

C.9  Advanced linuxrc Options
The linuxrc program is used for setting up the kernel for installation purposes. It lets you load 
modules or start an installed system, a rescue system, or an installation via YaST. It is designed to be 
as small as possible, so all needed programs are linked directly into one binary. There is no need for 
shared libraries in the initdisk.

Start/Stop

$DIR/rules/
rules.xml

exists?

YES

Parse Command line

NO

Retrieve and process

File or Dir?

Dir

FileCreate rule for file

Create rules for hex
and mac files

Retrieve
Files

Create rules for hex
and mac files

Create rules for hex
and mac files
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NOTE: If you run linuxrc on an installed system, it works slightly differently as it tries to not 
destroy your installation. As a consequence, you cannot test all features this way.

C.9.1  Passing Parameters to linuxrc
Unless linuxrc is in manual mode, it looks first for /info on the floppy disk. If that does not exist, 
it looks for /info in the initrd. After that, it parses the kernel command line for parameters. You 
can change the info file that linuxrc reads using the info command line parameter. If you don’t want 
linuxrc to read the kernel command line (for example, because you need to give a kernel parameter 
that accidentally is recognized by linuxrc, too), use linuxrc=nocmdline.

linuxrc always looks for and parses the /linuxrc.config file. You can use this file to change 
default values if you need to, but in general, use the info file instead. The /linuxrc.config file 
is read before any info file, even in manual mode.

C.9.2  The info File Format
Lines starting with # are comments. Valid entries are of the form key: value.

Note that value extends to the end of the line and so might contain spaces. key is matched case 
insensitive.You can use the same key/value pairs on the kernel command line using the syntax 
key=value. Lines that don’t have the form described above are ignored.

Valid keys are listed in the following table. The values given are only examples.

Table C-9   Valid Keys for the info File

Keyword/Value Description

Language: en_EN Sets the language.

Keytable: en-lat1-nd Loads this keytable.

Display: Color|Mono|Alt Sets the menu color scheme.

Install: nfs://server/install/8.0-
i386

Installs via NFS from the server. You can also 
give username, password, etc., in the URL.

InstMode: cd|hd|nfs|smb|ftp|http|tftp Sets installation mode.

HostIP: 10.10.0.2 Client IP address.

Netmask: 255.255.0.0 Network mask.

Gateway: 10.10.0.1 Gateway.

Server: 10.10.0.1 Installation server address.

Nameserver: 10.10.0.1 Name server

Proxy: 10.10.0.1 Proxy (either FTP or HTTP).

ProxyPort: 10.10.0.1 Proxy port.

Partition: hda1 Partition with install sources for hard disk install.

Serverdir: /install/8.0-i386 Base directory of the installation sources.
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Netdevice: eth0 Network interface to use.

BOOTPWait: 5 Sleeps five seconds between network activation 
and starting bootp.

BOOTPTimeout: 10 10-second timeout for BOOTP requests.

DHCPTimeout: 60 60-second timeout for DHCP requests.

TFTPTimeout: 10 10-second timeout for TFTP connection.

ForceRootimage: 0|1 Loads the installation system into RAM disk.

Textmode: 0|1 Starts YaST in text mode.

Username: name Sets use name (for example, for FTP install).

Password: password Sets password (for example, for FTP install).

WorkDomain: domain Sets work domain for SMB install.

ForceInsmod: 0|1 Uses -f option when running insmod.

DHCP: 0|1 Starts DHCP daemon now, but sees UseDHCP.

UseDHCP: 0|1 Uses DHCP instead of BOOTP (DHCP is default).

MemLimit: 10000 Asks for swap if free memory drops below 10000 
KB.

MemYaST: 20000 Runs YaST in text mode if free memory is below 
20000 KB.

MemYaSTText: 10000 Asks for swap before starting YaST if free 
memory is below 10000 KB.

MemModules: 20000 Deletes all modules before starting YaST if free 
memory is below 20000 KB.

MemLoadImage: 50000 Loads installation system into ramdisk if free 
memory is above 50000 KB.

Manual: 0|1 Starts linuxrc in manual mode.

NoPCMCIA: 0|1 Doesn’t start card manager.

Domain: zap.en Sets domain name (used for name server 
lookups).

RootImage: /nld/images/root Installation system image.

RescueImage: /nld/images/rescue Rescue system image.

InstallDir: /nld/inst-sys Installation system.

Rescue: 1|nfs://server/dir Loads rescue system; the URL variant specifies 
the location of the rescue image explicitly.

AutoYaST: ftp://autoyastfile Location of autoinstall file; activates auto-install 
mode.

VNC: 0|1 Sets up VNC server.

Keyword/Value Description
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C.9.3  Advanced Network Setup
The netsetup keyword allows advanced network configurations and enables dialogs to set up the 
network where required.

netsetup=1 
The normal network setup questions.

netsetup=xxx,yyy  Just xxx and yyy.

netsetup=+xxx,-yyy  Additionally xxx, but not yyy

xxx could have the following values: dhcp, hostip, gateway, netmask, nameserver. nameserverN asks 
for N nameservers (4 maximum).

For example, the following can be entered at the command line:
netsetup=-dhcp,+nameserver3

VNCPassword: password Sets VNC server password.

UseSSH: 0|1 Sets up SSH server.

SSHPassword: password Sets SSH server password. This is not the final 
root password.

AddSwap: 0|3|/dev/hda5 If 0, never asks for swap.

If the argument is a positive number n, activates 
the nth swap partition.

If the argument is a partition name, activates this 
swap partition.

Exec: command Runs the command.

USBWait: 4 Waits four seconds after loading USB modules.

Insmod: module params Loads this module.

Loghost: 10.10.0.22 Enables remove logging via syslog.

Keyword/Value Description
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DPartitioning

This appendix discusses the following topics:

“Partition Types” on page 255
“Required Disk Space” on page 255
“Partitioning with YaST” on page 256
“Using the YaST Expert Partitioner” on page 257

D.1  Partition Types
Every hard disk has a partition table with space for four entries. An entry in the partition table can 
correspond to a primary partition or an extended partition. Only one extended partition entry is 
allowed, however.

A primary partition consists of a continuous range of cylinders (physical disk areas) assigned to a 
particular operating system. If you have only primary partitions, you are limited to four partitions 
per hard disk (because more will not fit in the partition table). This is why extended partitions are 
used. Extended partitions are also continuous ranges of disk cylinders, but an extended partition can 
be subdivided into logical partitions. Logical partitions do not require entries in the partition table. 
In other words, an extended partition is a container for logical partitions.

If you need more than four partitions, create an extended partition as soon as the fourth partition or 
earlier. This extended partition should span the entire remaining free cylinder range. Then create 
multiple logical partitions within the extended partition. The maximum number of logical partitions 
is 15 on SCSI disks and 59 on (E)IDE disks.

It does not matter which type of partitions are used for Linux. Primary and logical partitions both 
work fine.

D.2  Required Disk Space
YaST normally proposes a reasonable partitioning scheme with sufficient disk space. If you want to 
implement your own partitioning scheme, consider the following recommendations concerning the 
requirements for different system types.

Table D-1   Partitioning Recommendations

System Type Size Description

Minimal System 500 MB No graphical interface (X Window System) is installed, so only 
console applications can be used. Also, only a very basic selection 
of software is installed.

Minimal System 
with Graphical 
Interface

700 MB This includes the X Window System and some applications.
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Depending on the amount of space and how the computer will be used, adjust the distribution of the 
available disk space. These are some basic guidelines for partitioning:

Table D-2   Partitioning Guidelines

Depending on the hardware, it might also be useful to create a boot partition (/boot) to hold the 
boot mechanism and the Linux kernel. This partition should be located at the start of the disk and 
should be at least 8 MB or 1 cylinder. As a rule of thumb, always create such a partition if it was 
included in YaST’s original proposal. If you are unsure about this, create a boot partition to be on 
the safe side.

You should also be aware that some (mostly commercial) programs install their data in /opt. 
Therefore, you might want to create a separate partition for /opt or make the root partition larger.

D.3  Partitioning with YaST
When you select the partitioning item in the suggestion window for the first time, YaST displays a 
dialog listing the partition settings currently proposed. You can accept these current settings without 
change or change them before continuing. Or you can discard all the settings and start over from 
scratch.

Nothing in the partitioning setup is changed if you select Accept Suggested Partitioning Setup. If 
you select Change Suggested Partitioning Setup, the Expert Partitioner opens. The Expert 
Partitioner lets you configure the partition setup in great detail. This is explained in “Using the 
YaST Expert Partitioner” on page 257. The original setup as proposed by YaST is offered there as a 
starting point.

Selecting Create Custom Partitioning Setup opens the Preparing Hard Disk—Step 1 dialog. Use the 
list to select from the existing hard disks on your system. Novell Linux Desktop is installed on the 
disk selected here.

The next step is to determine whether to use entire disk (Use Entire Hard Disk) or to use any existing 
partitions (if available) for the installation. If a Windows operating system was installed on the disk, 
you might be asked to delete or resize the partition. Before doing so, read “Resizing a Windows 

Default System 1.5 GB This includes a modern desktop environment, like KDE or GNOME, 
and also provides enough space for large application suites like 
Netscape* or Mozilla.

Full Installation 4 GB All the packages included with Novell® Linux Desktop can be 
installed.

Disk Space Partitioning Guideline

Less than 4 GB One partition for the swap space and one root partition (/). In this case, the root 
partition must allow for those directories that often reside on their own partitions if 
more space is available.

4 GB or more A swap partition (1 GB or more), a root partition (2 to 4 GB), and one partition each for 
the following directories as needed: /usr (4 GB or more), /opt (4 GB or more), and 
/var (1 GB). The rest of the available space can be used for /home.

System Type Size Description
 Desktop 9 Deployment Guide



novdocx (E
N

U
)  10 A

ugust 2006
Partition” on page 259. If desired, go to the Expert Partitioner dialog to create a custom partition 
setup at this point (see “Creating a Partition” on page 258).

WARNING: If you select Use Entire Hard Disk, all existing data on that disk is completely erased 
later in the installation process and is then lost.

YaST checks during the installation to see if the disk space is sufficient for the software selection 
made. If not, YaST automatically removes parts from the software selection as needed. The 
suggestion window then includes a notice to inform you about this. As long as there is sufficient 
disk space available, YaST simply accepts your settings and partitions the hard disk accordingly.

D.4  Using the YaST Expert Partitioner
With the Expert Partitioner dialog in YaST, you can manually modify the partitioning of your hard 
disk. Partitions can be added, deleted, or edited.

Figure D-1   YaST Partitioner in Expert Mode

All existing or suggested partitions on all connected hard disks are displayed in the list. Entire hard 
disks are listed as devices without numbers, such as /dev/hda or /dev/sda. Partitions are listed 
as parts of these devices, such as /dev/hda1 or /dev/sda1. The size, type, file system, and 
mount point of the hard disks and their partitions are also displayed. The mount point describes 
where the partition is mounted in the Linux file system tree.

Any free hard disk space is also listed and automatically selected. To provide more disk space to 
Linux, free the needed space starting from the bottom toward the top of the list (starting from the last 
partition of a hard disk toward the first).
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D.4.1  Creating a Partition
1 Click Create in the Expert Partitioner dialog.
2 (Conditional) If several hard disks are connected and a selection dialog appears, select the hard 

disk for the new partition.
3 Specify the partition type (primary or extended).

You can create up to four primary partitions or up to three primary partitions and one extended 
partition. Within the extended partition, you can create several logical partitions (see “Partition 
Types” on page 255).

4 Select the file system you want to use to format the partition and a mount point, if necessary. 
YaST suggests a mount point for each partition created. The parameters are described in 
“Partitioning Parameters” on page 258.

5 Click OK to apply your changes.
The new partition is now listed in the partition table. 

6 Click Next to adopt the current values and return to the suggestion screen.

D.4.2  Partitioning Parameters
If you create a new partition or modify an existing partition, various parameters can be set in the 
partitioning tool. For new partitions, suitable parameters are set by YaST and usually do not require 
any modification. To perform manual settings, use the following procedure.

1 Select a partition, then click Edit.
2 Set the following parameters:

3 Click Next to activate the partition.

Parameter Description

File System ID Even if you do not want to format the partition at this stage, assign it a 
file system ID to ensure that the partition is registered correctly. 
Possible values include Linux, Linux swap, Linux LVM, or Linux RAID.

File System To format the partition immediately within the scope of the installation, 
specify one of the following file systems for the partition: Swap, Ext2, 
Ext3, ReiserFS, or JFS.

File System Options Sets various parameters for the selected file system.

Encrypt File System If you activate encryption, writes all data to the hard disk in an 
encrypted format.

fstab Options Specifies various parameters for the administration file of the file 
systems (/etc/fstab).

Mount Point Specifies the directory where the partition should be mounted in the file 
system tree. Various YaST suggestions can be expanded in the 
respective entry field. If you accept these suggestions, the default file 
system structure is implemented. You can also specify any other 
names.
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If you partition manually, create a swap partition. The swap partition is used to free the main 
memory of data that is not used at the present moment. This keeps the main memory free for the 
most frequently used important data.

D.4.3  Resizing a Windows Partition
If a hard disk containing a Windows FAT or NTFS partition was selected as the installation target, 
YaST offers to delete or shrink this partition. This way, you can install Novell Linux Desktop even 
if there is currently not enough space on the hard disk. This functionality is especially useful if the 
selected hard disk contains only one Windows partition that covers the entire hard disk. This is 
sometimes the case on computers where Windows comes preinstalled.

If YaST sees that there is not enough space on the selected hard disk, but that space could be made 
available by deleting or shrinking a Windows partition, it presents a dialog where you can choose 
one of these two options.

If you select Delete Windows Completely, the Windows partition is marked for deletion and the 
space is used for the installation of Novell Linux Desktop.

WARNING: If you delete Windows, all data will be lost beyond recovery as soon as the formatting 
starts.

To shrink the Windows partition, interrupt the installation and boot Windows to prepare the 
partition from there. Although this step is not strictly required for FAT partitions, it speeds up the 
resizing process and also makes it safer. These steps are vital for NTFS partitions.

Table D-3   Steps for NTFS Partitions

File 
System Steps to Perform

FAT In Windows, first run scandisk to make sure the FAT partition is free of lost file fragments 
and crosslinks. Then run defrag to move files to the beginning of the partition. This 
accelerates the resizing procedure in Linux.

If you have optimized virtual memory settings for Windows in such a way that a contiguous 
swap file is used with the same initial (minimum) and maximum size limit, consider 
disenabling these Windows optimizations for the time being and re-enabling them after the 
resizing has been completed. With these Windows settings, the resizing might split the 
swap file into many small parts scattered all over the FAT partition. Also, the entire swap file 
would need to be moved during the resizing, which makes the process rather slow.

NTFS In Windows, run scandisk and defrag to move the files to the beginning of the hard disk. 
In contrast to the FAT file system, you must perform these steps or the NTFS partition 
cannot be resized.

NOTE: If you operate your system with a permanent swap file on an NTFS file system, this 
file might be located at the end of the hard disk and remain there despite defrag, possibly 
making it impossible to shrink the partition sufficiently. In this case, temporarily deactivate 
the swap file (the virtual memory in Windows). After the partition has been resized, 
reconfigure the virtual memory.
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After these preparations, return to the Linux partitioning setup and select Shrink Windows Partition. 
After a quick check of the partition, YaST opens a dialog with a suggestion for resizing the 
Windows partition.The first bar graph shows how much disk space is currently occupied by 
Windows and how much space is still available. The second bar graph shows how the space would 
be distributed after the resizing, according to YaST’s current proposal.

Accept the proposed settings or use the slider to change the partition sizing (within certain limits). If 
you click Next, the settings are stored and you are returned to the previous dialog. The actual 
resizing takes place later, before the hard disk is formatted.

By default, Windows NT*, 2000, and XP use the NTFS file system. Unlike FAT file systems, NTFS 
file systems can be read (but not edited) from Linux. In other words, you can read your Windows 
files from Linux, but you cannot edit them. If you want write access to your Windows data and do 
not need the NTFS file system, install Windows on a FAT32 file system. This way, you can have 
full access to your Windows data from Novell Linux Desktop.
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EGNOME Configuration for 
Administrators

This appendix discusses the following topics:

“Using GConf for Defaults” on page 261
“Customizing Menus” on page 277
“Installing Themes” on page 283
“Configuring Fonts” on page 287
“MIME Types” on page 288
“Setting Screensavers” on page 294
“Session Management” on page 295
“Improving Performance” on page 295
“Hidden Directories” on page 301
“Security Note on Configuring SMB Printers” on page 302
“Disabling GNOME Desktop Features” on page 302

E.1  Using GConf for Defaults
GConf is a system for storing application preferences that simplifies the administration of user 
preferences. GConf lets system administrators do the following:

Set mandatory values for particular preferences for all users. This controls whether users can 
update particular preferences.
Set default values for particular preferences for all users. 
Use suggested values for preferences that are specified in definition files for the preferences.
Read documentation on each preference.

GConf also notifies applications when a preference value changes, locally or across a network. 
Therefore, when you change a preference, all applications that use the preference are immediately 
updated.

GConf provides a preferences database, similar to a simple file system. The file system contains 
keys organized into a hierarchy. Each key is either a directory containing more keys or it has a value. 
For example, the key /apps/metacity/general/titlebar_font contains an integer 
value giving the size of the titlebar font for the Metacity window manager.

GConf has the following components: 

“GConf Repository” on page 262
“GConf Daemon” on page 265
“GConf Command Line Tool” on page 265)
“Configuration Editor” on page 275
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E.1.1  GConf Repository
Each preference in the GConf repository is expressed as a key-value pair. A GConf preference key is 
an element in the repository that corresponds to an application preference. For example, the /
apps/gnome-session/options/show_splash_screen preference key corresponds to 
the Show Splash Screen on Login option in the Sessions preference tool. The GNOME Desktop user 
interface does not contain all of the preference keys in the GConf repository. For example, the Panel 
preference tool does not contain an option that corresponds to the /apps/panel/global/
tooltips_enabled key.

The repository is structured like a simple hierarchical file system. The repository contains the 
following:

Directories that correspond to applications that use the GConf repository. For example, the file 
system contains the directory /apps/metacity. 
Subdirectories that correspond to categories of preferences. For example, the file system 
contains the directory /apps/metacity/general.
Special files that list the preference keys in the directory and contain information about the 
keys. For example, a file that contains information about the keys that relate to the HTTP proxy 
preferences is in the directory /system/http_proxy. 
A /schemas directory that contains files that describe all of the preference keys.

Preference keys typically have simple values such as strings, integers, or lists of strings and integers. 
The format of the preference key in the repository depends on the backend module that is used to 
read the repository. The following is an example of the /desktop/gnome/interface/font_name 
preference key when an Extensible Markup Language (XML) backend module is used to read the 
repository:
<entry name=”font_name” mtime=”1038323555” muser=”user123” 
type=”string”>
<stringvalue>Sans 10</stringvalue>
</entry>

NOTE: When this guide refers to a preference key, the path to the key is added to the name of the 
key. For example, the font_name preference key in the /desktop/gnome/interface 
subdirectory is referred to as /desktop/gnome/interface/font_name.

GConf Configuration Sources

The GConf repository contains a series of storage locations that are called configuration sources. 
The configuration sources are listed in the /etc/opt/gnome/opt/gnome/gconf/
gconf-version-number/ path GConf path file. Each user has a path file. The path file 
specifies the following information for each configuration source:

Backend module to use to read the repository
Permissions on the repository
Location of the repository

The GConf path file also contains include instructions. By default, the contents of the GConf path 
file are as follows: 
xml:readonly:/etc/opt/gnome/opt/gnome/gconf/gconf.xml.mandatory
include /etc/opt/gnome/opt/gnome/gconf/2/local-mandatory.path
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include “$(HOME)/.gconf.path”
include /etc/opt/gnome/opt/gnome/gconf/2/local-defaults.path
xml:readwrite:$(HOME)/.gconf
xml:readonly:/etc/opt/gnome/opt/gnome/gconf/gconf.xml.defaults

When GConf searches for a preference value, it reads the configuration sources in the order 
specified in the path file. The following table describes the configuration sources in the path file:

Table E-1   Configuration Sources in the Path File

The sequence of the configuration sources in the path file ensures that mandatory preference settings 
override user preference settings. The sequence also ensures that user preference settings override 
default preference settings. That is, GConf applies preferences in the following order of priority:

1. Mandatory preferences
2. User-specified preferences
3. Default preferences

The include instructions in the GConf path file enable system administrators to specify other 
configuration sources:

Table E-2   Other Configuration Sources

GConf Schema

A GConf schema is a collective term for a GConf schema key and a GConf schema object. The 
following table describes schema keys and schema objects and their relationship to preference keys:

Configuration Source Description

Mandatory The permissions on this configuration source are set to Read Only. Users 
cannot overwrite the values in this source, so the preferences in the source 
are mandatory.

User This configuration source is stored in the .gconf directory in the home 
directory of the user. When the user sets a preference, the new preference 
information is added to this location. 

You can use the Configuration Editor to modify the user configuration 
source.

Default This configuration source contains the default preference settings.

Included Configuration Source Description

/etc/opt/gnome/opt/gnome/
gconf/2/local-mandatory.path

Stores mandatory preference values for a particular system.

$(HOME)/.gconf.path Specifies the location of the configuration source in the 
.gconf.path file in the user's home directory.

/etc/opt/gnome/opt/gnome/
gconf/2/local-defaults.path

Stores default preference values for a particular system.
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Table E-3   Schema Keys and Objects

The following are examples of a preference key, a schema key, and a schema object:

Table E-4   Preference Key, Schema Key, and Schema Object Examples

You can associate a schema key with a preference key. For example, the following /desktop/
gnome/interface/font_name key includes a schema key:
<entry name=”font_name” mtime=”1034873859” 
schema=”/schemas/desktop/gnome/interface/font_name”/>

When you associate a schema key with a preference key, the preference uses the suggested value 
that is specified in the schema object of the schema key. The suggested value is contained in the 
<default> element in the schema object. By default, all the preference keys in the default 
configuration source are associated with schema keys.

Typically, schemas are stored in the default configuration source. 

GConf Schema Definition Files

Schemas are generated from schema definition files. A schema definition file defines the 
characteristics of all of the keys in a particular application. Schema definition files have a .schemas 
extension.

The schema definition files are included in the /etc/opt/gnome/opt/gnome/gconf/
schemas directory. You can use the schema definition files to create a new configuration source.

Item Description

Preference key An element in the GConf repository that corresponds to an application 
preference.

Schema key A key that stores a schema object for a preference key.

Schema object An element in a configuration source that contains information for a 
preference key, such as the following:

The name of the application that uses the preference key

The type of value required for the preference key (for example, integer, 
boolean, etc.)

A default value for the preference key 

Brief documentation on the preference key

Preference key: /desktop/gnome/interface/font_name

Schema key: /schemas/desktop/gnome/interface/font_name

Schema object: <schema> <applyto>/desktop/gnome/interface/font_name</
applyto> <key>/schemas/desktop/gnome/interface/font_name</
key> <owner>gnome</owner> <type>string</type> 
<default>Sans 10</default> <locale name=”C”> 
<short>Default font</short> <long>Name of the default font 
used by gtk+.</long> </locale>
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Some schema definition files correspond closely to a part of the GNOME Desktop user interface. 
For example, system_http_proxy.schemas corresponds to the Network Proxy preference tool. Other 
schema definition files contain preference keys that are not present in the GNOME Desktop user 
interface. For example, the /apps/panel/global/tooltips_enabled key is not present. 

Some parts of the GNOME Desktop user interface contain preferences that represent preference 
keys from more than one schema definition file. For example, the Keyboard Shortcuts preference 
tool contains preferences that represent keys from the panel-global-config.schemas and 
metacity.schemas files.

E.1.2  GConf Daemon
The GConf daemon is called gconfd-2. It notifies applications when a preference value changes. For 
example, you might choose to show only icons in toolbars in the Menus & Toolbars preference tool. 
When you select this option in the preference tool, the toolbars on all open applications are updated 
instantly. The daemon can operate locally or across a network.

An instance of the GConf daemon is started for each user. It does not have to deal with complex 
problems such as authentication and data security. When the daemon starts, it loads the GConf path 
file. The daemon also manages all access between applications and the configuration sources.

When an application requests the value of a preference key, the daemon searches the configuration 
sources as follows:

1. Search for the value of the preference key in each configuration source, in the order specified in 
the path file. 

2. If the value is found, return the value.
3. If the value is not found, search for the schema key that corresponds to the preference key in 

each configuration source, in the order specified in the path file.
4. If the schema key is found, check the value of the schema key.
5. If the value of the schema key is a schema object, return the suggested value in the <default> 

element of the schema object.

The GConf daemon also caches preference key values. All applications use this cache, so 
applications need to access the configuration sources only once.

To terminate the GConf daemon, use the following command:

gconftool-2 --shutdown 

E.1.3  GConf Command Line Tool
GConf includes a command line tool called gconftool-2. You can use gconftool-2 to perform the 
following tasks: 

Set the values of keys
Display the values of keys
Install schemas from schema definition files when you install an application

For example, you would use the following command to display the values of all keys in the /
desktop/gnome directory and subdirectories:
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gconftool-2 --recursive-list /desktop/gnome 

The following table lists some of the options that you can use with the gconftool-2 command:

Table E-5   gconftool-2 Options

Option Function

--all-dirs Lists all subdirectories in a directory that you specify.

--all-entries Displays the values of all keys in a directory that you specify.

--config-
source=configuration-source 

Use with the --direct option to specify a configuration 
source to use. If you do not specify a configuration source 
with this option, the command runs on all configuration 
sources in the path file.

--direct Use with the --config-source option to access a 
configuration source directly. When you use this option, 
GConf bypasses the server. Ensure that the GConf daemon, 
gconfd-2, is not running before you use this option.

--dump Generates a list that contains all preference keys in a GConf 
repository directory that you specify. The list contains XML 
descriptions of all the keys, in a <gconfentryfile> element.

For example, you can redirect the output from this option to 
generate a file that lists all keys that are related to your panel 
configuration. You can use the --load option with this file.

--get Displays the value of a preference key that you specify. Also 
displays the values of the elements in the schema object for 
a schema key that you specify.

--help Displays a help message about the gconftool-2 
command and the options that you can use with it.

--load=filename Sets the values of preference keys in the current directory in 
a configuration source to the values in the file that you 
specify. The file that you specify must contain XML 
descriptions of the keys, in a <gconfentryfile> element.

--long-desc=description Use with the --set-schema option to specify a long 
description for a schema key. 

--makefile-install-rule Installs schema definition files to applications.

--owner=owner Use with the --set-schema option to specify an owner for 
a schema key. 

--recursive-list Displays the values of all preference keys in all 
subdirectories in a directory that you specify.

--recursive-unset Resets the values of all preference keys, in all subdirectories 
in a directory, from the user setting to the setting in the 
default configuration source.
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--set Sets the value of a preference key and writes the value to 
the user configuration source. Use it with the --type option 
to specify the data type of the value that you want to set. For 
example, the following command sets the value of the /
apps/gnome-terminal/profiles/Default/
background_color key in the user configuration source:
gconftool-2 --set “/apps/gnome-terminal/
profiles/Default/background_color” --
type string “#000000” 

You can also use it with the --direct option and the --
config-source option to write a value to another 
configuration source.

--set-schema Sets the value of an attribute in a schema key and writes the 
value to the default configuration source.

Use it with the following options to specify the attribute that 
you want to update:

--type 

--short-desc 

--long-desc 

--owner 

For example, the following command sets the short 
description in the schema key for the /apps/gnome-
terminal/profiles/Default/background_color 
key:
gconftool-2 --set-schema “/schemas/apps/
gnome-terminal/profiles/Default/
background_color” --short-desc “Default 
background color of terminal” 

--short-desc=description Use with the --set-schema option to specify a short 
description for a schema key. 

--shutdown Terminates the GConf daemon.

--type=data-type Specifies the data type when you set a value of a preference 
key. You can also use this option when you set the value of 
an attribute in a schema key. The following are valid data 
types:

bool

float

int

list

pair

string

--unset Resets the value of a preference key from the user setting to 
the setting in the default configuration source.

Option Function
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E.1.4  Setting Preference Values
You can set a mandatory value or a default value for a preference key. Before you change mandatory 
preference values or default preference values for users, you must ensure that the GConf daemon is 
not running for any user.

IMPORTANT: Before you change mandatory preference values or default preference values for 
users, you must ensure that all users are logged out.

To set a mandatory value or a default value for a preference key, use the gconftool-2 command, 
as follows:

gconftool-2 --direct --config-source configuration-source --type data-
type --set preference-keyvalue 

For example, to set wwwproxy.xyz.com as the mandatory HTTP proxy host, use the following 
command:
gconftool-2 --direct --config-source xml:readwrite:/etc/opt/gnome/opt/
gnome/gconf/gconf.xml.mandatory --type string --set /system/
http_proxy/host wwwproxy.xyz.com 

The user cannot override this preference value.

You can also use the gconftool-2 command to set default values. For example, to set the default 
number of workspaces to five, use the following command:
gconftool-2 --direct --config-source xml:readwrite:/etc/opt/gnome/opt/
gnome/gconf/gconf.xml.defaults --type int --set /apps/metacity/
general/num_workspaces 5 

The user can override this preference value.

E.1.5  Setting General Preferences
The following sections describe how to assign mandatory or default values to general preferences:

“Setting HTTP Proxy Preferences” on page 269
“Setting Print Manager Preferences” on page 269
“Setting the Number of Workspaces” on page 269
“Setting Keyboard Accessibility Preferences” on page 270
“Setting Keyboard Shortcut Preferences” on page 270
“Setting Panel and Panel Object Preferences” on page 270

--usage Displays a brief help message about the gconftool-2 
command and the options that you can use with it.

Option Function
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Setting HTTP Proxy Preferences

To set HTTP proxy preferences, modify the values of the preference keys in the /system/
http_proxy/ location. For example, to set a mandatory value for the HTTP proxy host, use the 
following command:

gconftool-2 --direct --config-source xml:readwrite:/etc/opt/gnome/opt/
gnome/gconf/gconf.xml.mandatory --type string --set /system/
http_proxy/host proxy-name 

To set a default value for the HTTP proxy host, use the following command: 

gconftool-2 --direct --config-source xml:readwrite:/etc/opt/gnome/opt/
gnome/gconf/gconf.xml.defaults --type string --set /system/http_proxy/
host proxy-name

You can also set other HTTP proxy-related preferences. For more information, see the 
system_http_proxy.schemas schema definition file.

Setting Print Manager Preferences

To set print manager preferences, modify the values of the preference keys in the /apps/gnome-
print-manager location. For example, if you do not want users to view the print jobs of 
other users, set a mandatory value as follows: 
gconftool-2 --direct --config-source xml:readwrite:/etc/opt/gnome/
gconf/gconf.xml.mandatory --type bool --set /apps/gnome-print-manager/
show_all_jobs false 

To set a default value for this preference, use the following command:
gconftool-2 --direct --config-source xml:readwrite:/etc/opt/gnome/
gconf/gconf.xml.defaults --type bool --set /apps/gnome-print-manager/
show_all_jobs false 

You can also set other print manager preferences. For more information, see the gnome-print-
manager.schemas schema definition file.

Setting the Number of Workspaces

To set a mandatory number of workspaces, use the following command:
gconftool-2 --direct --config-source xml:readwrite:/etc/opt/gnome/
gconf/gconf.xml.mandatory --type int --set /apps/metacity/general/
num_workspaces integer 

To set a default number of workspaces, use the following command:
gconftool-2 --direct --config-source xml:readwrite:/etc/opt/gnome/
gconf/gconf.xml.defaults --type int --set /apps/metacity/general/
num_workspaces integer 

You can also set other window manager preferences. For more information, see the 
metacity.schemas schema definition file.
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Setting Keyboard Accessibility Preferences

To set keyboard accessibility preferences, modify the values of the preference keys in the 
/desktop/gnome/accessibility/keyboard location. For example, if you want to set a 
mandatory value so that keyboard accessibility features are enabled, use the following command:
gconftool-2 --direct --config-source xml:readwrite:/etc/opt/gnome/
gconf/gconf.xml.mandatory --type bool --set /desktop/gnome/
accessibility/keyboard/enable true 

To set a default value for this preference, use the following command:
gconftool-2 --direct --config-source xml:readwrite:/etc/opt/gnome/
gconf/gconf.xml.defaults --type bool --set /desktop/gnome/
accessibility/keyboard/enable false 

You can also set other keyboard accessibility preferences. For more information, see the 
desktop_gnome_accessibility_keyboard.schemas schema definition file.

Setting Keyboard Shortcut Preferences

To set keyboard shortcut preferences, modify the values of preference keys in /apps/
metacity/global_keybindings location. For example, you might want users to use only 
the Alt+F3 keyboard shortcut to open the Run Application dialog. To set this mandatory value, use 
the following command:
gconftool-2 --direct --config-source xml:readwrite:/etc/opt/gnome/
gconf/gconf.xml.mandatory --type string --set /apps/metacity/
global_keybindings ’<Alt>F3’ 

You can also set other keyboard shortcut preferences. For more information, see the 
metacity.schemas schema definition file.

Setting Panel and Panel Object Preferences

The panel-default-setup.entries file specifies the following details of the panels in the GNOME 
Desktop:

Number of panels
Types of the panels
Properties of the panels
Contents of the panels

The configuration of individual panels and of panel objects is a complex task. You must first 
understand the structure of the panel-default-setup.entries file. For more information, see 
“Specifying Individual Panels and Panel Objects” on page 271.

To set preferences for individual panels and panel objects, you must set the values of many 
preferences in a configuration source. The easiest way to do this is to use the gconftool-2 command 
with the --dump and --load options. For more information, see “Setting Preferences for 
Individual Panels and Panel Objects” on page 273.
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Specifying Individual Panels and Panel Objects

The panel-default-setup.entries file contains sections that specify panels and panel 
contents, and it specifies values for schema keys. This file is located in the /etc/opt/gnome/
gconf/schemas directory.

The panel-default-setup.entries file is structured as follows:

1. Keys that specify the general structure of panels, applets, and other panel objects in the 
GNOME Desktop. 

The following keys specify the number of panels, panel objects, and applets that appear in the 
GNOME Desktop:

/apps/panel/default_setup/general/toplevel_id_list 
/apps/panel/default_setup/general/object_id_list 
/apps/panel/default_setup/general/applet_id_list 

The keys also assign identifiers to each panel, panel object, and applet. For example, the 
following sample from panel-default-setup.entries specifies that one panel appears in the 
GNOME Desktop:
<entry>
      <key>toplevel_id_list</key>
      <schema_key>/schemas/apps/panel/general/toplevel_id_list
      </schema_key>
      <value>
        <list type=”string”>
          <value>
            <string>bottom_panel</string>
          </value>
        </list>
      </value>
    </entry>

In the panel-default-setup.entries file, the identifier bottom_panel identifies 
the bottom edge panel.

2. Keys that specify the properties of the panels. 
The panel property keys are structured as follows:
/apps/panel/default_setup/toplevels/panel-name/panel-property-key

For example, the /apps/panel/default_setup/toplevels/bottom_panel/
size key specifies the size of the bottom panel. 

3. Keys that specify the panel objects, the panel object properties, and the panels where the 
objects reside. 
For example, the following sample from panel-default-setup.entries specifies a Main Menu 
object at the left side of the bottom panel:
<entrylist base=”/apps/panel/default_setup/objects/main_menu”>
   <entry>
      <key>object_type</key>
      <schema_key>/schemas/apps/panel/objects/object_type</
schema_key>
      <value>
        <string>menu-object</string>
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      </value>
    </entry>
    <entry>
      <key>toplevel_id</key>
      <schema_key>/schemas/apps/panel/objects/toplevel_id</
schema_key>
      <value>
        <string>bottom_panel</string>
      </value>
    </entry>
    <entry>
      <key>position</key>
      <schema_key>/schemas/apps/panel/objects/position</schema_key>
      <value>
        <int>0</int>
      </value>
    </entry>
.
.
.
  </entrylist>

4. Keys that specify the applets, the applet preferences, and the panels where the applets reside. 
For example, the following sample from panel-default-setup.entries specifies the 
Window List applet, in the bottom panel:
<entrylist base=”/apps/panel/default_setup/applets/window_list”>
    <entry>
      <key>object_type</key>
      <schema_key>/schemas/apps/panel/objects/object_type
      </schema_key>
      <value>
        <string>bonobo-applet</string>
      </value>
    </entry>
    <entry>
      <key>toplevel_id</key>
      <schema_key>/schemas/apps/panel/objects/toplevel_id
      </schema_key>
      <value>
        <string>bottom_panel</string>
      </value>
    </entry>
    <entry>
      <key>position</key>
      <schema_key>/schemas/apps/panel/objects/position
      </schema_key>
      <value>
        <int>2</int>
      </value>
    </entry>
.
.
.
    <entry>
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      <key>bonobo_iid</key>
      <schema_key>/schemas/apps/panel/objects/bonobo_iid_type</
schema_key>
      <value>
        <string>OAFIID:GNOME_WindowListApplet</string>
      </value>
    </entry>
  </entrylist>

The OAFIID is a unique identifier for an applet. To find the OAFIID for a particular applet, see 
the .server file for the applet in the /usr/lib/bonobo/servers directory. For example, 
the following excerpt from GNOME_Wncklet_Factory.server shows the OAFIID for 
the Window List applet:
<oaf_server iid=”OAFIID:GNOME_WindowListApplet” 
type=”factory” location=”OAFIID:GNOME_Wncklet_Factory”>

Setting Preferences for Individual Panels and Panel Objects

1 Log in to a GNOME session, then configure the panels as required.
2 Use the --dump option with the gconftool-2 command line tool to generate a file that 

contains an XML description of your panel configuration.
The --dump option generates a list that contains all preference keys in a GConf repository 
directory that you specify. 
For example, the following command creates an XML description of the default panel 
configuration in a file called my-panel-setup.entries:
gconftool-2 --dump /apps/panel/profiles/default > my-panel-
setup.entries 

3 Open the my-panel-setup.entries file in a text editor, then modify the file as required.
For example, you might want to change the location of the desktop entry files. The following is 
an excerpt from a file generated with the --dump option:
<entry>
      <key>objects/object_16/launcher_location</key>
      <schema_key>/schemas/apps/panel/objects/launcher_location
      </schema_key>
      <value>
        <string>hadjaha-00adce02f7.desktop</string>
      </value>
    </entry>

In the above example, you might want to change the reference to 
hadjaha-00adce02f7.desktop to another desktop entry file that is available globally.
When you generate a panel configuration with the --dump option, the positions of the panel 
objects are absolute positions. You might want to change these positions to relative positions. 
The object at the extreme left of a panel has a position value of 0. The next object has a 
position value of 1, and so on. If you want object positions to be relative to the right side of the 
panel, set the value of the right_stick key to True.

4 Use the --load option with the gconftool-2 command line tool to set the values of the 
default configuration source to the values in the my-panel-setup.entries file. 
For example, the following command sets the values of the keys in the default configuration 
source to the values of the corresponding keys in my-panel-setup.entries:
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gconftool-2 --direct --config-source xml:readwrite:/etc/opt/gnome/
gconf/gconf.xml.defaults --load my-panel-setup.entries 

E.1.6  Setting Look-and-Feel Preferences
The following sections describe how to assign mandatory or default values to look-and-feel 
preferences:

“Setting Font Preferences” on page 274
“Setting Background Preferences” on page 274
“Setting Splash Image Preferences” on page 275

Setting Font Preferences

To set font preferences, modify the values of two preference keys. The following table shows the 
keys to modify and the part of the user interface that the keys correspond to:

Table E-6   Font Preference Keys

For example, to set Sans 12 as the mandatory application font, use the following command:
gconftool-2 --direct --config-source xml:readwrite:/etc/opt/gnome/
gconf/gconf.xml.mandatory --type string --set /desktop/gnome/
interface/font_name “Sans 12” 

To set Palatino 12 as the default desktop object font, use the following command:
gconftool-2 --direct --config-source xml:readwrite:/etc/opt/gnome/
gconf/gconf.xml.defaults --type string --set /apps/nautilus/
preferences/desktop_font “palatino 12” 

Setting Background Preferences

To set preferences for the desktop background, modify the values of the preference keys in the 
/desktop/gnome/background location. For example, to set a mandatory image for the 
background, use the following command:
gconftool-2 --direct --config-source xml:readwrite:/etc/opt/gnome/
gconf/gconf.xml.mandatory --type string --set /desktop/gnome/
background/picture_filename filename.png 

To set a default value for this preference, use the following command:
gconftool-2 --direct --config-source xml:readwrite:/etc/opt/gnome/
gconf/gconf.xml.defaults --type string --set /desktop/gnome/
background/picture_filename filename.png 

You can also set other background preferences. For more information, see the 
desktop_gnome_background.schemas schema definition file.

GConf Location User Interface Component

/desktop/gnome/interface/font_name Font preference tool, Application font option

/apps/nautilus/preferences/
desktop_font

Font preference tool, Desktop font option
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Setting Splash Image Preferences

To set splash image preferences, modify the value of the preference keys in the 
/apps/gnome-session/options/ location. For example, if you do not want users ever to 
see a splash image, set a mandatory value as follows:
gconftool-2 --direct --config-source xml:readwrite:/etc/opt/gnome/
gconf/gconf.xml.mandatory --type bool --set /apps/gnome-session/
options/show_splash_screen false 

To set a default value for this preference, use the following command:
gconftool-2 --direct --config-source xml:readwrite:/etc/opt/gnome/
gconf/gconf.xml.defaults --type bool --set /apps/gnome-session/
options/show_splash_screen false 

You can also set other splash image preferences. For more information, see the gnome-
session.schemas schema definition file.

E.1.7  Restoring Default Preference Values
To restore the default preference values for a user, use the following command:

gconftool-2 --direct --config-source user-configuration-source --
recursive-unset 

Replace user-configuration-source with the configuration source in the .gconf directory in the 
home directory of the user. 

This command resets the values of all preference keys, in all subdirectories, from the user setting to 
the setting in the default configuration source.

E.1.8  Configuration Editor
The Configuration Editor (GConf Editor) lets you view and edit the values of the keys stored in the 
GConf repository.

To open the Configuration Editor:

1 Click System > Run Program.
2 Type /opt/gnome/bin/gconf-editor, then click Run.
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Figure E-1   Configuration Editor Window 

The Configuration Editor window contains the following panes:

Tree 
Lets you navigate the directories and subdirectories in the GConf repository. Use this pane to 
display the keys that you want to modify in the modification pane. The tree pane is on the left 
side of the window.

Modification  
Displays the keys in the selected GConf repository directory. Use this pane to select keys that 
you want to modify, and to modify the values of keys. The modification pane is in the upper 
part of the right side of the window.
The icons beside the keys in the modification pane indicate what type of value you can enter for 
the key. For example, the check mark icon beside the /system/http_proxy/
use_http_proxy key indicates that you can enter a boolean value for the key. 
The icons also indicate if you cannot edit the value of a key. For example, a key icon beside a 
schema key indicates that you cannot modify the value of the key. 

Documentation  
Displays documentation for the currently selected key. Use this pane to get more information 
about the GConf preference keys.

You can copy the names of keys so that you can paste them into another application. You can also 
add bookmarks to keys.

Modifying the Value of a Key

1 Use the tree pane to display the key that you want to modify in the modification pane. 
2 Click the key you want to modify.
3 To change the value of an integer key or a string key, click the Value column of the key and 

then type the new value for the key.
4 To change the value of a boolean key, click the Value column of the key.
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Copying a Key Name

1 Click the key whose name you want to copy in the modification pane.
2 Click Edit > Copy Key Name. 
3 If required, you can paste the name of the key into another application.

Using Bookmarks with Keys

To access a key in your bookmarks, select the key from the Bookmarks menu.

Adding a Bookmark

1 Click the key that you want to bookmark in the modification pane.
2 Click Bookmarks > Add Bookmark.

Deleting a Bookmark

1 Click Bookmarks > Edit Bookmarks.

An Edit Bookmarks dialog is displayed.
2 Select a bookmark from the list on the left, then click Delete. 
3 Click Close.

E.2  Customizing Menus
The way in which the GNOME Desktop implements menus enables you to do the following:

Customize the menu hierarchy easily. The menu hierarchy is not based on the file system 
hierarchy. You can edit a small number of files to customize the menu hierarchy. You do not 
need to modify your applications or move files.
Install applications easily. You do not need to provide information about the menu hierarchy to 
applications when you install the applications.
Configure menus so that users cannot modify them.

Menus in the GNOME Desktop use the following components:

File abstraction layer
Vfolders
Desktop entry files
Directory entry files

E.2.1  File Abstraction Layer
The gnome-vfs file abstraction layer provides a simplified and generalized way for applications to 
interact with files. The file abstraction layer also provides Uniform Resource Identifier (URI) 
locations that map to particular menu configuration files. To add a menu or a menu item for all 
users, you must add the menu or menu item to one of the URI locations. The following table lists the 
menus that you can add items to, and the URI locations that correspond to the menus.
GNOME Configuration for Administrators 277



278 Novell Linux

novdocx (E
N

U
)  10 A

ugust 2006
Table E-7   Menus You Can Add Items To

E.2.2  Vfolders and Menus
In general terms, a vfolder is a virtual representation of items that reside in a physical location or 
locations on your system. For example, a vfolder might represent the contents of several directories. 
A vfolder is an abstraction from one or more physical locations. In terms of menus in the GNOME 
Desktop, a vfolder is a representation in a menu of items that might be physically located in several 
directories.

A vfolder information file is an XML file that describes a vfolder. Vfolder information files specify 
the structure of your menus. Vfolder information files specify the names of your menus and the 
order in which applications appear in your menus. Vfolder information files have a .vfolder-info file 
extension. 

The following is an excerpt from a vfolder information file:
<?xml version=”1.0”?>
<VFolderInfo>
.
.
.
  <Folder>
    <Name>Applications</Name>
    <Desktop>Applications.directory</Desktop>
    <Folder>
      <Name>Accessories</Name>
      <DontShowIfEmpty/>
      <Desktop>Accessories.directory</Desktop>
      <Query>
        <And>
          <Keyword>Application</Keyword>
          <Keyword>Utility</Keyword>
        </And>
      </Query>
    </Folder>
.
.
.
  </Folder>
</VFolderInfo>

The following table describes some of the elements in vfolder information files.

Menu URI Locations

Applications menu for all users applications-all-users:///

Desktop Preferences menu for all users preferences-all-users:///
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Table E-8   Vfolder Elements

E.2.3  Desktop Entry Files
A desktop entry file is a data file that provides information about an item in a menu. This file 
specifies the details for the item such as a name, a command to run, or an icon. It also contains 
keywords which determine the location of the item in the menu hierarchy. Desktop entry files have a 
.desktop file extension.

The following is a sample desktop entry file:
[Desktop Entry]
Encoding=UTF-8
Name=Calculator
Comment=Perform calculations
Exec=gcalctool
Icon=gcalctool.png
Terminal=false
Type=Application
Categories=GNOME;Application;Utility;
X-GNOME-DocPath=gcalctool/gcalctool.xml

The following table describes the most important keys in desktop entry files.

Table E-9   Desktop Entry File Keys

Element Description

<Folder> Contains the elements that define the name, content, and structure of the 
menu.

<Name> Specifies the name of the menu.

<Desktop> Specifies the name of the directory entry file that specifies the name, 
comment, and icon for the menu.

<Query> Specifies a query to run on desktop entry files. If a desktop entry file 
matches the requirements in the query, the menu item is displayed in the 
menu.

The query in the excerpt searches for desktop entry files that contain the 
keywords Application and Utility in the Categories key. Desktop entry files 
that match are displayed in the Applications menu.

This element is optional.

<DontShowIfEmpty/> If this element is present, the menu is not displayed if the menu does not 
contain any items.

This element is optional.

Desktop Entry Key Description

Encoding Specifies the encoding of the desktop entry file. 

Name Specifies the name of the item. This name is displayed on the item in the 
menu. 
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For more information on the keys in desktop entry files, see the desktop entry specification at 
freedesktop.org (http://www.freedesktop.org). 

NOTE: Panel launchers and desktop objects also use desktop entry files. These desktop entry files 
provide the same information as for items in a menu. For example, the desktop entry files provide 
the command to run when a user selects the launcher or object.

E.2.4  Directory Entry Files
A directory entry file is a data file that provides information about a menu. The directory entry file 
specifies the details for the menu, such as a name, a tooltip, and an icon. Directory entry files have a 
.directory file extension.

The following is a sample directory entry file:
[Desktop Entry]
Name=Accessories
Comment=Accessories menu
Icon=gnome-util.png
Type=Directory

The following table describes the most important keys in directory entry files.

Comment Specifies a short description of the item. The comment is displayed as a 
tooltip when you point to the item in the menu. 

Exec Specifies a command to execute when you select the item from the 
menu. 

Icon Specifies the filename of an icon that represents the item. Does not 
specify the file extension or the path to the filename. 

Terminal Specifies whether the command in the Exec key runs in a terminal 
window. If the value is True, the command runs in a terminal window.

If the command does not create a window in which to run, the value of 
this key must be True.

Type Specifies the type of item. This value is one of the following:

Application: Use this option for an item that starts an application.

Link: Use this option for an item that links to a file, folder, or FTP 
site.

Categories Specifies the keywords that describe the item. The keywords are 
separated with semicolons (;). To view a list of the standard category 
keywords, see the desktop menu specification at freedesktop.org (http://
www.freedesktop.org)

The vfolder information files map the keywords to menus.

X-GNOME-DocPath Specifies the help file to display when you select Help on application-
name from the menu item pop-up menu.

Desktop Entry Key Description
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Table E-10   Directory Entry File Keys

E.2.5  Editing Menus
You use the following GNOME Desktop components to edit menus:

Nautilus file manager
Menus on panels

When you use the file manager to add menus or menu items for all users, you must add the menu or 
menu item to a URI location. The table in “File Abstraction Layer” on page 277 lists the menus that 
you can add items to, and the URI locations that correspond to the menus.

When you use panels to customize menus for all users, you use the menu item popup menu. For 
more information, see Working With Menus in the GNOME 2.6 Desktop User Guide.

You can also use menu configuration files and menu data files to customize menus.

Adding Menus

You can add menus for all users in either of the following ways.

Using the File Manager

To add a menu for all users, perform the following steps:

1 In a file manager window, access the location where you want to add the menu.

For example, to add a menu to the Applications menu, type applications-all-
users:/// in the Location field and then press Enter.

2 Click File > New Folder.
An untitled folder is added to the view pane. The name of the folder is selected.

3 Type a name for the folder, then press Enter.
The vfolder information file for the location that you accessed in Step 1 on page 281 is 
automatically updated with the details of the new menu. The name of the folder is displayed as 
the name of the menu.

The next time that users log in, the menu is in the assigned location.

Directory Entry Key Description

Name Specifies the name of the menu, which is displayed on the menu.

Comment Specifies a short description of the menu. The comment is displayed as a 
tooltip when you point to the menu.

Icon Specifies the filename of an icon that represents the menu. Does not 
specify the file extension or the path to the filename.

Type Specifies the type of menu. The value of this key is always Directory.
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Using Menu Files

To add a menu for all users, perform the following steps:

1 Create a directory entry file for the item that you want to add. 

Create the directory entry file in the /opt/gnome/share/gnome/vfolders directory. 
For more information on directory entry files, see “Directory Entry Files” on page 280. 

2 Locate the vfolder information file for the location where you want to add the menu. 
For example, to add a menu to the Applications menu, locate the file /etc/opt/gnome/
gnome-vfs-2.0/vfolders/applications-all-users.vfolder-info. 

3 In the vfolder information file, add a <Folder> element for the new menu.
For more information, see “Vfolders and Menus” on page 278.

The next time that users log in, the menu will be in the assigned location.

Adding an Item to a Menu

To add an item to a menu for all users:

1 Create a desktop entry file for the item that you want to add.

For more information, see “Desktop Entry Files” on page 279. 
2 Open a file manager window, then click File > New Window to open a second file manager 

window.
3 In one window, access the location where you want to add the menu item.

For example, to add a menu item to the Preferences menu, type preferences-all-
users:/// in the Location field and then press Enter.

4 In the other window, select the desktop entry file that you created for the menu item and then 
drag the desktop entry file to the location where you want to add the menu item.
or
Copy the desktop entry file, then paste the file into the location where you want to add the 
menu item.

The next time that users log in, the menu item is in the assigned location.

Editing the Properties of a Menu

To edit the properties of a menu for all users:

1 In a panel, open the menu that you want to edit and right-click any item in the menu.
2 Click Edit > Properties. 

A Launcher Properties dialog is displayed.
3 Modify the properties of the menu in the Launcher Properties dialog.

For more information on the elements in the Launcher Properties dialog, see Working With 
Panels (http://www.gnome.org/learn/users-guide/2.6/ch04.html) in the GNOME 2.6 Desktop 
User Guide.

4 Click OK.
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Editing a Menu Item

1 In a panel, open the menu that contains the item that you want to edit and right-click the item 
that you want to edit.

2 Click Properties. 
A Launcher Properties dialog is displayed.

3 Modify the properties of the menu item in the Launcher Properties dialog.
For more information on the elements in the Launcher Properties dialog, see Working With 
Panels (http://www.gnome.org/learn/users-guide/2.6/ch04.html) in the GNOME 2.6 Desktop 
User Guide.

4 Click OK.

Deleting an Item from a Menu

1 In a panel, open the menu that contains the item that you want to delete.
2 Right-click the item that you want to delete.
3 Click Remove This Item.

The next time that users log in, the menu item is not displayed in the menu.

E.2.6  Configuring Menus That Users Cannot Modify
Users cannot modify a menu if the following conditions are true:

A vfolder information file that corresponds to the menu is present in the /etc/opt/gnome/
gnome-vfs-2.0/vfolders directory
The vfolder information file has the same name as the URI location that corresponds to the 
menu
The user permissions for the vfolder information file are set to read only 

To configure a menu so that users cannot modify the menu:

1 Create a vfolder information file for the menu that you want to configure in the /etc/opt/
gnome/gnome-vfs-2.0/vfolders directory.

2 Give the vfolder information file the name of the URI location that corresponds to the menu 
that you want to configure. 
For example, to configure the Applications menu, create a vfolder information called 
applications.vfolder-info in the /etc/opt/gnome/gnome-vfs-2.0/vfolders 
directory.

3 Set the permissions on the vfolder information file to read only.

E.3  Installing Themes
A theme is a group of coordinated settings that specifies the visual appearance of a part of the 
GNOME Desktop. Users can select themes to change the appearance of the GNOME Desktop.

A theme contains settings that affect different parts of the GNOME Desktop, as follows:

Controls 
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Determines the visual appearance of windows, panels, and applets. It also determines the visual 
appearance of the GNOME-compliant interface items that appear on windows, panels, and 
applets (such as menus, icons, and buttons). Some of the controls setting options that are 
available are designed for special accessibility needs. Users can select an option for the controls 
setting from the Controls tabbed section in the Theme preference tool.

Window frame 
Determines the appearance of the frames around windows only. Users can select an option for 
the window frame setting from the Window Border tabbed section in the Theme preference 
tool.

Icon 
Determines the appearance of the icons on panels and the desktop background. Users can select 
an option for the icon setting from the Icons tabbed section in the Theme preference tool.

E.3.1  Theme Index File
Each theme has an index file which defines the characteristics of the theme. The name of the index 
file is /opt/gnome/share/themes/theme-name/index.theme.

The following is a sample theme index file:
[Desktop Entry]
Type=X-GNOME-Metatheme
Name=High Contrast Large
Name[es]=Alto contraste grande
Comment=Large black-on-white text and icons
Comment[es]=Textos e iconos grandes en negro sobre blanco
Encoding=UTF-8
[X-GNOME-Metatheme]
GtkTheme=HighContrastLargePrint
IconTheme=HighContrast
MetacityTheme=Atlanta
ApplicationFont=sans 18

The following table describes the keys in theme index files:

Table E-11   Theme Index File Keys

Index File Key Description

Type Specifies that this theme determines the appearance of several theme options, 
such as controls, window frames, and icons.

Name The name of the theme, which is displayed in the Theme preference tool.

Comment A brief description of the theme, which is displayed under the name of the theme 
in the Theme preference tool.

GtkTheme Corresponds to the controls setting in the Theme preference tool. Specifies 
which controls setting option to apply to windows, panels, and applets.

IconTheme Corresponds to the icons setting in the Theme preference tool. Specifies which 
icons setting option to apply to panels and the desktop background.
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E.3.2  Installing a New Controls Option
You can add a new option for the controls setting in the Theme preference tool. Controls options 
reside in the /opt/gnome/share/themes directory. The typical structure of a controls option 
in the file system is as follows.

Option file

/opt/gnome/share/themes/option-name/gtk-2.0/gtkrc 

Image files

/opt/gnome/share/themes/option-name/pixmaps/*.* 

Typically, a new option for the controls setting is supplied as a .tar.gz file. To install the new 
controls option, unzip the .tar.gz file and then untar the .tar file into the /opt/gnome/share/
themes directory.

Users can install their own options for the controls setting. If a user installs an option for the controls 
setting, the option is stored in the $HOME/.themes directory.

E.3.3  Installing a New Window Frame Option
You can add a new option for the window frame setting in the Theme preference tool. Window 
frame options reside in the /opt/gnome/share/themes/option-name/metacity-1 
directory. The typical structure of a window frame option in the file system is as follows.

Option file

/opt/gnome/share/themes/option-name/metacity-1/metacity-theme-
1.xml 

Image files

/opt/gnome/share/themes/option-name/metacity-1/*.* 

Typically, a new option for the window frame setting is supplied as a .tar.gz file. To install the new 
window frame option, unzip the .tar.gz file and then untar the .tar file into the /opt/gnome/
share/themes directory.

Users can install their own options for the window frame setting. If a user installs an option for the 
window frame setting, the option is stored in the $HOME/.themes directory.

MetacityTheme Corresponds to the window frame setting in the Theme preference tool. 
Specifies which window frame setting option to apply to windows.

ApplicationFont Corresponds to the application font setting in the Font preference tool.

Index File Key Description
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E.3.4  Installing a New Icons Option
You can add a new option for the icons setting in the Theme preference tool. Icons options reside in 
the /opt/gnome/share/icons/option-name directory. The typical structure of an icons 
option in the file system is as follows.

Option file

/opt/gnome/share/icons/option-name 

Image files

/opt/gnome/share/icons/option-name/icons/*.* 

Typically, a new option for the icons setting is supplied as a .tar.gz file. To install the new icons 
option, unzip the .tar.gz file and then untar the .tar file into the /opt/gnome/share/icons 
directory.

Users can install their own options for the icons setting. If a user installs an option for the icons 
setting, the option is stored in the $HOME/.icons/option-name directory.

E.3.5  Installing Icons for Themes
The GNOME Desktop provides several themes that are designed for users with special visual needs. 
For example, some of the themes are designed for users with low vision. Several versions of icons 
might be required so that the icon can be displayed properly in each theme.

You might need to install a new icon for an application. When you install a new icon, you must 
create several versions of the icon so that the icon displays correctly in the themes. You must create 
several versions of the following types of icon:

Icons that are used within applications in the GNOME Desktop
Icons that are used internally by GTK+ applications or GTK+ stock icons

You can create the icons in several formats (for example, Portable Network Graphic (PNG) format). 
The suggested size of icons for the desktop environment is 48 x 48 pixels; at this size, most themes 
can rescale the icons.

When you install a new icon, create the following 48 x 48 pixel versions of the icon:

Regular icon
Low-contrast icon
High-contrast icon
Inverse high-contrast icon

If possible, also create 16 x 16 pixel versions of the each of the icons above, for themes that do not 
require large print.

Install the icons to the image files location that is specified for the theme in “Installing a New 
Controls Option” on page 285 or “Installing a New Window Frame Option” on page 285. For 
example, to add icons to the HighContrastLargePrint theme, add the icons to the /opt/gnome/
share/themes/HighContrastLargePrint/pixmaps directory. Add references to the 
icons to the relevant theme files. For example, to add icons to the HighContrastLargePrint theme, 
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add references to the icons to the /opt/gnome/share/themes/
HighContrastLargePrint/
gtk-2.0/gtkrc file. Modify the gtkrc file for the theme to associate the icon with a GTK stock 
icon identifier.

For more information on how to create icons for application launchers and panels, see the Icon 
Themes (http://www.freedesktop.org/Standards/icon-theme-spec).

E.3.6  Creating a Custom Controls Option
If the options for the controls setting are not suitable for the needs of your users, you can create a 
custom controls option.

1 Create a directory structure for the option in the /opt/gnome/share/themes directory. 

Use the same directory structure that other options use. For example, to create an option that is 
called SmallPrint, create the following directories:

/opt/gnome/share/themes/SmallPrint 
/opt/gnome/share/themes/SmallPrint/gtk-2.0 

2 Locate the gtkrc file that is closest to meeting the needs of your users, then copy the file to the 
gtk-2.0 directory of your new option.

3 Open the gtkrc file in a text editor and modify the attributes of the interface elements as 
needed. 

4 (Conditional) If the new option includes images, install the images for the new option in the 
pixmaps directory of your new option. 
If the new option uses images from another option, you do not need to create copies of the 
images for the new option. Instead, make sure that the reference to the images in the 
pixmap_path entry in the gtkrc file is correct.

Users can now select the new option for the controls setting.

For more information on gtkrc files, see the GTK+ Reference Manual (http://developer.gnome.org/
doc/API/2.0/gtk/index.html).

E.4  Configuring Fonts
The GNOME Desktop uses the fontconfig font configuration and customization library. The 
fontconfig library can use all kinds of fonts, including PostScript Type 1 fonts and TrueType* fonts. 
The fontconfig library provides a list of all the fonts available on a GNOME Desktop system. To 
compile this list, fontconfig searches the directories listed in the /etc/opt/gnome/fonts/
fonts.conf file. To view all the fonts available on a system, access the fonts:/// location in 
the file manager on the system.

For more information about the fontconfig library, see the Fontconfig (http://freedesktop.org/
software/fontconfig) Web site.

E.4.1  Font Substitution
The fontconfig library performs font substitution when entire fonts or individual characters are not 
present. If the system needs to display a font that is not available, fontconfig attempts to display 
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another, similar font. For example, if a Web page requests to display the Verdana font, and that font 
is not installed on the system, fontconfig displays a similar font, such as Helvetica. The list of 
similar fonts is defined in the /etc/opt/gnome/fonts/fonts.conf file.

If the system needs to display a character that is not present in the selected font, fontconfig attempts 
to display the character in another, similar font. For example, you might select Bitstream Vera Sans 
as the font for the Text Editor application. The Bitstream Vera font family does not include Cyrillic 
characters. If you open a document which contains a Cyrillic character, Text Editor uses a similar 
font that includes Cyrillic characters to display the character.

The fontconfig library also defines aliases for fonts (for example, serif, sans-serif, and monospace). 
When you select one of the aliases for a font, the system uses the first font that is defined for that 
alias in the /etc/opt/gnome/fonts/fonts.conf. 

E.4.2  Adding a Font for All Users
1 Copy the font file to one of the directories in the /etc/opt/gnome/fonts/fonts.conf 

file. 

Typically, fonts are stored in the /opt/gnome/share/fonts/ directory.
2 (Conditional) The fontconfig library updates the list of fonts automatically. If the list of fonts is 

not updated, run the following command:

fc-cache directory-name

E.4.3  Adding a Font for an Individual User
1 Copy the font file to the $HOME/.fonts directory of the user.

If you drag the font file to the fonts:/// location in the file manager, the font file is copied 
to the $HOME/.fonts directory.

2 (Conditional) The fontconfig library updates the list of fonts automatically. If the list of fonts is 
not updated, run the following command:

fc-cache directory-name

E.5  MIME Types
A Multipurpose Internet Mail Extension (MIME) type identifies the format of a file. The MIME 
type enables applications to read the file. Applications such as Internet browsers and e-mail 
applications use the MIME type to handle files of different types. For example, an e-mail application 
can use the MIME type to detect what type of file is attached to an e-mail.

The Nautilus file manager uses MIME types to identify the type of a file. The file manager needs to 
know the MIME type of a file to perform the following tasks:

Open the file in an appropriate application
Display a string that describes the type of file
Display an appropriate icon to represent the file
Display a list of other applications that can open the file
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If you add a new application, you must make sure that other applications can recognize the files 
associated with the application. You must perform several tasks to enable other applications to 
detect the MIME type of the application files.

This section describes how applications detect the MIME types of files, and how applications are 
associated with MIME types. This section also describes the procedure that you must follow to add 
a new application.

E.5.1  Detecting the MIME Type for a File
Applications can detect the MIME type of a file as follows:

1. The application uses file content sniffers to search for a particular pattern in the file. A file 
content sniffer associates a specific pattern in a file with a MIME type. If the application finds 
a match for the pattern, the MIME type associated with the pattern is the MIME type of the file.

2. If file content sniffers do not identify the MIME type, then the application can check the 
filename. The application checks the filename against the MIME type registry. The MIME type 
registry associates particular file extensions and filename patterns, with particular MIME types. 
If a match for the filename is found, the MIME type associated with the extension or pattern is 
the MIME type of the file.

The following sections provide further information on file content sniffers and the MIME type 
registry.

File Content Sniffers

File content sniffers are specified in the /etc/opt/gnome/gnome-vfs-mime-magic file. 
The following is an example of a file content sniffer:
0 string \x89PNG image/png

The syntax for file content sniffers is as follows:
offset_start[:offset_end] pattern_type pattern [&pattern_mask] type

The following table describes the fields in a file content sniffer.

Table E-12   Fields in a File Content Sniffer

Field Description

offset_start Specifies the number of characters to ignore in the file before searching for a text 
pattern.

pattern_type Specifies the type of pattern to search for. Currently, the string pattern type is the 
only pattern type that is supported.

pattern Specifies the pattern to search for.

pattern_mask Specifies a pattern mask, in hexadecimal format. For more information, see 
“Pattern Masks” on page 290.

This field is optional and is not present in the previous example.

type Specifies the MIME type to associate with files that match this entry.
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Pattern Masks

A pattern mask identifies bits in the pattern to ignore when searching for a pattern in a file. The 
following is an example of a file content sniffer with a pattern mask:
0  string   BMxxxx\000\000 &0xffff00000000ffff  image/bmp

The pattern and mask in the example are as follows:
Pattern  B  M  x  x  x  x   \000 \000 
Mask     ff ff 00 00 00 00 ff  ff

The above pattern and mask specify a file with the following characteristics:

The file begins with BM
BM is followed by four bytes with any values
The four bytes are followed by \000\000

The file content sniffer specifies that the MIME type of files that match the pattern and mask is 
image/bmp.

MIME Type Registry

The MIME type registry is located in /opt/gnome/share/mime-info. The MIME type 
registry contains the following files:

Table E-13   MIME Type Registry Files

The following sections describe MIME information files and MIME keys files.

MIME Information Files

MIME information files associate MIME types with one or both of the following:

File extensions
Filename patterns

When an application searches for the MIME type of a file, the application checks the filename 
against the MIME information files. If a match for the filename is found, the MIME type associated 
with the extension or pattern is the MIME type of the file.

In MIME information files, the filename pattern to search for is written as a regular expression.

The format of MIME type entries in MIME information files is as follows:
MIME-type
ext[,priority]: list-of-extensions
regex[,priority]: list-of-regular-expressions

You can specify a priority value for the file extension and the regular expression. You can use the 
priority value to differentiate composite filenames. For example, you can assign a priority of 1 to the 

File File Extension

MIME information file .mime

MIME keys file .keys
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.gz extension, and assign a higher priority of 2 to the .tar.gz extension. In this case, the file abc.tar.gz 
takes the MIME type for .tar.gz.

IMPORTANT: You must indent the ext field and the regex field with a Tab character (\t).

The following MIME type entries are samples from the gnome-vfs.mime MIME information 
file:
application/x-compressed-tar
regex,2: tar\.gz$
ext: tgz
audio/x-real-audio
ext: rm ra ram
image/jpeg
ext: jpe jpeg jpg
image/png
ext: png
text/html
ext: html htm HTML
text/plain
ext: asc txt TXT
text/x-readme
regex: README.*

The file manager reads the MIME information files alphabetically. The alphabetical order 
determines the order in which MIME types are assigned to file extensions or regular expressions. 
For example, if the same file extension is assigned to different MIME types in the files abc.mime 
and def.mime, the MIME type in abc.mime is used.

MIME Keys Files

MIME keys files provide information about MIME types that are used in the user interface. For 
example, the MIME keys file provides a description of a MIME type and specifies an icon to 
represent files of that MIME type.

The following is a sample from a MIME keys file:
text/html
description=HTML page
icon_filename=gnome-text-html
default_action_type=application
short_list_application_ids_for_novice_user_level=mozilla,netscape,gale
on
category=Documents/World Wide Web

IMPORTANT: You must indent the keys in a MIME keys file with a Tab character (\t).

The following table describes the most important keys in MIME keys files. Typically, the 
description key and the category key are localized.
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Table E-14   MIME Key Files

E.5.2  Registering Applications for MIME Types
The application registry contains text files that register applications. The application registration 
files contain a series of key-value pairs that specify details for applications. For example, the 
application registration files can contain the following information:

The command to use to start the application
MIME types to associate with the application

An application registration file can contain one or more application registrations. Application 
registration files have a .applications extension.

The location of the application registry is /opt/gnome/share/application-registry. 
This directory contains a default application registration file named gnome-vfs.applications.

To register an application, add a registration file for the application to the application registry. 

The following is an example of an application registration file:
eog
command=eog
name=Eye of Gnome
can_open_multiple_files=true
expects_uris=false

Key Description

can_be_executable Specifies whether files of this MIME type 
can be executed.

description Describes the MIME type. This description 
can be displayed in the file manager and 
other applications.

icon_filename Specifies the filename of an icon to 
represent the MIME type. Does not specify 
the file extension or the path to the filename.

This icon can be displayed in the file 
manager and other applications.

default_action_type Specifies the category of action to take 
when a file of this MIME type is opened by 
the user. Enter application for this MIME 
type for most applications.

short_list_application_ids_for_novice_user_
level

Specifies the application to use when a file 
of this MIME type is opened by a user. 
Specify one or more applications, in order of 
priority. The applications must also be 
registered in the application registry.

category Specifies a category for the MIME type. The 
value of this key determines the location of 
the MIME type in the File Types and 
Programs preference tool.
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requires_terminal=false
mime_types=image/bmp,image/gif,image/jpeg,image/png,image/tiff,
image/x-xpixmap,image/x-bmp,image/x-png,image/x-portable-anymap,
image/x-portable-bitmap,image/x-portable-graymap,
image/x-portable-pixmap

The following table describes the keys in application registration files.

Table E-15   Application Registration File Keys

E.5.3  Adding an Application to the GNOME Desktop
1 Add a menu item for the application.

For more information, see “Adding Menus” on page 281.
2 Add an icon for the application to /opt/gnome/share/icons/theme-name/icon-
size/apps.
For more information, see “Installing Themes” on page 283. 

3 (Conditional) If the application uses a new MIME type, add a file content sniffer for the new 
MIME type.
For more information, see “File Content Sniffers” on page 289.

4 (Conditional) If the application uses a new MIME type, add a MIME information file for the 
application to the MIME type registry.
For more information, see “MIME Information Files” on page 290.

5 Add a MIME keys file for the application to the MIME type registry.

Key Description

Application identifier Specifies a unique identifier for the application. This identifier must 
be the same as the identifier in the 
short_list_application_ids_for_novice_user_level 
key in the MIME keys file for the application.

command Specifies the command to use to start the application and any 
options to use with the command.

name Specifies a name for the application. The name is used in the user 
interface. For example, the name is used in the Open With submenu 
in the file manager.

can_open_multiple_files Specifies whether the application can open several files at the same 
time.

expects_uris Specifies whether the application can process URIs. If the value of 
this key is true, the application registration entry must also contain a 
supported_uri_schemes key.

supported_uri_schemes Specifies the URI schemes that the application can process.

requires_terminal Specifies whether to run the application in a terminal window. 
Specify True for this field for an application that does not create a 
window in which to run.

mime_types Specifies the MIME types that the application can use.
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For more information, see “MIME Keys Files” on page 291.
6 (Conditional) If the application uses a new MIME type, add an icon for the MIME type to 
/opt/gnome/share/icons/theme-name/icon-size/mimetypes.
For more information, see “Installing Themes” on page 283. 

7 (Optional) To associate the application with a MIME type, add an application registration file 
to the application registry.
For more information, see “Registering Applications for MIME Types” on page 292.

E.6  Setting Screensavers
A screensaver is an application that replaces the image on a screen when the screen is not in use. The 
screensaver application for the GNOME Desktop is XScreenSaver. The following sections describe 
how to set preferences for the XScreenSaver application and how to modify the displays that are 
available for the screensaver.

E.6.1  Setting Screensaver Preferences
Default screensaver preferences are stored in the XScreenSaver file, located in /usr/X11R6/
lib/X11/app-defaults/XScreenSaver.

To modify screensaver application preferences, users can use the Screensaver preference tool. When 
a user modifies the screensaver preferences, the preferences are stored in the home directory of the 
user, in the $HOME/.xscreensaver file. For information on screensaver preferences, see the 
GNOME 2.6 Desktop User Guide (http://www.gnome.org/learn/users-guide/2.6).

Users can also run the /usr/X11R6/bin/xscreensaver-demo command to open the 
XScreenSaver dialog.

To set default screensaver preferences for all users, modify the XScreenSaver file. You can also use 
the XScreenSaver dialog to create a $HOME/.xscreensaver file, then copy the file to the 
location of the XScreenSaver file.

To restore the default settings for a user, delete the $HOME/.xscreensaver file from the home 
directory of the user. If no $HOME/.xscreensaver file is present, the default preferences in the 
XScreenSaver file are used.

TIP: The default display behavior of XScreenSaver is to display a blank screen. The blank screen 
might confuse users. You might want to change this default display behavior.

To activate changes to the screensaver preferences, use the following command to reload 
screensaver preferences:

xscreensaver-command -restart 

E.6.2  Modifying Screensaver Displays
The screensaver application allows users to select one or more screensaver displays. A screensaver 
display is an application that displays images on the screen of the user when the screen is not in use. 
The screensaver displays are listed in the XScreenSaver file and in the $HOME/.xscreensaver 
file.
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To add a new screensaver display, copy the executable file for the display to the directory where the 
displays are located. Add the command for the screensaver display to the XScreenSaver file or the 
$HOME/.xscreensaver file. Include any arguments that are required to run the screensaver 
display on the whole screen, rather than in a window. For example, you might want to include the -
root option to display the screensaver display on the whole screen.

To disable a screensaver display, add a Minus sign (-) to the start of the command for the 
screensaver display in the preferences file. The following excerpt from a $HOME/
.xscreensaver file shows a disabled Qix (solid) screensaver display:
-  “Qix (solid)”  qix -root -solid -segments 100

E.7  Session Management
A session occurs between the time that a user logs in to the GNOME Desktop and the time that the 
user logs out. The session manager starts after the login manager authenticates the user. The session 
manager lets the user manage the session. For example, a user can save the state of a session and 
return to that session the next time that he logs in. 

At a minimum, the following applications run in a session:

The session manager, gnome-session.
The GConf X settings daemon, gnome-settings-daemon.
The gnome-panel application, which runs the panels in the GNOME Desktop.
The Metacity window manager.

The following table lists the files that contain default session information:

Table E-16   Default Session Information Files

To set default session details for all users, modify the default session file. 

To restore the default session settings for a user, delete the session file from the home directory of 
the user. If no user session file is present, the default settings in /opt/gnome/share/gnome/
default.session are used. 

To save the current session as the default session, users can run the gnome-session-save 
command. 

E.8  Improving Performance
This section discusses several preference settings you can change to improve the performance of the 
GNOME Desktop. You can use the gconftool-2 command to set values for preferences for users. 
The example commands in this section show how to set values in the user configuration source.

File Description

/opt/gnome/share/gnome/
default.session

Default session file. Default session details are stored in this 
file.

$HOME/.gnome2/session User session file. When a user modifies the session, the 
details are stored in this file.
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You can also use the --direct and --config-source options to set mandatory values or 
default values for preferences. And you can use the gconftool-2 command in a script to set the 
values of many preferences. For more information on the gconftool-2 command and the options that 
are available with the command, see “Using GConf for Defaults” on page 261.

E.8.1  Reducing CPU Usage
There are a number of preferences that you can set to reduce CPU usage by the GNOME Desktop. 

Using Theme Options That Require Less CPU Resources

Some window frame theme options load image files to draw the window frame. Other options use 
simpler techniques to draw the window frame. The Crux window frame option loads image files, but 
can be slow on systems with limited CPU resources. To reduce CPU usage, use one of the following 
window frame options:

Atlanta
Esco

The following window frame options also use fewer CPU resources than Crux:

AgingGorilla
Bright
Metabox

TIP: Metabox does not work well with inverse controls options such as HighContrastInverse. Use 
Atlanta with inverse controls options.

To change the window frame theme option, use the following command: 
gconftool-2 --type string --set /apps/metacity/general/theme option-
name 

For example, to use Atlanta, run the following command:
gconftool-2 --type string --set /apps/metacity/general/theme Atlanta

Users can also use the Theme preference tool to select the appropriate option.

You can use the Metacity Theme Viewer to measure the performance of a window frame option and 
to preview the option. To start Metacity Theme Viewer, use the following command:
metacity-theme-viewer option-name 

For example, to measure the performance of Atlanta and preview Atlanta, use the following 
command: 
metacity-theme-viewer Atlanta

Turning Off Display of Icons in Menus

Some items in menus display an icon beside the item. To turn off this feature, use the following 
command: 
gconftool-2 --type bool --set /desktop/gnome/interface/
menus_have_icons false 
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Users can also use the Menus & Toolbars preference tool to deselect the Show Icons in Menus 
option.

Turning Off the Splash Screen

When users log in to the desktop environment, a splash screen is displayed by default. Icons are 
displayed on the splash screen while the user logs in. You can turn off the splash screen to reduce 
CPU usage during login. 

To turn off the splash screen, use the following command:
gconftool-2 --type bool --set /apps/gnome-session/options/
show_splash_screen false

Turning Off Panel Animation

When users show or hide panels, the panels can show or hide in an animated style. To turn off panel 
animation, use the following command:
gconftool-2 --type bool --set /apps/panel/global/enable_animations 
false 

Users can also use the Panel preference tool to deselect the Drawer and Panel Animation option.

Improving File Manager Performance

The Nautilus file manager includes some features that you can modify to improve performance.

Modifying Performance Preferences

The file manager includes performance-related preferences. Each of these preference can take any of 
the following three values.

Table E-17   Performance-related Preferences

The following table describes the performance preferences for the file manager. For the fastest 
performance, set the value of the preferences to Never.

Value Description

always Performs the action for both local files and files on other file systems.

local_only Performs the action for local files only. Using this value reduces CPU usage.

never Never performs the action. Using this value reduces CPU usage and network 
traffic.
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Table E-18   File Manager Performance Preferences

Turning Off the Side Pane, Toolbar, and Location Bar

The file manager includes preferences that let you turn off the side pane and the toolbar. Turning 
these off improves file manager performance.

To turn off the side pane, use the following command: 

Preference Description

show_icon_text Specifies when to preview the content of text files in the icon that 
represents the file. To never preview the content of text files, use 
the following command: 
gconftool-2 --type string --set /apps/
nautilus/preferences/ show_icon_text never 

Users can also perform the following steps:

1. Click Edit > Preferences in a file manager window, then click 
Preview.

2. Select an option for the Show Text in Icons preference.

show_directory_item_counts Specifies when to show the number of items in folders. To never 
show the number of items in folders, use the following command:
gconftool-2 --type string --set /apps/
nautilus/preferences/ 
show_directory_item_counts never 

Users can also perform the following steps:

1. Click Edit > Preferences in a file manager window, then click 
Preview.

2. Select an option for the Count Number of Items preference.

show_image_thumbnails Specifies when to show thumbnails of image files. To never show 
thumbnails, use the following command:
gconftool-2 --type string --set /apps/
nautilus/preferences/ show_image_thumbnails 
never 

Users can also perform the following steps:

1. Click Edit > Preferences in a file manager window, then click 
Preview.

2. Select an option for the Show Thumbnails preference.

preview_sound Specifies when to preview the content of sound files. To never 
preview the content of sound files, use the following command:
gconftool-2 --type string --set /apps/
nautilus/preferences/preview_sound never 

Users can also perform the following steps:

1. Click Edit > Preferences in a file manager window, then click 
Preview.

2. Select an option for the Preview Sound Files preference.
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gconftool-2 --type bool --set /apps/nautilus/preferences/
start_with_sidebar false 

To turn off the toolbar, use the following command: 
gconftool-2 --type bool --set /apps/nautilus/preferences/
start_with_toolbar false 

You can also turn off the location bar. Users can use the Ctrl+L keyboard shortcut to display a 
location bar when required. 

To turn off the location bar, use the following command:
gconftool-2 --type bool --set /apps/nautilus/preferences/
start_with_location_bar false 

Turning Off the Desktop

The file manager contains a preference that lets users use Nautilus to manage the desktop. You can 
disable the desktop to improve performance. However, if you disable the desktop, you cannot

Use the Desktop menu.
Use the file manager to change the pattern or color of the desktop background. 
Use the desktop objects, such as Trash. (The desktop objects are not displayed on the desktop.) 

To disable the desktop, use the following command: 
gconftool-2 --type bool --set /apps/nautilus/preferences/show_desktop 
false 

E.8.2  Reducing X Window System Network Traffic
There are some preferences that you can set to reduce X Window System network traffic on the 
GNOME Desktop. 

Using Theme Options That Create Less Network Traffic

Remote display protocols do not transfer every pixel in a block of pixels if all pixels in the block are 
the same color. To reduce X Window System network traffic, use one of the following window 
frame options that uses solid colors:

Atlanta
Esco

For information on how to change theme options, see “Using Theme Options That Require Less 
CPU Resources” on page 296.

Turning Off Display of Icons in Menus

Some items in menus display an icon beside the item. This feature can increase X Window System 
network traffic if the icon is located on another file system or if the panels are displayed on a remote 
host. 

For information on how to turn off this feature, see “Turning Off Display of Icons in Menus” on 
page 296.
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E.8.3  Reducing Color Usage and Improving Display Quality
Many modern computer systems support 24-bit color (that is, 16,777,216 colors). However, many 
users still use systems that support only 8-bit color (256 colors). The GNOME Desktop uses the 
websafe color palette. This palette is a general-purpose palette of 216 colors which is designed to 
optimize the use of color on systems that support 8-bit color. However, some visual components of 
the GNOME Desktop are designed for systems that support 24-bit color.

The following display problems might occur on systems that support only 8-bit color:

Windows, icons, and background images might appear grainy. Many themes, background 
images, and icons use colors that are not in the websafe color palette. The colors that are not in 
the palette are replaced with the nearest equivalent or a dithered approximation, which causes 
the grainy appearance.
Applications that do not use the websafe color palette have fewer colors available; therefore, 
color errors might occur. Some colors might not appear in the user interface of the application, 
and some applications might crash if the application cannot allocate colors.
Color flashing might occur when users switch between applications that use the websafe color 
palette and applications that do not use this palette. The applications that do not use the 
websafe color palette might use a custom colormap. When the custom colormap is used, other 
visual components might lose colors and then become unviewable.

The following sections describe how to optimize the appearance of the GNOME Desktop for 
systems that support only 8-bit color. 

Using Theme Options That Use the Websafe Color Palette

Some window frame theme options use colors that are in the websafe color palette. Bright and Esco 
use colors from the websafe color palette and do not have the grainy appearance of other window 
frame options on 8-bit color displays. Use Bright or Esco for the best color display on 8-bit visual 
modes.

For information on how to change theme options, see “Using Theme Options That Require Less 
CPU Resources” on page 296.

Reducing Color Usage by Turning Off Display of Icons in Menus

Some items in menus display an icon beside the item. If the icon contains colors that are not in the 
websafe color palette, this feature can increase the number of colors used.

For information on how to turn off this feature, see “Turning Off Display of Icons in Menus” on 
page 296.

Reducing Color Usage by Turning Off the Splash Screen

You can turn off the splash screen to make more colors available for the GNOME Desktop and for 
applications.

For information on how to turn off the splash screen, see “Turning Off the Splash Screen” on 
page 297.
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Reducing Color Usage by Using a Solid Color for the Background

Use a solid color for the desktop background. This reduces the number of colors used by the 
GNOME Desktop.

To set a solid color for the background, use the following commands: 
gconftool-2 --type string --set /desktop/gnome/background/
picture_options none 
gconftool-2 --type string --set /desktop/gnome/background/
color_shading_type solid 
gconftool-2 --type string --set /desktop/gnome/background/
primary_color \#hexadecimal-color 

Users can also use the Background preference tool to choose a solid color for the background.

E.9  Hidden Directories
The following table describes the hidden directories that the GNOME Desktop adds to the home 
directories of users. A hidden directory is a directory that has a name that begins with a period (.).

Table E-19   Hidden Directories Added to Users’ Home Directories

Directory Description

.esd_auth Contains the authentication cookie for the GNOME sound daemon, the 
Enlightened Sound Daemon (ESD).

.gconf Contains the GConf configuration source for the user. When the user sets a 
preference, the new preference information is added to this location.

.gconfd Contains the following GConf daemon details:

Configuration information

Lock information for objects that are referenced by an Interoperable 
Object Reference (IOR)

State information for objects that are referenced by an IOR

.gnome Contains user-specific application data that is not stored in the GConf 
repository. For example, this directory contains MIME type information and 
session information for the user. 

.gnome-desktop The Nautilus file manager contains a preference that enables users to use the 
file manager to manage the desktop. If this option is selected, this directory 
contains the following:

Objects on the desktop (for example, the Home object, the Trash object, 
and other launchers). The objects appear in the directory as desktop 
entry files. For example, the starthere.desktop file contains a link to the 
Start Here location. 

Removable media volumes that are mounted.

The file manager also contains a preference that enables users to use the 
home directory as the desktop directory, instead of .gnome-desktop. If a user 
selects this option, the contents of the home directory are displayed as desktop 
objects.
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E.10  Security Note on Configuring SMB Printers
Windows network shares are also referred to as Samba or SMB shares. When you configure a 
printer on an SMB share, you must enter a username and password for the print queue.

The username and password are stored as unencrypted text in the /etc/opt/gnome/cups/
printers.conf file. This file has read-only permissions for users with root privileges, so any 
user with root privileges can read the username and password for the print queue. 

To reduce the impact of possible security violations, make sure that the username and password 
required to access the print queue is used only for the print queue. This ensures that any possible 
security violation is restricted to unauthorized use of the print queue.

E.11  Disabling GNOME Desktop Features
The GNOME Desktop includes features you can use to restrict access to certain of its functions. 
These disable (or lockdown) features let you restrict the actions that users can perform on a 
computer. For example, you might want to prevent command line operations on a computer that is 
for public use at a trade show.

You disable feature by setting GConf keys (see “Using GConf for Defaults” on page 261). You can 
also use the Configuration Editor application to set GConf keys in a user configuration source (see 
“Configuration Editor” on page 275).

.gnome2 Contains user-specific application data that is not stored in the GConf 
repository, such as the following:

Keyboard shortcut information

Window location information

Desktop entry files for panel launchers

This directory also contains user-specific menu data. If a user modifies menus, 
the details are stored here.

.gnome2-private (Ignore this directory. It currently has no function.)

.metacity Contains session data for the Metacity window manager.

.nautilus Contains file manager data that is specific to the use, such as the following: 

Metadata for the directories with which the user works

Nautilus emblems that the user adds

Nautilus desktop images

.themes Contains controls theme options, window frame theme options, and icons 
theme options that the user adds. The user can add themes from the Theme 
preference tool.

.thumbnails Contains image thumbnails for the user. The image thumbnails are used in the 
file manager. The file manager contains a preference that the user can select 
to stop generation of thumbnail images.

.xscreensaver Contains screensaver configuration data and screensaver preference data.

Directory Description
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E.11.1  Disabling Lock Screen and Log Out
To disable the lock screen and log out functions, set the /apps/panel/global/
disable_lock_screen key and the /apps/panel/global/disable_log_out key to 
True.

When you disable the lock screen and log out functions, the following items are removed from the 
panels:

Lock Screen and Log Out user menu items from the Main Menu
Lock and Log Out menu items from the Add to Panel > Actions menu
To open this menu, right-click a vacant space on a panel and then click Add to Panel > Actions.
Lock Screen and Log Out user menu items from the Actions menu in the Menu Bar applet

Additionally, any Lock Screen buttons and Log Out buttons on panels are disabled.

E.11.2  Disabling Command Line Operations
To disable operations from a command line, set the /desktop/gnome/lockdown/
disable_command_line key to True.

When you disable command line operations, the following changes occur in the user interface:

The Run Application menu item is removed from the following menus:
Main Menu 
Actions submenu in the Add to Panel menu
Actions menu in the Menu Bar applet

Any Run buttons on panels are disabled

To disable command line operations, you must also remove menu items that start terminal 
applications. For example, you might want to remove menu items that contain the following 
commands:

GNOME Terminal command (/opt/gnome/bin/gnome-terminal)
/usr/bin/xterm 
/usr/bin/setterm 

These items are removed from the following menus:

Main Menu 
Add to Panel > Launcher From menu 

To disable command line operations, you must also disable the Command Line applet. To disable 
this applet, add the applet to the /apps/panel/global/disabled_applets key. When 
you disable the Command Line applet, it is removed from the Main Menu and the Add to Panel > 
Utility menu. 

E.11.3  Disabling Panel Configuration
To disable panel configuration, set the /apps/panel/global/locked_down key to True.
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When you disable panel configuration, the following changes occur in the user interface:

The following items are removed from the Panel and Drawer pop-up menus:
Add to Panel 
Delete This Panel 
Properties 
New Panel 

The launcher popup menu is disabled.
The following items are removed from the Applet pop-up menu:

Remove from Panel 
Lock 
Move 

The Main Menu pop-up menu is disabled. 
The Launcher drag feature is disabled so that users cannot drag launchers to or from panels.
The Panel drag feature is disabled so that users cannot drag panels to new locations.
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FKDE Configuration for 
Administrators

KDE is an extensively configurable desktop environment. In addition to being configurable for the 
individual user, it is also configurable for administrators. This allows system administrators to 
provide custom default settings for their environments. Settings can differ between groups and 
individual users. It is also possible to restrict which settings users can change. Additionally, access 
to parts of KDE or functions in KDE can be restricted for all users, groups of users, or specific users.

KDE reads and stores all files in fixed directory trees. Several directories can be used to store system 
or group-specific configuration. One directory tree with user data is saved in each user’s home 
directory.

KDE and all KDE applications scan these directory trees in a preset order. Normally, the home 
directory tree is scanned first, giving it a higher priority. In most cases, the application uses the first 
file found. For configuration files, all files in all directory trees with the same name are read and the 
content merged. The priority order is used to handle different configurations for the same 
configuration key.

The directory locations can be changed using the following environment variables:

Table F-1   Directory Location Environment Variables

Each directory tree used by KDE has a fixed directory structure. However, directories not relevant 
for a certain tree need not be included. For example, directories used for temporary files are usually 
found in $KDEHOME but not in any other directory tree.

The KDE runtime environment combines the subdirectories found in the various directory trees and 
refers to them as a single KDE resource. There are three broad categories: files that are CPU or 
architecture-specific, files that are host-specific, and files that are not specific with regard to host, 
CPU, or architecture. You can view a list of resources at the KDE for System Administrators 
Filesystem Hierarchy (http://www.kde.org/areas/sysadmin/fsh.php) Web site.

Variable Description

$KDEHOME Sets the private user’s directory—the only directory used to store user 
settings. The default location is $HOME/.kde A tilde (~) can be used to 
indicate the user’s home directory.

$KDEROOTHOME The same as $KDEHOME, but used only for the root user. To avoid problems 
with applications started with root privileges, root ignores the $KDEHOME 
variable.

$KDEDIRS Sets one or more system configuration directories. These directories are 
handled as read-only directories. Separate multiple directories with colons 
(:). The default value is /etc/opt/kde3:/opt/kde3, which contains the 
core KDE installation files that come with applications. /etc/opt/kde3 
also contains Novell® Linux Desktop-specific configurations and has a 
higher priority. Add directories in front of these to give the added directories a 
higher priority.
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F.1  Profiles
To avoid problems with future updates, do not use the /opt/kde3 and /etc/opt/kde3 
directories for custom configuration Any package update or installation might revert changes in 
those directories. Add your own directory via $KDEDIRS or, preferably, use the profile mechanism. 
Profiles can be used to configure the user desktop for all users, for specific user groups, or even for 
single users.

A profile is basically an additional KDE directory tree as described above. It has a higher priority 
than the system trees, but a lower one than the user configuration. The profile directory can be 
placed in any location—for example, in an NFS directory mounted by the automounter.

The default profile is used if no other profiles are specified for the user. Save this profile to /var/
run/kde-profiles/default. This directory does not exist by default.

F.1.1  Adding Profiles
Kiosk allows you to both add local or remote profiles. This allows you not only to have local Kiosk 
configurations for single users, but to distribute a central configuration to all workstations.

Local Profiles

Profile directory trees can be placed in any directory, but they must be added to /etc/kde3rc as 
a separate section. This example shows the default profile:
[Directories-default]
ProfileDescription=Default profile
ProfileDescription[de]=Defaultprofiel
ProfileInstallUser=root
prefixes=/var/run/kde-profile/default

Only the prefixes key is required below [Directories-profile]. The other values are 
usually written and used by the Kiosk tool.

Remote Profiles

Profiles stored in a remote directory, such as those saved to a partition mounted with NFS, require 
an additional step. The base directory must be specified using the profileDirsPrefix key in /etc/
kde3rc in the [Directories] section. Create a profile in this directory using a subdirectory 
tree with the same name as the profile.

F.1.2  Mapping Profiles to Users
A mapping file determines which profiles should be used for which users. Configure the mapping 
file in /etc/kde3rc in the [Directories] group:
[Directories]
userProfileMapFile=/etc/kde-user-profile

Map profiles to individual users based on username or to groups of users based on the groups that 
the users are members of (see man groups). It might make sense to save this file on an NFS share 
to create one central configuration location.
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Mapping Profiles to Individual Users

Include a [Users] section in the mapping file to map profiles to an individual user. Entries in the 
[Users] section consist of the user’s account name followed by one or more profiles, as in the 
following example:
[Users]
tux=developer
geeko=developer,packager</screen>

The above example assigns the profile developer to user tux. To user geeko, it assigns the two 
profiles developer and packager. The order in which the profiles are listed is significant in that 
settings in earlier profiles overrule settings in profiles listed after it. In the above case of user geeko, 
the settings of the developer profile take precedence when the developer and packager profiles 
contain conflicting settings.

If a user has an entry under the [Users] section, this entry determines all profiles applicable to the 
user. The user is not assigned any additional profiles based on the groups that the user is a member 
of.

Mapping Profiles to Groups

If a user has no entry under the [Users] section in the mapping file, the profiles applicable to the 
user are determined by the groups that the user is a member of. The groups and the order that they 
are considered in is determined by the following entry in the [General] section of the mapping 
file:
[General]
groups=pkgs,devel</screen>

Each of these groups should have an entry under the [Groups] section that defines which profiles 
belong to that group, as in the following example:
[Groups]
pkgs=packager
devel=developer
bofh=admin,packager,developer

For each group for a user, the corresponding profiles are used. The order in which the groups are 
listed in the [Groups] entry determines the resulting order of all the applicable profiles. If 
multiple profiles are applicable to a particular user and a profile contains settings that conflict with 
settings in another profile, the settings in the earlier listed profile take precedence.

If, in the above example, a user is part of the pkgs group, the packager profile is used for that user. If 
the user is part of the devel group, the developer profile is used. Users that are part of the bofh group 
use the admin, packager, and developer profiles. In case of conflict, settings in the admin profile 
take precedence over settings in the packager or developer profiles.

If the user is part of both the pkgs and devel groups, both the packager and developer profiles are 
used. In case of conflicting settings between the two profiles, the packager profile takes precedence 
because the pkgs group associated with the profile is listed before the devel group.

The groups command can be used to see which groups a user belongs to:
groups geeko
geeko : users uucp dialout audio video cdrecording devel
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In general, only a few groups have profiles associated with them. For this example user, only the 
devel group has a profile associated with it. The other groups do not, so they are ignored. If there is 
no profile defined for any of a user’s groups, the user is assigned the default profile. 

F.2  KDE3 Action Restrictions
Most functionality within KDE is coupled with actions. For example, when a user selects File > 
Open in a KDE application, the file_open action is activated. Likewise, toolbar icons are usually 
also coupled with actions. KDE makes it possible to disable functionality by restricting specific 
actions. By restricting the file_open action, for example, the corresponding entry in the menu bar 
and the corresponding icon on the toolbar disappear. 

To restrict access to functions, include the group [KDE Action Restrictions] in the 
kdeglobals file. Each action can then be restricted by adding action=false. For example, to 
disable the shell_access action, add the following entry:
[KDE Action Restrictions][$i] shell_access=false

Actions that refer to menu and toolbar actions are prefixed with “action/”.

The following actions are defined:

Standard Actions

action/file_new

action/file_open

action/file_open_recent

action/file_save

action/file_save_as

action/file_revert

action/file_close

action/file_print

action/file_print_preview

action/file_mail

action/file_quit

action/edit_undo

action/edit_redo

action/edit_cut

action/edit_copy

action/edit_paste

action/edit_select_all

action/edit_deselect

action/edit_find

action/edit_find_next

action/edit_find_last

action/edit_replace
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action/view_actual_size

action/view_fit_to_page

action/view_fit_to_width

action/view_fit_to_height

action/view_zoom_in

action/view_zoom_out

action/view_zoom

action/view_redisplay

action/go_up

action/go_back

action/go_forward

action/go_home

action/go_previous

action/go_next

action/go_goto

action/go_goto_page

action/go_goto_line

action/go_first

action/go_last
action/bookmarks

action/bookmark_add

action/bookmark_edit

action/tools_spelling

action/options_show_menubar

action/options_show_toolbar

action/options_show_statusbar

action/options_save_options

action/options_configure

action/options_configure_keybinding

action/options_configure_toolbars

action/options_configure_notifications

action/help

action/help_contents

action/help_whats_this

action/help_report_bug

action/help_about_app

action/help_about_kde

action/fullscreen
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Konqueror-related Actions

action/editfiletype

action/properties

action/openwith

action/openintab

action/kdesktop_rmb

Kicker-related Actions

action/kicker_rmb

action/menuedit

KWin Action

action/kwin_rmb

Konsole-related Actions

action/konsole_rmb

action/settings

action/show_menubar

action/show_toolbar

action/scrollbar

action/fullscreen

action/bell

action/font

action/keyboard

action/schema

action/size

action/history

action/save_default

action/save_sessions_profile

action/options_configure_notifications

action/options_configure_keybinding

action/options_configure

action/send_signal 

action/bookmarks

action/add_bookmark

action/edit_bookmarks

action/clear_terminal

action/reset_clear_terminal
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action/find_history

action/find_next

action/find_previous

action/save_history

action/clear_history

action/clear_all_histories

action/detach_session

action/rename_session

action/zmodem_upload

action/monitor_activity

action/monitor_silence

action/send_input_to_all_sessions

action/close_session

action/new_session

action/activate_menu

action/list_sessions

action/move_session_left

action/move_session_right

action/previous_session

action/next_session

action/switch_to_session_1

action/switch_to_session_2

action/switch_to_session_3

action/switch_to_session_4

action/switch_to_session_5

action/switch_to_session_6

action/switch_to_session_7

action/switch_to_session_8

action/switch_to_session_9

action/switch_to_session_10

action/switch_to_session_11

action/switch_to_session_12

action/bigger_font

action/smaller_font

action/toggle_bidi

NOTE: action/options_show_toolbar also disables the Toolbars submenu if present. 
action/bookmarks also disables action/bookmark_add and action/
bookmark_edit. action/help is not yet implemented. action/kdesktop_rmb disables 
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the RMB menu but some actions (cut, copy, rename, trash, and delete) might still be accessible 
using keyboard shortcuts.

Applications can use additional actions that they define. To get a list of the actions used by certain 
applications, use the following dcop command:

dcop dcopid qt objects | grep KActionCollection/ | cut -d ’/’ -f 3

Alternatively, you can use the following:

dcop dcopid maindwindowid actions

Actions that refer to applications that need to be run as a different user are prefixed by “user/” and 
identified by the username. For example, user/root=false disables all application entries that 
require root access.

Many useful actions are available. The following actions are related to printing restrictions.

Table F-2   Printing Restriction Actions

Other actions that are not print related are also available. They include:

Table F-3   Other Restriction Actions

Action Description

print/system Disables the option to select the printing system (back-end). We recommend 
disabling this option after the correct printing system has been configured.

print/options Disables the button to select additional print options.

print/copies Disables the panel that allows users to make more than one copy.

print/selection Disables the options that allow selecting a printer or changing any of the printer 
properties. Make sure a proper default printer has been selected before 
disabling this option. Disabling this option also disables the print/system 
and print/options.

print/dialog Disables the complete print dialog. Selecting the print option immediately prints 
the selected document using default settings. Make sure that a system-wide 
default printer has been selected. No application-specific settings are honored.

Action Description

shell_access Defines whether a shell suitable for entering random commands can be 
started. This also determines whether Run Command (Alt+F2) can be 
used to run shell commands and arbitrary executable. Likewise, 
executables placed in the user’s Autostart folder can no longer be 
executed. Applications can still be started automatically by placing 
desktop files in the $KDEHOME/Autostart or $KDEDIR/share/
autostart directory. See also “run_desktop_files” on page 313.

custom_config Defines whether the --config command line option should be 
honored. This option can be used to circumvent locked-down 
configuration files.
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You probably will also want to activate the following resource restrictions, or users can still execute 
desktop files by placing them in, for example, $KDEHOME/share/kdesktop/Desktop:

Table F-4   Resource Restrictions

logout Defines whether the user can log out of KDE.

lock_screen Defines whether the user can lock the screen.

run_command Defines whether Run Command (Alt+ F2) is available.

movable_toolbars Defines whether toolbars can be moved around by the user. See also 
action/options_show_toolbar.

editable_desktop_icons Defines whether icons on the desktop can be moved, renamed, 
deleted, or added. You might want to set the path for the desktop to a 
read-only directory instead of $HOME/Desktop.

run_desktop_files Defines whether users can execute desktop files that are not part of the 
default desktop, KDE menu, registered services, and autostart services.

The default desktop includes the files under $KDEDIR/share/
kdesktop/Desktop but not the files under $HOME/Desktop.

The KDE menu includes all files under $KDEDIR/share/applnk and 
$XDGDIR/applications.

Registered services includes all files under $KDEDIR/share/
services.

Autostart services include all files under $KDEDIR/share/autostart 
but not the files under $KDEHOME/Autostart.

Resource Restriction Description

appdata_kdesktop Restricts the default desktop.

apps Restricts the KDE menu.

xdgdata-apps Restricts the KDE menu.

services Restricts registered services.

autostart Restricts autostart services.

lineedit_text_completion Defines whether input lines should have the 
potential to remember any previously entered 
data and make suggestions based on this when 
typing. When a single account is shared by 
multiple people, consider disabling this for privacy 
reasons.

start_new_session Defines whether the user can start a second X 
session. See also the KDM configuration.

opengl_screensavers Defines whether OpenGL screensavers can be 
used.

Action Description
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IMPORTANT: Changing restrictions might influence the data cached in the KDE System 
Configuration Cache (ksycoca) database. Because changes to .../share/config/
kdeglobals do not trigger an automatic ksycoca update, force an update manually by touching 
the .../share/services/update_ksycoca file. This forces a user’s sycoca database to be 
rebuilt the next time the user logs in.

Application desktop files can have an additional field—X-KDE-AuthorizeAction. In this field, 
specify actions that need authorization. Separate multiple actions with commas (,). If the desktop file 
of an application lists one or more actions this way and the user has no authorization for one of these 
actions, the application does not appear in the KDE menu and cannot be used by KDE for opening 
files.

F.3  KDE3 URL Restrictions
It is also possible to restrict URL-related actions. The restriction framework can disable URL 
actions based on the action, the URL and, in some cases, the referring URL. URLs can be matched 
based on protocol, host, and path.

Following is the syntax for adding URL action restrictions to kdeglobals.

NOTE: Parameters of rule_ are on the same line without the trailing backslash.

[KDE URL Restrictions]
rule_count=N
rule_1=action,referingURL_protocol,\
       referingURL_host,referingURL_path,\
       URL_protocol,URL_host,\
       URL_path,enabled
rule_n=action,referingURL_protocol,\
       referingURL_host,referingURL_path,\
       URL_protocol,URL_host,\
       URL_path,enabled

The following actions are supported:

Table F-5   Supported URL Action Restrictions

manipulatescreen_screensavers Defines whether screensavers that manipulate an 
image of the screen (for example, moving chunks 
of the screen around) can be used.

Action Description

redirect With this, an HTML page obtained via HTTP could redirect itself to file:/path/
some-file. This is disabled by default but could be explicitly enabled for a 
specific HTTP host. For example:
rule_1=redirect,http,myhost.acme.com,,file,,,true

Resource Restriction Description
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When restricting actions, consider the following:

Empty entries match everything.
Hostnames can start with a wildcard, as in *.acme.com.
A protocol also matches similar protocols that start with the same name—http matches both 
http and https. Use http! to match http and not https.
Specifying a path matches all URLs that start with the same path. For better results, do not 
include a trailing slash. To specify one specific path, add an exclamation mark (!). For 
example, /srv matches both /srv and /srv/www, but /srv! matches only /srv and not /
srv/www.

F.4  KDE3 Resource Restrictions
Most KDE applications use additional resource files that are typically located in directories under 
$KDEDIR/share. By default, KDE allows users to override any of these resources by placing files 
in the same location under $KDEHOME/share. For example, Konsole stores profiles under 
$KDEDIR/share/apps/konsole and users can add additional profiles by installing files in 
$KDEHOME/share/apps/konsole.

KDE3 resource restrictions make it possible to restrict the lookup of files to directories outside of 
$KDEHOME only. The following resources are defined:

Table F-6   KDE3 Resource Restrictions

list Controls which directories can be browsed with KDE’s file dialogs.To restrict users 
to be able to browse files only under their own home directories, use the following 
rules:
rule_1=list,,,,file,,,false 
rule_2=list,,,,file,,$HOME,true

The first rule disables browsing any directories on the local file system. The second 
rule then enables browsing the user’s home directory.

open Controls which files can be opened by the user in applications. It also affects where 
users can save files. To restrict users to open the files only in their own home 
directories, use the following rules:
rule_1=open,,,,file,,,false 
rule_2=open,,,,file,,$HOME,true 
rule_3=open,,,,file,,$TMP,true

With the above rules, users would still be able to open files from the Internet. They 
are also given access to $TMP to ensure correct operation of KDE applications. 
($TMP is replaced with the temporary directory KDE uses.)

Resource Directory

data share/apps

html share/doc/HTML

icon share/icon

Action Description
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For the purpose of resource restrictions, there are two special resources:

all: Covers all resources.

data_appname: Covers the subsection for appname in the data resource.

To restrict resources, include the [KDE Resource Restrictions] group in the kdeglobals 
file. Each resource can then be restricted by adding resource=false. For example, to restrict 
the wallpaper resource to $KDEDIR/share/wallpapers, add the following:
[KDE Resource Restrictions][$i]
wallpaper=false

To prevent a user from adding additional konsole profiles, add the following:
[KDE Resource Restrictions][$i]
data_konsole=false

F.5  Expansion of Environment Variables in KDE 
Configuration Files
Entries in configuration files can contain environment variables. To use them, the entry must be 
marked with [$e]. For example:
Name[$e]=$USER

When the Name entry is read, $USER is replaced with the value of the $USER environment 
variable. Normally, the application replaces $USER with the value of the environment variable 
when saving. To prevent this, combine $e with $i (immutable). For example:
Name[$ei]=$USER

This example ensures the Name entry always returns the value of the $USER environment variable. 
The user cannot change this entry. The following syntax is also supported:

config share/config

pixmap share/pixmaps

apps share/applnk

xdgdata-apps share/applications

sound share/sounds

locale share/locale

services share/services

servicetypes share/servicetypes

mime share/mimelnk

wallpaper share/wallpapers

templates share/templates

exe bin

lib lib

Resource Directory
 Desktop 9 Deployment Guide



novdocx (E
N

U
)  10 A

ugust 2006
Name[$ei]=${USER}

F.6  Shell Commands in KDE Configuration Files
Entries in configuration files can contain shell commands. This way, the value of a configuration 
entry can be determined dynamically at runtime. To use this, the entry must be marked with [$e].

For example:
Host[$e]=$(hostname)

F.7  Tools
The Kiosk desktop configuration framework comes can be managed by editing bare text files, but 
using Kiosktool or KConfigEditor offer a much more intuitive way of handling desktop 
configuration issues.

F.7.1  Kiosktool
Kiosktool is intended to create and modify profiles. It can enable any lockdown mechanism as 
described. Kiosktool lets you set up the configuration profiles via the existing applications or KDE 
configuration modules, such as the panel, the desktop, and various kcontrol settings. 

Kiosktool can also be used to define which profiles should apply to any specific users or groups. It 
can work with remote configurations, hosted by any server, when configured via the configuration 
dialog. Import all configuration settings using an SSH connection (via the fish://protocol), 
so it is not necessary to configure the server with a writable network file system.

See “Using the KDE Lockdown Mechanism (Kiosk)” on page 317 for more information.

F.7.2  KConfigEditor
KConfigEditor can be used to show and modify single keys in configuration files either for a 
specific user or globally. It can work on both local and remote configurations. It also supports both 
KDE and GNOME. For more information, see “GNOME Configuration for Administrators” on 
page 261.

Browse the settings using the tree view in the side bar. Limit the visible entries by inserting a string 
in its search field. Applications that use the KDE KConfig XT system provide a longer explanation 
for each key. KConfigEditor can show all changes not yet saved with the Tools menu.

F.8  Using the KDE Lockdown Mechanism 
(Kiosk)
The KDE lockdown mechanism (also known as Kiosk) provides an easy way to disable certain 
features within KDE so you can create a more controlled environment (for example, if the system is 
used for one or more specific dedicated tasks only). It builds on KDE’s configuration framework 
and adds a simple application API that applications can query to get authorization for certain 
operations. The KDE Kiosk framework should be used in addition to the standard Linux security 
measures.
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Default values are no longer written. When a configuration file in a location other than $KDEHOME 
defines a value for a key and the application subsequently writes a new configuration file to 
$KDEHOME, that configuration file contains an entry for the key only if its value differs from the 
value read from the other file.

This eliminates the problem of changes to default configuration files under $KDEDIR not taking 
effect for users, because these users have their own copy of these settings under $KDEHOME. KDE 
makes sure not to copy these settings so changes made under $KDEDIR affect all users that have not 
explicitly changed the affected settings to something else.

Starting with KDE3, configuration entries can be marked immutable. When a configuration entry is 
immutable, entries under $KDEHOME for that value are ignored. Configuration files read after the 
file in which it is marked immutable cannot override its value. Immutable entries cannot be changed 
via KConfig. 

Entries can be marked immutable on four different levels:

On an entry-by-entry basis by appending [$i] after the key. 

For example:
[MyGroup]
someKey[$i]=42

On a group-by-group basis by appending [$i] after the group. All entries specified in the 
group are marked immutable and no new entries can be added to the group.
For example:
[MyGroup][$i]
someKey=42

On a file-by-file basis by starting the file with [$i].
For example:
[$i]
[MyGroup]
someKey=42
[MyOtherGroup]
someOtherKey=11

The file system can also be used to mark files immutable. If KDE does not have write access to 
the user’s version of a configuration file, the file is automatically considered immutable. 
To make the configuration file of kicker (the panel) immutable, for example, use the following 
commands:
chown root.root /home/user/.kde/share/config/kickerrc
chmod 644 /home/user/.kde/share/config/kickerrc

If you do this, the user is warned that the configuration file is not writable. If you do not want 
the warning, add the following two lines to the application’s configuration file (or to 
kdeglobals, to disable the warning for all applications):
[KDE Action Restrictions]
warn_unwritable_config=false

When configuration files are marked immutable in whole or in part, the user can no longer make 
permanent changes to the settings that have been marked immutable. Ideally, the application 
recognizes this and no longer offers the user the possibility to change these settings. Unfortunately, 
not all applications support this at the moment. It is therefore possible that the user is still presented 
with an option in the user interface to change a setting that is immutable. However, changes made 
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are not saved. In some cases, the user might be able to use the changed setting until the application 
terminates. In other cases, the changed setting is simply ignored and the application continues to 
work with the immutable setting.

The following applications currently do detect when their configuration files have been marked 
immutable and adjust their user interface accordingly:

kicker 
By marking the kickerrc configuration file as immutable, the panel is locked down so it is not 
possible to make any changes to it.

kdesktop 
By marking the kdesktoprc configuration file as immutable, the desktop is locked down so it is 
no longer possible to select Configure Desktop from its menus.

kcalc 
By marking the kcalcrc configuration file as immutable, the Configure button is not displayed.
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GWorking with the Shell

Graphical user interfaces are increasingly becoming important for Linux, but using the mouse is not 
always the best way to perform daily tasks. The command line provides high flexibility and 
efficiency. The first part of this appendix provides an introduction to the Bash shell. It is followed by 
an explanation of the user permissions concept in Linux and a list of the most important commands. 
It then closes with a description of the vi text editor. 

WARNING: Some commands used at the terminal prompt can delete data and cause your operating 
to cease functioning. Only administrators and advanced users should execute shell commands.

Text-based applications are especially important for controlling older Linux computers that do not 
have the resources for demanding display systems. Virtual consoles are used in this case. Six of 
them are available in text mode (Alt+F1 through Alt+F6). The seventh console is reserved for X. 

G.1  Introduction to Bash
In the KDE taskbar, there is an icon depicting a monitor with a seashell. When you click this icon, a 
console window opens where you can enter commands. The console normally runs Bash (Bourne 
again shell), a program developed as part of the GNU project. It is, by far, the most widely used 
derivative of the Bourne shell (sh). The prompt on the shell's first line usually consists of the 
username, hostname, and current path, but it can be customized. When the cursor is behind this 
prompt, you can send commands directly to your computer system. 

G.1.1  Commands
A command consists of several elements. The first element is always the actual command, followed 
by parameters or options. Commands are executed when you press Enter. Before doing so, you can 
easily edit the command line, add options, or correct typing errors. One of the most frequently used 
commands is ls, which can be used with or without arguments. Entering the plain ls command in the 
console shows the contents of the current directory. 

Options are prefixed with a hyphen. The command ls -l, for instance, shows the contents of the 
same directory in full detail. Next to each filename, you can see the date when the file was created, 
the file size in bytes, and further details, which will be discussed later. One very important option 
that exists for many commands is the --help option. Entering ls --help displays all the 
options for the ls command. 

You can also use the ls command to view the contents of other directories. To do so, the directory 
must be specified as a parameter. For example, to see the contents of Desktop, you would enter ls 
-l Desktop. 

G.1.2  Files and Directories
To use the shell efficiently, it is really useful to have some knowledge about the file and directory 
structures of a Linux system. You can think of directories as electronic folders in which files, 
programs, and subdirectories are stored. The top level directory in the hierarchy is the root directory, 
referred to as /. This is the place from which all other directories can be accessed. 
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The /home directory contains directories where individual users can store their personal files. The 
following figure shows the standard directory tree in Linux, with the home directories of the 
example users xyz, linux, and tux. 

Figure G-1   Excerpt from a Standard Directory Tree

The directory tree of a Linux system has a functional structure that follows the Filesystem Hierarchy 
Standard. The following list provides a brief description of the standard directories in Linux. 

Table G-1   Standard Linux Directories

Directory Description

/ Root directory, starting point of the directory tree.

/home Private directories of users.

/dev Device files that represent hardware components.

/etc Important files for system configuration.

/etc/init.d Boot scripts.

/usr/bin Generally accessible programs.

/bin Programs needed early in the boot process.

/usr/sbin Programs reserved for the system administrator.

/sbin Programs reserved for the system administrator and needed for booting.

/usr/include Header files for the C compiler.

/usr/include/g++ Header files for the C++ compiler.

/usr/share/doc Various documentation files.

/

bin boot dev etc home lib sbin root opt proc mnt tmp usr var srv

ftp wwwkde gnomevmlinuz

hda sda st0

yxz linux tux

ld.so

bin Mail test.c

lib local sbinX1 1R6 bin etc share

bin lib man bin lib man

f2c

doc man

xdm xterm xv faq howto packages
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G.1.3  Bash Functions
There are two important functions of the shell that can make your work a lot easier: 

The history function 
To repeat a command that has been entered before, press the Up arrow until the previous 
command appears at the prompt. Move forward through the list of previously entered 
commands by pressing the Down arrow. To edit the command line, just move the cursor to the 
desired position using the arrow keys and start typing. Use Ctrl+R to search in the history.

The expansion function 
To expand a filename to its full length after typing its first letters until it can be uniquely 
identified, type the first letters and then press Tab. If there are several filenames starting with 
the same letters, obtain a list of them by pressing Tab twice. 

Exercise

Now that you know what a command looks like, which directories exist in Novell® Linux Desktop, 
and how to speed up things when using Bash, put this knowledge into practice with a small exercise. 

1. Open a console from the KDE desktop by clicking the Shell icon. 
2. Enter ls to see the contents of your home directory. 
3. Use the mkdir command (which stands for make directory) to create a new subdirectory 

called test by entering mkdir test. 
4. Now launch the Kate editor by pressing Alt+F2 and typing kate in the input field. Type a few 

letters in the editor, then save the file as Testfile in your home directory. Linux 
distinguishes between uppercase and lowercase; for this exercise, use an uppercase T. 

/usr/share/man System manual pages (man pages).

/usr/src Source code of system software.

/usr/src/linux Kernel source code.

/tmp, /var/tmp Temporary files.

/usr All application programs.

/var Configuration files (for example, those linked from /usr).

/var/log System log files.

/var/adm System administration data.

/lib Shared libraries (for dynamically linked programs).

/proc Process file system.

/usr/local Local, distribution-independent extensions.

/opt Optional software, larger add-on program packages (such as KDE, 
GNOME).

Directory Description
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5. View the contents of your home directory again. Instead of typing ls again, just press the up 
arrow key twice and the ls command should reappear at the prompt. To execute the command, 
press Enter. The newly created directory named test should appear in blue letters and 
Testfile in black. This is how directories and files can be distinguished in a console. 

6. Move Testfile into the subdirectory test with the command mv. To speed this up, use the 
expansion function: just enter mv T and press Tab. As long as there is no other file beginning 
with this letter in the directory, the shell expands the filename and adds the string estfile. 
Otherwise, add a letter or two yourself and press Tab each time to see whether the shell can 
now expand the name. Finally, type a space then test after the expanded filename and press 
Enter to execute the command. 

7. At this point, Testfile should no longer be in the directory. Check this by entering ls 
again. 

8. To see whether the file has been successfully moved, change to the directory test by entering 
the cd test command. Now enter ls again. You should see Testfile in the listing. 
Change back to your home directory at any point by entering only cd. 

9. To make a copy of a file, enter cp. For instance, enter cp Testfile Testbackup to copy 
Testfile to Testbackup. Again, the ls command can be used to see whether both files 
are in the directory. 

G.1.4  Specifying Paths
When working with files or directories, it is important specify the correct path. However, you do not 
need to enter the entire (absolute) path from the root directory to the respective file. Rather, you can 
start from the current directory. Address your home directory directly with a tilde (~). Accordingly, 
there are two ways to list the file Testfile in the directory test: by specifying the relative path with 
ls test/* or by specifying the absolute path with ls ~/test/*. 

To list the contents of home directories of other users, enter ls ~username. In the above-
mentioned directory tree, one of the sample users is tux. In this case, ls ~tux would list the 
contents of the home directory of tux. 

Refer to the current directory with a dot (.). The next higher level in the tree is represented by two 
dots (..). By entering ls .., you can see the contents of the parent directory of the current 
directory. The command ls ../.. shows the contents of the directory two levels higher in the 
hierarchy. 

Exercise

Try this exercise to practice moving around in the directories of your Novell Linux Desktop system. 

1. Change into your home directory using the cd command. Then create a directory in it with the 
name test2 by entering mkdir test2. 

2. Change into the new directory using cd test2 and create a subdirectory in it with the name 
subdirectory. To change to it, use the expansion function: enter cd su then press Tab. 
The shell will expand the rest of the directory name. 

3. Now try to move the previously created file Testbackup into the current directory 
(subdirectory) without changing the directory again. To achieve this, enter the relative path to 
that file: mv ../../test/Testbackup .. The dot at the end of this command is required 
to tell the shell that the current directory is the destination to move the file to. In this exercise, 
../../ refers to your home directory. 
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G.1.5  Wildcards
Another convenience offered by the shell is four types of wildcards:

Table G-2   Shell Wildcards

Assuming that your test directory contains the files Testfile, Testfile1, Testfile2, and 
datafile, the command ls Testfile? lists the files Testfile1 and Testfile2. 
Entering ls Test* will add Testfile. The command ls *fil* shows all the sample files. 
Finally, you can use the set wildcard to address all sample files whose last character is a number (for 
example, ls Testfile[1-9]). 

Of the four types of wildcards, the most inclusive one is the asterisk (*). It can be used to copy all 
files contained in one directory to another one or to delete all files with one command. The rm 
*fil* command, for instance, would delete all files in the current directory whose name includes 
the string fil. 

G.1.6  Less and More
Linux includes two small programs for viewing text files directly in the shell. Rather than starting an 
editor to read a file like Readme.txt, simply enter the command less Readme.txt to display 
the text in the console window. Use the Space key to scroll down one page. Use Page Up and Page 
Down to move forward or backward in the text. To exit the less program, press Q. 

Instead of less, you can also use the older program, more. However, it is less convenient because it 
does not allow you to scroll backwards. 

The program less got its name from the precept that “less is more” and it can also be used to view the 
output of commands in a convenient way. To see how this works, see the next section, “Pipes” on 
page 325. 

G.1.7  Pipes
Normally, the standard output in the shell is your screen or the console window, and the standard 
input is the keyboard. To forward the output of a command to an application such as less, use a 
pipeline (|). 

To view the files in the test directory, you would enter the ls test | less command. The 
contents of the test directory will be displayed with less. This makes sense only if the normal 
output with ls would be too lengthy. For instance, if you view the contents of the dev directory 
with ls /dev, you will only see a small portion in the window. But you can view the entire list 
with ls /dev | less. 

Wildcard Description

? Matches exactly one arbitrary character.

* Matches any number of characters.

[set] Matches one of the characters from the group specified inside the square 
brackets, which is represented here by the string set.

[!set] Matches one character other than those identified by set.
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It is also possible to save the output of commands to a file. For example, ls test > Content 
generates a new file called Content that contains a list of the files and directories in test. View 
the file using the less Content command. 

You can also use a file as the input for a command. For example, sort the text lines in Testfile with 
sort < Testfile. The output of the command sort is sent to the screen. The text is sorted by 
the first letters of the individual lines. 

If you need a new file containing the sorted list, pipe the output of the command sort to a file. To test 
this, create an unsorted name list in an editor and save it under list in the test directory. Then 
change to test and enter the sort < unsortedlist > sortedlist command. Finally, 
view the sorted list with the less command. 

Just like the standard output, the standard error output is sent to the console as well. However, to 
redirect the standard error output to a file named errors, append 2> errors to the 
corresponding command. Both standard output and standard error are saved to one file named 
alloutput if you append >& alloutput. Finally, to append the output of a command to an already 
existing file, the command must be followed by >> instead of a single >. 

G.1.8  Archives and Data Compression
Now that you have already created a number of files and directories, consider the subject of archives 
and data compression. Suppose you want to have the entire test directory packed into one file that 
you can save on a floppy disk as a backup copy or send by e-mail. To do so, use the tar command 
(for tape archiver). With tar --help, you can view all the options for the tar command. The 
most important of these options are explained here: 

Table G-3   tar Command Options

To pack the test directory with all its files and subdirectories into an archive named 
testarchive.tar, use the -c and -f options. For the testing purposes of this example, also 
add -v to follow the progress of the archiving, although this option is not mandatory. After using cd 
to change to your home directory where the test directory is located, enter tar -cvf 
testarchive.tar test. After that, view the contents of the archive file with tar -tf 
testarchive.tar. The test directory with all its files and directories has remained 
unchanged on your hard disk. To unpack the archive, you can enter tar -xvf 
testarchive.tar, but do not try this yet. 

For file compression, the obvious choice on Linux is the popular gzip program. Just enter gzip 
testarchive.tar. With ls, you can now see that the testarchive.tar file is no longer 

Option Description

-c (create) Creates a new archive.

-t (table) Displays the contents of an archive.

-x (extract) Unpacks the archive.

-v (verbose) Shows all files on screen while creating the archive.

-f (file) Selects a filename for the archive file. When creating an archive, this option 
must always be given as the last one.
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there and that the testarchive.tar.gz file has been created instead. This file is much smaller 
and, therefore, much better suited for transfer via e-mail or storage on a floppy. 

Now, unpack this file in the test2 directory created earlier. To do so, enter cp 
testarchive.tar.gz test2 to copy the file to that directory. Change to the directory using 
cd test2. A compressed archive with the .tar.gz extension can be unzipped with the gunzip 
command. Enter gunzip testarchive.tar.gz, which results in the testarchive.tar 
file, which then needs to be extracted (or untarred) with tar -xvf testarchive.tar. You 
can also unzip and extract a compressed archive in one step by adding the -z option. The complete 
command would be tar -xzvf testarchive.tar.gz. With ls, you can see that a new test 
directory has been created with the same contents as your test directory in your home directory. 

G.1.9  mtools
mtools is a set of commands for working with MS-DOS file systems. The commands included in 
mtools allow you to address the first floppy drive as a:, just like under MS-DOS, and the commands 
are like MS-DOS commands except they are prefixed with m.

Table G-4   mtools Commands

G.1.10  Cleaning Up
After this crash course, you should be familiar with the basics of the Linux shell or command line. 
You might want to clean up your home directory by deleting the various test files and directories 
using the rm and rmdir commands. See “Important Linux Commands” on page 331 for a list of the 
most important commands and a brief description of their functions.

G.2  Users and Access Permissions
Since its inception in the early 1990s, Linux has been developed as a multiuser system. Any number 
of users can work on it simultaneously. Users need to log in to the system before starting a session at 
their workstation, and each user has a username with a corresponding password. This differentiation 
of users guarantees that unauthorized users cannot see files for which they do not have permission. 
Larger changes to the system, such as installing new programs, are also usually impossible or 
restricted for normal users. Only the super user (root), has the unrestricted capacity to make changes 
to the system and has unlimited access to all files. Those who use this concept wisely, only logging 

Command Description

mdir a: Displays the contents of the floppy disk in drive a:.

mcopy Testfile a: Copies the file Testfile to the floppy disk.

mdel a:Testfile Deletes Testfile from a:. 

mformat a: Formats the floppy disk in MS-DOS format (using the fdformat 
command).

mcd a: Makes a: your current directory. 

mmd a:test Creates the subdirectory test on the floppy disk. 

mrd a:test Deletes the subdirectory test from the floppy disk.
Working with the Shell 327



328 Novell Linux

novdocx (E
N

U
)  10 A

ugust 2006
in with full root access when necessary, can cut back the risk of unintentional loss of data. Because 
under normal circumstances only root can delete system files or format hard disks, the threat from 
the Trojan horse effect or from accidentally entering destructive commands can be significantly 
reduced. 

G.2.1  File System Permissions
Basically, every file in a Linux file system belongs to a user and a group. Both of these proprietary 
groups and all others can be authorized to write, read, or execute these files. 

A group, in this case, can be defined as a set of connected users with certain collective rights. For 
example, you can call a group of people working on a certain project project3. Every user in a 
Linux system is a member of at least one proprietary group, normally called users. There can be as 
many groups in a system as needed, but only root is able to add groups. Every user can find out 
which groups he is a member of by using the groups command.

File Access

The organization of permissions in the file system differs for files and directories. File permission 
information can be displayed with the ls -l command. The output could appear as follows: 
-rw-r----- 1 tux project3 14197 Jun 21  15:03 Roadmap

In this example, this file belongs to the tux user. It is assigned to the project3 group. To discover 
the user permissions of the Roadmap file, the first column must be examined more closely. 

This column is comprised of one leading character followed by nine characters grouped in threes. 
The first of the 10 letters stands for the type of file system component. The dash (-) shows that this 
is a file. A directory (d), a link (l), a block device (b), or a character device could also be indicated. 

The next three blocks follow a standard pattern. The first three characters refer to whether the file is 
readable (r) or not (-). A w in the middle portion symbolizes that the corresponding object can be 
edited and a dash (-) means it is not possible to write to the file. An x in the third position denotes 
that the object can be executed. Because the file in this example is a text file and not one that is 
executable, executable access for this particular file is not needed. 

In this example, tux has, as owner of the file Roadmap, read (r) and write access (w) to it, but 
cannot execute it (x). The members of the project3 group can read the file, but they cannot 
modify it or execute it. Other users do not have any access to this file. Other permissions can be 
assigned by means of ACLs (Access Control Lists). See “Access Control Lists” on page 331 for 
more information.

Directory Permissions

Access permissions for directories have the type d. For directories, the individual permissions have 
a slightly different meaning. 
drwxrwxr-x 1 tux project3 35 Jun 21 15:15 ProjectData

In the above example, the owner (tux) and the owning group (project3) of the ProjectData 
directory are easy to recognize. In contrast to the file access permissions from “Working with the 

- rw- r-- ---

Type Users Permissions Group Permissions Permissions for Other Users
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Shell” on page 321, the set reading permission (r) means that the contents of the directory can be 
shown. The write permission (w) means new files can be created. The executable permission (x) 
means the user can change to this directory. In the above example, this means the user tux as well as 
the members of the project3 group can change to the ProjectData directory (x), view the 
contents (r), and add new files to it (w). The rest of the users, on the other hand, are given less 
access. They can enter the directory (x) and browse through it (r), but not insert any new files (w). 

G.2.2  Modifying File Permissions

Access Permissions

The access permissions of a file or directory can be changed by the owner and, of course, by the root 
user, with the chmod command followed by the parameters changing the permissions and one or 
more filenames. The parameters form different categories: 

1. Users concerned
u (user): Owner of the file
g (group): Group that owns the file
o (others): Additional users (if no parameter is given, the changes apply to all categories)

2. A character for deletion (-), setting (=), or insertion (+)
3. The abbreviations

r (read)
w (write)
x (execute)

4. Filenames separated by spaces

If, for example, the tux user also wants to grant other users write (w) access to the ProjectData 
directory, he can do this using the chmod o+w ProjectData command. 

If, however, he wants to deny all users other than himself write permissions, he can do this by 
entering the chmod go-w ProjectData command. To prohibit all users from adding a new file 
to the ProjectData folder, enter chmod -w ProjectData. Now, not even the owner can 
write to the file without first re-establishing write permissions. 

Ownership Permissions

Other important commands to control the ownership and permissions of the file system components 
are chown (change owner) and chgrp (change group). The command chown can be used to 
transfer ownership of a file to another user. However, only root is permitted to perform this change. 

Suppose the file Roadmap should no longer belong to tux, but to the user geeko. root should then 
enter chown geeko Roadmap. 

chgrp changes the group ownership of the file. However, the owner of the file must be a member 
of the new group. In this way, the user tux can switch the group owning the file ProjectData to 
project4 with the command chgrp project4 ProjectData, as long as he is a member of 
this new group. 
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G.2.3  The setuid Bit
In certain situations, the access permissions might be too restrictive. Therefore, Linux has additional 
settings that enable the temporary change of the current user and group identity for a specific action. 
For example, the cdrecord program normally requires root permissions to access the writer for 
burning CDs (or DVDs). Thus, a normal user would not be able to create CDs, because it would be 
too dangerous to grant all users direct access to all devices. A possible solution to this problem is 
setuid (set user ID), which is a special file attribute that instructs the system to execute programs 
marked accordingly under a specific user ID. Consider the cdrecord command: 
-rwxr-x---  1 root root  281356 2002-10-08 21:30 /usr/bin/cdrecord

Set the setuid bit with the chmod u+s /usr/bin/cdrecord command, then assign the 
cdrecord program to the users group with the chgrp users /usr/bin/cdrecord 
command. The following access permissions are granted:
-rws--x---  1 root users  281356 2002-10-08 21:30 /usr/bin/cdrecord

By means of the setuid bit, all users belonging to the users group can use the program. In effect, 
this means that the program is executed as root. 

WARNING: Setting the setuid bit for a program makes your computer more vulnerable to attacks. 
Do this only in exceptional cases when you know the program well and are aware of the potential 
risks. 

G.2.4  The setgid Bit
The setuid attribute applies to users. However, there is also an equivalent property for groups—the 
setgid attribute. Any program that this attribute is set for runs under the group ID it was save under, 
no matter which user starts it. Therefore, in a directory with the setgid bit, all newly created files and 
subdirectories are assigned to the group that the directory belongs to. Consider the following 
example directory: 
drwxrwxr--  2 root archive   48 Nov 19 17:12 backup

Set the setuid bit with the chmod g+s /test command. Subsequently, the access permissions 
appear as follows: 
drwxrwxr--   2 root archive   48 Nov 19 17:12 backup

G.2.5  The Sticky Bit
There is also the sticky bit. It makes a difference whether it belongs to an executable program or a 
directory. If it belongs to a program, a file marked in this way will be loaded to the RAM to avoid 
needing to get it from the hard disk each time it is used. This attribute is rarely used because modern 
hard disks are usually fast enough. If this attribute is assigned to a directory, it prevents users from 
deleting each other’s files. Typical examples include the /tmp and /var/tmp directories: 
drwxrwxrwt   2 root  root   1160 2002-11-19 17:15 /tmp
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G.2.6  Access Control Lists
The traditional permission concept for Linux file system objects, such as files or directories, can be 
expanded by means of ACLs (Access Control Lists). They allow the assignment of permissions to 
individual users or groups other than the original owner or owning group of a file system object. 

Files or directories bearing extended access permissions can be detected with a simple ls -l 
command: 
-rw-r--r--+ 1 tux project3 14197 Jun 21  15:03 Roadmap

The output of ls does not reveal much of a change compared to an ls on a file without an ACL. 
Roadmap is owned by tux who belongs to the project3 group. tux holds both write and read 
access to this file, and his group as well as all other users have read access. The only difference that 
distinguishes this file from a file without an ACL is the additional + in the first column holding the 
permission bits. 

Get details about the ACL by executing getfacl Roadmap, which results in the following: 
# file: Roadmap
# owner: tux
# group: project3
user::rw-
user:jane:rw-       effective: r--
group::r--
group:djungle:rw-   effective: r--
mask::r--
other::---

The first three lines of the output do not hold any information not available with ls -l. These lines 
only state filename, owner, and owning group. Lines 4 to 9 hold the ACL entries. Conventional 
access permissions represent a subset of those possible when using ACLs. This example ACL grants 
read and write access to the owner of the file as well as to the jane user (lines 4 and 5). The 
conventional concept has been expanded, allowing access to an extra user. The same applies to the 
handling of group access. The owning group holds read permissions (line 6) and the djungle 
group holds read and write permissions. The mask entry in line 8 reduces the effective permissions 
for the jane user and the djungle group to read access. Other users and groups do not get any 
kind of access to the file (line 9). 

Only very basic information has been provided here. Find more information about ACLs, see 
“Chapter 27: Access Control Lists in Linux” in the SUSE LINUX Enterprise Server 9 
Administration Guide (http://www.novell.com/documentation/sles9/pdfdoc/sles_9_admin_guide/
sles_9_admin_guide.pdf).

G.3  Important Linux Commands
This section gives insight into the most important commands of your Novell Linux Desktop system. 
Along with the individual commands, parameters are listed and, where appropriate, a typical sample 
application is introduced. To learn more about the various commands, use the man pages, accessed 
using man followed by the name of the command (for example, man ls). 

In the man pages, move up and down with the PgUp and PgDn keys. Move between the beginning 
and the end of a document with Home and End. End this viewing mode by pressing Q. Learn more 
about the man command itself with man man command. 
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Adjust the settings to your needs. It makes no sense to write ls file(s), if no file named file(s) actually 
exists. You can usually combine several parameters, for example, by writing ls -la instead of ls 
-l -a. 

TIP: There are many more commands than listed here. For information about other commands, or 
more detailed information, we recommend the O’Reilly publication Linux in a Nutshell. 

G.3.1  File Commands
This section introduces the most important file commands you will need in your every day life with 
a Linux system.

File Administration Commands

Command Description

ls [option(s)] [file(s)] If you run ls without any additional parameters, the 
program lists the contents of the current directory in short 
form. 

-l Detailed list.

-a Displays hidden files.

cp [option(s)] source target Copies source file to a target file. 

-i Waits for confirmation, if necessary, before an existing 
target file is overwritten. 

-r Copies recursively (includes subdirectories)

mv [option(s)] source target Copies source file to target file, then deletes the 
original source file. 

-b Creates a backup copy of the source file before 
moving.

-i Waits for confirmation, if necessary, before an existing 
target file is overwritten.

rm [option(s)] files Removes the specified files from the file system. 
Directories are nor removed by rm unless the -r option is 
used.

-r Deletes any existing subdirectories.

-i Waits for confirmation before deleting each file.

ln [option(s)] source target Creates an internal link from the source file to the 
target file. Normally, such a link points directly to the 
source file on the same file system. However, if ln is 
executed with the -s option, it creates a symbolic link that 
only points to the directory in which the source file is 
located, enabling linking across file systems. 

-s Creates a symbolic link.
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cd [options(s)] [directory] Changes the current directory; cd without any parameters 
changes to the user’s home directory.

mkdir [option(s)] directoryname Creates a new directory.

rmdir [option(s)] directoryname Deletes the specified directory, if it is already empty.

chown [option(s)] username.group 
files

Transfers ownership of a file to the user with the specified 
username. 

-R Changes files and directories in all subdirectories. 

chgrp [option(s)] groupname files Transfers the group ownership of a given file to the group 
with the specified group name. The file owner can change 
group ownership only if he is a member of both the 
current and the new group.

chmod [options] mode files Changes the access permissions. 

The mode parameter has three parts: group, access, and 
access type. group accepts the following characters: 

u user

g group

o others

For access, grant access with + and deny it with -. 

The access type is controlled by the following options: 

r read

w write

x eXecute (executing files or changing to the 
directory) 

s Set uid bit (the application or program is started as 
if it were started by the owner of the file) 

As an alternative, a numeric code can be used. The four 
digits of this code are composed of the sum of the values 
4, 2, and 1 (the decimal result of a binary mask). The first 
digit sets the set user ID (SUID) (4), the set group ID (2), 
and the sticky (1) flags. The second digit defines the 
permissions of the owner of the file. The third digit defines 
the permissions of the group members, and the last digit 
sets the permissions for all other users. The read 
permission is set with 4, the write permission with 2, and 
the permission for executing a file is set with 1. The owner 
of a file would usually receive a 7 (the sum of all 
permissions). 

Command Description
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gzip [parameters] files This program compresses the contents of files using 
complex mathematical algorithms. Files compressed in 
this way are given the extension .gz and need to be 
uncompressed before they can be used. To compress 
several files or even entire directories, use the tar 
command. 

-d Decompresses the packed gzip files so they return to 
their original size and can be processed normally (like the 
command gunzip). 

tar options archive files tar puts one or more files into an archive. Compression is 
optional. tar is a complex command with a number of 
options available. The most frequently used options are 
the following: 

-f Writes the output to a file and not to the screen as is 
usually the case. 

-c Creates a new tar archive. 

-r Adds files to an existing archive.

-t Outputs the contents of an archive.

-u Adds files, but only if they are newer than the files 
already contained in the archive.

-x Unpacks files from an archive (extraction). 

-z Packs the resulting archive with gzip. 

-j Compresses the resulting archive with bzip2. 

-v Lists files processed.

The archive files created by tar end with .tar. If the tar 
archive was also compressed using gzip, the ending is 
.tgz or .tar.gz. If it was compressed using bzip2, the 
ending is .tar.bz2. Application examples can be found in 
“Archives and Data Compression” on page 326. 

locate pattern(s) The locate command can find which directory a specified 
file is located in. If desired, use to specify filenames. The 
program is very fast, because it uses a database 
specifically created for the purpose (rather than searching 
through the entire file system). This very fact, however, 
also results in a major drawback: it is unable to find any 
files created after the latest update of its database. The 
database can be generated by root with updatedb.

updatedb [options(s)] This command performs an update of the database used 
by locate. To include files in all existing directories, run 
the program as root. It also makes sense to place it in the 
background by appending an ampersand (&), so you can 
immediately continue working on the same command line 
(updatedb &).

Command Description
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Commands to Access File Contents

find [option(s)] With find, search for a file in a given directory. The first 
argument specifies the directory to start the search in. 
The option -name must be followed by a search string, 
which can also include wildcards. Unlike locate, which 
uses a database, find scans the actual directory. 

Command Description

cat [option(s)] files The cat command displays the contents of a file, printing 
the entire contents to the screen without interruption. 

-n Numbers the output on the left margin.

less [option(s)] files This command can be used to browse the contents of the 
specified file. Scroll half a screen up or down with PgUp 
and PgDn, or a full screen page down with the Spacebar. 
Jump to the beginning or end of a file using Home and 
End. Press Q to exit the program.

grep [option(s)] searchstring 
filenames

The grep command finds a specific search string in the 
specified file(s). If the search string is found, the command 
displays the line in which the searchstring was found 
along with the filename. 

-i Ignores case.

-H Displays only the names of the respective files, not the 
text lines. 

-n Additionally displays the numbers of the lines in which 
it found a hit. 

-l Lists only the files in which searchstring does not 
occur. 

diff [option(s)] file1 file2 The diff command compares the contents of any two 
files. The output produced by the program lists all lines 
that do not match. This is frequently used by programmers 
who need to send only their program alterations and not 
the entire source code. 

-q Reports only whether the two files differ. 

Command Description
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File System Commands

G.3.2  System Commands
This section introduces some of the most important commands you need in managing your system.

System Information Commands

Command Description

mount [option(s)] [device] mountpoint This command can be used to mount any data 
media (such as hard disks, CD-ROM drives, and 
other drives) to a directory of the Linux file system. 

-r Mounts read-only.

-t filesystem Specifies the file system. The most 
common are ext2 for Linux hard disks, msdos for 
MS-DOS media, vfat for the Windows file system, 
and iso9660 for CDs. 

For hard disks not defined in the file /etc/fstab, 
the device type must also be specified. In this case, 
only root can mount it. If the file system should also 
be mounted by other users, enter the option user in 
the appropriate line in the /etc/fstab file 
(separated by commas) and save this change. 
Further information is available in man mount. 

umount [option(s)] mountpoint This command unmounts a mounted drive from the 
file system. To prevent data loss, run this command 
before taking a removable data medium from its 
drive. Normally, only root is allowed to run the 
commands mount and umount. To enable other 
users to run these commands, edit the 
/etc/fstab file to specify the option user for the 
respective drive. 

Command Description

df [option(s)] [directory] This command, when used without any options, displays 
information about the total disk space, the disk space currently in 
use, and the free space on all the mounted drives. If a directory is 
specified, the information is limited to the drive where that directory 
is located. 

-H Shows the number of occupied blocks in gigabytes, megabytes, 
or kilobytes (in human-readable format). 

-t Type of file system (ext2, nfs, etc.).
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Processes Commands

du [option(s)] [path] This command, when executed without any parameters, shows the 
total disk space occupied by files and subdirectories in the current 
directory. 

-a Displays the size of each individual file.

-s Displays only the calculated total size.

-h Output in human-readable form.

free [option(s)] The command free displays information about RAM and swap 
space usage, showing the total and the used amount in both 
categories. 

-b Output in bytes.

-k Output in kilobytes.

-m Output in megabytes.

date [option(s)] This simple program displays the current system time. If run by 
root, it can also be used to change the system time. Details about 
the program are available in date.

Command Description

top [options(s)] Provides a quick overview of the processes currently 
running. Press H to access a page that briefly explains the 
main options to customize the program.

ps [option(s)] [process ID] If run without any options, this command displays a table 
of all your own programs or processes—those you started. 
The options for this command are not preceded by 
hyphen. 

aux Displays a detailed list of all processes, independent 
of the owner. 

kill [option(s)] process ID Unfortunately, sometimes a program cannot be terminated 
in the normal way. In most cases, you should still be able 
to stop such a runaway program by executing the kill 
command, specifying the respective process ID (see top 
and ps). kill sends a TERM signal that instructs the 
program to shut itself down. If this does not help, the 
following parameter can be used: 

-9 Sends a KILL signal instead of a TERM signal. This 
brings the specified process to an end in almost all cases. 

killall [option(s)] 
processname

This command is similar to kill, but uses the process 
name (instead of the process ID) as an argument, killing all 
processes with that name.

Command Description
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Network Commands

Miscellaneous Commands

G.4  The vi Editor
Operating the vi editor takes some practice. For many, it is the preferred editor, partly because it is 
available on any UNIX-like operating system and is included in default Linux installations. Also, if 

Command Description

ping [option(s)] host name|IPaddress The ping command is the standard tool for testing 
the basic functionality of TCP/IP networks. It sends a 
small data packet to the destination host, requesting 
an immediate reply. If this works, ping displays a 
message to that effect, which indicates that the 
network link is basically functioning. 

-cnumber 

Determines the total number of packages to send 
and ends after they have been dispatched. By 
default, there is no limitation set.

-f flood ping: sends as many data packages as 
possible. A popular means, reserved for root, to test 
networks. 

-i value Specifies the interval between two data 
packages in seconds. Default=one second. 

host The domain name system resolves domain names to 
IP addresses. With this tool, send queries to 
information servers (DNS servers).

Command Description

passwd [option(s)] [username] Users can change their own passwords at any time using this 
command. The administrator root can use the command to 
change the password of any user on the system. 

su [option(s)] [username] The su command makes it possible to log in under a different 
user name from a running session. When using the command 
without specifying a user name, you will be prompted for the 
root password. Specify a user name and the corresponding 
password to use the environment of the respective user. The 
password is not required from root, as root is authorized to 
assume the identity of any user.

halt [option(s)] To avoid loss of data, you should always use this program to 
shut down your system.

reboot [option(s)] Does the same as halt except the system performs an 
immediate reboot.

clear Cleans up the visible area of the console. It has no options.
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nothing else works, vi will. The short instructions that follow should enable you to edit various 
configuration files and other types of files with vi. 

vi provides three operating modes. In command mode keys are interpreted as command elements. 
Insert mode interprets all keys as text entries. Last line mode is used for more complex commands, 
which are entered in the last line. 

The most important commands in command mode are: 

Table G-5   vi Command Mode Commands

Each command can be preceded by a number specifying on how many objects the following 
command should operate. Delete three words at once by entering 3dw. The command 10x deletes 
ten characters after the cursor position and 20dd deletes twenty lines. 

The most important commands in last line mode are: 

Command Description

ESC Changes to last line mode.

i Changes to insert mode (characters appear at the current cursor position).

a Changes to insert mode (characters appear after the current cursor position).

A Changes to insert mode (characters are added at the end of the line).

R Changes to command mode (overwrites the old text).

r Changes to insert mode and overwrites each character.

s Changes to insert mode (the character where the cursor is positioned is replaced by 
the next entry you make).

C Changes to insert mode (the rest of the line is replaced by the new text).

o Changes to insert mode (a new line is inserted after the current one).

O Changes to insert mode (a new line is inserted before the current one).

x Changes to insert mode (a new line is inserted before the current one).

dd Deletes the current line.

dw Deletes up to the end of the current word.

cw Changes to insert mode (the rest of the current word is overwritten by the next 
entries you make).

u Undoes the last command.

J Joins the following line with the current one.

. Repeats the last command.

: Changes to last line mode.
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Table G-6   vi Last Line Mode Commands

Command Description

:q! Exits vi without saving any changes.

:w filename Saves as filename.

:x Saves the modified file and exits the editor.

:e filename Edits (loads) filename.

:u Undoes the last edit command.
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HGNU Licenses

This appendix contains the following:

“GNU General Public License” on page 341
“GNU Free Documentation License” on page 346

H.1  GNU General Public License
Version 2, June 1991 

Copyright (C) 1989, 1991 Free Software Foundation, Inc. 59 Temple Place - Suite 330, Boston, MA 
02111-1307, USA

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing 
it is not allowed.

H.1.1  Preamble
The licenses for most software are designed to take away your freedom to share and change it. By 
contrast, the GNU General Public License is intended to guarantee your freedom to share and 
change free software--to make sure the software is free for all its users. This General Public License 
applies to most of the Free Software Foundation’s software and to any other program whose authors 
commit to using it. (Some other Free Software Foundation software is covered by the GNU Library 
General Public License instead.) You can apply it to your programs, too.

When we speak of free software, we are referring to freedom, not price. Our General Public 
Licenses are designed to make sure that you have the freedom to distribute copies of free software 
(and charge for this service if you wish), that you receive source code or can get it if you want it, that 
you can change the software or use pieces of it in new free programs; and that you know you can do 
these things. 

To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or to 
ask you to surrender the rights. These restrictions translate to certain responsibilities for you if you 
distribute copies of the software, or if you modify it. 

For example, if you distribute copies of such a program, whether gratis or for a fee, you must give 
the recipients all the rights that you have. You must make sure that they, too, receive or can get the 
source code. And you must show them these terms so they know their rights. 

We protect your rights with two steps: (1) copyright the software, and (2) offer you this license 
which gives you legal permission to copy, distribute and/or modify the software. 

Also, for each author’s protection and ours, we want to make certain that everyone understands that 
there is no warranty for this free software. If the software is modified by someone else and passed 
on, we want its recipients to know that what they have is not the original, so that any problems 
introduced by others will not reflect on the original authors’ reputations.

Finally, any free program is threatened constantly by software patents. We wish to avoid the danger 
that redistributors of a free program will individually obtain patent licenses, in effect making the 
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program proprietary. To prevent this, we have made it clear that any patent must be licensed for 
everyone’s free use or not licensed at all. 

The precise terms and conditions for copying, distribution and modification follow. 

H.1.2  GNU GENERAL PUBLIC LICENSE TERMS AND 
CONDITIONS FOR COPYING, DISTRIBUTION AND 
MODIFICATION
0. This License applies to any program or other work which contains a notice placed by the 
copyright holder saying it may be distributed under the terms of this General Public License. The 
“Program”, below, refers to any such program or work, and a “work based on the Program” means 
either the Program or any derivative work under copyright law: that is to say, a work containing the 
Program or a portion of it, either verbatim or with modifications and/or translated into another 
language. (Hereinafter, translation is included without limitation in the term “modification”.) Each 
licensee is addressed as “you”.

Activities other than copying, distribution and modification are not covered by this License; they are 
outside its scope. The act of running the Program is not restricted, and the output from the Program 
is covered only if its contents constitute a work based on the Program (independent of having been 
made by running the Program). Whether that is true depends on what the Program does. 

1. You may copy and distribute verbatim copies of the Program’s source code as you receive it, in 
any medium, provided that you conspicuously and appropriately publish on each copy an 
appropriate copyright notice and disclaimer of warranty; keep intact all the notices that refer to this 
License and to the absence of any warranty; and give any other recipients of the Program a copy of 
this License along with the Program. 

You may charge a fee for the physical act of transferring a copy, and you may at your option offer 
warranty protection in exchange for a fee. 

2. You may modify your copy or copies of the Program or any portion of it, thus forming a work 
based on the Program, and copy and distribute such modifications or work under the terms of 
Section 1 above, provided that you also meet all of these conditions: 

a) You must cause the modified files to carry prominent notices stating that you changed the files 
and the date of any change. 

b) You must cause any work that you distribute or publish, that in whole or in part contains or is 
derived from the Program or any part thereof, to be licensed as a whole at no charge to all third 
parties under the terms of this License.

c) If the modified program normally reads commands interactively when run, you must cause it, 
when started running for such interactive use in the most ordinary way, to print or display an 
announcement including an appropriate copyright notice and a notice that there is no warranty (or 
else, saying that you provide a warranty) and that users may redistribute the program under these 
conditions, and telling the user how to view a copy of this License. (Exception: if the Program itself 
is interactive but does not normally print such an announcement, your work based on the Program is 
not required to print an announcement.) 

These requirements apply to the modified work as a whole. If identifiable sections of that work are 
not derived from the Program, and can be reasonably considered independent and separate works in 
themselves, then this License, and its terms, do not apply to those sections when you distribute them 
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as separate works. But when you distribute the same sections as part of a whole which is a work 
based on the Program, the distribution of the whole must be on the terms of this License, whose 
permissions for other licensees extend to the entire whole, and thus to each and every part regardless 
of who wrote it. 

Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely 
by you; rather, the intent is to exercise the right to control the distribution of derivative or collective 
works based on the Program. 

In addition, mere aggregation of another work not based on the Program with the Program (or with a 
work based on the Program) on a volume of a storage or distribution medium does not bring the 
other work under the scope of this License. 

3. You may copy and distribute the Program (or a work based on it, under Section 2) in object code 
or executable form under the terms of Sections 1 and 2 above provided that you also do one of the 
following: 

a) Accompany it with the complete corresponding machine-readable source code, which must be 
distributed under the terms of Sections 1 and 2 above on a medium customarily used for software 
interchange; or, 

b) Accompany it with a written offer, valid for at least three years, to give any third party, for a 
charge no more than your cost of physically performing source distribution, a complete machine-
readable copy of the corresponding source code, to be distributed under the terms of Sections 1 and 
2 above on a medium customarily used for software interchange; or, 

c)  Accompany it with the information you received as to the offer to distribute corresponding 
source code. (This alternative is allowed only for noncommercial distribution and only if you 
received the program in object code or executable form with such an offer, in accord with 
Subsection b above.) 

The source code for a work means the preferred form of the work for making modifications to it. For 
an executable work, complete source code means all the source code for all modules it contains, plus 
any associated interface definition files, plus the scripts used to control compilation and installation 
of the executable. However, as a special exception, the source code distributed need not include 
anything that is normally distributed (in either source or binary form) with the major components 
(compiler, kernel, and so on) of the operating system on which the executable runs, unless that 
component itself accompanies the executable. 

If distribution of executable or object code is made by offering access to copy from a designated 
place, then offering equivalent access to copy the source code from the same place counts as 
distribution of the source code, even though third parties are not compelled to copy the source along 
with the object code. 

4. You may not copy, modify, sublicense, or distribute the Program except as expressly provided 
under this License. Any attempt otherwise to copy, modify, sublicense or distribute the Program is 
void, and will automatically terminate your rights under this License. However, parties who have 
received copies, or rights, from you under this License will not have their licenses terminated so 
long as such parties remain in full compliance. 

5. You are not required to accept this License, since you have not signed it. However, nothing else 
grants you permission to modify or distribute the Program or its derivative works. These actions are 
prohibited by law if you do not accept this License. Therefore, by modifying or distributing the 
Program (or any work based on the Program), you indicate your acceptance of this License to do so, 
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and all its terms and conditions for copying, distributing or modifying the Program or works based 
on it. 

6. Each time you redistribute the Program (or any work based on the Program), the recipient 
automatically receives a license from the original licensor to copy, distribute or modify the Program 
subject to these terms and conditions. You may not impose any further restrictions on the recipients’ 
exercise of the rights granted herein. You are not responsible for enforcing compliance by third 
parties to this License. 

7. If, as a consequence of a court judgment or allegation of patent infringement or for any other 
reason (not limited to patent issues), conditions are imposed on you (whether by court order, 
agreement or otherwise) that contradict the conditions of this License, they do not excuse you from 
the conditions of this License. If you cannot distribute so as to satisfy simultaneously your 
obligations under this License and any other pertinent obligations, then as a consequence you may 
not distribute the Program at all. For example, if a patent license would not permit royalty-free 
redistribution of the Program by all those who receive copies directly or indirectly through you, then 
the only way you could satisfy both it and this License would be to refrain entirely from distribution 
of the Program. 

If any portion of this section is held invalid or unenforceable under any particular circumstance, the 
balance of the section is intended to apply and the section as a whole is intended to apply in other 
circumstances. 

It is not the purpose of this section to induce you to infringe any patents or other property right 
claims or to contest validity of any such claims; this section has the sole purpose of protecting the 
integrity of the free software distribution system, which is implemented by public license practices. 
Many people have made generous contributions to the wide range of software distributed through 
that system in reliance on consistent application of that system; it is up to the author/donor to decide 
if he or she is willing to distribute software through any other system and a licensee cannot impose 
that choice. 

This section is intended to make thoroughly clear what is believed to be a consequence of the rest of 
this License. 

8. If the distribution and/or use of the Program is restricted in certain countries either by patents or 
by copyrighted interfaces, the original copyright holder who places the Program under this License 
may add an explicit geographical distribution limitation excluding those countries, so that 
distribution is permitted only in or among countries not thus excluded. In such case, this License 
incorporates the limitation as if written in the body of this License. 

9. The Free Software Foundation may publish revised and/or new versions of the General Public 
License from time to time. Such new versions will be similar in spirit to the present version, but may 
differ in detail to address new problems or concerns. 

Each version is given a distinguishing version number. If the Program specifies a version number of 
this License which applies to it and “any later version”, you have the option of following the terms 
and conditions either of that version or of any later version published by the Free Software 
Foundation. If the Program does not specify a version number of this License, you may choose any 
version ever published by the Free Software Foundation. 

10. If you wish to incorporate parts of the Program into other free programs whose distribution 
conditions are different, write to the author to ask for permission. For software which is copyrighted 
by the Free Software Foundation, write to the Free Software Foundation; we sometimes make 
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exceptions for this. Our decision will be guided by the two goals of preserving the free status of all 
derivatives of our free software and of promoting the sharing and reuse of software generally. 

NO WARRANTY

11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO 
WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. 
EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR 
OTHER PARTIES PROVIDE THE PROGRAM “AS IS” WITHOUT WARRANTY OF ANY 
KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE 
PROGRAM IS WITH YOU. SHOULD THE PROGRAM PROVE DEFECTIVE, YOU ASSUME 
THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN 
WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY 
MODIFY AND/OR REDISTRIBUTE THE PROGRAM AS PERMITTED ABOVE, BE LIABLE 
TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR 
CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE 
PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING 
RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A 
FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF 
SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES. 

END OF TERMS AND CONDITIONS

H.1.3  How to Apply These Terms to Your New Programs
If you develop a new program, and you want it to be of the greatest possible use to the public, the 
best way to achieve this is to make it free software which everyone can redistribute and change 
under these terms.

To do so, attach the following notices to the program. It is safest to attach them to the start of each 
source file to most effectively convey the exclusion of warranty; and each file should have at least 
the “copyright” line and a pointer to where the full notice is found. 

one line to give the program’s name and an idea of what it does. Copyright (C) yyyy name of author
This program is free software; you can redistribute it and/or
modify it under the terms of the GNU General Public License
as published by the Free Software Foundation; either version 2
of the License, or (at your option) any later version.
This program is distributed in the hope that it will be useful,
but WITHOUT ANY WARRANTY; without even the implied warranty of
MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the
GNU General Public License for more details.
You should have received a copy of the GNU General Public License
along with this program; if not, write to the Free Software
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Foundation, Inc., 59 Temple Place - Suite 330, Boston, MA 02111-1307, 
USA.

Also add information on how to contact you by electronic and paper mail.

If the program is interactive, make it output a short notice like this when it starts in an interactive 
mode: 
Gnomovision version 69, Copyright (C) year name of author
Gnomovision comes with ABSOLUTELY NO WARRANTY; for details
type `show w’. This is free software, and you are welcome
to redistribute it under certain conditions; type `show c’ 
for details.

The hypothetical commands `show w’ and `show c’ should show the appropriate parts of the 
General Public License. Of course, the commands you use may be called something other than 
`show w’ and `show c’; they could even be mouse-clicks or menu items--whatever suits your 
program.

You should also get your employer (if you work as a programmer) or your school, if any, to sign a 
“copyright disclaimer” for the program, if necessary. Here is a sample; alter the names: 
Yoyodyne, Inc., hereby disclaims all copyright
interest in the program `Gnomovision’
(which makes passes at compilers) written 
by James Hacker.
signature of Ty Coon, 1 April 1989
Ty Coon, President of Vice

This General Public License does not permit incorporating your program into proprietary programs. 
If your program is a subroutine library, you may consider it more useful to permit linking 
proprietary applications with the library. If this is what you want to do, use the GNU Lesser General 
Public License (http://www.fsf.org/licenses/lgpl.html) instead of this License. 

H.2  GNU Free Documentation License
Version 1.2, November 2002

Copyright (C) 2000,2001,2002 Free Software Foundation, Inc. 59 Temple Place, Suite 330, Boston, 
MA 02111-1307 USA 

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing 
it is not allowed.

H.2.1  0. PREAMBLE
The purpose of this License is to make a manual, textbook, or other functional and useful document 
“free” in the sense of freedom: to assure everyone the effective freedom to copy and redistribute it, 
with or without modifying it, either commercially or noncommercially. Secondarily, this License 
preserves for the author and publisher a way to get credit for their work, while not being considered 
responsible for modifications made by others.

This License is a kind of “copyleft”, which means that derivative works of the document must 
themselves be free in the same sense. It complements the GNU General Public License, which is a 
copyleft license designed for free software.
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We have designed this License in order to use it for manuals for free software, because free software 
needs free documentation: a free program should come with manuals providing the same freedoms 
that the software does. But this License is not limited to software manuals; it can be used for any 
textual work, regardless of subject matter or whether it is published as a printed book. We 
recommend this License principally for works whose purpose is instruction or reference.

H.2.2  1. APPLICABILITY AND DEFINITIONS
This License applies to any manual or other work, in any medium, that contains a notice placed by 
the copyright holder saying it can be distributed under the terms of this License. Such a notice grants 
a world-wide, royalty-free license, unlimited in duration, to use that work under the conditions 
stated herein. The “Document”, below, refers to any such manual or work. Any member of the 
public is a licensee, and is addressed as “you”. You accept the license if you copy, modify or 
distribute the work in a way requiring permission under copyright law.

A “Modified Version” of the Document means any work containing the Document or a portion of it, 
either copied verbatim, or with modifications and/or translated into another language.

A “Secondary Section” is a named appendix or a front-matter section of the Document that deals 
exclusively with the relationship of the publishers or authors of the Document to the Document’s 
overall subject (or to related matters) and contains nothing that could fall directly within that overall 
subject. (Thus, if the Document is in part a textbook of mathematics, a Secondary Section may not 
explain any mathematics.) The relationship could be a matter of historical connection with the 
subject or with related matters, or of legal, commercial, philosophical, ethical or political position 
regarding them.

The “Invariant Sections” are certain Secondary Sections whose titles are designated, as being those 
of Invariant Sections, in the notice that says that the Document is released under this License. If a 
section does not fit the above definition of Secondary then it is not allowed to be designated as 
Invariant. The Document may contain zero Invariant Sections. If the Document does not identify 
any Invariant Sections then there are none.

The “Cover Texts” are certain short passages of text that are listed, as Front-Cover Texts or Back-
Cover Texts, in the notice that says that the Document is released under this License. A Front-Cover 
Text may be at most 5 words, and a Back-Cover Text may be at most 25 words.

A “Transparent” copy of the Document means a machine-readable copy, represented in a format 
whose specification is available to the general public, that is suitable for revising the document 
straightforwardly with generic text editors or (for images composed of pixels) generic paint 
programs or (for drawings) some widely available drawing editor, and that is suitable for input to 
text formatters or for automatic translation to a variety of formats suitable for input to text 
formatters. A copy made in an otherwise Transparent file format whose markup, or absence of 
markup, has been arranged to thwart or discourage subsequent modification by readers is not 
Transparent. An image format is not Transparent if used for any substantial amount of text. A copy 
that is not “Transparent” is called “Opaque”.

Examples of suitable formats for Transparent copies include plain ASCII without markup, Texinfo 
input format, LaTeX input format, SGML or XML using a publicly available DTD, and standard-
conforming simple HTML, PostScript or PDF designed for human modification. Examples of 
transparent image formats include PNG, XCF and JPG. Opaque formats include proprietary formats 
that can be read and edited only by proprietary word processors, SGML or XML for which the DTD 
and/or processing tools are not generally available, and the machine-generated HTML, PostScript or 
PDF produced by some word processors for output purposes only.
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The “Title Page” means, for a printed book, the title page itself, plus such following pages as are 
needed to hold, legibly, the material this License requires to appear in the title page. For works in 
formats which do not have any title page as such, “Title Page” means the text near the most 
prominent appearance of the work’s title, preceding the beginning of the body of the text.

A section “Entitled XYZ” means a named subunit of the Document whose title either is precisely 
XYZ or contains XYZ in parentheses following text that translates XYZ in another language. (Here 
XYZ stands for a specific section name mentioned below, such as “Acknowledgements”, 
“Dedications”, “Endorsements”, or “History”.) To “Preserve the Title” of such a section when you 
modify the Document means that it remains a section “Entitled XYZ” according to this definition.

The Document may include Warranty Disclaimers next to the notice which states that this License 
applies to the Document. These Warranty Disclaimers are considered to be included by reference in 
this License, but only as regards disclaiming warranties: any other implication that these Warranty 
Disclaimers may have is void and has no effect on the meaning of this License.

H.2.3  2. VERBATIM COPYING
You may copy and distribute the Document in any medium, either commercially or 
noncommercially, provided that this License, the copyright notices, and the license notice saying 
this License applies to the Document are reproduced in all copies, and that you add no other 
conditions whatsoever to those of this License. You may not use technical measures to obstruct or 
control the reading or further copying of the copies you make or distribute. However, you may 
accept compensation in exchange for copies. If you distribute a large enough number of copies you 
must also follow the conditions in section 3.

You may also lend copies, under the same conditions stated above, and you may publicly display 
copies. 

H.2.4  3. COPYING IN QUANTITY
If you publish printed copies (or copies in media that commonly have printed covers) of the 
Document, numbering more than 100, and the Document’s license notice requires Cover Texts, you 
must enclose the copies in covers that carry, clearly and legibly, all these Cover Texts: Front-Cover 
Texts on the front cover, and Back-Cover Texts on the back cover. Both covers must also clearly 
and legibly identify you as the publisher of these copies. The front cover must present the full title 
with all words of the title equally prominent and visible. You may add other material on the covers 
in addition. Copying with changes limited to the covers, as long as they preserve the title of the 
Document and satisfy these conditions, can be treated as verbatim copying in other respects.

If the required texts for either cover are too voluminous to fit legibly, you should put the first ones 
listed (as many as fit reasonably) on the actual cover, and continue the rest onto adjacent pages.

If you publish or distribute Opaque copies of the Document numbering more than 100, you must 
either include a machine-readable Transparent copy along with each Opaque copy, or state in or 
with each Opaque copy a computer-network location from which the general network-using public 
has access to download using public-standard network protocols a complete Transparent copy of the 
Document, free of added material. If you use the latter option, you must take reasonably prudent 
steps, when you begin distribution of Opaque copies in quantity, to ensure that this Transparent copy 
will remain thus accessible at the stated location until at least one year after the last time you 
distribute an Opaque copy (directly or through your agents or retailers) of that edition to the public.
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It is requested, but not required, that you contact the authors of the Document well before 
redistributing any large number of copies, to give them a chance to provide you with an updated 
version of the Document.

H.2.5  4. MODIFICATIONS
You may copy and distribute a Modified Version of the Document under the conditions of sections 
2 and 3 above, provided that you release the Modified Version under precisely this License, with the 
Modified Version filling the role of the Document, thus licensing distribution and modification of 
the Modified Version to whoever possesses a copy of it. In addition, you must do these things in the 
Modified Version:

A. Use in the Title Page (and on the covers, if any) a title distinct from that of the Document, and 
from those of previous versions (which should, if there were any, be listed in the History section of 
the Document). You may use the same title as a previous version if the original publisher of that 
version gives permission.

B. List on the Title Page, as authors, one or more persons or entities responsible for authorship of the 
modifications in the Modified Version, together with at least five of the principal authors of the 
Document (all of its principal authors, if it has fewer than five), unless they release you from this 
requirement.

C. State on the Title page the name of the publisher of the Modified Version, as the publisher.

D. Preserve all the copyright notices of the Document.

E. Add an appropriate copyright notice for your modifications adjacent to the other copyright 
notices.

F. Include, immediately after the copyright notices, a license notice giving the public permission to 
use the Modified Version under the terms of this License, in the form shown in the Addendum 
below.

G.  Preserve in that license notice the full lists of Invariant Sections and required Cover Texts given 
in the Document’s license notice.

H. Include an unaltered copy of this License.

I. Preserve the section Entitled “History”, Preserve its Title, and add to it an item stating at least the 
title, year, new authors, and publisher of the Modified Version as given on the Title Page. If there is 
no section Entitled “History” in the Document, create one stating the title, year, authors, and 
publisher of the Document as given on its Title Page, then add an item describing the Modified 
Version as stated in the previous sentence.

J. Preserve the network location, if any, given in the Document for public access to a Transparent 
copy of the Document, and likewise the network locations given in the Document for previous 
versions it was based on. These may be placed in the “History” section. You may omit a network 
location for a work that was published at least four years before the Document itself, or if the 
original publisher of the version it refers to gives permission.

K. For any section Entitled “Acknowledgements” or “Dedications”, Preserve the Title of the 
section, and preserve in the section all the substance and tone of each of the contributor 
acknowledgements and/or dedications given therein.
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L. Preserve all the Invariant Sections of the Document, unaltered in their text and in their titles. 
Section numbers or the equivalent are not considered part of the section titles.

M. Delete any section Entitled “Endorsements”. Such a section may not be included in the Modified 
Version.

N. Do not retitle any existing section to be Entitled “Endorsements” or to conflict in title with any 
Invariant Section.

O. Preserve any Warranty Disclaimers.

If the Modified Version includes new front-matter sections or appendices that qualify as Secondary 
Sections and contain no material copied from the Document, you may at your option designate some 
or all of these sections as invariant. To do this, add their titles to the list of Invariant Sections in the 
Modified Version’s license notice. These titles must be distinct from any other section titles.

You may add a section Entitled “Endorsements”, provided it contains nothing but endorsements of 
your Modified Version by various parties--for example, statements of peer review or that the text 
has been approved by an organization as the authoritative definition of a standard.

You may add a passage of up to five words as a Front-Cover Text, and a passage of up to 25 words 
as a Back-Cover Text, to the end of the list of Cover Texts in the Modified Version. Only one 
passage of Front-Cover Text and one of Back-Cover Text may be added by (or through 
arrangements made by) any one entity. If the Document already includes a cover text for the same 
cover, previously added by you or by arrangement made by the same entity you are acting on behalf 
of, you may not add another; but you may replace the old one, on explicit permission from the 
previous publisher that added the old one.

The author(s) and publisher(s) of the Document do not by this License give permission to use their 
names for publicity for or to assert or imply endorsement of any Modified Version.

H.2.6  5. COMBINING DOCUMENTS
You may combine the Document with other documents released under this License, under the terms 
defined in section 4 above for modified versions, provided that you include in the combination all of 
the Invariant Sections of all of the original documents, unmodified, and list them all as Invariant 
Sections of your combined work in its license notice, and that you preserve all their Warranty 
Disclaimers.

The combined work need only contain one copy of this License, and multiple identical Invariant 
Sections may be replaced with a single copy. If there are multiple Invariant Sections with the same 
name but different contents, make the title of each such section unique by adding at the end of it, in 
parentheses, the name of the original author or publisher of that section if known, or else a unique 
number. Make the same adjustment to the section titles in the list of Invariant Sections in the license 
notice of the combined work.

In the combination, you must combine any sections Entitled “History” in the various original 
documents, forming one section Entitled “History”; likewise combine any sections Entitled 
“Acknowledgements”, and any sections Entitled “Dedications”. You must delete all sections 
Entitled “Endorsements”.
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H.2.7  6. COLLECTIONS OF DOCUMENTS
You may make a collection consisting of the Document and other documents released under this 
License, and replace the individual copies of this License in the various documents with a single 
copy that is included in the collection, provided that you follow the rules of this License for 
verbatim copying of each of the documents in all other respects.

You may extract a single document from such a collection, and distribute it individually under this 
License, provided you insert a copy of this License into the extracted document, and follow this 
License in all other respects regarding verbatim copying of that document.

H.2.8  7. AGGREGATION WITH INDEPENDENT WORKS
A compilation of the Document or its derivatives with other separate and independent documents or 
works, in or on a volume of a storage or distribution medium, is called an “aggregate” if the 
copyright resulting from the compilation is not used to limit the legal rights of the compilation’s 
users beyond what the individual works permit. When the Document is included in an aggregate, 
this License does not apply to the other works in the aggregate which are not themselves derivative 
works of the Document.

If the Cover Text requirement of section 3 is applicable to these copies of the Document, then if the 
Document is less than one half of the entire aggregate, the Document’s Cover Texts may be placed 
on covers that bracket the Document within the aggregate, or the electronic equivalent of covers if 
the Document is in electronic form. Otherwise they must appear on printed covers that bracket the 
whole aggregate.

H.2.9  8. TRANSLATION
Translation is considered a kind of modification, so you may distribute translations of the Document 
under the terms of section 4. Replacing Invariant Sections with translations requires special 
permission from their copyright holders, but you may include translations of some or all Invariant 
Sections in addition to the original versions of these Invariant Sections. You may include a 
translation of this License, and all the license notices in the Document, and any Warranty 
Disclaimers, provided that you also include the original English version of this License and the 
original versions of those notices and disclaimers. In case of a disagreement between the translation 
and the original version of this License or a notice or disclaimer, the original version will prevail.

If a section in the Document is Entitled “Acknowledgements”, “Dedications”, or “History”, the 
requirement (section 4) to Preserve its Title (section 1) will typically require changing the actual 
title.

H.2.10  9. TERMINATION
You may not copy, modify, sublicense, or distribute the Document except as expressly provided for 
under this License. Any other attempt to copy, modify, sublicense or distribute the Document is 
void, and will automatically terminate your rights under this License. However, parties who have 
received copies, or rights, from you under this License will not have their licenses terminated so 
long as such parties remain in full compliance.
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H.2.11  10. FUTURE REVISIONS OF THIS LICENSE
The Free Software Foundation may publish new, revised versions of the GNU Free Documentation 
License from time to time. Such new versions will be similar in spirit to the present version, but may 
differ in detail to address new problems or concerns. See http://www.gnu.org/copyleft/.

Each version of the License is given a distinguishing version number. If the Document specifies that 
a particular numbered version of this License “or any later version” applies to it, you have the option 
of following the terms and conditions either of that specified version or of any later version that has 
been published (not as a draft) by the Free Software Foundation. If the Document does not specify a 
version number of this License, you may choose any version ever published (not as a draft) by the 
Free Software Foundation.

H.2.12  ADDENDUM: How to use this License for your 
documents
To use this License in a document you have written, include a copy of the License in the document 
and put the following copyright and license notices just after the title page:
Copyright (c) YEAR YOUR NAME.
Permission is granted to copy, distribute and/or modify this document
under the terms of the GNU Free Documentation License, Version 1.2
or any later version published by the Free Software Foundation;
with no Invariant Sections, no Front-Cover Texts, and no Back-Cover 
Texts.
A copy of the license is included in the section entitled “GNU
Free Documentation License”.

If you have Invariant Sections, Front-Cover Texts and Back-Cover Texts, replace the “with...Texts.” 
line with this:
with the Invariant Sections being LIST THEIR TITLES, with the
Front-Cover Texts being LIST, and with the Back-Cover Texts being LIST.

If you have Invariant Sections without Cover Texts, or some other combination of the three, merge 
those two alternatives to suit the situation.

If your document contains nontrivial examples of program code, we recommend releasing these 
examples in parallel under your choice of free software license, such as the GNU General Public 
License, to permit their use in free software.
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